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Notices
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Preface

The criticality of messaging & collaboration in the enterprise persists. 
Dependency on messaging & collaboration infrastructure to deliver a core set of 
communication & collaboration services, enables small and large enterprises 
alike to provide secure, dependable, flexible communications, contributing to 
organization's information flows, knowledge flows, productivity and cross 
organizational responsiveness. While the mission critical nature of messaging & 
collaboration continues, the variety of collaboration, productivity requirements of 
end users, increased security needs, the support for varying client types and the 
heterogeneous nature of the infrastructure it runs on continues to evolve. 

This Redbook covers both the strategic and market factors that promote the 
benefits of IBM® Lotus® Domino® over Microsoft® Exchange, as well as 
providing an overview of the tools and strategies available, together with hands 
on instruction for how to perform the migration process. The beginning of the 
book explores common business drivers, considerations, benefits and scenarios 
organizations find themselves in when faced with "migration" decision such as 
migrating from Exchange to Domino. The remainder of the book is devoted to the 
architectural planning and technical activities of your migration decision. For 
business or IT managers, the strategic portion of this Redbook provides essential 
information about the “what” and “why” of migration. The rest of the book is 
focused on the “how” of migration, the "how" of co-existence strategies. 

This Redbook will give you the confidence that your organization will achieve the 
results you expect—and deserve—from this migration process from Exchange to 
Domino.

The team that wrote this redbook
This Redbook was produced by a team of specialists from around the world 
working at the International Technical Support Organization, Cambridge, MA, 
USA Center.

Robert Bry is the Worldwide Sales Leader for Worldwide Messaging & 
Collaboration Sales, Lotus software, IBM Software Group in Cambridge, MA 
USA. As a Sales Leader, Robert is responsible representing and driving key 
Collaboration software sales initiatives and growth strategies with IBM software 
sales teams worldwide. He is also leveraged frequently in articulating the 
competitive differentiators of IBM Lotus collaboration software to global 
customers and partners. This is Robert's 11th year with IBM SWG, and has been 
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messaging & collaboration software industry for 15 years. Finally, Robert was an 
author on the Redbook IBM Workplace Services Express, SG24-6758-00. 

Pascal Bourgeois works as a Senior IT Specialist in charge of competitive 
messaging projects for Lotus software in France. He has more than 15 years of 
experience managing technology projects and providing consulting services. 
Among his areas of expertise are MS Exchange and Lotus Domino architectures, 
migration and coexistence strategies and implementations. He joined Lotus in 
1991 and worked in many parts of the organization, ranging from product 
localization to lotus.com management, before joining the recently formed SWAT 
Team. 

Lisa Chase has co-authored several Redbooks/Redpapers, published numerous 
magazine and web articles, and contributed to documentation for the 
Lotus/Domino suite of products. For several years she was part of the Lotus 
Notes Client team, developing features and functionality for the Lotus Notes 
Client, and more recently was a member of the DAMO development team, with 
responsibility for the DUS/Domino Migration Tool. Since leaving IBM, Lisa has 
established her own communications firm, Lucky Fish Communications 
(http://www.luckyfishcomm.com), specializing in business and marketing 
communications with a focus on the high-tech industry. She can be reached at 
lchase@luckyfishcomm.com

Gregory Engels is the founder and CEO of Kompurity - a IBM business partner 
in Frankfurt, Germany (http://www.kompurity.com). He has more then 13 years 
of experience in solution design and architecture, as well as in system consulting 
and integration, with a main focus on Lotus Notes® infrastructure and migration 
projects since 1998. He has been involved in migration projects for over 150.000 
users in total. His areas of expertise include operating complex messaging 
infrastructures, PKI and migration. Gregory is IBM Advanced Certified System 
Administrator and Application Developer for Lotus Notes since R5 and speaks 
three languages fluently, including German, English and Russian.

Graeme Povall is a Senior IT Specialist and Team Leader of the UK Microsoft 
SWAT team. He provides pre-sales consulting on Lotus competitive products 
(WebSphere Portal, Messaging and Collaboration) for  customers within the UK 
and South Africa. Graeme has 20 years of experience working with different 
messaging systems. He joined IBM in 1993 and during his tenure, he  has held 
various positions within the UK and EMEA providing support, training  and 
leadership in messaging, coexistence and migration. Finally, he was a co-author 
of the Redbook, Migrating from Microsoft Exchange 5.5 to Lotus Notes and 
Domino 6, SG24-6955.

Robert Ryan is a Staff Software Engineer for Lotus Software in North America. 
Rob worked as a Corporate Training in the Banking Industry before joining IBM in 
2000. He holds a B.S. in Business Administration from Saint Michael's College 
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and a Web Design Certificate from Boston University. His primary area of 
expertise include Mail Routing Protocols, System Administration, and Migration.  
He is an IBM Certified Domino System Administrator and Application Developer. 
Rob has spoken at multiple World Wide TechTalks and Support Seminars 
covering such topics as Troubleshooting Mail Routing, Mail Journaling, and Mail 
Rules.

John Bergland is a project leader at the International 
Technical Support Organization, Cambridge Center. He 
manages projects that produce Redbooks™ about IBM/Lotus 
Software products. Before joining the ITSO in 2003, John 
worked as an Advisory IT Specialist with IBM Software 
Services for Lotus (ISSL), specializing in Notes and Domino 
messaging and collaborative solutions. 
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with leading-edge technologies. You'll team with IBM technical professionals, 
Business Partners and/or customers. 

Your efforts will help increase product acceptance and customer satisfaction. As 
a bonus, you'll develop a network of contacts in IBM development labs, and 
increase your productivity and marketability. 

Find out more about the residency program, browse the residency index, and 
apply online at:

ibm.com/redbooks/residencies.html

Comments welcome
Your comments are important to us!

We want our Redbooks™ to be as helpful as possible. Send us your comments 
about this or other Redbooks in one of the following ways:

� Use the online Contact us review redbook form found at:

ibm.com/redbooks

� Send your comments in an email to:

redbook@us.ibm.com
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Part 1 Why Migrate 
from Exchange 
to Notes and 
Domino

In this part we discuss key considerations and benefits for migrating from 
Microsoft Exchange 2000 / 2003 to Lotus Notes and Domino 7. 

Part 1
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Chapter 1. Why migrate from Exchange 
2000 / 2003 to Domino 7

This chapter covers the strategic and market factors that promote the benefits of 
IBM Lotus Domino over Microsoft Exchange. It explores common business 
drivers, considerations, benefits and scenarios organizations find themselves in 
when faced with a "migration" decision such as migrating from Exchange to 
Domino. While the first part of the Redbook addresses the strategic question 
about the advantages of migrating to IBM Lotus Domino, the remainder of the 
book is devoted to the architectural planning and technical activities for 
implementing your migration decision. 

For business or IT managers, this chapter provides essential information about 
the “what” and “why” of migration.   The rest of the book is focused on the 
implementation - namely describing in detail how to perform the migration, and 

1

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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how to implement various co-existence strategies. This Redbook gives you the 
confidence and knowledge that your organization needs to achieve the results 
you expect—and deserve—from this process.
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1.1  Introduction

The criticality of messaging & collaboration in the enterprise persists. 
Dependency on messaging & collaboration infrastructure to deliver a core set of 
communication and collaboration services, enables small and large enterprises 
alike to provide secure, dependable, flexible communications, contributing to 
organization's information flows, knowledge flows, productivity and cross 
organizational responsiveness. While the mission critical nature of messaging 
and collaboration continues, the variety of collaboration, productivity 
requirements of end users, increased security needs, the support for varying 
client types, and the heterogeneous nature of the infrastructure it runs on 
continues to evolve.   

Over the past several years there has been a collaboration convergence across 
messaging and collaboration IT infrastructures. For example, the blending of 
synchronous communication into asynchronous communications, such as the 
adding of presence awareness, instant messaging, web conferencing and other 
real-time capabilities into traditional asynchronous collaboration models like 
email, and collaborative applications. Through the natural blending of 
synchronous and asynchronous communication capabilities organizations 
achieve more productive collaboration, and promote quicker response time, 
foster team-building, and make communication richer and more efficient without 
having to manage and administer multiple offerings. Another example is the 
extension of messaging & collaboration into personalized user interfaces like 
dynamic collaborative workplaces or portals and even on mobile devices, which 
deliver a single point of personalized interaction with applications, team 
workplaces, content, processes and people. The emergence of enabling 
technologies such as blogs, wikis, real simple syndication (RSS), are other 
examples of how pervasive the needs are across organizations to share 
information, and collaborate beyond the enterprise.

This collaboration convergence coupled with the proliferation of open standards, 
and open computing models such as J2EE™, Eclipse, Linux®, (and open source 
approaches) are rapidly being adopted to support heterogeneous environments, 
provide interoperability, and insulate from vendor lock in.    Choices on what 
messaging & collaboration platform will be utilized in the organization are now 
more than ever impacted by these trends as organizations adopt a more 
Services Oriented Architecture (SOA) approach and look toward adopting 
solutions that can deliver leading capabilities to enhance productivity, support 
wide range operating systems, clients, extensibility into the infrastructure such as 
to delivering composite applications. Composite application enable the 
integration of information from multiple applications, providing end users with the 
content they need based on their role and task, are quickly assembled from 
reusable components, allow organizations to efficiently adapt software to 
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changing requirements by deliver contextual collaboration and contribute toward 
lowering total cost of ownership.   

Most vendors in the industry are helping drive standards, build their products to 
support and embrace standards to support these heterogeneous environments 
and embrace this pattern of collaboration evolution. While other vendors appear 
to be threatened by it and are choosing instead to regress, or perpetuate their 
proprietary pre-internet models and approaches to collaboration. Some of these 
vendors rather than delivering capabilities which can be delivered with customer 
choice and flexibility, are instead offering solutions which mandate single 
operating systems, client/desktop deployments, and other particular 
infrastructure like Directories. This later proprietary approach can impede the 
potential of collaboration, and limit it's effectiveness which prompts many 
organizations to seek alternatives that more closely align with their business 
objectives.

Perhaps that is why you are reading this publication. You may be re-evaluating 
your commitment to Microsoft Exchange and realizing yet again, a move to the 
most current release of Exchange, Exchange 2007, like the releases before it, 
Exchange 2003/Exchange 2000, will require a migration effort which could have 
significant implications across your infrastructure. A migration that evolves 
moving mail boxes, migration to directory updates, user accounts and migrating 
to an entire new server infrastructure with a specific (latest) release of Windows® 
Server System, followed by decommissioning the older servers, in order to meet 
the requirements and use/embrace/utilize the updated messaging capabilities. 

Figure 1-1 on page 7 refers to what we term as the Microsoft Exchange 
Challenge, emphasizing the need to re-evaluate and re-architect your messaging 
and collaboration infrastructure with each subsequent release of Microsoft 
Exchange. 
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Figure 1-1   Microsoft Exchange Challenge continues

This rigid infrastructure "migration" requirement, and lack of Exchange to support 
"in-place" upgrades to move from one release of Exchange to the next, is in stark 
contrast to that of how IBM Lotus Domino customers for over a decade, 
approach, and conduct upgrades to latest releases of Lotus Domino to embrace 
innovations.   The approach Lotus Domino takes to conduct in-place upgrades; 
leveraging existing infrastructure, existing hardware, existing directories, skills 
and tools built into the product, can be taken as well to "migrate" from Microsoft 
Exchange to Lotus Domino. 

Perhaps your organization is running a number messaging & collaboration 
offerings from multiple vendors and you are seeking co-existence and migration 
best practices. For example, you may be running IBM Lotus Domino for both 
collaborative applications and messaging, while also supporting a community of 
Microsoft Exchange users for simple messaging. These messaging co-existence, 
or messaging unification scenarios sometimes occur as the result of Mergers & 
Acquisition, and you may be trying to determine how to proceed with either 
standardizing/unifying on a common platform or how to continue with a 
co-existence approach.
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These are just few scenarios focused on migrating & co-existence that will be 
covered in this book. More specifically, Part 3, “Coexistence - Tools and 
Strategies” on page 105 highlights specific technical tools available for 
co-existence, while Part 4, “Migration Process - tools and procedures” on 
page 337 highlights methods and tools available for performing the migration. 

1.2  Why migrate?

Why do organizations make migration decisions to move from one messaging & 
collaboration solution to another? Thousands of organizations the past few years 
have made such migrations from Microsoft Exchange to IBM Lotus Domino. The 
reasons are very specific to the organization and are usually interwoven with 
business circumstances such as a merger & acquisition, or strategic projects like 
a messaging unification, server consolidation, or to address key business 
objectives like enhanced security, compliance, reduced downtime, improved 
productivity or lowering total cost of ownership. These messaging & collaboration 
migration decisions can also be heavily driven or prompted by an organizations 
"platform" decisions. Such platform decisions, as eluded to earlier, such as which 
server, and client operating systems to deploy in the enterprise then tend to 
closely align, or influence perhaps what solutions may be preferred to run upon 
them. Several examples include an organization which may have deployed 
Windows 2000 as the required operating system to support a migration 
Exchange 2000. Active Directory and move from NT Directory was also required. 
Now that an organization has deployed the necessary platform clients to meet 
their messaging needs, that might not also be the same platform they use for the 
rest of the mission critical applications. 

� Migrating to IBM Lotus Domino could be easier than Migrating to 
Exchange 2007.

What if you could, rather than migrate to a new hardware and software 
infrastructure in order to merely use the new messaging capabilities in 
Exchange 2007, instead migrate to Domino? This allows you to benefit from 
the industry's leading messaging & collaboration capabilities, on the 
platform(s) of your choice such as multiple variations of Windows and Linux 
servers, with little architectural change, support your current directory & client 
deployed. Finally, this all contributes toward reducing your total cost of 
ownership.

� Migration Tools included

Built in migration tools, Domino Upgrade Services helps reduce the cost of 
migration by extending automated tools, to create new Domino mail accounts, 
migrate data from Exchange to Domino thereby eliminating the need to 
manually re-create entries in the Domino directory or manually move data. 
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There is also a well established set of IBM Partners skills and tools also 
available to assist with various migration scenarios. 

� Support of Microsoft clients

While integrating Domino into Microsoft server infrastructure is key, equally 
important to simplify a migration to Domino at the server end to leverage 
existing Microsoft infrastructure, Domino can also support an Microsoft client 
community. This client support ranges from Microsoft Internet Explorer 
browser based access to Domino mail, calendaring and applications, Notes 
clients integrating with MS Office, Office SmartTag support and even the 
support of Microsoft Outlook® as the primary client interface to Domino. A 
deeper a look at our client options when deploying Domino can be found in 
Chapter 2, “Overview of the Domino clients” on page 25

� Support for more than 1 (one) operating system

Domino runs on 7 operating systems, and 12 different variations of those 
operating systems such as Windows 2000, Windows 2003, RedHat Linux, 
SuSE Linux, AIX, Solaris™ 9, Solaris 9, i5 etc...Being able to exploit and 
leverage a diverse set of existing architecture assets contributes toward 
lowering total cost of administration.

1.2.1  Advantages of migrating from Exchange to Domino

If you are planning or investigating a "messaging migration" you are probably 
interested in determining how the two leading messaging server offerings in the 
market today compare. How are IBM Lotus Domino and Microsoft Exchange 
similar, and how are they different?   Both offerings offer key messaging, and 
calendaring services to their respective primary clients, as well as web browsers 
and mobile devices.

Table 1-1   Offerings from IBM vs. Microsoft

It's almost inappropriate to compare the two. It's more appropriate to compare a 
subset, a fraction of domino capabilities; Domino Messaging Server to Microsoft 
Exchange. as shown in Figure 1-2 on page 10. 

IBM Microsoft

Server Lotus Domino Microsoft Exchange

Client Lotus Notes, Domino Web 
Access, Domino Access 
for Microsoft Outlook

Microsoft Office Outlook, 
Outlook Web Access
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Figure 1-2   Comparison of offerings and functionality between Exchange and Domino

What is common between Domino and Exchange is that they do both provide 
email, calendaring & scheduling and associated rooms/resource reservations 
etc.... but after that differences begin to more and more apparent. (See 
Figure 1-2) For example Domino has built in collaborative capabilities to share 
information, documents, conduct workflows, embedded real-time collaboration 
for presence awareness and interactive instant messaging. Domino provides a 
series of templates for the rapid creation of customized applications, web 
services support to host or consume web services, built administration tools to 
monitor trends performance, and policies. Domino also provides an embedded 
web application server so that email, calendaring and applications be accessed 
via web browsers, includes directory services for authentication, key/credential 
management, provides a rich data store for text, attachments, audio, a replication 
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engine to synchronize data between servers and clients including real-time 
access to backend enterprise systems. 

1.3  Advantages of Domino Server over Exchange 
Server 

The following list provides an overview of the advantage of the Domino Server 
over Microsoft Exchange, with supporting information provided in the subsequent 
section.

� Leading Messaging & Collaboration capabilities

� Integrated Real-time Collaboration

� Choice & Flexibility of Client, Server OS, Directory

� Replication – field level, bidirectional synchronization of data, design, security

� Rapid Application Development & Deployment of Collaborative Applications

� Enterprise Data Integration (SAP, DB2®, Oracle, ERP)

� Investment protection, backward compatibility, and flexible upgrade paths

� Ease of adoption, deployment and administration 

� Enterprise Extensibility via Portlets, built in Web Services & Java™ support

� Security

� IT Governance requirements

� Continued Innovation, w/ Activity Centric computing, composite applications., 
SOA

� Clear Roadmap

1.3.1  Advantages explained

� Leading Messaging & Collaboration capabilities

Lotus Domino server provides enterprise-grade collaboration capabilities that 
can be deployed as world-class e-mail, calendar and scheduling capabilities, 
discussion databases and custom application platform to help companies 
enhance the productivity of people, streamline business processes and 
improve overall business responsiveness. 

The messaging & collaboration capabilities of this industry leading platform 
continue to bring enhancements and benefits to help users prioritize, 
organize, manage information and collaborate. These capabilities range from 
effective mail management built in, easily viewing email threads, 
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priority/attention indicators, quick flagging messages, and preventing data 
loss automatically saving of emails while being composed, to enterprise 
calendaring scheduling to manage their schedules and resources more 
effectively, helping to improve daily productivity. 

While messaging is key part of a collaboration spectrum for communications 
amongst individuals, teams, organizations and external partners for 
information flow, knowledge flow, and workflow it is the foundation of 
collaboration which to build upon. Messaging itself is not the pinnacle of 
collaboration. Unlike Microsoft Exchange which is positioned as a Messaging 
& Collaboration offering, it really has evolved over time and reverted back to 
merely be a messaging server. Lotus Domino is an integrated messaging & 
collaboration platform complete with end user productivity capabilities, such a 
email, calendaring, desktop integration, workflow, web access, document 
sharing and teams to achieve an integrated collaborative environment. Unlike 
Domino, Microsoft Exchange organizations must deploy additional Microsoft 
infrastructure as indicated above to deliver Domino equivalent collaboration 
capabilities.

� Integrated Real-time Collaboration

Lotus Notes/Domino helps maximize employee responsiveness with a single 
point of access to frequently-used resources such as e-mail, calendar, as well 
as built in instant messaging and collaborative tools. Notes/Domino includes 
some enhanced real-time collaboration capabilities, which allow for facilitates 
decision-making through collaboration by incorporating presence awareness, 
instant messaging into the native messaging, calendaring interfaces, andy 
custom built Notes/Domino application and easy integration with the optional 
Web conferencing integration. 

Lotus Notes/Domino users, as part of their license agreement are entitled to 
enable the innate presence awareness capabilities in their Notes application 
interface ranging from e-mail, calendaring, address book, the packaged 
templates that accompany Notes/Domino, including any customized 
applications.   Directly in the context of specific mail messages, documents or 
views users have the ability to see who is on line and initiate a live instant 
messaging session from anywhere in the Lotus Notes and Domino 
environment and save their chat transcript in their a secure, encrypted, full 
text searchable mail file.

This offers both the personal convenience and business necessity of alive 
connection to your colleagues, and the means to engage in real-time 
information exchanges and decision-making directly in the context of the 
collaboration experience — without leaving your Lotus Notes client, nor 
launching a separate client interface installed or third party service. 
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Lotus Notes 7 software provides many improvements to instant messaging 
integration, enabling users to more effectively collaborate in a timely and 
productive manner. By continuing to blend synchronous collaboration such as 
instant messaging and presence awareness more tightly into the natural 
routine of messaging & collaborative applications, employees can respond 
more quickly to urgent issues and make informed business decisions more 
rapidly. Similar approaches with Exchange infrastructure require additional 
Microsoft Office System server middleware deployed including, additional 
hardware, additional software services such as Office Live Communications 
Server, SQL Server, SQL CALs, and desktop software such as Messenger or 
Communicator client and in some cases even linking that requirement to 
specific release of the traditional Microsoft Office desktop suite.

� Choice & Flexibility of Client, Server OS, Directory

Choice and Flexibility are key to determining the right messaging & 
collaboration that fits your organization infrastructure solution to meet your 
company's unique business needs. 

Lotus Notes/Domino provide customers leading capabilities with flexible 
deployment models, which enable organizations to deliver function and 
capability to wide range of clients including supporting Lotus Notes running 
on Windows, Mac and Linux Desktops; Browser clients running Microsoft 
Internet Explorer in a Windows desktop, or Mozilla browsers on Linux; as well 
Microsoft Office centric desktops who might use Outlook as their primary 
email & calendaring client. 

This choice and flexibility model, or as sometimes referred to as "leverage 
without dependence" includes being able to leverage interoperability with an 
organization's enterprise directory of choice for user credentials, 
authentication referrals, and key management. For example, as mentioned 
earlier, most Microsoft environments have Microsoft Active Directory deployed 
to some degree and may prefer to administer their Domino accounts and 
account management from that preferred interface. Domino supports this 
model, and allows for Microsoft administrators to manage, create accounts, 
set up Windows Single Sign On (SSO), propagate account changes from 
Active Directory to Lotus Domino simplifying administration.

The Domino server runs on 7 operating systems, and 12 different variations of 
those operating systems such as Windows 2000, Windows 2003, RedHat 
Linux, SuSE Linux, AIX, Solaris 9, Solaris 9, i5 etc...and is being able to 
leverage a diverse set of existing architecture assets, yet exploit each unique 
server operating system strengths without requiring or over dependence of 
one over the other. This flexibility of supporting multiple client types, on 
multiple client operating systems, and multiple or a mix of server operating 
systems provides our customers a very adaptable and open deployment 
model helps them leverage existing assets, skills and contributes to lowering 
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total cost of ownership than that of systems that are more closed or provide 
limited choice & flexibility such as Microsoft Exchange.

Microsoft's latest release of Exchange, Exchange 2007 requires both a 64 bit 
software and hardware architecture in order to address key memory handling 
constraints which impact scalability of Exchange. As mentioned earlier this 
approach to require a specific Server operating system, as well as specific 
hardware in order to run the latest release of messaging server is 
fundamentally different than that of the approach IBM takes with IBM Lotus 
Domino. Lotus Domino server is well known for supporting a wide range of 
hardware and operating systems – to provide flexibility and help you leverage 
existing investments. In fact, Domino (7.0.1) has already supported 64 bit 
platforms such as IBM i5/OS, IBM AIX, IBM z/OS, Sun Solaris 9 &10, select 
Linux options on IBM System z like Red Hat Enterprise Linux 4.0 (update 3) 
on Intel processor-based systems & Novell SUSE Enterprise Linux 9. 
Updates in subsequent Domino 7 quarterly maintenance releases (7.0.2) 
added more choice & flexibility for the Windows environments to support 
64-bit operating system choices on Intel processor-based systems; Windows 
2003 Server Standard x64 Edition, Microsoft Windows 2003 Server 
Enterprise x64 Edition, Novell SUSE Enterprise Linux 10. While Microsoft not 
only requires 64 bit software and hardware for Exchange 2007 in an attempt 
to address memory and performance constraints of Exchange, IBM expands 
it's choice & flexibility to support more 64 bit architecture, staying in step with 
customers adoption patterns, while also continuing to support Microsoft 
Windows 2000, Windows 2003 and the 32-bit Linux options supported today 
by previous Lotus Domino releases.

Providing choice, flexibility of deployment can mean the difference in adhering 
to total cost of ownership (TCO) scrutiny you are facing and with helps you 
achieve lower TCO.

� Replication – field level, bidirectional synchronization of data, design, 
security

Lotus Domino provides proven replication technology that allows users to be 
productive and efficient even when they are disconnected from the network.

One of the key original differentiators of Lotus Notes since it's inception is the 
patented replication technology built in Notes/Domino. Replication allows for 
the bi-directional exchange and synchronization of data, design and security 
between clients & servers, and amongst servers in an enterprise.   A term that 
has been commoditized in recent years by several competitors, the unique 
capabilities of Lotus Notes replication remain unprecedented.    Replication 
means for mobile users that they have access to mission critical data, 
collaborative applications and enterprise data locally in their encrypted 
replicas on their laptop, that can be seamlessly replicated via a background 
schedule so users can be productive and efficient even when disconnected 
from the network. It also refers to the intuitive drag and drop approach to 
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creating selective replication to retrieve and maintain local version of specific 
team documents folder, or view in a Domino CRM or project tracking 
application. Replication capabilities can also be delivered to browser users 
with Domino Off-Line Services (DOLS), to work with Domino web application 
in a disconnected state with similar productivity results. Replication for system 
administrators means an effective way to propagate administration changes 
such as directory updates, user accounts, global policies, and collect 
statistics across the centralized or decentralized enterprise. Replication for 
designers and developers of applications means change management, or to 
rapidly deploy new applications to new users, design changes to applications 
such as new corporate branding on the corporate web site, additional data 
input fields, or to control a subset enterprise back end enterprise data for 
selective access to key teams. Replication combined with the network 
compression and efficient bandwidth utilization capabilities of Notes/Domino 
are enabling technologies that can be utilized in many ways to bring value 
throughout the organization.

Some of our competitors like Microsoft claim to have replication, or deliver 
only a subset of this replication approach with document level 
synchronization. None of these other vendors have a unified way to effectively 
disseminate not only any new data updates at the document level, but also a 
way to disseminate up to the minute field level changes, security changes 
such as Access Control List, roles based access to certain views, fields, and 
design changes such as new pages, forms, web framesets, java script, or web 
services as a core capability like Notes/Domino does.

� Rapid Application Development & Deployment of Collaborative 
Applications

The integrated collaborative environment of Lotus Domino, and it's capability 
to rapidly develop and deploy collaborative applications with it's Domino 
Designer client continues to be a fundamental difference compared to other 
offerings such as Microsoft Exchange, a messaging solution that requires an 
abundance of additional tools and products to build collaborative solutions. 
Lotus Domino enables organizations to build, manage and deploy 
security-rich, multi-platform, multi-lingual, situational, line of business and 
enterprise applications. An intuitive, graphical user interface gives 
experienced developers, beginner designers and Web site designers the 
capabilities to develop applications that can be accessed from Lotus Notes 
clients, Web browsers, business portals and mobile devices. 

Domino Designer 7 includes numerous features and functions to help build 
applications and increase developer productivity, including rapid development 
templates, object model and components that integrate with other systems by 
hosting industry standards-based Web services such as importing an existing 
Web Service Definition Language (WSDL) as the starting point to build a new 
Web service within a Domino database. Domino's support for Extensible 
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Mark-up Language  (XM) is yet another example of data sharing for robust 
standards based collaborative solutions with Domino. XML marries perfectly 
with Domino applications, as XML gives the power to describe data and share 
it across a network, Domino provides all of the other tools you need to make 
that data sharing secure, reliable, and efficient.

Providing development teams and administrators the flexibility to capture, 
store, and re-purpose Lotus Domino data in a relational database, Lotus 
Domino 7 can use IBM DB2 as an alternative data store to it's proprietary 
database model NSF.

� Enterprise Data Integration (SAP, DB2, Oracle, ERP)

Since Domino helps deliver collaboration in the enterprise by bringing 
together people, process, data, information, and knowledge with wide range 
of services and can be used very closely with Enterprise Resource Planning 
systems and relational data stores. Domino provides non programatic, wizard 
driven connection to external data and define parameters for each connection 
to systems such as DB2, Oracle, SAP, and SQL.

This approaches enables Domino to function as the integration point for 
seamless connectivity among mission-critical enterprise data sources. Now 
your collaborative solutions can transparently leverage Domino collaborative 
strengths in combination with the data management strengths of your 
RDBMS and ERP applications. 

IBM Lotus Notes Suite for SAP Solutions extends the Domino/SAP integration 
capabilities available since 1997, and provides out-of-the-box integration of 
Domino and SAP data and business processes.

This new solution provides out-of-the-box integration for messaging and 
custom applications as part of upgrade or point release to Notes/Domino free 
of charge and delivers several sample use cases Budget monitoring, Time 
management, Leave management, and Organizational management. While 
competitors like Microsoft announce similar capabilities, with partners such as 
SAP, they require additional tools such as Microsoft Infopath and SAP's 
Netweaver. They also charge users an end user fee, IBM enhances its 
existing capabilities to its user community as free quarterly maintenance 
releases as part of Notes/Domino 7.0.1. 

� Investment protection, backward compatibility, and flexible upgrade 
paths

When IBM delivered Lotus Noes 7 to market in 2005, in the same approach 
when we shipped Notes 6, we tested backward compatibility between the 
releases Notes/Domino even running Notes 1, Notes 2 & Notes 3 and 4 
applications going back over 15 years with new Notes/Domino 7. This level of 
backward and forward compatibility enables our customers to apply specific 
enhancements, benefit from specific productivity capabilities at a flexible 
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adoption rate and pace and maximizing their return on investment (ROI).  It 
provides our customers the ability to run and support multiple releases of the 
Notes client, accessing a mixed server release while the design of the 
applications and templates may vary as well - for example running Notes 6.5 
clients against a mix of Domino 7 & 6.5 servers perhaps with some 
applications that were developed with Notes/Domino 5 - all seamless to the 
user community.   This backward compatilibty and interoperability assists 
organizations in flexible deployment and upgrade paths such as being able to 
benefit from key performance and administration features by for example 
implementing a Domino 7, yet run that Domino 7 server in either a cluster, or 
even same physical partition with Domino 6 servers.

Domino supports "in place" upgrades, the ability to install and apply the new 
release of the Domino server on the existing hardware, and on top previous 
release of the software  to upgrade or embrace the new enhancements 
without costly, disruptive migration.  While Notes/Domino supports in place 
upgrades from Domino 6 to Domino 7, even Directly from Domino 5 directly 7, 
competitive offerings offer little support for this flexibility and instead require 
more complex migration approaches moving from one infrastructure to 
another in order to potentially gain from new feature sets.  As previously 
discussed, this concept of an in place upgrade; merely applying the new 
messaging & collaboration enhancements on top of the current installation, a 
model that Notes/Domino has supported from release to release for over a 
decade was not a model supported when moving from Microsoft Exchange 
5.5 to Exchange 2003 nor will be supported when moving from Exchange 
2000/2003 to Exchange 2007. This was referred to earlier in figure 1-1 The 
Exchange Migration Challenge.

The backward compatibility, and interoperability described above equates to 
investment protection, return on investment maximization, mitigation of risk 
and straightforward low cost upgrades.

� Ease of adoption, deployment and administration 

� Lotus Domino has long provided a number of administration facilities which 
can help reduce time and costs associated with administration, systems 
management and software deployment and configuration compared to other 
offerings in market today.

The adoption and deployment of Lotus Notes/Domino is easily executed via 
sophisticated method for performing silent server installs, automated no touch 
client installations via MSI install scripts, upgrades via a push of button for 
smart upgrades without visiting users desktops, and policies to help expedite 
deployments and minimize total cost of ownership. Flexible client deployment 
models, include the ability to support users who share physical assets or 
computers to deliver personalized access to key Notes/Domino applications 
in a multi-user role, as well as highly mobile users who roam from desktop to 
desktop yet retrieve personalized data whenever needed. User communities 
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can be Lotus Notes users, browser users on Windows with Internet Explorer, 
Mozilla Browser users on Linux with Domino Web Access, as well as 
Microsoft Outlook using Domino Access for Microsoft Outlook (note: see 
Chapter 2 for deeper look at client options), allowing for flexible client 
deployments to an organizations clients of choice and minimizing training 
costs/requirements. New user accounts and mail boxes can be created from 
existing LDAP directory entries, by leveraging built in migration tools that can 
also migrate data from Microsoft Exchange into Notes/Domino as part of a 
automated account creation process.

Once flexible deployments are executed, Domino differentiators continue 
such as setting and managing mail quotas, policies, quarantine, journaling 
and archiving for compliance built in. With Domino policy-based 
administration you can easily set standards and enforce IT policies across the 
organization such as the option to lock down client settings, or deploy 
granular archiving, security and corporate governance/compliance settings, 
and messaging confidentiality disclaimers. 

Without having to acquire third party add on products, Domino also empowers 
administrators to reduce time spent troubleshooting servers, capturing & 
analyzing server data, provide prescriptive actions and load balancing tools. 
Domino 7 now includes Domino domain monitoring for fast recognition and 
reporting of critical server issues by delivering a single, feature-oriented view 
through which administrators can see the status of multiple servers across an 
entire organization in one or multiple domains. This customizable tool enables 
administrators to assess the overall health of across the collaboration 
infrastructure in the enterprise and locate problems that may need attention. 
When a problem is reported, domain monitoring suggests probable causes, 
provides possible solutions to fix the problem, and the actions to do so. 
Additional administration technology built in to Domino provides powerful, 
predictive analysis tools to help administrators to capture activities, trends to 
predict growth and sizing requirements within the Lotus Domino server 
environment and to plan for potential hardware, software changes, workload 
balancing and change management tools to help keep the Domino 
deployment running at an optimal level in your infrastructure.

One of the most significant differentiators affirmed by organizations who have 
migrated from Microsoft Exchange to Domino is the product maturity, 
scalability, performance associated with availability and meeting service level 
agreements with Domino. Existing Domino customers have benefited in 
upgrading to Notes/Domino 7 to achieve a higher level of scaleability. For 
example metrics from the IBM development lab (using NotesBench 
workloads, a performance metric used by server hardware vendors) and 
statistics show significantly enhanced scalability and performance.   IBM 
Lotus Domino 7 uses up to 25 percent less CPU resources than it's previous 
Domino 6.5 server release, and can support up to 80 percent more Lotus 
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Notes users or up to 50 percent more Lotus Domino Web Access users for 
browser access on the same server hardware. Similar benefits can be gained 
when you move from Microsoft Exchange to Lotus Domino. You can leverage 
your existing hardware, support and exploit existing server operating systems, 
and deliver a more scalable, reliable environment. 

In addition to the superior administration tools and capabilities mentioned 
above Domino provides capabilities to help maximize server availability: 
advanced clustering, transaction logging, server fault recovery, and 
automated diagnostic tools. Clustering delivers high availability, constant 
access to data to user community, balances server workload across servers 
balancing and fail over to provide un-interrupted access to mail and 
applications to user communities. A Domino cluster is a group of two or more 
servers that provides users with constant access to data, balances the 
workload between servers, improves server performance, and maintains 
performance when you increase the size of your enterprise. The servers in a 
cluster contain replicas or real-time replicas of databases that you want to be 
readily available to users at all times. If a user tries to access a database on a 
cluster server that is not available, Domino opens a replica of that database 
on a different cluster server seamless to the user for un-interrupted access. 
Domino continuously synchronizes databases so that whichever replica a 
user opens, the information is always the same, current and available 24x7.

Solutions from vendors like Microsoft are tied specifically to a certain 
operating system, and may require add on or third party products to aspire to 
have this level of availability, providing fail over or back up & recovery.  For 
example, Exchange clustering is really dependent, and leverages the 
Windows clustering and database management facilities.   Lotus Domino 
clustering is achieved independent of the operating system by leveraging it's 
unique, efficient replication capabilities, transaction logging, cross platform 
support and flexible database model. This helps ensure load balancing, fault 
recovery, and rapid backup and recovery procedures that can across multiple 
operating systems, still not attained by competitive products like Microsoft 
Exchange. 

� Enterprise Extensibility via Portlets, built in Web Services & Java 
support

Lotus Notes/Domino collaborative application access can easily be extended 
& integrated with other enterprise technologies such as portals through 
various programatic, and non-programatic ways including Web Services, Java 
or portlets. Domino provides this enterprise extensibility by embracing open 
standards and actively integrating in today’s heterogeneous environments. 
Lotus Domino provides a native Web services hosting service based on 
Simple Object Access Protocol (SOAP). This enables organizations to use 
Web services to integrate your applications with J2EE and Microsoft .NET 
environments, simply, and using existing skills. 
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For integrating or extending custom built Domino applications, or one of the 
thousands available from IBM Business Partners into a an organizations 
enterprise portal, portlets can be used. This can be accomplished with no 
programming, or without re-writing the Domino application in a WebSphere 
Portal Server environment with the help of Portlets. The term portlet refers to 
a small portal application, usually depicted as a small box on a Web page or 
in a portal user interface. A portlet is a reusable Web module that runs on a 
portal server component. 

Integrating or extending custom built Domino applications, or one of the 
thousands available from IBM Business Partners into a an organizations 
enterprise portal, can be accomplished with no programming, or without 
re-writing the Domino application in a WebSphere Portal Server environment 
with the help of Portlets. The term portlet refers to a small portal application, 
usually depicted as a small box on a Web page on a portal user interface. 
These portlets are a reusable module that runs on a portal server component. 

This extensibility approach allows organizations to derive value from the rapid 
application development and collaborative nature of Domino centric 
applications. It also allows organizations to extend the reach of a wide range 
of communities in the organization via standard interfaces, commonly 
leveraged to further the return on investment and avoid costly disruptive 
migration approaches associated to other platforms.

� IT Governance Requirements

Recent developments in the area of IT Governance have arisen that may 
impact the decision to migrate from one messaging platform to another.

Legislation such as Sarbanes/Oxley, Graham-Leach Bliley, Patriot Act and 
HIPPA as well as civil lawsuits are impacting messaging systems in that legal 
discovery is often dictating messaging architecture.  Increased server 
consolidation is one area that is a direct result of the desire to better control 
the information life cycle of email.

– IT Governance in the form of CoBIT 4.0, ISO 17799, ITIL and ValIT are 
requiring vendors to demonstrate that their products can be managed 
within those frameworks.

– Confidentiality, availability and integrity of data are seen as essentials 
feature sets in any deployment of new software.  Applications that due not 
meet these criteria are unlikely to be accepted not because of their 
technical capabilities but more because of a perceived lack of these vital 
characteristics by independent auditors.

– Microsoft's Exchange product can be portrayed as vulnerable in several of 
the aforementioned areas.

• Exchange 2003 cannot support large numbers of users on a heavily 
used system once disk i/o becomes an issue.  Virtual memory 
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fragmentation becomes a problem.  The inability to support large 
number of users impacts efforts at server consolidation which in turn 
hampers efforts at information life cycle management.  Microsoft's 
answer is the 64 bit architecture of Exchange 2007 which reduces disk 
i/o by putting more transactions into cache.

• Availability is still a weakness with Exchange. Clustering over any 
geographic distance to provide quick recovery in the event of a facilities 
disaster requires third party products which introduce high levels of 
complexity.  As messaging is used by many automated controls to 
provide notification of control failure, the availability of a messaging 
system can impact the reliability of systems considered by external 
auditors to be critical.  AD and DNS are also vulnerable to denial of 
service attacks which in turn can reduce Exchange's availability.

• Auditing of changes made to a Microsoft environment or event failures 
may require third party software simply to manage the large number of 
events.  If software policies require action be taken and documented, 
this can prove to be a costly control.

Domino 7 has the ability to meet or exceed IT governance requirements.It 
provides scalability on secure Unix servers This allows for industry leading 
asynchronous clustering and high availability. Messaging systems contain 
automated controls for event notification and Domino provides the reliable 
messaging and high availability required to avoid consequences of not 
receiving those notifications.

� Security

Advanced and proven security features – granular access control, end to end 
encryption of data; locally on the desktop, at the server, at the ports and in 
transit to deliver strong cryptography for Notes protocols, and Internet 
protocols. Includes digital signatures to digitally sign emails, and electronic 
documents for non repudiation. Includes x.509 certificate services, and ability 
to support dozens of third party x.509 Certificates of Authority (CA). Includes 
Server level spam control, with DNS Black lists & White lists support. Support 
for SmartCards, and ability to customize the LDAP scheme, 

� Continued Innovation with Composite Applications & Activity Centric 
Collaboration

The innovation with Notes/Domino continues with delivering enhanced 
collaboration services to users with Activity Centric Collaboration and 
Composite Applications. Composite applications enable the integration of 
information from multiple applications (such as Java, .Net, Web Services, 
Web applications, Domino applications), providing end users with the content 
they need based on their role and task. Based on Services Oriented 
Architecture approach (SOA), composite applications are quickly assembled 
from reusable components, and allow organizations to efficiently adapt 
 Chapter 1. Why migrate from Exchange 2000 / 2003 to Domino 7 21



7777ch_why_migrate_strategy.fm Draft Document for Review September 11, 2006 10:43 pm
software to changing requirements. With Lotus Notes, customers will be able 
to combine disparate desktop applications into reusable services. Lotus 
Notes/Domino also integrates a new concept called activity-based computing. 
Activity-based computing extends the value of content created in the course 
of everyday work -- e-mails, meetings, documents, chats and notes -- by 
associating them with specific projects or processes. The ability to bring 
together all of the content related to an activity in an intuitive shared 
repository helps ensure team members have the same, up-to-date view of all 
aspects of the activity, helping to increase productivity and speeding 
time-to-completion of the activity. 

� Clear Roadmap

Lotus software continues its evolution into the future, with a clear roadmap 
building on a history of investment protection and smooth integration. 
Understanding the need for communicating a clearn roadmap and 
commitment to Notes/Domino, the next major release of Notes  code named 
"Hannover" currently in Beta at the time of writing this redbook, was 
announed even before we shipped Notes/Domino 7, is planned to be 
available 2007

The roadmap is clear, the next release of Lotus Notes aims to set new 
industry and customer precedents for openness, value and productivity. At 
major points in it's history Notes delivered innovative collaborative 
enhancements & capabilities, seldomly taking anything way, and while 
supporting emerging open standards for growth and interoperbility.  This 
additive approach of being responsive to the needs of  a passionate user 
communitiy, to the evolving nature of collaboration while supporting emerging 
standards contirbutes toward the broadening the adoption and innovative 
ways the technology could be applied.  Lotus Notes/Domino is poised yet 
again, for growth with it's clear roadmap of innovation, investment protection 
and openess to naturally extend the product’s openness to a new class of 
open, role-based, server managed, messaging and collaborative applications.

Planned updates as part of this roadmap include Innovative user interface, 
Notes "Hannover" be the first major commercial collaboration client based on 
the Eclipse open source framework, ability to develop and run composite 
applications which combine components from multiple applications into a 
single, role-based interface,new activity centric computing model that lets 
users organize, navigate, manage, share information such as e-mails, 
calendar entries, documents, e-meetings — around a particular activity or 
project and the inclusion of business producitivity editors.  These business 
productivty editors such as word processing, spreadsheet, presentations etc.. 
will be included at no additional charge and are compatible with Microsoft 
Office software and will support the OpenDocument Format (ODF), an 
international standard for saving and sharing editable documents.
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With this roadmap and upcoming "Hannover release, IBM is staying true to 
the purpose and usefulness of the Lotus Notes client experience, and to the 
investments users have made in IBM Lotus Notes, while at the same time 
naturally extending the product’s openness to new programming techniques 
and incorporating real innovation.

1.4  Summary

By moving from Exchange to Lotus Domino, organizations are migrating to a 
secure, reliable, and scalable Lotus Domino messaging infrastructure that can 
use the hardware and operating system platforms that are supported by Lotus 
Domino. This gives organizations far more server side deployment flexibility than 
Microsoft Exchange and allows them to more effectively leverage the 
performance, scalability, and reliability of different types of hardware and, more 
significantly, a multitude of non-Windows-based operating systems. Finally, it 
helps administrators control IT costs that are associated with this change. The 
product‘s maturity, dependanbility, built in tools for migration, adminstration, 
standards baseds support, flexible client support and years of migration best 
practices, such as those reflected in this publication, can help you mitigate the 
risk and more quickly gain the benefits of migrating to Lotus Domino.
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Chapter 2. Overview of the Domino 
clients

This chapter provides an overview of the client options to consider when 
migrating from Exchange to Notes and Domino 7. 

The Lotus Notes and Domino 7 platform gives you a much broader and wider 
choice of available clients to choose from than Microsoft does for the Exchange 
platform 

In this chapter we provide an overview of the different clients and explain each of 
their key strengths.

2

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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2.1  Think Outside the Inbox

With Lotus Notes and Domino 7, the goal is to think beyond email. Lotus Notes 
and Domino 7 provide a total solution to your messaging, application 
development, and integration needs, making your users more productive by 
giving them exactly what they need, when and where they need it, with 
unparalleled security, robustness, and scalability. 

Lotus Notes and Domino 7 have much to offer. Many enhancements to the Lotus 
Notes Client give your users the tools they need to do their jobs, all with an 
improved and more intuitive interface. Improved performance and features in 
Domino Web Access and Domino Access for Microsoft Outlook allow you to 
extend your environment. Progammability and Usability enhancements to the 
IBM Lotus Domino Designer® allow your developers to leverage existing skills 
and take advantage of new technologies, all from within a single, familiar 
interface. Performance and administration improvements to the Lotus Domino 7 
Server allow you to “do more with less”, and enable your administrators to keep 
your environment running smoothly. And the Extended Products add value to 
your existing investment in Lotus Notes and Domino, while also allowing you to 
leverage your other IT investments, and extend their reach. Lotus Notes and 
Domino 7 have something to offer nearly everyone in your enterprise.

Lotus / IBM provide a full range of client offerings, providing a broad range of fully 
featured clients to address specific needs most appropriately. 

Figure 2-1   Offering of clients for Notes and Domino 7
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2.2  Flexibility in Features and Offerings

When considering the needs of end users and client offerings, it is important to 
distinguish between different categories of user needs and the technology 
required to meet these needs. For example, certain groups of users will require a 
fully functional messaging client, with ‘advanced’ functionality while another 
category of users may have much more basic needs. In addition to meeting the 
users’ needs with an appropriate client, an organization must also consider the 
cost in deploying, managing and updating these clients throughout the 
organization. For the purpose of this discussion, we identify five typical 
categories of end users and their workstation requirements:

� Fixed Function Kiosk
� Technical workstation
� Transactional workstation
� Basic office workstation
� Advanced office workstation

The objective is to examine the client offerings for the Notes and Domino 7 
platform, and better understand how each of these different client offerings from 
IBM can best meet these needs. 

Figure 2-2 illustrates the client offerings in terms of functionality vs. frequency of 
use. 

Figure 2-2   Workstation classifications
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Deskless Workforce - 
� Fixed Function Kiosk

The fixed-function kiosk usually runs only one or two specialized applications 
and can be served by other Workplace™ client technologies like the browser 
or the mobile client. 

� Transactional workstation:

Users using these desktop machines typically run multiple customized 
business applications, most of which are structured or forms-based. They 
also browse the Web and collaborate through basic email. Email usage is 
limited to within the company, and generally the users do not have operating 
system expertise. These users may use simple server-based office 
productivity applications that may be remote or available via HTML. 

Office Workforce
� Technical workstation:

Workstation in a development or engineering environment. Users 
communicate via email, instant messaging and make extensive use of 
development tools or graphical CAD/CAM applications. 

� Basic office workstation:

Employees in the business world use desktop computers to drive company 
processes and productivity using word processing, presentation and 
spreadsheet applications. These users use the applications to create and 
view simple documents such as memos, letters, presentations and 
spreadsheets.

Generally these users require only basic compatibility (including basic import 
and export compatibility) with other document formats, such as Microsoft 
Office. These are not “power” office users, so they do not require complex 
functions such as scripting. They require basic browser functionality to access 
information such as corporate guidelines, parts information and loan 
information. They use email to communicate information and to send 
documents through attachments.

Knowledge Workforce
� Advanced office workstation:

Advanced office workstations users use desktop computers to drive company 
processes. They use arbitrary Windows applications that are dependent on 
Windows application program interfaces (APIs) such as MFC, IE and WIN 
APIs. They are highly skilled in the Windows user interface, and they depend 
on being able to interact with the Windows operating system and 
Windows-based applications to do their jobs.
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Users of these general-purpose desktops employ applications to create and 
modify complex documents for use within and outside of their companies. 

2.2.1  Overview of the Client Offerings

Lotus Notes 7 Client
IBM Lotus Notes is high-function, integrated desktop client software that set the 
standard for innovation in messaging and collaboration two decades ago. Lotus 
Notes client software is the premier of several client options for IBM Lotus 
Domino server. Together, Lotus Notes and Domino deliver a reliable, 
security-rich messaging and collaborative environment that is designed to help 
companies increase employee productivity, facilitate decision making, and 
improve overall business responsiveness.

Lotus Notes software can be deployed specifically for e-mail, calendar and 
scheduling as well as integrated personal and team productivity tools (IBM Lotus 
Notes for Messaging). Alternatively, it can be deployed as a customizable 
desktop platform to access and run collaborative applications in addition to using 
messaging capabilities (IBM Lotus Notes for Collaboration)*. 

Lotus Notes offers robust security features that can help minimize or eliminate 
the impact of computer viruses. Execution control features can help keep 
unauthorized scripts, code and formulas from running on your workstation. 
Multi-tier security options allow control of access rights from the server level all 
the way down to an individual field on a form.

Lotus Notes incorporates advanced replication technology that allows users to 
be productive and efficient even when they are disconnected from the network. 
Replication enables users to save a local copy of a Lotus Domino application and 
its data, and to periodically synchronize the data that has changed. Network 
compression and streaming replication features can help reduce the amount of 
data transmitted over the network, and thus help minimize use of precious 
bandwidth resources.

With Version 7, IBM extends the reach of Lotus Notes messaging and 
collaboration solutions while continuing to leverage your IT and application 
investments. Integration with IBM Workplace products allows organizations to 
extend and leverage their existing infrastructure investments. Enhanced 
integration with instant messaging and Web conferencing enables users to have 
immediate access to the people and tools they need to do their jobs more 
effectively and make better, more-informed business decisions. And productivity 
enhancements in e-mail and calendar functions enable users to better manage 
daily information and resources.
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Enhance features in Lotus Notes 7
Lotus Notes 7 offers a number of new Calendar and Scheduling features as well 
as tighter integration with IBM Lotus Sametime®. Other functional areas that 
have been enhanced include mail, desktop, accessibility, and interoperability. 

Significant improvements have been made to the desktop, allowing users to 
customize their interaction with the desktop, either by saving window state on 
exit, or by determining which tabs open on startup. Further, a user no longer has 
to wait while a view updates; since the update happens in the background, the 
user can work in other areas while the view is updated, providing the opportunity 
for improved productivity. And a new AutoSave feature has been introduced to 
help prevent data loss when unexpected outages occur; users can enable 
AutoSave in their preference on the Lotus Notes client to save their work every 
few minutes when working in AutoSave-enabled applications, and designers can 
enable AutoSave on forms in new and existing applications

Calendar and Scheduling has been updated to better reflect customer needs. A 
new Calendar Cleanup action allows users to easily and quickly delete old 
entries from their calendar. Handling of conflicts has been improved, first by 
giving the user the option to allow Autoprocess to accept conflicts, and also by 
improving the display of schedule conflicts. Additionally, users can now cancel 
Calendar/Scheduling workflow when sending comments. View and miniviews of 
calendar information have been improved for better usability, and the needs of 
Calendar Managers have been addressed. Further, many improvements have 
been made to the way Rooms and Resources are managed, including the ability 
to restrict rooms, and to designate a room as restricted to those attempting to 
reserve it, and changes to the workflow to prevent double-booking, in addition to 
providing greater granularity of control to Administrators in charge of the Rooms 
and Resources process.

In Lotus Notes 7, you will find much closer integration with Lotus Sametime. 
Integration has been added to templates for the mailfile, Teamroom and 
Discussion databases, the Personal Name and Address book, the Lotus Domino 
Directory, and the Rooms and Resources databases. In these databases, not 
only can users see who is online, they can initiate an instant messaging session 
directly by clicking on the status icon. Also, several preferences have been added 
for Lotus Sametime Integration that allow a user to specify automatic or manual 
logging in, to save transcripts of instant messaging conversations to the mailfile, 
and support set preferences about how Screen Sharing, Whiteboarding, Audio 
and Video are used through the Lotus Notes client.

Numerous usability improvements have been made to Mail. Among the highlights 
are a no subject warning, the ability to sort by subject out of the box, quick 
access to flag items for follow-up, and the ability to see mail threads within an 
email. The right-click menu has been expanded as well, and administrators can 
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now control Mail Preferences via policies. Finally, visual tags have been provided 
to indicate whether an email was sent to the recipient only, and a user can now 
find out what folders hold a document using the “Discover Folders” action.

To increase your options, the Lotus Notes Application plug-in included as part of 
the Lotus Notes and Domino 7 release, which was designed to work with the IBM 
Workplace Managed Client. For additional information, please consult the 
product documentation for IBM Workplace Collaboration Services 2.5, which 
can be found here:

http://www-10.lotus.com/ldd/notesua.nsf/6c87a7297ac2aa71852569810051910
9/865ed40240bc25ae852570060050eb40?OpenDocument

Finally, a number of improvements have been made to the archiving process.

For details on these and all other new client features, see the Lotus Notes and 
Domino 7 release notes on the Lotus Developerworks site:

http://www-10.lotus.com/ldd/notesua.nsf/e18d5eb0b8be97d9852567e50052ad1
6/ec099861d91381fc852570360051903c?OpenDocument

IBM Lotus Domino Web Access 7
In some situations, accessing email and discussion forums from a thick client 
installed on a dedicated workstation is not practical. For instance, employees 
require the flexibility to access important information when at home, while 
traveling or using a shared workstation. For those situations, we created Lotus 
Domino Web Access, IBM's premier Web client for accessing a Lotus 
Domino-based mail file. Lotus Domino Web Access offers a rich user experience 
for both Microsoft Internet Explorer, Mozilla and Firefox browsers through the 
use of dynamic HTML (DHTML). As a DHTML application, Lotus Domino Web 
Access client performance is governed by server performance, network 
performance, and client configuration.
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Figure 2-3   Domino Web Access 7

Lotus Domino Web Access 7 has many improvements in the areas of 
performance and usability. Highlights include:

� Opportunity for improved client and server performance

� Enhanced security features

� Expanded presence awareness and instant messaging integration

� Updated user interface

� Added mail and calendar productivity features

� Enhanced support for Linux

� New administration and management features

� Improved offline access to personal data

IBM Lotus Domino Web Access 7 software is a sophisticated Web client for 
Lotus Domino server. Lotus Domino Web Access software gives your employees 
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the power to create rich text messages, schedule meetings, manage tasks and 
collaborate with colleagues-whether they are using their own workstation, an 
Internet kiosk or another user's PC. With Lotus Domino Web Access 7, you get 
the best of both worlds: access to a robust, reliable, enterprise-class messaging 
and collaboration platform, with the ease of simply opening a browser.

Note: Lotus Domino Web Access 7 takes advantage of Lotus Domino 7 Server 
performance improvements, both in the core server functionality, and in HTTP. 

IBM Lotus Domino Access for Microsoft Outlook (DAMO)
Lotus Domino Access for Microsoft Outlook offers the ideal solution for 
companies that want to leverage the robustness and security advantages of the 
Domino server, while preserving their dedicated Microsoft Outlook user base. 
Additionally, in the case where a company merger or acquisition leads to a 
mixed-client environment, Lotus Domino Access for Microsoft Outlook enables 
user to run the Outlook or Lotus Notes client over the same Lotus Domino mail 
file data. Company mergers and acquisitions can mean having multiple email 
clients in use. Whether you choose to migrate fully to a Lotus Notes and Domino 
environment, or allow the Lotus Notes and Lotus Domino Access for Microsoft 
Outlook clients to coexist, Lotus Domino Access for Microsoft Outlook provides 
the functionality to smoothly integrate Microsoft Outlook users into your Lotus 
Domino infrastructure, while letting them continue to access mail and work with 
calendar functions through a familiar interface.
 Chapter 2. Overview of the Domino clients 33



7777ch_client_options.fm Draft Document for Review September 11, 2006 10:43 pm
Figure 2-4   Outlook client - accessing data through a Domino Server

Among the highlights of Lotus Domino Access for Microsoft Outlook 7 are:

� Opportunity for improved client software performance, reducing the time to 
launch the application compared to 6.5.3.

� Native support for Internet standards, including X.509 and Secure 
Multipurpose Internet Mail Extensions (S/MIME) 

� Installation option for separate program and data directories, allowing multiple 
users to share the same machine, using Microsoft Windows operating system 
security. 

� New mail notification options, including playing a sound, briefly changing the 
mouse cursor, and showing an envelope icon in the notification area. 

� Option to use a local copy of your global address book; this can be a full copy 
of the directory or a condensed directory catalog to save space on your 
workstation.
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Additionally, Lotus Domino Access for Microsoft Outlook 7 users can use Lotus 
Domino applications via a browser, dramatically increasing access to your 
existing Lotus Domino applications. Finally, because, Lotus Domino Access for 
Microsoft Outlook 7 does not require a Lotus Domino 7 server, you can take 
advantage of these improvements today, before you complete your server 
upgrade, as long as your users’ mailfiles reside on Lotus Domino release 6.5.1 or 
above. For more information on DAMO, please refer to the product homepage at:

http://www-142.ibm.com/software/sw-lotus/products/product1.nsf/wdocs/ac
cessmsoutlookhome

2.2.2  Common PIM Portlet

Common Personal Information Management (PIM) portlets were first introduced 
in IBM WebSphere® Portal 5.1 and include two portlets, Common Mail and 
Common Calendar. CPP provides a single user interface and user experience to 
access a range of PIM solutions, including IBM Lotus Domino, Microsoft 
Exchange, IMAP, and POP3. In WebSphere Portal 5.1, the Common Mail portlet 
supports Domino, Exchange 2000, POP3, and IMAP. The Common Calendar 
portlet supports Domino.

Figure 2-5   Common PIM Portlet can integrate different backend systems into a single 
portal

Exchange 2000

Workplace Domino POP3 Server

IMAP Server

Common PIM Portlet for Mail and Calendar

WebSphere Portal Server
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For a company that has multiple PIM systems, such as Exchange, Domino, and 
POP3/IMAP servers, CPP gives users a common user experience while 
accessing different backend systems. As a result, it could be argued that CPP 
lowers the total cost of ownership (TCO) in terms of training and technical 
support. The latter part of the article will focus on the user experience and 
advanced features, including Document Library integration, Document 
Conversion for viewing attachments as HTML, Address Finder, and C2A in the 
Common Mail portlet.

Figure 2-6 illustrates the Mail Portlet for the Common PIM Portlets.

Figure 2-6   A Common PIM Portlet connected to a Domino Mailbox

Advantages to the Common PIM Portlet include

� Provides a Browser client user interface to Mail functions such as Email 
composition, viewing and Inbox management

� Can connect to multiple Email service providers, including Domino, 
Exchange, POP3 and IMAP

� Adapts to the capabilities of the service provider – not a least common 
denominator approach

� Can launch DWA or Notes as a secondary client for Domino if enabled by 
Administrator

Figure 2-7 illustrates the Calendar PIM Portlet.
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Figure 2-7   A Common PIM Calendar Portlet

When using the Common PIM Portlet, you can select which backend system you 
wish to connect with. 

Figure 2-8   Configuration of the Mail Portlet - you can select different back-end mail systems

2.2.3  Potential Co-existence scenario using the PIM Portlet approach. 

The figures in the upcoming section focus Exchange integration and Domino 
integration and how the Common PIM Portlets could be potentially in a 
coexistence scenario between Lotus Domino and Microsoft Exchange. Similar to 
functionality provided by WebSphere Portal, the Common PIM Portlets could 
deliver a common interface to both Domino and Exchange communities. Once a 
portal approach and browser based approach is taken the migration behind the 
scenes can be "transparent" or seamless giving the user either a consistent 
interface no matter which system is serving as the back-end. This functionality 
remains valid before, during, and after a migration/coexistence scenario.
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Figure 2-9 on page 38 illustrates how using the calendaring PIM Portlet allows a 
user a seamless, consistent interface, using either a Domino back-end server, or 
when working in an Exchange environment. 

Figure 2-9   Calendar PIM Portlet - used with either Domino or Exchange

Figure 2-10 illustrates again how using the Common PIM Messaging Portlet 
(Mail Portlet) allows a consistent, seamless interface, with flexibility to work with 
either a Domino messaging system or an Exchange messaging server. 

Domino Back-endExchange Back-end
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Figure 2-10   Common PIM Portlet (Mail Portlet) - working with either a Domino Server or an Exchange 
server. 

Finally - while this represents one potential co-existence option, we discuss 
several possible approaches to co-existence and what to expect in Part 3, 
“Coexistence - Tools and Strategies” on page 105. 

Domino Back-end
Exchange Back-end
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Part 2 Planning for 
Migration

In this part we introduce/provide/describe/discuss...

Part 2
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Chapter 3. Migration project overview

This chapter is to help project managers and IT architects develop an overall 
migration project plan. It covers some standard project management topics, as 
well as very specific information on what will be needed to get the project 
running.

Since no two migration projects are alike, we strongly recommend that the 
information in this book be used as input for the project, not as the final word on 
how the project should be run.

We discuss several project scenarios and high level considerations for the project 
plan. We also address migration as well as a possible coexistence scenarios. 

The steps and activities described in this chapter, along with the detailed 
guidelines and technical examples for migration and coexistence provided in later 

3

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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chapters, will assist the project team in migrating from the Microsoft Exchange 
2000 / 2003 environment to Domino 7.

3.1  The key steps in a co-existence/migration project
The following high-level steps are the keys to successfully planning and 
implementing a migration project:

� Have a project sponsor that is involved in the project

� Define the project vision

� Assemble the right project team

� Develop and maintain the project schedule

� Project scope management

� Document business requirements

� The communication plan

� Set project expectations

� Document the current Microsoft Exchange messaging environment

� Develop the training plan

� Plan, design, and document the new Domino and Notes environment

� Risk analysis

� Pilot the new environment

� Develop a coexistence and migration strategy

� Pilot the coexistence and migration strategy

� Implement the coexistence and migration strategy

� Final phase - project closure

Attention: This chapter is not intended to be a complete project management 
handbook, even for a migration project. Every organization, environment, and 
project is different, and expert project management skills are needed to 
manage the project successfully. The goal of this chapter is to increase your 
awareness of the topics you should consider and act on when planning and 
implementing the project.

For information about project management, refer to the Project Management 
Institute Web site at: 

http://www.pmi.org
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An overview of each step follows; thorough discussion of these topics is in later 
chapters.

Project sponsor involvement
The importance of high-level sponsorship must be strongly emphasized for a 
project such as migration.

Project vision
The project vision is a high-level, unbound view of the future.

Assemble the right project team
Putting together the right project team is a critical factor in ensuring a successful 
migration. This type of project requires a group with the right technical and 
management skills to ensure an accurate, high-quality design and a realistic, 
manageable project schedule.

Develop and maintain the schedule
There is a lot at stake in any coexistence and migration project. Things must 
occur in a certain order, within a set time frame, to ensure a successful migration. 
Therefore, realistic, achievable schedules must be established for the project.

Project scope management
The project scope defines the boundaries of the migration project. The scope 
statement should enumerate the functionalities of the new environment.

Document the business requirements
The first task the migration project team must tackle is fully documenting the 
business requirements and the scope of the migration. This exercise involves 
expanding on the requirements laid out in the messaging evaluation study and 
detailing any additional requirements. The result of this step is a set of clearly 
defined, realistic goals for the project.

The communication plan
The objective of a communication plan is to educate, inform, energize, and 
engage all parties of a project. Without adequate communication throughout the 
migration project, you run the risk of creating an excellent plan that never has the 
opportunity to be implemented. Developing a communications plan can be 
regarded as a internal marketing campaign, and will help keeping the amount of 
“FUD” (fear, uncertainty, and doubt) to a minimum.

Set project expectations
Setting expectations requires open, honest communication throughout the life of 
the project. From the top on down, all people involved need to have a realistic 
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picture of what they will receive and when they can reasonably expect to receive 
it. Everyone should understand the project and the progress being made on it. 
Unrealistic expectations and perceptions can be deadly, causing a successful 
project to be perceived as a failure. You can avoid this by keeping everyone's 
expectations in sync.

Document the current Exchange messaging environment
This phase of the project involves gathering specific and detailed information 
about:

� The infrastructure

� e-mail metrics

� Applications

� Services 

This information defines the current messaging environment. It includes such 
things as the network topology and the current naming scheme. 

Develop the training plan
New skills might be required for the new messaging system. Training everyone 
involved with and affected by this project will be a key factor in its success. In 
addition to the technical training necessary to enable IT staff to design, test, 
deploy, and support the new environment, all those who will use the new system 
should be trained on its features, functions, and any new or migrated 
applications.

Training should be an ongoing activity throughout the course of the project. 
Communicating the reasons for the migration can be a part of the training, and 
developing the training plan can actually begin concurrently with the 
documentation of the current environment. The plan can then be updated during 
subsequent steps.

Plan, design, and document the Domino environment 
In this step, the project team designs the new environment, one which reflects 
the company’s strategic infrastructure plans, meets current needs, and provides 
opportunities for future enhancements. The team must design a well researched 
and carefully conceived messaging infrastructure, to support not only end user’s 
e-mail needs, but a variety of other messaging applications.

The activities in this step of the project include:

Note: Being very thorough here avoids unpleasant problems later, as 
“forgotten” or neglected functionality may escalate to be a showstopper.
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� Planning the new environment
� Designing the new environment
� Documenting the new environment

Develop a coexistence and migration strategy 
The coexistence and migration strategies are the plans that define how to join the 
old and new messaging systems, and describe the steps in which users stop 
using the old system and begin using the new system. These strategies are 
dependent on:

� Business requirements and the scope of migration
� Setup of the old system or systems 
� The design and implementation of the new Domino and Notes environment 

Implement the coexistence and migration strategy
At this point the design of the new environment has been validated, as well as the 
coexistence and migration strategies for the company. Now the actual migration 
of users to the new environment can take place. Key activities in this step are:

� Training
� Publishing the migration schedule
� Announcing the kickoff of the migration
� Starting the coexistence/migration

Close the project
When the migration is done, there are still a few tasks necessary to close out the 
project. They are discussed in a later section.

3.2  The sponsor
High-level sponsorship is crucial to a large-scale project like messaging 
migration.

In addition to making major changes to the IT infrastructure, the migration project 
can affect the way the company does business, as well as causing cultural 
changes within the company. The cultural changes can be very difficult to “sell” to 
the users, and even more so to a company being migrated into another. For that 
reason, the sponsors must come from high enough in the organization to have 
the power to drive and effect those cultural changes. 

The sponsor should preferably be of executive level, have a clear and complete 
understanding of the business reasons for the project, and be committed to the 
vision. 
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The sponsor’s full understanding of the business reasons helps both the sponsor 
and the project team to provide clear and precise communication about the 
project and its goals. This enables the sponsor to emphasize the importance of 
this project and help ensure the project team gets the cooperation they need 
from all areas of the company. It is recommended that the project sponsor work 
with the project manager to hold an initial kickoff meeting for company 
management.

The goal of the kickoff meeting is to gain the needed management cooperation to 
build the project team and the advisory panel. Further into the process, having 
the project sponsor acknowledge the work of the test users and participants in 
the pilot will foster a positive attitude about the migration throughout the 
company.

3.3  The project vision
The “project vision” is a high-level, unbound view of the future messaging and 
collaboration system that is to be created by migrating to Notes and Domino 7. 
The project vision should be aligned with the overall business vision of the 
company. Such a vision helps to establish both long-term goals and short-term 
objectives to ensure the success of the migration project.

Example of a vision statement:

The vision of the migration project is to replace our multiple existing 
divisional-based messaging systems with an enterprise-wide messaging and 
collaboration system that uses Lotus Notes and Domino. This upgrade will 
enable all our business units to interoperate seamlessly while adding user 
functionality and reducing administrative and operational costs. The new 
system will be deployed in each of the company’s locations and for all 
employes worldwide. Deployment will commence within 3 month, and will be 
complete within 9 month.

3.4  The project team
Assembling the right project team is the key factor in ensuring a successful 
migration project. It is mandatory to assemble a group with the right technical 
and management skills to ensure an accurate high-quality design and a realistic, 
manageable project schedule.

The team will most likely consist of employees from your company along with 
subject matter experts and consultants from IBM or its business partners. While 
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the subject matter experts may participate for only limited periods of time, it will 
be crucial to know whom to call and when to call them in.

The team may consist of one or more persons in each of the following roles (and 
multiple roles may be filled by a single individual): 

� Project manager

� Sponsor (does not have to be a member of the team, but needs to be kept 
informed regularly)

� Domino architect

� Exchange administrator

� Domino administrator

� Domino application developer

� Network administrator

� IT/IS manager

� Migration specialist

� Support team representative

� Specialists (these individuals may be on call)

� Users from key interest groups

Some training may be required for members of the project team, or for those 
designated as part of the initial support team. Allow sufficient time for this training 
at the beginning of the project.

Experienced users from the organizations being affected by the change should 
be involved. They can help communicate the progress of the project and assist 
with choosing appropriate test users. They could also provide early feedback on 
plans and schedules, as well as ensuring any requirements unique to their areas 
are accounted for in the design of the new environment.

Special care should be taken on handling the Exchange administrators and 
others who have been involved in the administration of the Exchange 
environment. Those people will most likely be the first and most powerful 
resisters to be encountered. However, since they have precise knowledge of how 
the old messaging infrastructure works, the Exchange administrators can be 
great advocates for the upcoming migration if they are handled right. This 
involves a lot of communication, retraining, and assuring them that they will not 
be obsolete after the migration.

Getting access to the right personnel for the project team and the panel will 
require buy-in on the project from all levels of management.
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3.5  The schedule
A realistic, achievable schedule must be created for the project. This schedule 
should not only consist of a target date for completing the project, but should 
identify important milestones, deadlines, and the resources needed along the 
way.

To help you explain the basis of the established schedule to a sponsor or 
management team, be certain to:

� Educate management on the steps involved in this type of a project
� Explain the processes involved
� Lay out a reasonable, achievable high-level timeline
� Explain the risks involved in delays in any of the steps or processes

The goal is to gain acceptance from the project sponsor for a realistic, achievable 
timeline.

3.6  The scope
The project scope sets the boundaries for the migration project. The scope 
statement should define the functionalities of the new environment that you can 
implement within the time given and the resources allocated. The scope should 
differentiate between what the migration must have and what is non-essential.

Example of a migration project scope:

When migration is completed, our new system will:

• Provide a functional implementation for 5000 users and accommodate 
8% expected yearly growth over the next 5 years

• Replace the existing messaging systems: Microsoft Exchange and 
POP mail servers

• Coexist with the Exchange system until migration is complete

• Be a highly available system that fulfills the requirements specified by 
the SLA of the company

• Take advantage of the collaboration features presented in Domino

3.7  Documenting the business requirements
There are many reasons why a company might want to improve and expand their 
messaging infrastructure. Among these motivations are changes in corporate 
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structure brought about by a merger or acquisition, changes in the company’s 
business model, or the constant shifts in focus necessary to keep up in today’s 
fast-paced business environment. The need to deal quickly with change, and to 
communicate efficiently with employees, customers, and business partners can 
also be motivating factors.

The use of a messaging infrastructure need not be confined to just sending and 
receiving simple messages and attachments. It can be a whole collaborative 
environment supporting e-mail, instant messaging, group discussions, virtual 
team workspaces, corporate intranets, quick publishing to the Internet, and 
custom applications—all within a reliable, scalable, secure, integrated framework 
that is manageable and cost-efficient.

Documenting the business reasons for the migration project and the business 
uses of the new functionality that will be provided is one of the first tasks the 
migration project team must undertake. The project sponsor and the project 
manager must communicate the reasons and goals of the migration project to the 
project team. The project team must then communicate the reasons, goals and 
other project information to the end-user community. Open communication will 
facilitate cooperation and help ensure success.

3.7.1  The basic requirements
Many of the basic requirements for migration may have already been presented 
at a high level in the migration study. The team must now expand on those 
requirements and detail specifics on each, to ensure they are incorporated into 
the design of the new messaging environment.

The basic requirements include such things as:

� Additional client functionality.
� Greater messaging server scalability, reliability, and manageability.
� Lower total cost of ownership (TCO). This refers to the company’s cost to run, 

support, and administer the new messaging environment. It does not refer to 
the costs associated with migrating from the old environment to the new 
environment. 

� Improved interoperability with Internet standards.
� Improved throughput.

What is expected in each of these areas by the corporation should be detailed in 
the requirements. For example, the project sponsor might expect a specific 
delivery time for a simple mail message. The project team must ensure this is 
stated, and that the designers of the new infrastructure specify the right network 
topology and systems to meet that goal. Additionally, if the sponsor has a 
requirement that is unrealistic, this is the time to modify the expectation to be 
within the boundaries of what is possible or feasible.
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3.7.2  Further requirements
After dealing with general requirements, the team must address the detailed 
requirements in the areas of:

� Features, functions, and applications that are part of the current environment

� Features, functions, and applications that the corporation wishes to add 
based on the capabilities of the new environment

The functionality of the current environment
Documenting the requirements for migrating existing functionality should be a 
very straightforward task. The key is to cover all the functionality. Users are more 
likely to be upset by being unable to do something they were used to, rather than 
about learning a new function.

Each existing feature, function, and application should be documented. This list 
should then be used by the designers to ensure that each item is built into the 
new environment. This list can also be input to the training plan, to ensure users 
know how to perform tasks in the new environment.

The functionality of the new environment
Documenting new features, functions, and applications that can be added to the 
messaging infrastructure is more complicated.

In the areas of features and functions, the project team needs to document those 
that are new, and ensure their usefulness is effectively communicated to the end 
users. This communication can take place through end-user training and through 
internal marketing, such as quick reference guides.

Promoting new applications is more is involved. The job of the migration team 
may be to build a “wish list” of the applications that various individuals and 
groups would like to see incorporated into the new environment. The specific 
applications should be identified as “must have,” “should have,” or “nice to have,” 
and be evaluated against the implementation cost. The project migration team 
then details the requirements for each of these applications, reviews the 
requested priority, obtains approval (or modification of the priority), schedules the 
development work, and adds this work to the scope of the migration project. 
Review, prioritization, project approval, and funding should be done by the 
management group. 

Depending on the number and complexity of these applications, separate 
workgroups may need to be established to complete these applications within the 
timeline of the migration project. It may be the case that only one or two key 
applications are considered important enough to be part of the overall migration 
project, and the remaining applications could be placed outside the scope of the 
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migration project, to be handled separately at a later time, or selected to be 
discontinued.

At this point it is necessary to realign the expectations. After studying the current 
environment and making plans for what functionality will be available in the new 
environment initially, at a later stage, or not at all, the revised expectations should 
be communicated to the sponsors and the user community.

3.8  The communication plan
The objective of a communication plan is to educate, inform, energize, and 
engage all parties of the project. Without adequate communication throughout 
the planning process, you run the risk of creating a fabulous plan that never has 
the opportunity to be implemented. The communication should begin at the 
beginning—at the point where you assemble your project team and begin the 
planning process. 

To create your communication plan:

� Identify who to inform about the project (key individuals, decision makers, and 
strategic groups).

� Decide who is responsible for reaching each person or group.

� Determine when, what, and how communication will take place. That is, try to 
identify each communication step.

� Identify the communication vehicles you have available and any 
communication vehicles you may want to create.

� Pay attention to any feedback you receive.

Reach everyone who will play a role in implementing the project. If you identify 
additional players part of the way through the planning process, don't hesitate to 
include them in your communication from that point forward, being sure to catch 
them up and include them on the process.

Some of the topics you should consider communication about:

� Migration project in general
� Goals set for the project
� Implementation schedule
� Pilot project
� New environment
� Where and how the education is available
� How to contact support
� Progress of the project
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3.9  Setting the expectations
Setting the correct expectations is crucial to the success of a migration project. If 
the expectations aren’t set correctly, you run the risk of having very low customer 
satisfaction from the end users. 

Just because one migration approach worked in one environment does not mean 
that it will be successful in another. By assuming that a new migration project is 
identical to a previous one, there is a danger that significant differences in 
stakeholder expectations and requirements will be ignored or actively 
suppressed. Project outcomes must support the specific structures, processes, 
people, and existing systems in a particular organization, not some generic 
version. 

One of the most powerful strategies for keeping a project on track is to set the 
stage properly. This means more than distributing the project plan. Complement 
the plan by stating the project vision and goals. Describe the final result and how 
the project team will conduct itself to get to that result. 

It is important to set the expectations early in your project management activities. 
Incorporate these concepts in kickoff meetings and initial meetings with specific 
project teams. 

Examples of expectations set for the migration:

– All mail present on servers will be migrated.

– Mail will not be coexisted.

– Calendar and scheduling information be migrated.

– Calendar and scheduling information will not be coexisted.

– Users will be trained within one week prior to being migrated.

Examples of expectations set for the new environment

– Delivery of messages internally: 90% < 5 sec, 5% < 20sec.

– Open mailbox view: 90% < 5 sec, 8% < 20 sec.

– Send file and store: 90% < 5 sec, 8% < 15 sec.

(Sums not equal to 100%; remainders are for special exceptions.)

3.10  Documenting the current messaging environment
This section was designed to help you gather and document specific, detailed 
information about the current Microsoft Exchange system. This is the foundation 
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which will help the project team to build a complete and accurate design for the 
new Domino environment, if one is not already in place.

A checklist to assist you in documenting your current messaging environment is 
in Appendix E, “Exchange Connector installation checklist” on page 821. 

In this section we describe the steps for documenting the following:

� Microsoft Exchange environment

� IT profiles

� Administration support

� Risk assessment

3.10.1  Documenting the Microsoft Exchange environment
Whether you have a small, medium, or large Microsoft Exchange environment, it 
is important that you gather all the data recommended here. Having all this 
information will ensure nothing is missed in the design of the new Domino 
environment. Many of the details may already be documented, so this phase of 
the project may be just verifying the existing information.

Microsoft Exchange server topology
To document the Microsoft Exchange server topology, you need to know:

� The version/SP level of Exchange Software being used.

If different versions are being used, then state why. There might be a very 
specific reason that a newer or older version/SP is used.

� The operating system/version/SP level the Exchange servers are running on. 

If different versions are being used, then state why. There might be a very 
specific reason that a newer or older version is used. 

� The current Exchange topology.

Is this a Single site/Single server, Single site/Multi server, or even a Multi 
site/Multi server environment? This information can affect other decisions (for 
example, server consolidation).

� The organization’s name (assuming a single organization).

� In case of multiple sites, the site names.

� Connections to other internal/external mail systems. (If there are none, go on 
to documenting the Microsoft client topology.)
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– What Mail Transfer Agents (MTAs) and connectors are in use?

In a multi-site environment, it is expected that site-to-site connectors will 
be in place. The connectors/MTAs we are addressing here could be 
CCMail, MSMail, SNADS (if so, state what system), Internet, X.400, Lotus 
Notes, Exchange 2000/2003 to Active Directory, Novell Groupwise, and 
others. 

– Are calendaring and scheduling services/connectors provided across the 
connections?

If this is the case, state what connections are being used for this 
functionality. 

– With regard to multiple sites, is “free busytime” replicated across the 
connections?

If this is the case, state between what sites. 

– Are there any directory services provided over the connections?

If there are, you will need to know what type (LDAP, Native Dirsync, 
Gateway, or third party), and finally, if the import/export process is 
automated or manual.

� List the server names, and determine which server is the first Exchange 
server. 

What is the server name; is it a bridgehead server; is it a Public folder server; 
where is it located (organization and site); and how many users are on this 
server?

Microsoft Exchange client topology
To document the Microsoft Exchange client topology we will need to know:

� What clients are being used and how many?

Pre-Outlook (5.0 Clients), Outlook98 (for Windows, Macintosh or Web 
access), Outlook 2000, Outlook 2002, Other IMAP4 Client, POP3 client, or 
other? Can they use POP3 from any client?

� Are there mobile users?

– List types and amounts of mobile devices. 

– How is access to mobile users provided (RAS, Wireless, Web, PDA, or 
other)?

– Detail the functionality used with the mobile devices.

Be detailed; loosing functionality will act as a showstopper to the mobile 
workers.

� List of users per locations (include mobile).
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� Are personal storage (PSTs) and personal address books (PABs) being used, 
and if so, where is the user data stored?

If PST files are being used, can this affect the use of Migration tool and the 
Migration strategy? How about mobile users and the OST file?

� Are mail rules used?

� Is voting used?

� Are there distribution lists?

� Who is allowed to create folders?

Existing Exchange services
Services, such as those in the following list, are also key elements of the 
messaging infrastructure and must not be overlooked when planning a migration. 
Be sure to document how each of these services is used in the existing 
environment and whether that use will change in the new environment. 

� Calendar and Scheduling:

– Is Calendar and Scheduling functionality used? If so, to what extent?

– Are mailboxes assigned? If being used, is the management function for 
resources and conference rooms being used?

– Are users scheduling meetings across the enterprise?

– Are corporate holidays being maintained?

– Is it general practice to look up free time prior to scheduling meetings?

– Are there any applications based on the Calendar APIs?

These might be plug-ins, third-party software, or in-house developed 
software. Maintaining this kind of functionality might involve the 
developers, or require a separate project.

� e-Mail 

– How many registered/active/concurrent users are there in Exchange?

– How many peak time users are there? (Peak time, for example, during the 
beginning of a business day)?

If possible, try to obtain statistics that show the peak number of users on 
an hourly basis for a full month. There might be very big variations in 
different companies. This information will be used for the design of the new 
infrastructure.

– How many mail items, on average, are sent per day (average per user)?

If there are variances in how the users act on different sites, then state this 
as well.
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– What is the average size of a typical e-Mail?

Are there “heavy” sites or user groups that needs special handling? 

– What is the average size of the users’ mailboxes (PSTs)?

– Is mail quota being used? (If yes, state the limit.)

– Do users send attachments through the mail?

If they do, are there any restrictions, and how are those restrictions 
handled? Are there restriction in size, file types, where they are being sent 
(intrasite, site-to-site, external)?

– Are there any procedures/applications using the mail APIs?

These might be plug-ins, third-party software, or in-house developed 
software. Maintaining this kind functionality might involve the developers or 
other separate handling.

– Is message tracking being used?

� User Directory

– What type of information fields are kept in the Exchange Directory?

– How many documents are stored (per user; in total)?

– Where are forms stored?

Are forms stored on the server (Organizational), in the user’s inbox 
(Personal) or in public folders (Folder)?

� Public folders

– Are public folders being used?

If so, collect details on the folder names, describe the usage, access 
restrictions, number of entries, and so forth.

– Are there custom forms?

If custom forms are being used, make sure to collect the details on usage, 
size, interaction with Exchange and with other applications (for example, 
embedded OLE).

– Is Outlook Web Access used for Web access?

� Applications 

– Are Event Services used?

Event Services are scripts running against items posted in a public folder. 
If Event Services are used, collect details on purpose, usage, the script 
itself.

– Are there any third-party or in-house applications that interact with 
Exchange?
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� Exchange Security (key management?)

– Is the Key management system being used?

If yes, is Signing or Sealing (encryption) used? Encrypted documents can 
not be migrated since the keys can not be migrated. Therefore, it is crucial 
to know if this function is being used, and users should be informed about 
this. A solution is to decrypt the documents before migration.

– Is there any other form of e-Mail or Web security?

� Other services:

– Is any form of instant messaging being used?

If yes, what type (MSN® Messenger, IRC, Sametime, AIM (AOL), Yahoo or 
other)?

– Is there an e-Mail enabled fax solution?

List the details of any e-Mail fax solution used: Send fax only, Receive only, 
Send/Receive, how faxes are stored (personal/public folders).

– Is any externally hosted e-Mail service being used?

This might be Hotmail®, AOL or other provider. Be aware of a potential 
security risk,- mail sent/received through those channels may not be 
secure, on backup or accessible for later use.

– Are there other applications running on the Exchange Servers? If yes, list 
the applications and the servers those applications are available on.

– Is antivirus sofware being used? If yes, gather details on the antivirus 
software and where it runs (on server, on client, on firewall, or other).

– Is backup software being used? If yes, gather detail on the backup 
software and where it runs (on server and/or on client). Record the backup 
schedule for incremental and full backups.

– Is there a automated mechanism for software distribution (Tivoli®, SMS)

3.10.2  Documenting the hardware profile
This section describes the information you should gather about the physical 
characteristics of the environment. Check the Lotus Web site at 
http://www.lotus.com for the latest recommended specifications for servers and 
workstations running Domino and Notes. 

� Specifications of the servers in use:

Identify CPU, memory, storage (storage system) and function (which kind of 
server is this, does it have a special/dedicated function such as SAN, and so 
forth).
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� Specifications of the workstations in use:

Catalog the CPU, memory, available disk space, and operating system 
(Win95, Win98, NT, W2K, XP, Mac/OS or other) of all workstations. If any 
workstation has a special function, identify it.

3.10.3  Documenting the network infrastructure
You need to have a complete description of the network and a overview of the 
actual network configuration. This should include:

� Central/distributed location with number of users

� Type of communication lines mainly used (X.25, ISDN, Ethernet, Token ring 
and so forth)

� Type of connections (Leased lines, switched lines, and so forth)

� Bandwith of the lines

� Are lines shared with other functionality (phone or other)

� LAN configurations

� Available network protocols (SNA, TCP/IP, NetBIOS, IPX/SPX,or other)

� Connection to a public network provider (Internet)

� Routers

� DNS host files

� Firewalls and their open ports

� Quality of service supported

� Other essential functionality

� What are the most common types of information that the WAN transmits: text, 
data, images, graphics, voice, video, phone, or other? Are there future plans 
for the network that might need to get incorporated?

� Are there identifiable bottlenecks in the network? What are the problem areas 
and has a resolution been planned?

3.10.4  Administration and support infrastructure
You will need to know how the administration and support infrastructure is built. It 
is essential to make sure that, as a minimum, you keep the service on the level it 
is. If no SLAs are in place, those might be considered as well.
60 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777ch_planning_for_migration.fm
Support
� Has support been outsourced and, if so, can the new environment be 

supported?

� How many people are involved for user support in general:

– Are they placed centrally or distributed?

– Where are they placed?

– How many are specifically involved in messaging service for:

• Administration?

• Training support?

• Help desk?

• Project implementation?

� Detail any specific applications for managing user requests and questions.

� Detail any specific training guide/program for Exchange users.

� What kind of education is provided to new users, and does this include e-mail 
usage training?

� Are there any automated archive policies or applications; if yes, list the 
details.

� What backup/restore and disaster recovery policies are in place?

Service delivery
� Are there Service Level Agreements (SLAs), and if so, what values do they 

specify for the following categories?

– Message delivery internal
– Directory latency
– Message delivery external (only to Relay or IMS™)
– Server response time
– Network response time
– Web page delivery
– Max outage
– Notice of outage
– List any details on SLAs with ISP 

� Are there specific rules to inform users about system management and 
reported downtime?

� Are there any statistics available for mail flow, network performance and 
downtime?
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Administration procedures
You need to know if any of the following procedures are created and distributed to 
the users:

� Is there a Retention Management system in place for deciding how long you 
maintain your electronic documents, and what the users’ responsibilities are 
for each kind of document. This includes Archive and Backup.

� Is there a user guide with details about security, delegation, access 
authorization for messaging and office services (how to manage passwords, 
departmental user IDs for special needs, and so forth)?

� Are there standard definitions of specific structured forms for mail (that is, 
format for external letters, fax forms, internal communications, and so forth)?

� Is there a naming policy?

� Is there a procedure for users to request new or additional user IDs, 
resources, password changes, and so forth?

3.11  Developing the training plan
Training everyone who will be affected by the coexistence and migration project 
is essential. You need to ensure that the right people get the necessary technical 
training to enable them to design, test, deploy, and support the new environment. 
In addition, adequate training must be given to all end users who are going to use 
the new system.

Training will be an ongoing activity throughout the course of the project. Creating 
the training plan can actually begin concurrently with the documentation of the 
current environment. The plan can then be updated during subsequent steps of 
the project. 

Depending on the size and scope of your project, you may want to dedicate one 
or more project team members to training to ensure it receives appropriate 
attention and focus. 

Training requirements
Define your training requirements by answering the following questions:

� Who needs training?

� What features and functions must be presented?

� What applications must be presented?

� What services must be presented (fax, Internet, connections to other 
environments)?
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Delivery of the training
Here are some questions related to the delivery of the training:

� Can standard courses be used or will customization be needed?

� What method of delivery is best for each type of training or group to be 
trained?

� Should training be held on-site or off-site?

� Should classes be private or public?

� At what point in the project does each type of training need to be delivered?

Who needs training?
Everyone affected by the migration project is going to require some type of 
training. The training may simply be a review of how to use the new Lotus Notes 
client or it may be in-depth technical training enabling someone to support and 
maintain the new Lotus Domino environment.

Here we have identified some of the parties whose training requirements you 
must address:

� Executives with a special training needs (time restraints, PDAs. and so forth).

� System administrators

� Application developers

� Help desk personnel (if applicable)

� Test and pilot users

� Standard end users

Evaluating and reevaluating the training plan
After the first users have completed a particular part of training, the project team 
members responsible for training should review the users’ evaluations. If users 
feel that the training is inadequate, or some parts of it require more attention, 
these issues should be addressed immediately and the training revised as 
necessary. 

After the users have had the opportunity to apply their training in a “live” 
environment, they should be asked to do a second evaluation to gauge the 
effectiveness of the training and the relevance of the material covered. These 
reevaluations should be reviewed and any necessary changes made to the 
training.
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Training resources
� http://www.lotus.com/education

The Lotus site is a comprehensive education source that includes links to a 
variety of training locations, descriptions of selected courses, and many other 
materials.

� http://www.recor.com/
This site has a full suite of learning product for Domino/Notes 7. Some of the 
Recor products will be able to integrate with the ADT tool for deployment.

3.12  Risk
The risk in not performing the activities described in this chapter is that key 
features of the existing environment will not be included in the planning and 
design of the new environment. It is much simpler to design all the features in at 
the beginning than it is to try to retrofit a feature after deployment of the system 
has begun. The latter will negatively impact the project schedule and the users’ 
perceptions of the viability of the new messaging environment.

The current environment has a dramatic impact on both the coexistence and 
migration strategies. The information collected during this phase is invaluable in 
designing the strategies. Also, this process highlights potential problems with the 
current environments that must be addressed before a successful migration to 
Notes and Domino can take place.

Risk management
Risk is a natural part of any system integration project, and its proper 
management can determine the success or failure of the project. You should 
begin risk management during the proposal process by identifying the 
foreseeable risks in the project and developing an associated Risk Management 
Plan, which quantifies the risk and includes your recommendations for handling 
it.

Here are some actions you can choose to take to deal with a certain risk:

� Avoidance: Eliminates the cause of the risk through clearly-defined 
actions/events/tasks.

� Mitigation: Acknowledges that the risk is not avoidable, but defines steps to 
mitigate the level of risk.

� Acceptance: Acknowledges the risk and documents the associated 
consequences.

If new or different risks are identified during the implementation of the project, 
they should be added to your risk management plan. The project manager 
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utilizes this plan as an instrument to verify the progress against avoidance or 
mitigation plans, with the focus being to reduce the overall risk of the initiative.

3.13  Plan, design, and document the new environment
One of the prerequisites for a solid, scalable, and easily maintainable 
infrastructure is good design. Building a good design is strongly based on 
knowledge and experience. If you don’t have architects with strong Domino skills, 
it might be a good idea to have IBM or a business partner help you validate the 
new design.

Now that the project team knows what is needed, they must determine how to 
deliver it. This means establishing the design of the new Lotus Notes and 
Domino environment. The amount of effort spent on planning and designing 
directly correlates to the success of the implementation.

During the design process, frequent review sessions should be scheduled to 
keep the project team up-to-date and provide feedback on the developing design. 
At the completion of the design work, a final review should be held and sign-off 
on the design received from all project team members and the project sponsor.

Many of the key areas which must be considered when designing the new 
environment are discussed in the following sections.

3.13.1  Determining the characteristics of the servers needed
Traditionally, the number one comparison made between different platforms has 
been performance. Competition among vendors can make it difficult to find 
objective comparisons. Manufacturers like to show the results of tests that make 
them look the best, but their data may not be relevant to the way you plan to use 
the platform.

Is bigger better?
One common stumbling block when choosing a platform is the bigger-is-better 
attitude. People so often get caught up in getting the biggest, fastest box, that 
they lose sight of what they need. If your organization will only consist of 100 mail 
users, and is unlikely to grow significantly, you probably do not need one of the 
large platforms. It will support growth for a long time, but the startup costs would 
be great.

However, maybe you have a large, powerful server which is under-utilized, and 
you also have lots of in-house expertise in that server platform. You may wish to 
add the Domino server to that machine rather than buying a new server and 
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training your staff in a new operating system. In this case, your 100 mail users 
may not take much of that particular server’s resources.

Few versus many
If you choose a smaller platform you will need to maintain many smaller 
machines. This is not necessarily a bad thing, but it can mean more effort is 
required to maintain control and consistency across a group of many machines.

However, another factor to consider is that with a larger number of smaller 
servers the overall impact is reduced if any one server goes down. With the 
larger platforms, more attention needs to be paid to planning with regard to the 
impact of a server being down.

Number of Domino servers
The other major consideration when talking about performance and scalability is 
the number of actual Domino servers. One of the main advantages of using the 
larger platforms is that it reduces the number of physical machines to manage.

However, you should bear in mind that this does not necessarily reduce the 
number of logical Domino servers. On the smaller platforms, such as NT, you 
would typically have one logical Domino server per physical machine.

On the large platforms, such as pSeries®, iSeries™, and zSeries®, you would 
typically run one physical machine with several logical Domino servers on that 
machine, using Domino partitioning.

So in the end, you may have the same number of logical Domino servers.

Scalability
Characteristics of a highly scalable system include, among other factors:

� Ability to support the processing of large applications.

� Ability to manage the resource requirements of multiple applications (that is, 
mixed workloads).

� Large file systems support.

� Ability to accommodate from one user to thousands of simultaneous users.

� Hardware scalability, meaning from a single CPU to SMP configurations with 
up to 64 processors.

� Large I/O subsystems that can support a lot of controllers and large volumes 
of data and files. Supporting higher numbers of controllers means you can 
distribute your I/O more efficiently. Storage capacity and bandwidth can be 
further extended with high-speed RAID boxes.
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With Domino 7, changes have been made to improve the way Domino scales to 
take advantage of the larger platform architecture. Table 3-1 shows examples of 
platform scalability features, and how Domino exploits those features.

Table 3-1   Platform scalability features utilized by Domino 7

Different types of servers needed
There are several types of servers you can deploy in your Notes and Domino 
environment. These include:

� Mail servers
� Database servers

Platform scalability feature/metric How Domino utilizes the scalability metric 

Ability of platform to support large I/O 
subsystems (large number of controllers and 
volumes of data/files). Means that I/O can be 
distributed more efficiently.

1. Optimization of the database format (the on-disk 
structure or ODS) to minimize I/O contention. 
Writes to disk are fewer and more efficient.

2. Transaction logging: Database operations are 
recorded sequentially, which reduces I/O activity 
while increasing data integrity and significantly 
improving server restart time.

CPU scalability: Scaling application performance 
across multiple processors, using single version 
of the operating system.

Thread pool model: Results in less memory and CPU 
utilization.

Support for large memory configurations. More efficient memory utilization through:

� Improved memory management via Unified 
Buffer Manager

� Better use of RAM for internal caches and 
buffers, which boosts performance

� The ability to use higher than 500MB means 
faster throughput.

Inherent scalability features of, for example, 
UNIX® operating systems means:

� Journaled file system for faster recovery 
following server crash

� Support for very large memory configurations 
to process large applications

� Large file system support provides more 
scalability

� Application resource management, meaning 
the ability to support mixed workloads

Cumulative effect of Domino 7 performance / 
scalability enhancements with underlying platform 
scalability features means:

� Lower memory and CPU utilization

� Faster response times

� More efficient use of I/O

� Lower network traffic
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� Remote service servers
� Passthru servers
� Gateway servers
� Hub servers
� Backup servers

Determining the number of servers of each type needed
Which types of servers and how many of each you will need depends on the 
physical topology and the e-mail metrics that have been determined for your 
messaging environment. Those metrics include the number of users, the levels of 
e-mail traffic both during normal hours and peak usage hours, the number and 
types of applications being supported, and the messaging-based services 
available for the users. You also need to consider such things as geographic 
locations and balancing of usage loads.

Choosing a platform for each type of server
Lotus Domino servers can run on a variety of platforms, each of which has 
strengths and weaknesses. You must work closely with knowledgeable technical 
personnel to choose the appropriate type and size of hardware platform for each 
type of server in your new environment. Some of the factors which the project 
team should consider are:

� Cost: This includes not only the hardware cost but the total cost of ownership.

� Company policy: Does a company’s standard vendor have the right hardware 
or will you need to go outside the standard for it?

� Footprint: How much floor space is available to house the various servers?

� Scalability: Choose hardware with the view that expansion will most likely be 
needed in the future.

� High availability: Review your availability needs and ensure your hardware 
and network topology design will meet these needs.

� Disk space: The amount required depends on the kind of server and the 
number of users.

� Processor: The more speed, the better for performance. 

� Memory: The amount needed depends on usage.

� Skills: Do your support personnel have the necessary skills to work with the 
platforms you choose?

� Protocols: Will the chosen platforms support the network protocols already in 
use within your company?
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Domino 7 is currently supported on the following operating system platforms:

� Windows

– Microsoft Windows 2000 Intel® (Server and Advanced)

– Microsoft Windows NT4 Intel 

� UNIX 

– IBM AIX 4.3.3x, 5.1

– Sun™ Solaris/SPARC 8

– Sun Solaris/SPARC 9

– Linux (Intel) - Red Hat 7.2, SuSE 8.0

– IBM iSeries, V5R1 and later 

– IBM zSeries, z/OS® V1R2 and later

Further platform support might be added, so be sure to check with your local 
representative or the IBM Web site for the most up-to-date information.

3.13.2  Client selection
The first major step in designing a client infrastructure is choosing the client that 
your organization will use. The four choices available for Domino 7 are the Notes 
client, Domino Web Access (formerly iNotes™ Web Access), Domino Access for 
Outlook, or a Web browser. The best choice is different for each organization. 
Our purpose here is to give an overview of the differences between the clients 
and discuss some of the issues to consider when choosing a client.

This section covers the following topics:

� Single desktop client policy
� Web browsers
� User training
� Platform support
� Cost considerations
� Offline usage
� Standard browsers
� Performance considerations
� Security considerations
� How do I decide?

Single desktop client
A goal for many organizations is to have only one desktop client that can access 
all of their different data sources. The Web browser is a good candidate for 
becoming that client. Many software vendors are working on a way to make their 
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data available to a Web browser. Some are building direct interfaces while others 
are developing ways for the data to connect to the back end.

The other thing to consider is the amount of tools being developed and attention 
currently being given to the Web browser. This will give you different options and 
possibilities for the future.

Lotus has been looking for a way to build to the best of two worlds. As explained 
in the following sections, there are several options available: 

� The Notes Client, where the Microsoft Explorer integrates seamlessly

� The Domino Web Access mail and C&S usage via the browser

� The Domino Access for Outlook client

Lotus Notes 7 Client
IBM Lotus Notes is high-function, integrated desktop client software that set the 
standard for innovation in messaging and collaboration two decades ago. Lotus 
Notes client software is the premier of several client options for IBM Lotus 
Domino server. Together, Lotus Notes and Domino deliver a reliable, 
security-rich messaging and collaborative environment that is designed to help 
companies increase employee productivity, facilitate decision making, and 
improve overall business responsiveness.

With Version 7, IBM extends the reach of Lotus Notes messaging and 
collaboration solutions while continuing to leverage your IT and application 
investments. Integration with IBM Workplace products allows organizations to 
extend and leverage their existing infrastructure investments. Enhanced 
integration with instant messaging and Web conferencing enables users to have 
immediate access to the people and tools they need to do their jobs more 
effectively and make better, more-informed business decisions. And productivity 
enhancements in e-mail and calendar functions enable users to better manage 
daily information and resources.

Enhance features in Lotus Notes 7
Lotus Notes 7 offers a number of new Calendar and Scheduling features as well 
as tighter integration with IBM Lotus Sametime®. Other functional areas that 
have been enhanced include mail, desktop, accessibility, and interoperability. 

� Significant improvements have been made to the desktop, allowing users to 
customize their interaction with the desktop, either by saving window state on 
exit, or by determining which tabs open on startup. Further, a user no longer 
has to wait while a view updates; since the update happens in the 
background, the user can work in other areas while the view is updated, 
providing the opportunity for improved productivity. And a new AutoSave 
feature has been introduced to help prevent data loss when unexpected 
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outages occur; users can enable AutoSave in their preference on the Lotus 
Notes client to save their work every few minutes when working in 
AutoSave-enabled applications, and designers can enable AutoSave on 
forms in new and existing applications

� Calendar and Scheduling has been updated to better reflect customer needs. 
A new Calendar Cleanup action allows users to easily and quickly delete old 
entries from their calendar. Handling of conflicts has been improved, first by 
giving the user the option to allow Autoprocess to accept conflicts, and also 
by improving the display of schedule conflicts. Additionally, users can now 
cancel Calendar/Scheduling workflow when sending comments. View and 
miniviews of calendar information have been improved for better usability, 
and the needs of Calendar Managers have been addressed. Further, many 
improvements have been made to the way Rooms and Resources are 
managed, including the ability to restrict rooms, and to designate a room as 
restricted to those attempting to reserve it, and changes to the workflow to 
prevent double-booking, in addition to providing greater granularity of control 
to Administrators in charge of the Rooms and Resources process.

� In Lotus Notes 7, you will find much closer integration with Lotus Sametime. 
Integration has been added to templates for the mailfile, Teamroom and 
Discussion databases, the Personal Name and Address book, the Lotus 
Domino Directory, and the Rooms and Resources databases. In these 
databases, not only can users see who is online, they can initiate an instant 
messaging session directly by clicking on the status icon. Also, several 
preferences have been added for Lotus Sametime Integration that allow a 
user to specify automatic or manual logging in, to save transcripts of instant 
messaging conversations to the mailfile, and support set preferences about 
how Screen Sharing, Whiteboarding, Audio and Video are used through the 
Lotus Notes client.

� Numerous usability improvements have been made to Mail. Among the 
highlights are a no subject warning, the ability to sort by subject out of the 
box, quick access to flag items for follow-up, and the ability to see mail 
threads within an email. The right-click menu has been expanded as well, and 
administrators can now control Mail Preferences via policies. Finally, visual 
tags have been provided to indicate whether an email was sent to the 
recipient only, and a user can now find out what folders hold a document 
using the “Discover Folders” action.

IBM Lotus Domino Web Access 7
In some situations, accessing email and discussion forums from a thick client 
installed on a dedicated workstation is not practical. For instance, employees 
require the flexibility to access important information when at home, while 
traveling or using a shared workstation. For those situations, we created Lotus 
Domino Web Access, IBM's premier Web client for accessing a Lotus 
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Domino-based mail file. Lotus Domino Web Access offers a rich user experience 
for both Microsoft Internet Explorer, Mozilla and Firefox browsers through the 
use of dynamic HTML (DHTML). As a DHTML application, Lotus Domino Web 
Access client performance is governed by server performance, network 
performance, and client configuration.

Lotus Domino Web Access 7 has many improvements in the areas of 
performance and usability. Highlights include:

� Opportunity for improved client and server performance

� Enhanced security features

� Expanded presence awareness and instant messaging integration

� Updated user interface

� Added mail and calendar productivity features

� Enhanced support for Linux

� New administration and management features

� Improved offline access to personal data

IBM Lotus Domino Web Access 7 software is a sophisticated Web client for 
Lotus Domino server. Lotus Domino Web Access software gives your employees 
the power to create rich text messages, schedule meetings, manage tasks and 
collaborate with colleagues-whether they are using their own workstation, an 
Internet kiosk or another user's PC. With Lotus Domino Web Access 7, you get 
the best of both worlds: access to a robust, reliable, enterprise-class messaging 
and collaboration platform, with the ease of simply opening a browser.

Note: Lotus Domino Web Access 7 takes advantage of Lotus Domino 7 Server 
performance improvements, both in the core server functionality, and in HTTP.

IBM Lotus Domino Access for Microsoft Outlook (DAMO)
Lotus Domino Access for Microsoft Outlook offers the ideal solution for 
companies that want to leverage the robustness and security advantages of the 
Domino server, while preserving their dedicated Microsoft Outlook user base. 
Additionally, in the case where a company merger or acquisition leads to a 
mixed-client environment, Lotus Domino Access for Microsoft Outlook enables 
user to run the Outlook or Lotus Notes client over the same Lotus Domino mail 
file data. Company mergers and acquisitions can mean having multiple email 
clients in use. Whether you choose to migrate fully to a Lotus Notes and Domino 
environment, or allow the Lotus Notes and Lotus Domino Access for Microsoft 
Outlook clients to coexist, Lotus Domino Access for Microsoft Outlook provides 
the functionality to smoothly integrate Microsoft Outlook users into your Lotus 
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Domino infrastructure, while letting them continue to access mail and work with 
calendar functions through a familiar interface.

Among the highlights of Lotus Domino Access for Microsoft Outlook 7 are:

� Opportunity for improved client software performance, reducing the time to 
launch the application compared to 6.5.3.

� Native support for Internet standards, including X.509 and Secure 
Multipurpose Internet Mail Extensions (S/MIME) 

� Installation option for separate program and data directories, allowing multiple 
users to share the same machine, using Microsoft Windows operating system 
security. 

� New mail notification options, including playing a sound, briefly changing the 
mouse cursor, and showing an envelope icon in the notification area. 

� Option to use a local copy of your global address book; this can be a full copy 
of the directory or a condensed directory catalog to save space on your 
workstation.

Additionally, Lotus Domino Access for Microsoft Outlook 7 users can use Lotus 
Domino applications via a browser, dramatically increasing access to your 
existing Lotus Domino applications. Finally, because, Lotus Domino Access for 
Microsoft Outlook 7 does not require a Lotus Domino 7 server, you can take 
advantage of these improvements today, before you complete your server 
upgrade, as long as your users’ mailfiles reside on Lotus Domino release 6.5.1 or 
above. For more information on DAMO, please refer to to the product homepage 
at:

http://www-142.ibm.com/software/sw-lotus/products/product1.nsf/wdocs/ac
cessmsoutlookhome

User training
Many organizations have been using Web browsers for a while and their users 
have become familiar with them. Also, a lot of people are now connected to the 
Internet at home and are becoming proficient and comfortable with a Web 
browser.

However, this does not mean that no user training is required for the browser. 
Because of the open nature of the Web browser, every site on the Internet has 
designed its own user interface. Some sites use a graphical toolbar and place it 
in a frame on the left, right, top, or bottom of the screen. Others use text-based 
links or some new tool that no one has ever seen before.

It is very important to compare the need to educate on the browser to the need to 
educate on the actual Notes client.
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Platform support
The Notes 7 client is supported on the Win32® platforms as well as the 
Macintosh, and Domino Web Access 7 is available for Mozilla browsers, which 
means you could use it on machines running Linux. There are Web browsers 
available for just about every client platform on the market. If you are using a 
client platform other than Win32 or Macintosh in your organization, and you have 
no plans currently to implement one of those platforms, the browser may be your 
only choice.

Cost considerations
A number of companies look to using a Web browser because they believe it will 
be cost effective to implement. This might be true in some cases, but not 
necessarily in all, and will depend on your organization. Be aware that some 
important functionality your users need might not be available or easily 
implemented for browsers.

If you already have a Web browser on the workstations that will not need to be 
customized, installation costs could perhaps be saved. If there is a need to 
update or customize the installed browser, the potential cost savings may very 
well be minimal or nonexistent.

Other possible cost savings with a browser come from reduced training 
requirements for the users. If the users are already familiar with a browser, they 
will not need to have training on the browser. Users will usually still need training 
on any customization you may have performed. The amount of training, and 
therefore cost, might then not be lower than the cost associated with training the 
users on a Notes client.

Maintaining the Notes client may be easier than maintaining the browser since 
Notes 7 includes the AutoUpgrade feature, which automatically installs new 
versions and updates on the client.

Offline use
One of the major benefits of Domino/Notes is replication. Replication allows 
users to work offline by copying data down to local hard drives. It provides tools 
for synchronizing the data when needed.

Replication is now available when using a Web browser for the client, in the form 
of DOLS (Domino Off-Line Services). This is, however, a modification and extra 
installation to the client, and it is not necessary if the Notes client is deployed 
rather than the browser. Refer to the Administration manuals provided with 
Domino for more information on replication.
74 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777ch_planning_for_migration.fm
Performance considerations
The Web browser relies on the server to do most of the processing for it, and only 
needs to be able to display a text document. The Notes client is designed to do a 
lot of processing by itself. This means that a Domino server needs to do much 
more work to communicate with a Web browser than with a Notes client. On the 
other hand, a computer running a Notes client will need to do more work than a 
computer running a Web browser.

It is, of course, possible to build an infrastructure that will support both browser 
clients and Notes clients. In all likelihood, more servers will be required to 
support browser clients than will be needed to support the same number of 
Notes clients.

Example: It is possible to do mail with Notes clients, or a combination of POP3, 
IMAP, and/or HTTP-based mail with a Web browser could be used. If you want to 
minimize the load on the server in order to maximize the number of mail clients 
that can be supported, using the Notes client is the best option. Using POP3 is 
next best, IMAP is third best, and using HTTP, while sometimes appropriate, will 
support the fewest mail users of any of these four options.

Security considerations
One of the core aspects of Notes is the built-in security, which satisfies the most 
stringent security requirements a company may have.

Domino uses ID files to identify users and to control access to servers. The ID file 
sits on the client workstation and is protected by a password.

Web browsers do not use ID files. They are proprietary to Notes, which requires 
the ID files to be on the client workstation. If Domino required browser users to 
have an ID file on their local machine it would impact the advantages of using a 
browser. These include such things as being able to use any browser from any 
machine, or allowing users outside the organization to browse pages without any 
special software, to name just a few.

Instead of ID files, browsers typically use user names and passwords for security. 
Most sites on the Internet pass user names and passwords between the client 
and server in clear-text format. This means that anyone can intercept the 
message and easily read the user name and password. While this may not be of 
much concern in a closed, private network, it is definitely a big issue when 
opening up Domino to outside users.

Tip: Check http://www.lotus.com/performance for more information.
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To enhance security on the Web, Domino also allows the use of SSL (Secure 
Sockets Layer) and X.509 certificates for Web browser authentication. The main 
point here is that authentication and other aspects of security are different in a 
Web browser and a Notes client. You should look carefully at the differences 
between the two when making a client decision, especially if security is a top 
concern in your organization. 

For details on Web browser security, see the Lotus Domino 7 Administrator Help 
database or the IBM redbook Lotus Notes and Domino R5.0 Security 
Infrastructure Revealed, IBM SG24-5341.

How to decide
The “best” client choice will differ for each organization. Use the information you 
have gathered, combined with the points described in this section, to help you 
decide which client will work best in your organization.

1. Check to see if your desktops are ready to use the Notes client. If you are not 
running Windows 32 or MacOS on your desktops, the Notes client is not an 
option. If some of your clients can run Notes while others cannot, decide if 
you will allow a combination of clients. 

2. Can the required features be made available for Web browser users?

3. Determine if the browser will be used for other things. If the Web browser is 
going to be on the desktop anyway, it might be more practical to use the 
browser than to run the browser on some desktops and the Notes client on 
others. Also, if you already have Web developers in-house, they might feel 
more comfortable developing for the browser.

4. Try both of them out. Set up both a Web browser and a Notes client and test 
their functionality. Maybe the client offers some functionality you really like, or 
maybe the browser suits you more.

5. Determine if there is any feature of either of the two clients that you must 
have. If you must have replication, or your databases must be Web-capable, 
the decision is in favor of the Notes client.

6. Make a list of pros and cons for the Notes client, and one for the Web 
browser, and compare the lists. The client that turns out having the most pros 
and the least cons could be the winner.

Many companies have decided to use a combination of the two clients. A 
common setup is to use the Notes client inside the building and the Web browser 
outside the building. “Outside the building” could be either another company, or 
an employee working from home. You are then using the advantages of both 
clients where appropriate. Domino is unique in that it can gracefully handle this 
dual client setup.
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There might be some initial development overhead to make your Notes 
applications work in both clients, but it may be a good investment. It will give you 
a lot of flexibility for the future, and it takes less time in the end to make your 
applications dual-client capable at the start than to go back and change them 
later.

3.14  Developing a coexistence and migration strategy
Coexistence between the Exchange and Domino environments plays one of the 
most critical roles in ensuring seamlessness of the migration process for both 
administrators and end-users. Unless instantaneous migration of users from 
Exchange to Domino can be accomplished, users will be migrating gradually 
over a period of time. During that time, users in both environments must be able 
to continue communicating with one another as well as with users external to 
both environments. Failure to provide this ability to users will have an adverse 
effect on any migration project.

In this section we discuss the following topics:

� The levels of coexistence

Several options are available for establishing coexistence between Exchange 
and Domino. Coexistence solutions usually provide one or more of the 
following levels of functionality:

– Messaging: Ability to exchange mail between Exchange and Domino 
users as well as with external users

– Directory: Ability to exchange directory information between Exchange 
and Domino

– Calendar & Scheduling (C&S): Ability to exchange scheduling information 
between Exchange and Domino users.

– Application: Ability to access common application data by Exchange and 
Domino users

� Overview of the migration progress

� Introduction to the migration tools

� Acquiring the necessary information for migration

When migrating, there are areas other than mail and C&S to consider. The 
available migration tools will not migrate applications and backend interfaces. 
The discussion in earlier sections demonstrated the need for awareness of 
any development work that must be undertaken before starting the migration.

– Hardware profile

– Software profile
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– Network

3.14.1  Levels of coexistence
Several levels of coexistence between Exchange and Domino are possible. The 
functionality provided by the selected coexistence approach normally depends 
on the functionality presently utilized by Exchange users and existing Domino 
users, if any. The following list describes coexistence functionality from the 
simplest to the most complex. Refer to the technical sections later in this book for 
comparison of the different coexistence and migration tools.

� No coexistence

Users are migrated instantaneously, for example, during the weekend.

� Messaging only

This coexistence method uses SMTP to exchange mail messages between 
Exchange, Domino, and the Internet; and requires manual entry of 
addressing information for some or all recipients. 

This method is fairly easy to establish; however, it imposes a burden on 
end-users to know exact addresses of all recipients, some of whom they had 
previously been able to select from the directory. End-user addressing 
questions subsequently increase the load on the end-user support personnel, 
dramatically increasing the overall cost and decreasing satisfaction with the 
coexistence solution. This method is only recommended for brief coexistence 
periods.

� Messaging with Directory Synchronization

This coexistence method uses SMTP or other protocols for exchanging mail 
messages between Exchange, Domino, and the Internet; and allows 
selection of all Exchange and Domino recipients from the appropriate mail 
directory. Depending on the mail exchange approach selected, directory 
synchronization may be performed manually or automatically.

Manual directory synchronization requires periodic updates to Domino and 
Exchange directories initiated by an authorized individual. The process may 
consist of executing custom programs, performing manual data entry, or a 
combination of the two.

Automated directory synchronization is a process that automatically performs 
directory updates either instantly or based on a pre-defined schedule. 
Automated directory synchronization can be achieved by using Microsoft’s 
Domino Connector for Exchange, TenFour’s TFS Gateway, or by creating 
automatically invoked custom programs.

This method requires a fair amount of effort to establish; however, it enables 
end users to continue e-mail communication in a familiar way regardless of 
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the sender’s or recipient’s migration status. This method is recommended for 
extended coexistence periods.

� Messaging with Directory Synchronization and cross-platform Calendar and 
Scheduling support.

This coexistence method uses SMTP or other protocols for exchanging mail 
messages between Exchange, Domino, and the Internet; and allows 
selection of all Exchange and Domino recipients from the appropriate mail 
directory. Depending on the mail exchange approach selected, directory 
synchronization may be performed manually or automatically. Also, 
depending on the mail exchange approach selected, cross-platform Calendar 
and Scheduling support may be provided in a transparent or manual fashion.

In the manual approach to cross-platform Calendar and Scheduling, Domino 
and Exchange users include users of the opposite platform in the scheduling 
notices, which are translated into simple mail messages when delivered to 
such recipients. Recipients have to manually add scheduling notices to their 
calendars and manually respond to invitations. Cross-platform schedule 
check is not possible with this approach.

In the transparent approach to cross-platform Calendar and Scheduling, 
Domino and Exchange users are able to perform all Calendar and Scheduling 
functions, such as sending scheduling notices, accepting invitations, checking 
schedules, and so forth, regardless of the recipient’s platform. Transparent 
cross-platform Calendar and Scheduling support can only be achieved by 
using the Calendar Connector portion of Microsoft’s Domino Connector for 
Exchange.

This method requires a great deal of effort to establish; however, it enables 
end users to continue all of their e-mail and Calendar and Scheduling 
communication in a familiar way regardless of the sender’s or recipient’s 
migration status. This method is recommended for extended coexistence 
periods.

� Messaging with Directory Synchronization, cross-platform Calendar and 
Scheduling support and uninterrupted Application access.

This coexistence method uses SMTP or other protocols for exchanging mail 
messages between Exchange, Domino, and the Internet; and allows 
selection of all Exchange and Domino recipients from the appropriate mail 
directory. Depending on the mail exchange approach selected, directory 
synchronization may be performed manually or automatically. Also, 
depending on the mail exchange approach selected, cross-platform Calendar 
and Scheduling support may be provided in a transparent or manual fashion. 
Finally, depending on the nature of applications, application access can be 
achieved via universal application access, or manual or automatic application 
synchronization.
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Universal application access is achieved for applications that are Outlook 
client-independent, for example Web-enabled applications accessed via a 
Web browser. Users continue to access such applications regardless of their 
migration status. For Outlook client-dependent applications, continuous 
application access can be achieved by retaining the Outlook mail client on 
users’ workstations, possibly along with the Notes client, and continuing to 
access applications that so require it using Outlook client.

Manual application synchronization requires that periodic updates to 
applications be performed by an authorized individual. The process may 
consist of executing custom programs, performing manual data entry, or a 
combination of the two.

Automated application synchronization is a process which automatically 
performs application updates, either instantly or based on a pre-defined 
schedule. Depending on the nature of an application, automated application 
synchronization can be achieved by using a third-party product or by creating 
automatically invoked custom programs.

Depending on the nature of applications, this method may require a great 
deal of effort to establish; however, it enables end-users to continue 
accessing applications regardless of their migration status. This method is 
recommended for extended coexistence periods.

3.14.2  Pros and cons of migrating
Messaging data migration from Exchange and Outlook to Domino and Notes 
plays a critical role in ensuring that the migration process is completely 
non-disruptive for end users. The ability to access old messaging data in the new 
environment, in a similar way as in the old environment, is of great benefit and 
comfort to a user migrating from Exchange to Domino. Additionally, retaining old 
messaging data is sometimes mandatory due to certain legal and industry 
regulations covering data retention.

In some cases, however, a clean cutover to the new environment is preferred. In 
this case, the old system may live on as a reference for a period of time. This 
approach is very cost-effective in terms of migration and coexistence, but its 
success is heavily dependent on how the old system was used.

Example: A company uses mail and mail storage for project communication and 
documentation. Large amounts of the company’s project documentation and 
communication is stored in the mail files. If this documentation is lost or not easily 
accessible, severe problems could be encountered.
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3.14.3  What to migrate
Before determining what messaging data to migrate from Exchange and Outlook 
to Domino, one must clearly understand what types of data end users access, 
and how they do this. Exchange and Outlook data accessed by end users may 
include any combination of Exchange Mailboxes, Outlook Personal Folders, 
Public Folders, Contacts, and Personal Address Books. The characteristics of 
the data types are as follows:

� Exchange Mailboxes are located on Exchange Servers and usually include 
system- and user-created mail folders, calendar, tasks, journal, and so forth. 
Sizes of Exchange Mailboxes are usually limited by the server quotas. 
Exchange Mailboxes can be accessed in a connected or, if synchronized, an 
offline mode.

� Shared Exchange Mailboxes are located on Exchange Servers and resemble 
regular Exchange Mailboxes, except they may be shared by a number of 
users without any specific user owning them. Shared Exchange Mailboxes 
can only be accessed in a connected mode.

� Personal Folders are located on users’ workstations or network file servers 
and may include data similar to that of Exchange Mailboxes. Sizes of 
Personal Folders are usually not limited. Personal Folders located on users’ 
workstations are accessed in an offline mode; however, ones located on 
network file servers require network connectivity.

� Personal Address Books often have the same information as Contacts, but 
may have additional information.

� Public Folders are located on Exchange Servers and usually represent 
structured or unstructured collections of documents shared between users.

Determination of what data and how much data to migrate is often dependent on 
several of the following factors:

� Data importance: How valuable is data from personal, professional, 
corporate, and legal points of view?

� Data retention: What mailbox cleanup policies and activities are in effect?

� Server mailbox limitation: What are the differences in quota policies and 
enforcement in Exchange and Domino environments?

� Archiving policy: Where and how frequently will data be archived?

� Migration Tools selection – Which migration products will be used for data 
migration and what are their capabilities?

� Migration duration: How much time is allocated for data migration?

The final decision on what data to migrate may result in multiple alternatives 
applicable to different groups or categories of users.
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3.15  Deployment approaches - Proof of concept 
deployment

Assuming that you are migrating a large group of users or that you still wish to 
gain some key feedback from specific users about using the product, we 
recommend beginning with a smaller scale pilot or proof of concept deployment. 
The goal or a proof of concept deployment is to begin the rollout with a small 
group of selected users who can provide useful feedback and serve to further 
champion the larger scale deployment initiative.

You should plan one or more pilots to validate the functionality and deployment 
procedures that are planned by your organization. Lessons learned from such 
pilot activities can help make the general upgrade process smoother. 

3.15.1  Benefits of proof of concept deployment
Beginning with a smaller scale proof of concept deployment, prior to a larger 
rollout, can help ensure the success of your migration to Notes and Domino. This 
approach allows you to select your initial audience for the introduction of the 
technology, manage expectations more effectively, and gain valuable knowledge 
and feedback which can be incorporated into your full scale deployment. 

Key benefits include:

� Ability to determine test audience. 

When determining the initial team to participate in the proof of concept, you 
want to select participants who represent a broad range of users in your 
organization, from those who are early adopters of new technology to users 
who are especially resistant to change. Pilot participants can include:

– IT staff 
– Administrative assistants
– Key executive(s) (choose judiciously)

– People who are more resistant to change
– Some volunteers

� Solicit continued feedback and use this going forward. 

In order to maximize the benefits of a pilot deployment, you want a proper 
feedback mechanism or channel in place. This allows you to document and 

Note: Choosing administrative assistants and the specific executives 
with whom they work is especially important, given that assistants 
frequently have full delegation rights to the executive’s mail file. 
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improve upon your initial deployment plan and to implement a more effective 
rollout plan to the larger audience.

3.15.2  Key steps that are involved in the proof of concept 
deployment

When preparing to implement a pilot rollout of Notes and Domino in preparation 
for the migration, we recommend that you follow these general steps: 

1. Determine the group of pilot users.

2. Ensure that the following has been identified and communicated:

a. Pilot users responsibilities and expectations of their participation

b. Pilot users testing instructions

c. Pilot critical success factors

3. Provide proper training and manage user expectations. Because pilot users 
are operating in a mixed environment, most likely with both Exchange and 
Domino users, train users on using Notes and Domino, together with what 
they may expect to see in a period of co-existence.

4. Build or validate the infrastructure to be used for pilot team, including:

a. If users need to first be migrated from Exchange to Domino, follow the 
appropriate steps outlined in Part 4, “Migration Process - tools and 
procedures” on page 337. 

b. Install Notes on the client machines for pilot users.

5. Initiate the migration pilot and monitor results on a regular basis, 

6. After a determined amount of time in which users have been working with the 
system on a regular basis, solicit final pilot user feedback and document the 
results. Incorporate feedback or recommendations into a deployment plan for 
larger audience. 

3.15.3  Overview of the migration process
When considering a migration from Microsoft Exchange to Lotus Domino, there 
are a couple of different strategies available:

� The single step or straightforward process

� The coexistence and migration process

Single step process
Single step migration can be defined as a complete migration from a Microsoft 
Exchange environment to a Lotus Domino environment without a transitional 
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period of coexistence (also known as the “rip and replace” method). In this 
scenario, there is no need for gateways to interconnect Microsoft Exchange and 
Lotus Domino.

The single step migration process is ideal when an organization meets these 
criteria:

� Limited number of users to migrate on a single server.

� Users are typically located close to each other.

� Enough migration resources can be engaged in the migration effort to 
complete the tasks at hand over the shortest period of time.

� The migration process can be performed in a single event.

� The organization has a simple mail topology, for example, consisting of a 
couple of Exchange mail servers that need to be consolidated onto a single 
Domino 7 server.

In general, if the organization meets these conditions, the single step migration 
process can be used effectively.

Coexistence and migration process
Any mid-term or phased migration process requires the coexistence of both the 
old Microsoft Exchange servers with the new Lotus Domino environment. The 
coexistence period can vary from a few weeks to a couple of months. During this 
coexistence period, use gateways or connectors to provide message transfer 
between the two environments.

Mid-term coexistence planning is practical for organizations that meet these 
criteria:

� A large number of users in the Microsoft Exchange environment in a 
distributed environment.

� An organizational unit in multiple locations where it would be difficult to 
migrate all locations at the same time to Lotus Domino.

� An organization that has a complex Microsoft Exchange topology with 
multiple sites, servers, and gateways.

3.15.4  Migration tools
Migration tools provide a smooth and easy way to migrate the server and related 
data from an existing mail server to the new messaging environment. There are 
various tasks involved when migrating from an old mail server to a new one. 
These tasks include the conversion of users’ mail data and calendaring and 
scheduling information stored on the server, directory propagation and, in some 
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cases, the client. A separate chapter includes information on the coexistence 
and migration of Public Folders. A good migration tool should be able to perform 
these basic tasks successfully with the least amount of effort. In addition, 
migration tools should also support the most possible messaging environments. 
This section briefly covers the Lotus Domino Upgrade Services and Common 
Migration Tool (CMT) from BinaryTree. 

For detailed information about using these tools, as well as migration results, 
refer to Chapter 11, “Server level migration Using Domino Upgrade Services” on 
page 339 and Chapter 13, “Server Level Migration process using CMT from 
Binary Tree” on page 401.

Domino Upgrade Services
Domino Upgrade Services (DUS), a part of the Domino Administrator client, lets 
you easily upgrade your existing messaging and directory system to Lotus Notes 
and Domino 7. DUS automates the entire process of upgrading, creating users, 
and converting mail for one user at a time or for your entire existing environment. 
DUS supports all popular LAN mail systems with the same upgrade procedures 
for each of them. And best of all, DUS is integrated into the normal user 
registration process of the Domino Administrator.

DUS provides the smoothest migration path from Microsoft Exchange to 
Domino 7. With the Microsoft Exchange migration tools, you can migrate users 
and convert their mail and calendar information to Domino 7, with full fidelity. 
Best of all, mailbox conversion runs on any administrator workstation, which 
leaves the Domino server free to serve the users. Like all Domino Upgrade 
Services, the Microsoft Exchange DUS is built right into the Domino 
Administrator client.

Common Migration Tool from BinaryTree
The Common Migration Tool (CMT) builds on years of proven e-mail and 
calendar/schedule migration solutions from BinaryTree.com. The individual 
product solutions have now been integrated into one: CMT. Apart from Microsoft 
Exchange, CMT allows you to migrate from Novell Groupwise and Netscape Mail 
servers to Lotus Domino. It also has utilities that migrate data at the client level. 
These include migration from Microsoft Outlook, Netscape Messenger, Microsoft 
Outlook Express, Qualcomm Eudora, and Lotus Organizer® to Lotus Notes.

3.15.5  Acquiring the necessary information for migration
Prior to creating the migration plan, you should consider the various migration 
scenarios, client deployment options, data migration options, and the 
coexistence options. With the questions in the prior sections in mind, discuss 
what is to be migrated, what can’t be migrated and what will have to be 
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redeveloped in Domino. Along with all this, consider the Domino deployment and 
pay particular attention to client selection and deployment.

So before deciding what and when to migrate, we have to consider these 
questions:

� What is the main purpose of the migration (move to Domino, consolidate 
servers, security, and so forth)?

� How many users are to be migrated?

� How many locations do you have to migrate?

� What is the time frame for migration?

� Is information stored in Exchange or the Client needed?

� Are there other mail systems connected to Exchange?

With those questions in mind, think about the following issues.

Consider the training requirements and Client deployment issues, then decide:

� What Client are you migrating to (this will determine what data can be 
migrated):

– Notes client
– Domino Access for MS Outlook
– Domino Web Access
– Web browser
– Mixed environment

� Available training resources:

– Rooms
– Materials
– Personnel
– Availability (the company)
– Cost

� Post migration support/Helpdesk

Consider what information should be migrated:

� Data on server - server migration only (technically the only option for Domino 
Web Access)

� All data - server and local

� Locally saved data - local only

� No data

� Calendar information
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� Distribution lists

� Directory information

� Public folders and forms. Consider the following:

– Not migrating redundant forms
– Development work required to provide the same facilities
– Complexities of public folders/NSF coexistence

With regard to client migration, what type of information has been added to the 
personal address books:

� Entries copied from Global Access List (GAL)

� Custom entries

� Entries added from received mail

� No PABs used or allowed

It is important to review this information because the Client migration tools are 
not always able to resolve some addresses added via extraction from the GAL or 
recipient information.

With regard to physical infrastructure, consider the resources available:

� Hardware reuse: 

– Is it reusable?

– Will you need to consolidate on same or new platform?

– Is it redundant?

� With regard to the physical infrastructure, review the reuse/redeployment of 
any storage architecture in place.

� Internal IS support and Helpdesk.

� Network bandwith. This issue needs to be considered in terms of both Server 
and Client data migration and deployment.

– With regard to server migration, assuming all Exchange servers are 
accessible from one location, consider bandwith usage for each user 
migration from remote servers.

– With regard to Client deployment, specifically for Domino Access for 
Outlook, consider the bandwith available for all connections (WAN, LAN 
Dialup, and so forth). The Domino Access for Outlook deployment 
requires you to download both code and a replication/synchronization of 
the user’s mail file.

A similar situation may evolve with a remote client deployment and local 
replication of users migrated server-based mail files.
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� Network support and future plans for the network.

With regard to actual migration, consider the following in terms of timing and 
planning of the deployment:

� Number and types of other mail connections to Exchange

� Address resolution, internal and external

� Support of coexistence tools

� Mailflow restrictions

� Directory management

� Mailflow performance

� Scalability of coexistence tool

� Public folders/Workflow

� Calendars

� Instant messaging

� Internet addressing and message flow

� Facilities that will no longer be available, regardless of the Client selection (for 
example, voting, resource scheduling, and others).

With regard to the actual migration, consider the following:

� Number of users to be migrated

� Grouping of users to be migrated at the same time (this could reduce the 
mailflow over connectors)

� Number and size of documents present in public folders

� Access restrictions on public folders

� Amount of developers work required to emulate forms and integration with 
backend applications

� Selection criteria for documents to be migrated (if not all documents)

� Whether all directory information must be migrated

� Reliability of coexistence tools

� Other mail systems - migration or gateway support

� Should directory structure/naming be emulated in Domino

� Internet connection migration

� Helpdesk retraining

� User training
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� Methods of client deployment

� Server and client locations

� Passwords

� Post migration clean-up

With regard to coexistence, consider the following:

� Coexistence duration

� Number of users on either system at the mid-stage of the migration

� Calendar and scheduling requirements

� Internet coexistence requirements

� Expected message throughput of the gateway at the mid-stage of the 
migration

� Support personnel training

� Cost

� Post-migration cleanup 

All the migration tools available are non-destructive. This means that a 
migrated users NT/Exchange account would still be online. It is therefore 
necessary to remove his account from the Exchange system, or if there is a 
need to access data, to restrict the user sufficiently (no creation of new mail, 
not listed in the Exchange directory, and so forth). Be sure to back up all 
accounts before removing them.

3.16  Realigning the expectations
An original set of success criteria were defined for the pilot project, and you 
should review them now. Are they still appropriate, in light of lessons learned 
during the previous sections? If so, include them in your deployment planning. If 
not, discuss the success criteria with senior management and update the criteria 
so they continue to be relevant. The success criteria should also be included in 
the final deployment plan document.

Have the expectations realigned and communicated. This part of the 
communication is the most crucial part since these will be the expectations the 
users are measuring the results against. Deviations from the expectations can 
impact your project in a negative way.
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3.17  Deploying the coexistence and migration strategy
There are basically two methods used to roll out Domino: staged or 
instantaneous. Variations on these methods are called different things, but pretty 
much every strategy is a variation of these two, in technical projects.

The important thing to remember is that the strategy’s success will depend on 
good planning more than the method you choose. As always, you should be 
prepared for unforeseen events.

Meeting the prerequisites
Before you can roll out Domino, you need to be certain that all the prerequisites 
of the Domino rollout have been completed. Be sure that servers, network 
cabling, and other infrastructure is in place prior to beginning implementation. It 
will be difficult to install and configure clients if there is a problem with network 
connectivity, for instance.

It may be the case that all of this is handled by another area of the IT department, 
but it is critical the project manager understand what needs to happen, so that he 
or she can ensure it has been completed.

Staged rollout
In this type of rollout, the rollout team takes a step-by-step approach. This 
approach is quite common in smaller companies, where person power may be 
limited. For example, if you have just two people to handle the rollout, there are 
limits to the number of machines they can get ready in a day.

The staged rollout is also used in larger companies, if the rollout can be 
subdivided neatly. This is supported by coexistence during the actual migration.

The major advantage to this approach is that the risk if any given step goes 
wrong is minimal since it is only a fraction of the total project. The biggest 
disadvantage is that the total migration project can take a long time. Be aware 
that there tends to be a short span of time left between steps to determine if the 
one step has been successfully implemented before performing the next step.

Instantaneous rollout
This refers to a methodology where the entire rollout is done all at once, in one 
major step. Several underlying or background steps may have been performed 
prior to the rollout, though.

The biggest advantage with this type of rollout is that there is no period of 
coexistence. Be advised that for this type of rollout, management needs to be 
prepared for downtime. The downtime is needed to perform several steps all at 
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once. If you choose an instantaneous approach, management needs to be 
prepared for the possibility that there will be problems encountered along the 
way (like an operating system that refuses to install in a stable manner) that can 
cause the project to take a long time.

Most instantaneous projects are scheduled to run over a weekend or long 
weekend, and if there are problems, the rollout may run into Tuesday or even 
Wednesday. Management needs to know this is possible.

Reality check
In the real world, you rarely have the luxury of taking a system down during 
production hours. At the same time, management will not want to have a project 
which drags on interminably. Therefore, most rollouts end up falling somewhere 
between the extremes of instantaneous and staged.

Consider performing whatever you can separately, in controllable steps, to 
minimize risk. Do as much as you can at a time, after office hours. In this way 
you will benefit from doing big chunks at once, time-wise, but without the 
required production downtime a big bang requires.

Distributing client software
Depending on the platform you use, there are different tools available for 
software distribution. More appear on the market regularly; we recommend that 
you search Web automatic client deployment software.

Some of the tools available are architected for Notes client deployment, for 
example Automated Deployment Toolkit from Wolcott Systems Group and 
InstallPump from SoftQuest. You can also use Microsoft Active Directory for 
distributing Notes clients. The basic idea behind automated software distribution 
is to make installing multiple clients more efficient. This is generally done using 
some kind of template file, or a profile, which is set up once and then “pushed” to 
the user’s desktop. Then, the only tasks left in the client installations are the 
user-specific setup items.

Automated Deployment Toolkit (ADT) from Wolcott Systems Group is an 
automated, managed system for deploying, upgrading, or migrating an existing 
messaging system to Notes R5 and Notes 6. ADT centrally manages and 
automates the client deployment process and integrates with industry-leading 
data migration and training tools, saving companies significant time and 
expense.

Another option is to use one of the software products that are architected for 
distributing any software to the workstation. The most commonly used tools 
include IBM Tivoli Configuration Manager, Microsoft SMS, and ZenWorks. 
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Unless you work in a fairly small company, we recommend strongly that you 
consider using some kind of automated installation for the client installation.

For further information about distributing Notes clients automatically, refer to the 
Web sites and product documentation from the deployment software vendors, or 
to the IBM Redpaper Distributing Notes Clients Automatically, REDP3693.

Backup and disaster recovery
One of the most common errors made in Domino rollouts is not beginning 
backups until after the entire rollout is complete. We cannot stress enough that 
this is a bad idea. If you need to back out of changes that were made on a 
particular day, you will need a good backup from the day before to accomplish 
this.

Recovery planning
The concept of recovery planning is to save the organization from losing data. 
The type of disaster you are trying to be prepared for does not matter. If you’re 
prepared for the worst, you can get back to normal much faster.

Make sure, as a minimum, to have a rollback plan in place.

3.18  Final phase: Closure
This phase will close the migration project, transitioning the new system to 
ongoing operations and support. You should begin as soon as all 
migration-specific issues have been resolved. This phase should include:

� Acceptance report from the sponsor.

� Finalization of all project documentation.

� Completion of all technical documentation for the new system.

� Completion of a post-migration review and analysis of lessons learned.

� Closing down or securing the Exchange environment. (Refer to Chapter 23, 
“Migration Project wrap up - Removing the Microsoft Exchange environment” 
on page 715for details.)

� Disposal or reallocation of any hardware or software remaining from the 
replaced system.
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Chapter 4. Overview of the Migration 
Procedures

This chapter serves as an overview for the steps required for Migrating users 
from Exchange to Domino, and highlights the chapters where we provide more 
specific information for each step. This is intended to provide a general roadmap 
of the high level steps involved in a migration effort. 

Subsequent chapters in Part 3, “Coexistence - Tools and Strategies” on 
page 105, and Part 4, “Migration Process - tools and procedures” on page 337 
will highlight in much greater detail the specific tools and approaches to be used. 

Finally, this approach does not express a single path / only way to migrate, but 
merely demonstrates best practices that the team has developed over the many 

4

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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years they have spent in customer environments. There are many variations on 
the these procedures, but in general each and every step is undertaken.
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4.1  Migration steps

Figure 4-1 illustrates a high level overview of the migration steps in a migration 
project. The following steps are the minimum needed to be undertaken any 
Migration from Exchange to Domino. 

Figure 4-1   Migration Steps

The steps are detailed below, along with additional information on substeps 
involved in completing each of the steps. 

4.1.1  Step 1 Install Domino

While this may seem obvious, you can’t migrate if you have nothing to migrate to. 
This will be your ultimate destination. There are many Redbooks on deploying 
and configuring Domino, for the sake of completeness however, this Redbook 
also provides an appendix on installing Domino for the planning of the migration. 
(See Appendix F, “Installing Domino” on page 823.) We also recommend the 
Redpaper Lotus Notes and Domino 7 Enterprise Upgrade Best Practices, 
REDP-4120, (http://www.redbooks.ibm.com/abstracts/redp4120.html?Open) 
for administrators who are new to Domino. 

It is important that you take time to plan and deploy your domino infrastructure, 
including defining Administrative policies. Although implementing changes can 

EndDecommission
servers

Exchange to Domino overview

Step 4 Migrate inbound SMTP connections

Step 3 Migrate mailboxes

Step 2 Set up coexistence

Step 1 Design and Deploy Domino
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be rather simple, getting it right first time can save many of man hours in making 
changes later.

We fully appreciate that your main objective is to migrate your messaging 
environment, but Domino is a platform for advanced collaboration and application 
development/deployment. Please review the information in this and other 
redbooks before deploying a full domino messaging and collaboration 
infrastructure, as this will ensure that you get the maximum return on your 
investment. 

4.1.2  Step 2 - Set up co-existence strategy and implementation plan

� Plan the co-existence strategy and understand the differences between the 
systems and how these will manifest themselves for users. 

� Communicate the co-existence strategy early to a select group of users

� Educate users through training about the new system and what to expect 
during a period of co-existence. 

� Set up Exchange for mail coexistence

� Set up Domino for mail coexistence

� Deploy mail / directory coexistence solution

For detailed instructions on deploying the proper co-existence solution, see 
Part 3, “Coexistence - Tools and Strategies” on page 105. 

4.1.3  Step 3 Define Migration Plan

Defining the migration plan has been thoroughly discussed in Chapter 3, 
“Migration project overview” on page 43 of this Redbook. However, we like to 
reiterate the importance of user profiling. Know who the key users are, the early 
adopters, and make sure they are properly trained in advance. Their first 
impression will have a critical impact on the longer term success and impression 
of the migration project. For example, if higher level directors will be involved in 
the early stages of the migration, be absolutely sure to also migrate their 
Personal Assistant at the same time. Chances are that the Personal Assistant 

Important: Co-existence is possibly the most important, and in all likelihood, 
the most challenging aspect of a migration project. Please review all chapters 
in Part 3, “Coexistence - Tools and Strategies” on page 105, as well as 
Chapter 10, “Co-existence test results - what to expect” on page 309 to better 
understand in advance what some of the challenging issues are. 
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has important delegation rights to the director’s mail file - and this ability for the 
director and assistant to work together - on the same system - is critical.. 

4.1.4  Step 4 - Begin with a Proof of Concept/ Pilot Deployment

Assuming that you are migrating a large group of users or that you still wish to 
gain some key feedback from specific users about using the product, we 
recommend beginning with a smaller scale pilot or proof of concept deployment. 
The goal or a proof of concept deployment is to begin the rollout with a small 
group of selected users who can provide useful feedback and serve to further 
champion the larger scale deployment initiative.

You should plan one or more pilots to validate the functionality and deployment 
procedures that are planned by your organization. Lessons learned from such 
pilot activities can help make the general upgrade process smoother. 

Please refer to Part 3.15.1, “Benefits of proof of concept deployment” on page 82 
for details in how this can lead to a successful migration. 

4.1.5  Step 5 - Migrate Users at the server level

The following Procedures can be used for migrating users from Exchange to 
Domino. The physical migration of a user mailbox may be only a click of a button 
However, additional procedures should be undertaken to complete the process. 

1. Utilizing the Migration plan select the users for migration

a. Inform user of migration

Do this many times, request the user clean up his mailbox. If you were in 
the process of moving to a new home - you wouldn’t take the trash with 
you, right? In the case of a migration, why take your non-business and 
unwanted emails to your new system?

Important: Please review Chapter 3, “Migration project overview” on page 43, 
specifically 3.8, “The communication plan” on page 53. 

Note: Specific technical details for a migration procedure is documented in 
Part 4, “Migration Process - tools and procedures” on page 337. This section 
is merely intended to serve as a overview of the steps and key considerations.

Additionally, the specific steps to this process are highlighted in Appendix B, 
“Migration Procedures - abbreviated overview” on page 769. 
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2. Register the User in Domino either using Domino administration -> People 
and Groups -> Tools > register -> Migrate.

3. After selecting the system to be exchange and choosing the relevant profile

4. Select the users to migrate. 

At this moment in time, do not migrate the mailbox (i.e. select option do not 
convert mail)

Figure 4-2   Migration options on User registration

Alternatively, if you are using the CMT, select ADD users > Registration > register

5. Register users in Domino,

If using Domino migration tools deselect the option to convert mail and 
select add admin to ACL (this is necessary to be able to add migrated mail 
documents later

6. Install mail client for user being migrated - (Outlook Connector or Full Notes 
clients) optional enable sametime 

7. Set an Autoforward on the exchange account - the specific steps are 
described in Appendix B, “Migration Procedures - abbreviated overview” on 
page 769. 

Tip: While it sounds obvious - make sure users who are about to be migrated 
have cleaned out their mail files and emptied the trash from their mail file. This 
will have a significant impact to reduce the number of messages requiring 
migration. 
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8. Once the autoforward configuration is set, all email for the user will be 
forwarded to the Domino account. the user can be migrated any time from 
this point onwards

Considerations - Migrating the mail account using CMT 

The following instructions are a brief summary of the migration of the users’ data 
to Domino and assumes that users have already been registered (either using 
CMT or DUS)

a. Open CMT 

b. Add users 

c. Select import from foreign directory and click run wizard 

d. Enter the target domino server if different from default 

e. Select the tick boxes, migrate to notes folders, migrate rich text, 
distribution lists, resolve names. 

f. Click ok on the next screen, and ensure select users from exchange is 
selected and click ok 

g. Select the user(s) you are migrating and add users 

h. Click left hand pane [REGISTRATION] to see user list, 

i. Select user(s) you want to migrate and check that the information is 
correct in the doc (server name and mail file) 

i. if migrating to a different server than to the registered home server, 
then you will need to change the entry in CMT

j. select the top PANE [SERVER MIGRATION] 

k. select the user(s) to migrate and click ok. 

l. Users will now be migrated.

m. Check migration and mailflow changes are successful

Note: Setting the autoforward is an important step for a successful 
migration If non migrated users still in exchange reply to mail or 
select a recipient from local contacts the replyto address will be the 
old exchange address. Setting an autoforward will ensure that all 
mail is received in his new mailbox on Domino

Note: Full instructions on using the CMT to migrate users can be found in 
Chapter 13, “Server Level Migration process using CMT from Binary Tree” on 
page 387
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Considerations - Migrating the mail account using DUS

The following instructions are a summary of the steps to undertake to migrate a 
user:

a. Open administrator and click the people and Groups tab

b. Select Register

c. Select Migrate person

d. Select Exchange as the source

e. Select the user accounts to migrate

f. Click Migrate

g. Click Register All

h. The accounts will now be migrated

i. Check migration and mailflow changes are successful 

Final steps - post server migration
9. If using Exchange Connectors for directory synchronization, run a 

synchronize now and replicate directory between exchange servers

10.Provide users with desktop support (possibly via sametime where 
appropriate) 

11.In some migrations a removal of the account would be required once a 
successful migration has been acknowledged.

4.1.6  Step 6 - Deploy End user data migration option

Once the server migration is complete you should consider data held locally by 
users (i.e. PST files). This data can be migrated into the local notes account, 
Detailed instructions can be found in the following chapters

� Chapter 12, “Migrating local Outlook data using Notes Upgrade Services” on 
page 367

� Chapter 14, “Local Data Migration using the Binary Tree tools” on page 439

Summary of local data migration using CMT 
a. Open CMT

Note: Again specific instructions on using the DUS to migrate users can be 
found in Chapter 11, “Server level migration Using Domino Upgrade Services” 
on page 339. 
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b. Select End user migration

c. Select and open account

d. Open end user migration section

e. Click send end user migration doc

Figure 4-3   CMT send end user migration

In some cases you may have customized the mail template with the additional 
script provided by Binary Tree, which will migrate end user data automatically on 
mailbox open. In this case, the above 5 steps are not required

Summary of local data migration With Domino Migration tools
a. Ensure when installing the Notes client that the migration tools are 

selected

b. Using domino admin people & Group Tab

i. Select the users that you have migrated

ii. Select Upgrade from the right hand tools bar

Figure 4-4   DUS end user migration Upgrade
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In the upgrade message basics screen 

i. Select convert local ccmail/MS mail/MS exchange data to Notes

ii. Also select the Notify me when users have completed conversion 
button

Figure 4-5   Upgrade notification basics tab

– You can customize the message the user will receive if you wish

c. Click the mail conversion tab

d. If you have chosen to have the migration tools on a shared drive, enter the 
path

e. Select Exchange from the conversion options
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Figure 4-6   Upgrade notification Conversions tab

f. Click Send

The user will receive an email message with a button that will migrate the 
local pst file data into notes.

4.1.7  Step 7 - Backup Exchange

When all accounts are migrated, backup exchange server. Keep in mind that this 
may be a legal requirement and that there may be requirement for restore the 
data. 

4.1.8  Step 8 - Clean up mail routing

Migrate all external connections Inbound and outbound (SMTP). 

• Modify DNS MX records

Note: Outlook is required and the end user’s local profile will be 
utilized to access the pst file.
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• Change relay in domino if required

4.1.9  Step 9 - Clean up Infrastructure

• Review and Remove Coexistence tools where no longer required, as 
all users should be migrated. 

• Remove foreign directories

• If required, remove LDAP from Directory Assistance

4.1.10  Step 10 - Decommission Exchange

If you are reusing the old Exchange servers as is, then you will need to remove 
Exchange from the server. There are many technotes available on Microsoft’s 
support website on how to do this, and they include detailed instructions on 
removing registry entries. If you are not familiar with this process, or you are 
intending on rebuilding the OS, then ensure that the Hard disk has been fully 
wiped as it is possible that end user information could be retrieved if not properly 
cleaned.

Attention: Please refer to Chapter 23, “Migration Project wrap up - Removing 
the Microsoft Exchange environment” on page 715 for more details on this 
topic. 
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Chapter 5. Using the Microsoft 
Exchange Connector for 
coexistence (Exchange 
2000)

This chapter shows you how to install, configure, and use the Microsoft 
Exchange Connector for seamless coexistence with Lotus Notes. Although the 
Exchange Connector for Lotus Notes may not always be the best coexistence 
option for your environment, it is easy to set up and, properly managed, it is a 
useful and inexpensive coexistence option.

5

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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In this chapter covers the following topics:

� Setup and configuration of Domino Server

� Install and configure Notes Client

� Install and configure Exchange Connector for Lotus Notes

Attention: This chapter focuses specifically on using the Exchange 
Connector for Microsoft Exchange 2000. For information on using the 
Exchange Connector for Microsoft Exchange 2003, please refer to Chapter 6, 
“Using the Microsoft Exchange Connector for coexistence (Exchange 2003)” 
on page 169)
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5.1  Overview of the Exchange Connector

The Exchange Connector for Lotus Notes is a product provide by Microsoft which 
provides integration between Lotus Notes users and Microsoft Exchange users. 
The "Connector" acts as an intermediary between the two products, allowing mail 
from either product to route without having to implement SMTP Routing.

5.1.1  Conceptual Overview of how it works 

The Exchange Connector for Lotus Notes supports directory synchronization, 
e-mail messages, and meeting requests. In addition you can also use Calendar 
Connector, in conjunction with Exchange Connector for Lotus Notes, to provide 
Free or Busy information when scheduling a meeting.

The following figure Figure 5-1 illustrates the Directory Synchronization process. 
The Directory Synchronization keeps each Directory service up to date with the 
most recent user and group attributes.

Figure 5-1   Directory Synchronization
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The Exchange Connector for Lotus Notes converts messages sent between 
Exchange and Lotus Domino into a format that is understood by the receiving 
system.

The following figure illustrates Figure 5-2 on page 110 demonstrates a message 
sent from a Domino user and received by an Exchange users.

Figure 5-2   Mail from Domino user to Exchange user

The following illustration Figure 5-3 on page 111 demonstrates a message sent 
from an Exchange user to a Domino user.
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Figure 5-3   Mail from Exchange user to Domino user

5.2  Preparation

Before you begin to install and configure the Exchange Connector for Lotus 
Notes, you need to verify that you have a supported setup, and gather some 
specific information about your current environment that will be needed during 
the installation and configuration of the Connector.

5.2.1  Supported Environment

To run the Microsoft Exchange Connector for Lotus Notes, your environment 
must meet the following prerequisites:

� Windows 2000 Server SP1 or later (SP2 recommended)

� Exchange 2000 Service Pack 1 (SP1) or later (SP2 recommended)

� Has network connectivity to the server running Lotus Domino
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� Can resolve the name of the server running Lotus Domino

5.3  Installing the Exchange Connector

To successfully install the Exchange Connector for Lotus Notes, the following 
tasks needs to be accomplished:

On the Domino Server

Register the Exchange Connector (i.e create an ID file)

Prevent the Exchange Connector ID synchronization (optional)

Create the Exchange Connector mailboxes

Set up the Exchange Connector mailbox Access Control List (ACL)

Create a Foreign Domain document in Domino directory

Create the Exchange / Domino directory

Implement Directory Assistance

On the Exchange 2000 Server:

Install a Notes Client

Set up the Notes Client

Install the Exchange Connector for Lotus Notes

Configure the Exchange Connector for Lotus Notes

Enable the proxy addresses

Start the Exchange Connector services

Start Directory Synchronization

The following sections describe each task in detail.

5.3.1  Register a Lotus Notes User ID for Exchange Connector

In order to transfer messages and synchronize directories between Lotus 
Domino and Exchange 2000, Exchange Connector for Lotus Notes must have its 

Tip: For further information refer to the following URL:

http://www.microsoft.com/technet/prodtechnol/exchange/2000/library/e
2klotus.mspx
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own Lotus Domino user ID. As the Lotus Domino Administrator, you will need to 
create an ID file for the Exchange Connector for Lotus Notes.

From the Domino Administrator’s Notes desktop, follow these steps:

1. If you have not already done so, create a link to the certifier ID (CERT.ID). If 
not, when prompted for the certifier ID later, you will have to ensure a network 
path is available to the Domino server to access it. We generally do not 
recommend copying the CERT.id to a local workstation, as this might 
compromise security.

2. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

3. From menu select File → Open Server. Chose your registration server from 
the dialog box Figure 5-4.

Figure 5-4   Open Server Dialog Box

In our example the server name was migrate2ka/itso/FR, which is also our mail 
server; in your Domino infrastructure this may not be the case, so be sure you 
select the correct server

4. Select the People & Groups Tab. 
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Figure 5-5   People & Groups

5. Select People in the Tools Pane and click Register Figure 5-6 on page 114.

Figure 5-6   Select Register Person

6. After clicking Register, you maybe presented with the “Select certifier ID” box. 
Select your CERT.id and if necessary change the registration server. Click Ok 
Figure 5-7.
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Figure 5-7   Select Certifier ID

7. Enter the certifier password when prompted Figure 5-8 on page 115

Figure 5-8   Password Box

If you have not set up a Recovery ID process, a message pops up that warns you 
that the certifier does not contain recovery information. Click OK to continue 
(figure CertifierRecoveryInformationWarning)
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Figure 5-9   Certifier Recovery Information Warning

8. Use The following steps to create a Person document for the Exchange 
Connector Figure 5-10

a. Select the Advanced checkbox

b. In the First Name field, type Exchange

c. In the Last Name field, type Connector
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Figure 5-10   Register Person Advanced window

9. Click Password Options button and move the scale to Weak, setting a 
minimum password length field of 0 (optional). Click OK to continue 
Figure 5-11 on page 118.

This is required so that you can allow the Microsoft Exchange Connector for 
Lotus Notes to run in unattended mode, with no password prompt.
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Figure 5-11   Password options

10.Select the Mail Navigator tab. Set mail system field to None.
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Figure 5-12   Setting mail type

11.Select the ID Info tab. Complete the following steps:

a. Depending on the expected length of time for the coexistence, set the 
expiration date of the certifier at a safe point beyond your planned 
contingency.

b. Select the level of security for your region: North american or International.

c. In the Store user ID field, select to store the ID in a file, and have the user 
ID stored in the default directory D:\Lotus\Notes\Data\ids\People.

d. Click green checkmark to continue Figure 5-13 on page 120.

Note: In the ‘Location for storing user ID’, make sure you deselect ‘In Domino 
directory.
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Figure 5-13   Setting security options

12.Click the Register button on the bottom left of the screen Figure 5-14 on 
page 121.
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Figure 5-14   Registration queue

The Exchange connector will be registered and a person document added to the 
direcotry. The ID file will be created and stored in the specified directory.

5.3.2  Prevent Exchange Connector ID Synchronization (optional)

This is an optional step to be followed should you decide to hide the Exchange 
Connector ID from Exchange users or other Lotus Domino domains.(The 
procedure below can performed directly from within the Domino Directory.) 
Figure 5-15 on page 122.

Click the People and Groups tab.

1. In the left pane, click People.

2. In the right pane, select the user ID you created for Exchange Connector for 
Lotus Notes. For example, Connector, Exchange.

3. Click Edit Person.
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4. On the Administration tab, in the Foreign directory sync allowed text box, type 
No.

5. Click Save and Close.

Figure 5-15   Person Document Administration Tab

5.3.3  Create and Setup Exchange Connector Mailboxes

In order to route messages to Exchange, you need to create the following two 
mailbox databases on the Domino server:

� Connector mailbox. File name Exchange.box
The mailbox stores mail being routed from Lotus Domino to Exchange. Later, 
when you create the foreign domain document and configure Exchange 
Connector for Lotus Notes, you specify the name of the connector mailbox. 
All mail routed from Lotus Domino to Exchange is then sent to the connector 
mailbox, from which it is retrieved by Exchange Connector for Lotus Notes.

� Connector mailbox for bad mail. File name Exchange.bad.
This mailbox stores any mail that fails to transfer to Exchange.

To create and setup exchange.box following these steps:

1. Start Lotus Domino Administrator and log on as a user who has Lotus 
Domino Administrator permissions.

2. Select File → Open Server. 

3. In the Select a server to administer dialog box, in the Server text box, type the 
name of your Lotus Domino Server, including the certifier information. For 
example, migrate2003b/itso/fr. Click OK. 

4. Select the Files tab.

5. From Menu bar, Click File → Database → New. 
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6. In the New Database dialog box: 

• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Title text box, type a name for the new database. For example, 
type Exchange Mailbox. 

• In the File Name text box, type a name for the new database. For 
example, type exchange.box. You specify this name later when you 
configure the foreign domain document and Exchange Connector for 
Lotus Notes.

• Click the Template Server option, then from the Server drop-down list, 
select the server running Lotus Domino, and then click OK. 

• Select the Show advanced templates check box. 

• From the scroll box, below the Template Server option, select Mail 
Router Mailbox (7), and then click OK. 

Figure 5-16   Create exchange box

7. The new mailbox is created. Press Escape to close the About Mail Router 
Mailbox message (or select File → Close). 

8. Click File, point to Database, click Access Control, and then click Add. 
 Chapter 5. Using the Microsoft Exchange Connector for coexistence (Exchange 2000) 123



7777_f_ch_exchange_connector_coexistence_2K.fm Draft Document for Review September 11, 
9. In the Person, server, or group text box, click the browse icon.

10.Select the user ID for Exchange Connector for Lotus Notes, click Add, and 
then click OK. 

11.From the Access drop-down list, select Manager, select the Delete 
documents check box, and then click OK.

To create and setup exchange.bad following these steps:

1. .Repeat steps 1-5 from ‘Create and Setup Exchange Connector Mailboxes’

2. In the New Database dialog box: 

• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Title text box, type a name for the new database. For example, 
type Exchange Bad Mailbox. 

• In the File Name text box, type a name for the new database. For 
example, type exchange.bad. You specify this name later when you 
configure the foreign domain document and Exchange Connector for 
Lotus Notes.

• Click the Template Server option, then from the Server drop-down list, 
select the server running Lotus Domino, and then click OK. 

• Select the Show advanced templates check box. 

• From the scroll box, below the Template Server option, select Mail 
Router Mailbox (7), and then click OK. 

3. The new mailbox is created. Press Escape to close the About Mail Router 
Mailbox message (or select File → Close). 

4. Click File → Database → Access Control, and then click Add. 

5. In the Person, server, or group text box, click the browse icon.

6. Select the user ID for Exchange Connector for Lotus Notes, click Add, and 
then click OK. 

7. From the Access drop-down list, select Manager, select the Delete 
documents check box, and then click OK.

5.3.4  Create Foreign Domain Document

For messages to be routed from Lotus Domino to Exchange a Foreign Domain 
Document must be created. Follow these steps to create a Foreign Domain 
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Document:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. Click Configuration Tab

3. In the left-hand pane click Messaging, then click Domains.

4. In the View Action Menu Click Add Domain Figure 5-17.

Figure 5-17   Add Domain

5. On the Basic tab Figure 5-18

a. Domain type field, select Foreign Domain.

b. Foreign Domain Name field, type Exchange.

c. Domain description field, type Domain for the Exchange/Notes Connector
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Figure 5-18   Domain Document Basic tab

6. On the Mail Information tab Figure 5-19 on page 126

a. Gateway server name, type the name of your Domino Server. For 
example: migrate2ka/itso/FR.

b. Gateway mail file name, type Exchange.box.

Figure 5-19   Domain Document Mail Information tab

7. Click Save and Close.

5.3.5  Create Exchange User Directory

Create an address book which will be used to synchronize your Domino and 
Exchange Address books for the purpose of name lookup and resolution. 
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Use the following steps to create a secondary address book:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. From the menu bar, Click File → Database → New.

3. From the New Database Dialog box:

• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Title text box, type a name for the new database. For example, 
type Exchange Names. 

• In the File Name text box, type a name for the new database. For 
example, type exchangenames.nsf. You specify this name later when 
you configure the DirSync for the Exchange Connector for Lotus Notes.

• Click the Template Server option, then from the Server drop-down list, 
select the server running Lotus Domino, and then click OK. 

• Select the Show advanced templates check box. 

• From the scroll box, below the Template Server option, select Domino 
Directory, and then click OK Figure 5-20. 

Note: It is possible to synchronize the Exchange addresses into the 
names.nsf. We found that this can cause some complications when migrating 
and it is simpler and cleaner to synchronize with a secondary directory and set 
up directory assistance.
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Figure 5-20   Create Exchangenames.nsf

4. The new address book is created. Press Escape to close the About the 
Domino Directory message (or select File → Close)

5. Click File → Database → Access Control, and click add.

6. In the person, server, or group box, click the browse icon.

7. Select the user ID for Exchange connector for Lotus Notes, Click Add, and 
then Click Ok.

8. From the Access drop-down list, select Manager, select the Delete 
documents check box.

9. Select all Roles and Click Ok Figure 5-21.

Note: If you received error ‘You are not authorized to perform that operation: 
Server Name DBName.nsf’. See Lotus Software Knowledge Base Document. 

Title:Error Attempting to Create a Database From pubnames.ntf.Doc #:
1086231

URL:http://www.ibm.com/support/docview.wss?rs=899&uid=swg21086231
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Figure 5-21   ACL Exchange Directory

5.3.6  Implement Directory Assistance

Now that a secondary address book has been created you will want to implement 
Directory Assistance for the purpose of name lookup and resolution.

There are two major steps in implementing Directory Assistance.

1. Enable Directory Assistance in Server Document.

2. Create a Direcotry Assistance Database.

Use the following steps to Enable Direcotry Assistance:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. Click on Configuration tab.

3. Click on Server, then All Server Documents Figure 5-22.
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Figure 5-22   Configuration Tab

4. Open Domino Server document in edit mode.

5. In field Directory assistance database name, type DA.nsf Figure 5-23.

Figure 5-23   Server Document

6. Click Save and Close.

Use the following steps to create a Directory Assistance Database:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. From menu bar, Click File → Database → New.

3. From the New Database Dialog box:
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• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Title text box, type a name for the new database. For example, 
type Direcotry Assistance. 

• In the File Name text box, type DA.nsf

• Click the Template Server option, then from the Server drop-down list, 
select the server running Lotus Domino, and then click OK. 

• Select the Show advanced templates check box. 

• From the scroll box, below the Template Server option, select Directory 
Assistance, and then click OK Figure 5-20. 

Figure 5-24   New Database dialog box

Click on Add Direcotry Assistance

4. The Directory Assistance database is created. Press Escape to close the 
About the Domino Directory message (or select File → Close)

5. In view action bar, Click Add Directory Assistance.

6. On the basic tab complete the following fields:

a. Domain type, select Notes.

b. Domain name, type a unique name. For example: Unique
 Chapter 5. Using the Microsoft Exchange Connector for coexistence (Exchange 2000) 131



7777_f_ch_exchange_connector_coexistence_2K.fm Draft Document for Review September 11, 
Figure 5-25   Directory Assistance basic tab

7. Click on Replicias tab

8. Paste a Database Link for Exchangename.nsf Figure 5-26.

Figure 5-26   Directory Assistance Replicas tab

9. Click Save and Close

Note: Remember to restart the Domino Server.
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To verify Directory Assistance is set up properly issue a ‘Show xDir” from the 
Domino Console. You should see the exchangenames.nsf is listed.

Figure 5-27   Show Xdir

5.3.7  Install and Setup Notes Client

In order for the Exchange Connector for Lotus Notes to access the Domino 
server, it requires access to several of the DLLs from Lotus Notes. You will be 
required to install a Lotus Notes client on the Exchange Server.

From the Exchange Server, perform the following steps to install the Notes client:

1. Launch the Notes Client Setup Utility.

2. At the Welcome screen Click Next Figure 5-28.

Note: For further instructions on how to set up directory assistance, see the 
Lotus Domino 7 Administrators Help database.

Note: When deciding which version of the client to install, consider the 
information in the following Knowledge Base article:

Lotus Notes Client Versions That Are Tested with the Exchange Notes 
Connector

http://support.microsoft.com/?ID=316035

For our test environment while written this redbook we installed a 7.0.1 client.
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Figure 5-28   Welcome Install Wizard

3. Accept the terms in the license agreement and click Next Figure 5-29 on 
page 134.

Figure 5-29   License Agreement
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4. Enter the required information on the user and organization and click Next 
Figure 5-30.

Figure 5-30   User Information

5. Unless others wise required, do not change the Path names for the Notes 
program and data files Figure 5-31 on page 136.
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Figure 5-31   Installation Path Selection

6. Select the Install Notes Client button and select install to hard drive 
Figure 5-32. This will install all the subcomponents necessary. Click Next.

Figure 5-32   Setup
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7. Click Install Figure 5-33.

Figure 5-33   Install Program

8. Click Finish Figure 5-34.

Figure 5-34   Install Wizard Complete
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After the installation is complete, ensure that the lotus notes direcotry is in the 
server’s system path. If you need to update the system path, do so using the 
following steps:

Figure 5-35   System Advanced Properties tab
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Figure 5-36   Environment Variables

Figure 5-37   Variable Value

Configure the Notes Client

To set up the Notes client for the Exchange Connector, you need to use the ID 
file created to represent the Exchange Connector for Lotus Notes. In our 
example we created the user “Exchange Connector” with an ID file of 
econnect.id.

We placed the ID file in the D:\Lotus\Notes\Data\ids\People directory on the 
Domino server. The ID file needs to be copied to the Exchange Server’s 
\Notes\data directory, or when requested specify a path to the location of the ID 
file on the Notes server.
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Use the following steps to setup the notes client on the Exchange Server 
machine:

1. To set up the client you need to first launch it. Double-click the icon on the 
desktop.

2. At the Notes Workstation Setup dialog box click OK.

3. At the Welcome screen show in Figure 5-38 Click Next.

Figure 5-38   Lotus Notes Client Configuration

4. In the Your Name field, type Exchange Connector Figure 5-39 on page 141.

5. In the Domino Server Name, type the name of your Domino Server 
Figure 5-39 on page 141.

6. Click Next.
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Figure 5-39   User Information

7. Enter the location of the ID file for Exchange Connector Figure 5-40.

8. Click Next.

Figure 5-40   Notes ID File location

Note: In the Domino Server field you can you either the name of the server or 
the IP address.
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9. The Exchange Connector does not require any of the additional services. 
Click Next Figure 5-41.

Figure 5-41   Additional Services

Figure 5-42   Notes Client Setup complete

You have now successfully installed and configured the Notes Client on the 
Exchange Server.

5.3.8  Install Exchange Connector for Lotus Notes

From the Exchange Server complete the following steps to install the Exchange 
Connector for Lotus Notes:

1. Insert Exchange 2000 CD into the CD-ROM drive.

2. Run Setup.exe from the \setup\i386 directory.

Note: This ID file has no password so we will not be prompted for an 
authentication password.
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3. On the Microsoft exchange 2000 Installation Wizard Welcome page, click 
Next.

Figure 5-43   Install Welcome Wizard

4. On the Component Selection page Figure 5-44 on page 144:

a. In the Action drop-down menu next to Exchange 2000, select change.

b. In the Action drop-down menu next to Microsoft Exchange messaging and 
collaboration Services, select change.

c. In the Action drop-down menu next to Microsoft Exchange Connector for 
Lotus Notes, select Install.

d. Click Next.
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Figure 5-44   Component Selection

5. On the Component Summary Dialog, Click Next Figure 5-45.
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Figure 5-45   Component Summary

6. Click Finish Figure 5-46
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Figure 5-46   Install complete

5.3.9  Configure Exchange Connector for Lotus Notes

Exchange connector for Lotus notes is configured using the Exchange System 
Manager. The figure below Figure 5-47 shows the location of the connector when 
viewing for both routing and administrative groups is enabled.
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Figure 5-47   Exchange System Manager

Use the following steps to configure the Exchange Connector for Lotus Notes:

1. Right-Click Connector for Lotus Notes, and Click Properties.

2. On the General tab Figure 5-48 on page 148:

a. In the Notes Server field, type the name of your Domino Server.

b. Click Modify, type the path to your notes.ini file (include the file name) and 
Click OK. For example: c:\Program Files\lotus\notes\notes.ini

c. In the Connector Mailbox field, type Exchange.box

d. In the Polling interval field, type the interval (in seconds) that Exchange 
connector for Lotus Notes uses to check for new messages delivered to 
Exchange.

e. In the Notes Server language drop-down list, select the language of the 
server running Lotus Domino.

f. In the Convert Notes Doclinks to drop-down list, select one of the following 
formats for Exchange Connector for Lotus Notes to use to convert Lotus 
Notes document links:

Note: Leave the password and confirm password fields empty. Remember we 
did not require a password for the Exchange Connector ID.

Note: For the polling interval field, we suggest using the default of 15 seconds.
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• OLE document link This is represented by an icon in the Exchange 
message. When the user clicks on the icon, Lotus Notes is started and 
the document link works as it should. (Lotus Notes must be installed on 
the client computer.)

• RTF attachment (Default) Document is converted to an RTF 
attachment. Because this attachment is a copy of the data from the 
actual notes document, users cannot edit the document.

• URL shortcut The document link is converted to a URL. When you 
click the URL, the default Web browser tries to access the computer 
running Lotus Notes to which the link points. (The user still requires a 
Lotus Notes name, password, and license to access the document, 
unless anonymous authentication is allowed.)

Figure 5-48   Connector properties box -General tab

3. On the Import Container tab Figure 5-50:

a. To select the Active Direcotry container to which Lotus Domino users are 
imported, Click Modify

Note: Recommend default setting of RTF attachment.
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b. On the Choose a container tab, select container, and then Click OK.

c. On the Exchange System Manager Dialog box, Click OK Figure 5-49.

Figure 5-49   

d. In the When replicating a mailbox whose primary Windows account does 
not exist in the domain drop-down list, select one of following options for 
Active Directory to use when new users are imported:

• Create a disabled Windows user account

• Create a new Window user account

• Create a Windows contact

Note: Recommended you create a special organizational unit for all your 
Lotus Domino users.

Note: Recommend Create a Windows contact.
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Figure 5-50   Import tab

4. On the Export Containers tab Figure 5-51 on page 151:

a. Click Add

b. In the choose a container tab, select the group you want to export, and 
Click OK.

c. On the Exchange System Manager Dialog box, Click OK.

d. Repeat the previous three steps for each group you want to export.

e. Select Export contacts and Export groups.

Note: Nested organizational units are not selected for export if you select the 
parent organizational unit. You must select each organizational unit 
individually.
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Figure 5-51   Export tab

5. On the Address Space tab:

a. Click add Figure 5-52 on page 152
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Figure 5-52   Address Space tab

b. On the Add Address Space dialog, Select Notes, and Click Ok 
Figure 5-53.

Figure 5-53   Select Address Type

c. On the Lotus Notes Address Space Properties dialog Figure 5-54 on 
page 153:
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i. In the User name field, type *

ii. In the Domain field, type the name of the Lotus Domino Domain. For 
example: itso3.

iii. Leave cost at 1.

iv. Click OK

Figure 5-54   Select Domino Domain
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Figure 5-55   Address Space dialog

6. ‘On the Dirsync Options tab:

a. From the Exchange Notes directory update schedule drop-down list, 
select a schedule for directory synchronization Figure 5-56 on page 155.

Note: Do not schedule synchronization during peak traffic hours. If your 
directory information changes infrequently, schedule synchronization for once 
a day. If your directory information changes frequently, schedule 
synchronization for two or more times a day.
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Figure 5-56   Dirsync Options tab

b. Click Address Book Settings Figure 5-57

c. In the Target Name and Address Books section, type exhangenames.nsf, 
in the default name & address book field.

d. In the Source Name and Address Books section, type names.nsf.
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Figure 5-57   Select Target and Source Address Books

7. On the Advanced tab:

a. In the Notes letterhead field, type the Lotus Notes letterhead name you 
want to append to the top of message sent from Exchange 2000 users to 
Lotus Domino users.

b. In the Notes router mailbox field, enter mail.box or if running multiple 
mail.boxes type mail1.box.

c. From the Delivery order drop-down list, select the order in which 
messages are to be delivered from Exchange 2000 to Lotus Domino. The 
options are:

i. Priority priority messages, such as urgent messages, are delivered to 
the outbound queue first. This is the default setting.

ii. FIFO Messages are delivered to the outbound queue on a first in, first 
out (FIFO) basis.

iii. Size Smaller messages are delivered to the outbound queue before 
larger messages.

Note: The letter head name you specify must match the letterhead name 
defined in the Lotus Notes mail database to which messages are sent. if the 
names do not match, no letterhead is used.
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d. From the Notes database maintenance schedule drop-down list, select a 
schedule for compacting database files.

e. Under Routable domains, Click Add

f. On the Add Routable Domain dialog, type the name of the Lotus Domino 
domain to which Exchange Connector for Lotus Notes does not connect 
directly, and then Click OK. Repeat for each additional domain.

g. Message Size limit can be set. (Optional)

h. Click OK

Figure 5-58   Advanced Tab

5.3.10  Enable Lotus Domino Proxy Addresses

The default Lotus Notes e-mail address format that is used for Exchange 2000 
users is based on the user’s display name and the name of the Exchange 
organization. You can modify the rule used to represent Exchange e-mail 
addresses in Lotus Domino. This address rule uses a set of symbols to 
determine how Exchange addresses appear in the Lotus Domino organization.

The default format for Lotus Note’s addresses assigned to Exchange users is:
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&d/organization@domain name

Here is what the various portions of this address signify:

• &d = the Lotus Notes display name (typically the full name) of the user.

• Organization = the name of the user's Exchange organization.

• domain name = the Lotus Domino foreign domain name that represents the 
Exchange organization. This is the name you specified in the earlier section 
“Identify Exchange as a Foreign Domain.”

Use the following steps to enable and customize Lotus Notes proxy addresses:

1. From Exchange System Manager, expand Recipients, and then click 
Recipient Policies.

2. Right-click Default Policy, and then click Properties. 

3. On the E-Mail Addresses (Policy) tab, select the NOTES check box (this 
enables the address), and then click Edit.

Figure 5-59   Default Policy Properties box 
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4. In the Address text box, modify the address format. Use the symbols in the 
following table to represent various values in the format string.

Table 5-1   Proxy address configuration symbols

Note: After directory synchronization occurs, the connector creates 
secondary proxy addresses for Lotus Domino recipients. These addresses, 
which do not display bold formatting on the E-Mail Addresses tab, are used as 
unique identifiers for Lotus Domino recipients. Do not delete these secondary 
proxy addresses. In general, you should only delete addresses that you create 
manually.

To substitute Use this symbol Notes 

The user's alias &M or &m Typically the mailbox 
name. 

The user's initials &I or &i Typically the user's middle 
initial. 

An e-mail address based 
on the user's display name 

&D or &d Blanks and initials between 
the given name and 
surname are ignored. If 
there is a comma in the 
display name, the portion 
of the string to the left of 
the comma is interpreted 
as the surname; the 
portion to the right of the 
comma is interpreted as 
the given name. 

The user's given name &G or &g Typically the user's first 
name. 

The user's surname &S or &s Typically the user's last 
name. 

An ampersand (&) && To use an ampersand, you 
must precede it with 
another ampersand. 
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For example, you set the address format to &d@Exchange. A user whose 
display name is Jacob Ryan receives a Lotus Notes address of: Jacob 
Ryan@Exchange.

6. After you configure the address formula, click OK.

7. On the Default Policy Properties tab, click OK.

8. You are asked if you want to update all corresponding recipient e-mail 
addresses to match the new addresses. To run Recipient Update Service 
immediately, click Yes. To update the addresses the next time Recipient Update 
Service runs, click No. Non-Exchange addresses are always updated, even if 
you made manual changes to specific addresses.

9. Wait for Recipient Update Service to populate the Exchange address lists. The 
time required varies depending on the update interval set on the service.

Figure 5-60   Click Yes

Note: For additional symbols that can be used, see the following Knowledge 
Base article:

Q285136 How to Customize the SMTP E-mail Address Generators Through 
Recipient Policies

http://support.microsoft.com/?ID=285136
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Figure 5-61   Recipient Policies Address Format

Finally, Figure 5-61 illustrates the result of the Recipient Policies
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Figure 5-62   E-Mail Addresses tab

5.3.11  Start Exchange Connector Services

For operation of the Exchange Connector for Lotus Noes, you have two related 
services:

1. Microsoft Exchange Connectivity Controller

2. Microsoft Exchange Connector for Lotus Notes

Use the following steps to start Exchange Connector Services Figure 5-63 on 
page 163:

1. Click Start → Programs → Administrative Tools → Services.

2. Right-click Microsoft Exchange Connector for Lotus Notes, Click Start.

Note: By starting the Connector for Lotus Notes, it will start the Connectivity 
controller.
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Figure 5-63   Services

5.3.12  Start Direcotry Synchronization

Before you begin the directory synchronization, review the directories for both 
Exchange and the Domino server, noting the user names listed in Exchange and 
those in the Domino Directory. You will use these names to verify the directory 
synchronization. 

Use the following steps to synchronize the directories Figure 5-64 on page 164:

1. From the Exchange System Manager, right-click Microsoft Exchange 
Connector for Lotus Notes.

2. Click Properties.

3. On the Dirsync Options tab:

a. Click Immediate full reload button in the Exchange to Notes direcotry 
synchronization section.

b. Click Ok to acknowledge the full reload request.

c. Click Immediate full reload button in the Notes to Exchange direcotry 
synchronization section

d. Click Ok to acknowledge the full reload request.

4. Click OK.

Note: Suggest you change the startup type to Automatic.
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Figure 5-64   Dirsync dialog

Verify the Synchronization
To verify the directory synchronization from the Exchange Administrator 
program:

1. From Exchange Manager System, select the Notes Recipients container.

2. Locate any custom recipients (the ones with a card in front of their names) 
Figure 5-65 on page 165.
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Figure 5-65   Notes User Container

Here is an example of a Domino user in the Active Directory Figure 5-66 on 
page 166.
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Figure 5-66   Notes User in Active Direcotry

To verify the directory synchronization from Domino:

1. Launch Adminstrator Client

2. Click File → Database → Open and Launch exchange.nsf

3. Go to People view Figure 5-67 on page 167.
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Figure 5-67   Exchange.nsf People view

Here is an example of Exchange user in Exchange.nsf on Domino Server .

Figure 5-68   Exchange user in Exchange.nsf on Domino Server
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Chapter 6. Using the Microsoft 
Exchange Connector for 
coexistence (Exchange 
2003)

This chapter shows you how to install, configure, and use the Microsoft 
Exchange Connector for seamless coexistence with Lotus Notes and Domino 7. 
Although the Exchange Connector for Lotus Notes may not always be the best 
coexistence option for your environment, it is easy to set up and, properly 
managed, it is a useful and inexpensive coexistence option. The following topics 
are included in this chapter:

6

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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� Installing the Exchange Connector

� Configuring the Exchange Connector

� Customizing the Exchange Connector for Lotus Notes

� Running and monitoring the Exchange Connector

� Customizing the Directory Mapping

Attention: This chapter focuses specifically on using the Exchange 
Connector for Microsoft Exchange 2003. For information on using the 
Exchange Connector for Microsoft Exchange 2000, please refer to Chapter 5, 
“Using the Microsoft Exchange Connector for coexistence (Exchange 2000)” 
on page 107)
170 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm
6.1  Overview of the Exchange Connector

The Exchange Connector for Lotus Notes enables communication between 
individuals using Microsoft Exchange Server 5.5, Exchange 2000 or Exchange 
2003 Server and IBM Lotus Domino. Exchange Connector for Lotus Notes, which 
is available for Exchange 2003 Server, Exchange 2000 Server or Exchange 
Server 5.5 Service Pack 4 (SP4), supports directory synchronization, e-mail 
messages, and meeting requests. You can also use Calendar Connector, which 
is available for the same three Exchange platforms previously mentioned, in 
conjunction with Exchange Connector for Lotus Notes, to provide visibility to an 
individual's Free or Busy information when scheduling a meeting.

6.1.1  What has been improved in the Exchange Connector 2003

According to Microsoft, and to a limited extent, supported by our testing in the 
Redbooks lab, the following improvements have been integrated into the 
Exchange Connector 2003.

� Improved the HTML rendering, 

� Better calendar and connnector support

� Improved RTF rendering, 

� Slightly simplified the install procedures.

In our test results, documented in 10.3, “Coexistence with MS Exchange 
Connector” on page 320, we found the results to be on par with native SMTP 
routing in terms of message fidelity. 

6.1.2  Conceptual Overview of how it works 

The Exchange Connector for Lotus Notes supports directory synchronization, 
e-mail messages, and meeting requests. In addition you can also use Calendar 
Connector, in conjunction with Exchange Connector for Lotus Notes, to provide 
Free or Busy information when scheduling a meeting.

The following figure Figure 6-1 on page 172 illustrates the Directory 
Synchronization process. The Directory Synchronization keeps each Directory 
service up to date with the most recent user and group attributes.
 Chapter 6. Using the Microsoft Exchange Connector for coexistence (Exchange 2003) 171



7777ch_exchange_connector_coexistence_2003.fm Draft Document for Review September 11, 
Figure 6-1   Conceptual overview of Directory Synchronization

The Exchange Connector for Lotus Notes converts messages sent between 
Exchange and Lotus Domino into a format that is understood by the receiving 
system.

The following figure illustrates Figure 4-3 on page 77 demonstrates a message 
sent from a Domino user and received by an Exchange users.
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Figure 6-2   Conceptual overview of Exchange Connector for Mail routing from Domino to Exchange

The following illustration Figure 4-4 on page 78 demonstrates a message sent 
from an Exchange user to a Domino user.
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Figure 6-3   Conceptual overview of Exchange Connector for Mail routing from Exchange to Domino

6.2  Preparation

Before you begin to install and configure the Exchange Connector for Lotus 
Notes, you need to verify that you have a supported setup, and gather some 
specific information about your current environment that will be needed during 
the installation and configuration of the Exchange connector.

6.2.1  Supported Environment

To run the Microsoft Exchange Connector for Lotus Notes, your environment 
must meet the following prerequisites:

� Windows Server 2003 or 

� Windows Server 2000 SP1 or later (SP2 recommended)

� Exchange Server 2003 Service Pack 2 (SP2)
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� Has network connectivity to the server running Lotus Domino

� Can resolve the name of the server running Lotus Domino

6.2.2  General setup information
To install and configure the Exchange Connector for Lotus Notes you will need to 
gather information on the following:

� From the Domino side:

– The server names for mail and registration and Connector location

– The Domino administrator ID and password

– Client and server versions

� From the Exchange side:

– The Exchange server name where the Connector will be installed

– The administrator account and password

– Information on the Exchange environment, organization and site names

– Information on the NT domain

A checklist is provided in Appendix E, “Exchange Connector installation 
checklist” on page 821.

6.3  Installing and setting up the Exchange Connector

To successfully install and set up the Exchange Connector for Lotus Notes, the 
following tasks need to be accomplished:

On the Domino server:

Register the Exchange Connector (i.e create an ID file)

Prevent the Exchange Connector ID synchronization (optional)

Create the Exchange Connector mailboxes

Set up the Exchange Connector mailbox Access Control List (ACL)

Create a Foreign Domain document in Domino directory

Tip: For further information refer to the following URL:

http://www.microsoft.com/technet/prodtechnol/exchange/guides/NotesDi
rAndMailMigrat/7084e96b-3f6a-4751-ae6e-9c9df6747943.mspx?mfr=truex
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Create the Exchange / Domino directory

Implement Directory Assistance

On the Exchange server:

Install a Notes Client

Set up the Notes Client

Install the Exchange Connector for Lotus Notes

Configure the Exchange Connector for Lotus Notes

Enable the proxy addresses

Start the Exchange Connector services

Start Directory Synchronization

The following sections describe each task in detail.

6.3.1  Step 1: Register the Exchange Connector on the Lotus Domino 
Server

Prior to configuring Exchange Connector for Lotus Notes, you will need to create 
an ID file for Exchange Connector for Lotus Notes in order to transfer messages 
and synchronize directories between Lotus Domino and Exchange 2003.

From the Domino Administrator’s Notes desktop, follow these steps:

1. If you have not already done so, create a link to the certifier ID (CERT.ID). If 
not, when prompted for the certifier ID later, you will have to ensure a network 
path is available to the Domino server to access it. We generally do not 
recommend copying the CERT.id to a local workstation, as this might 
compromise security.

2. Launch the Domino Administrator Client on your administration workstation. 

3. From the workspace, select the Servers Domain tab and select your 
registration server. In our example the server name was migrate2003b/itso/fr, 
which is also our mail server. In your Domino infrastructure this may not be 
the case, so be sure you select the correct server.
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Figure 6-4   Select People and Groups

4. Select the People & Groups tab. This will display the People view of the 
Domino Directory (Figure 6-4).

5. Select People in the Tools pane and click Register, as shown in Figure 6-5.

Figure 6-5   Select Register person

6. After clicking the Register link, you may be presented with the “Select Certifier 
ID” box. Select your CERT.id and if necessary change the registration server. 
Once it is selected, click OK and enter the certifier password when prompted. 
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If you have not set up a Recovery ID process, a message pops up that warns 
you that the certifier does not contain recovery information. Click Yes to 
continue.

7. You will presented with the Register Person new entry screen (Figure 6-6 on 
page 178). 

Figure 6-6   Register person - new entry

8. Use the following steps to create a Person document for the Exchange 
Connector.

a. Select the Advanced checkbox to see more options.

Note: We strongly recommend that ID Recovery is set up to prevent problems 
that occur when users lose or damage ID files or forget passwords. For further 
information, consult the Lotus Domino Administrator 7 Help (IDs, recovering).
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Figure 6-7   Register person advanced window

• In the First Name field, type Exchange.
• In the Last Name field, type Connector.

We used these values because they are descriptive; you can use any 
values you like. However, at the least, you will need a last name for the 
Connector person document. 

b. Click the Password Options button and move the scale to Weak, setting a 
minimum password length field of 0 (optional).

This is required so that you can allow the Microsoft Exchange Connector 
for Lotus Notes to run in unattended mode, with no password prompt.

c. Select the Mail Navigator tab and for the Mail type field, select None. All 
remaining options will be removed, as can be seen in figure Figure 6-8 on 
page 180.
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Figure 6-8   Setting mail type

d. Select the ID Info tab. You will be presented with the certifier screen 
(Figure 6-9 on page 181).

• Select the level of security (License type) for your region: North 
American or International.

• Depending on the expected length of time for the coexistence, set the 
expiration date of the certificate at a safe point beyond your planned 
contingency. Setting it too early will stop the functioning of the 
Connector at the specified date, whether you are ready or not.

• In the Store User ID field, select to store the ID in a file, and have the 
user ID stored in the default directory C:\Lotus\Notes\Data\ids\People.

Note: In the ‘Location for storing user ID’, make sure you deselect ‘In Domino 
directory.
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Figure 6-9   Setting security options

e. Click the green check box on the right side to complete your task. Your 
person will be put in the Registration queue.
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Figure 6-10   Registration queue

f. Click the Register button on the bottom left of the screen. The Exchange 
Connector will be registered, and a person document added to the 
directory. The ID file will be created and stored in the specified directory.

g. When you receive the Register person window, click OK.

h. Click Done. This will return you to the People & Groups view in the 
administration client.

You have now created the Exchange Connector’s ID file.

6.3.2  Step 2: Prevent the Exchange Connector ID Synchronization 
(optional)

This is an optional step to be followed should you decide to hide the Exchange 
Connector ID from Exchange users or other Lotus Domino domains. (The 
procedure below can performed directly from within the Domino Directory.)

1. Start Lotus Domino Administrator and log on as a user who has Lotus 
Domino Administrator permissions.
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2. Click the People and Groups tab.

3. In the left pane, click People.

4. In the right pane, select the name ID you created for Exchange Connector for 
Lotus Notes. For example, Connector, Exchange.

5. Click Edit Person in the view Action bar.

6. Click on the Administration tab, go to Allow foreign directory synchronization 
and select No.

Figure 6-11   Preventing the Exchange Connector from synchronizing

7. Click Save & Close.

6.3.3  Step 3: Create the Domino mailboxes for routing mail to 
Exchange

In order to route messages to Exchange, you need to create the following two 
mailbox databases on the Domino server:

� Connector mailbox 
The mailbox stores mail being routed from Lotus Domino to Exchange. Later, 
when you create the foreign domain document and configure Exchange 
Connector for Lotus Notes, you specify the name of the connector mailbox. All 
mail routed from Lotus Domino to Exchange is then sent to the connector 
mailbox, from which it is retrieved by Exchange Connector for Lotus Notes.
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� Connector mailbox for bad mail
This mailbox stores any mail that fails to transfer to Exchange.

To create and set up the Exchange Connector mailbox
1. Start Lotus Domino Administrator and log on as a user who has Lotus 

Domino Administrator permissions.

2. Select File → Open Server. 

3. In the Select a server to administer dialog box, in the Server text box, type the 
name of your Lotus Domino Server, including the certifier information. For 
example, migrate2003b/itso/fr. Click OK. 

4. Select the Files tab.

5. Click File → Database → New. 

6. In the New Database dialog box (Figure 6-12 on page 185): 

• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Title text box, type a name for the new database. For example, 
type Exchange Connector Database. 

• In the File Name text box, type a name for the new database. For 
example, type exchangeconnector.box. You specify this name later 
when you configure the foreign domain document and Exchange 
Connector for Lotus Notes.

• Click the Template Server option, then from the Server drop-down list, 
select the server running Lotus Domino, and then click OK. 

• Select the Show advanced templates check box. 

• From the scroll box, below the Template Server option, select Mail 
Router Mailbox (7), and then click OK. 
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Figure 6-12   Creating the Exchange Connector mailbox

7. The new mailbox is created. Press Escape to close the About Mail Router 
Mailbox message (or select File → Close). 

8. Select File → Database → Access Control, and then click Add. 

9. In the People, Servers, Groups text box, click the browse icon.

10.Select the user ID for Exchange Connector for Lotus Notes, click Add, and 
then click OK.

11.From the Access drop-down list, select Manager, then select the Delete 
documents check box, and finally click OK.
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Figure 6-13   Setting up the mailbox Access Control List (ACL)

To create the connector mailbox for bad mail
The easiest way to create the connector mailbox for bad mail is to simply copy 
the connector database. 

1. On a computer with Lotus Domino Administrator installed, start Lotus Domino 
Administrator and log on as a user who has Lotus Domino administrator 
permissions.

2. Select File → Open Server.

3. In the Select a server to administer dialog box, in the Server text box, type the 
name of your server running Lotus Domino, including the certifier information. 
For example, migrate2003b/itso/fr. Click OK. 

4. Open the Exchange connector database:

• Select the Files tab.

• Select File → Database → Open.
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• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Filename text box, type the name of your connector database, for 
example exchangeconnector.box. 

• Click Open. 

5. Select File → Database → New Copy. 

6. In the Copy Database dialog box (see Figure 6-14): 

• From the Server drop-down list, select the server running Lotus 
Domino. 

• The Title text box should show the name you entered for your 
connector database, for example Exchange Connector Database. 
Modify the name accordingly, for example Exchange Connector 
Database - Bad mail. 

• In the File Name text box, change the extension of the existing file 
name to .bad. For example, if the existing file name is 
exchangeconnector.box change the file name to 
exchangeconnector.bad. 

• Select Database design only and make sure the Access Control List 
check box is selected. Click OK.

Figure 6-14   Creating the Exchange Connector mailbox for bad mail

The connector mailbox for bad mail is created.
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6.3.4  Step 4: Create the Exchange / Domino Directory

We strongly recommend that you create an address book which will be used to 
synchronize your Domino and Exchange Address books for the purpose of name 
lookup and resolution.

Use the following steps to create a secondary address book:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. From the menu bar, click File → Database → New.

3. From the New Database Dialog box:

• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Title text box, type a name for the new database. For example, 
type Exchange Names. 

• In the File Name text box, type a name for the new database. For 
example, type exchangenames.nsf. You specify this name later when 
you configure the DirSync for the Exchange Connector for Lotus Notes.

• Click the Template Server option, then from the Server drop-down list, 
select the server running Lotus Domino, and then click OK.

• Select the Show advanced templates check box. 

• From the scroll box, below the Template Server option, select Domino 
Directory, and then click OK (see Figure 6-15).

Note: It is possible to synchronize the Exchange addresses into the Domino 
names.nsf. We found that this can cause some complications when migrating 
and it is simpler and cleaner to synchronize with a secondary directory and set 
up directory assistance.
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Figure 6-15   Create Exchangenames.nsf

4. The new address book is created. Press Escape to close the About the 
Domino Directory message (or select File → Close).

5. Click File → Database → Access Control, and click Add.

6. In the People, Servers, Groups text box, click the browse icon.

7. Select the user ID for Exchange Connector for Lotus Notes. Click Add, and 
then click OK.

8. From the Access drop-down list, select Manager, then select the Delete 
documents check box.

9. Select the Roles as shown on Figure 6-16 and click OK.

Note: If you receive the error ‘You are not authorized to perform that 
operation: Server Name DBName.nsf’, see Lotus Software Knowledge Base 
Document.

Title:Error Attempting to Create a Database From pubnames.ntf.Doc #:
1086231

URL:http://www.ibm.com/support/docview.wss?rs=899&uid=swg21086231
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Figure 6-16   ACL Exchange Directory

6.3.5  Step 5: Implement Directory Assistance

Now that a secondary address book has been created you will want to implement 
Directory Assistance for the purpose of name lookup and resolution.

There are two major steps in implementing Directory Assistance.

1. Enable Directory Assistance in the Server document.

2. Create a Directory Assistance database.

Use the following steps to enable Directory Assistance:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. Click on Configuration tab.
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3. Click on Server, then All Server Documents (Figure 6-17).

Figure 6-17   Configuration tab

4. Select your Domino server and click Edit Server.

5. In field Directory assistance database name, type DA.nsf (Figure 6-18).

Figure 6-18   DA entry in Server document

6. Click Save & Close.

Use the following steps to create a Directory Assistance database:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. From the menu bar, select File → Database → New.

3. From the New Database dialog box:
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• From the Server drop-down list, select the server running Lotus 
Domino. 

• In the Title text box, type a name for the new database. For example, 
type Directory Assistance. 

• In the File Name text box, type DA.nsf

• Click the Template Server option, then from the Server drop-down list, 
select the server running Lotus Domino, and then click OK. 

• Select the Show advanced templates check box. 

• From the scroll box, below the Template Server option, select Directory 
Assistance, and then click OK (see Figure 6-19).

Figure 6-19   Creating Directory Assistance database

4. The Directory Assistance database is created. Press Escape to close the 
About the Domino Directory message (or select File → Close).

5. In the view action bar, click Add Directory Assistance.

6. On the Basics tab complete the following fields:

a. Domain type, select Notes.

b. Domain name, type a unique name. For example: Exchange
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Figure 6-20   Directory Assistance Basics tab

7. Click on Replicas tab

8. Paste a Database Link for Exchangename.nsf (Figure 6-21).(If you don’t know 
how to create a database link, click on the Database links text to display 
assistance.)

Figure 6-21   Directory Assistance Replicas tab

9. Click Save & Close

Note: Remember to restart the Domino server.
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To verify Directory Assistance is set up properly issue a ‘Show xDir” from the 
Domino Console. You should see the exchangenames.nsf is listed.

Figure 6-22   Show Xdir

6.3.6  Step 6: Create a Foreign Domain document

For messages to be routed from Lotus Domino to Exchange a Foreign Domain 
Document must be created. Follow these steps to create a Foreign Domain 
Document:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. Click the Configuration tab, then select Messaging → Domains.

3. Click Add Domain.

4. In the Basics tab, enter the following information:

– Select Foreign Domain for the Domain type from the drop-down list.

– Enter any appropriate name (such as Exchange2003) for the Foreign 
Domain name.

– Enter a short domain description (optional).

5. In the Mail Information tab, enter the following information (Figure 6-23):

– In the Gateway server name field, specify the Domino server you will be 
using to connect to the Microsoft Exchange Server running the Exchange 
Connector for Lotus Notes (for example migrate2003b/itso/fr).

– In the Gateway mail file name field, specify the name of the routing 
mailbox previously created (for example exchangeconnector.box).

Note: For further instructions on how to set up directory assistance, see the 
Lotus Domino Administrator 7 Help database.
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Figure 6-23   Creating a Foreign Domain document

6. Click Save & Close.

The newly created Foreign Domain document will appear in the Domains view 
(Figure 6-24).

Figure 6-24   Domains view

6.3.7  Step 7: Install the Notes Client on the Exchange Server
In order for the Exchange Connector for Lotus Notes to access the Domino 
server, it requires access to several of the DLLs from Lotus Notes. You will be 
required to install a Lotus Notes client on the Exchange Server. Although we 
have tested and have not identified any problems using a Lotus Notes 7 client, 
Microsoft support has not yet verified that using a Lotus Notes 7 client with the 
Connector is a supported environment, and any problems reported will be 
treated on a best endeavours basis. Therefore, if you wish to remain in a 
Microsoft-supported configuration during the period of coexistence, we 
recommend that you use a Notes 6.x client on the Exchange server rather than a 
Notes 7 client. IBM does support a Lotus Notes 6 client connecting to a Lotus 
Domino 7 server.
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From the Exchange Server, perform the following steps to install the Notes client:

1. Launch the Notes client Setup utility.

2. At the Welcome screen click OK.

3. Accept the terms in the license agreement and click Next.

4. Enter the required information on the user and organization and click Next.

5. Unless otherwise required, do not change the Path names for the Notes 
program and data files. 

6. Select the Install Notes Client button and select install to hard drive (see 
Figure 6-25). This will install all the subcomponents necessary. Click Next.

Figure 6-25   Notes installation - setup selection

7. Click Install.

8. When the installation is complete, ensure that the Lotus Notes directory is in 
the server’s system path. If you need to update the system path, do so using 
the following steps:

Tip: We do, however, recommend that you install the data on a separate 
drive/partition.
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a. To get to the Systems Properties box, click Start → Settings → Control 
Panel. Double-click the System icon.

b. Select the Environments tab and select Path in the Variable Field.

c. Add the Lotus Notes directory at the end of the Value Field, for example, 
c:\Program Files\Lotus\Notes; (This entry must terminate with a semicolon 
(;), for example c:\Program Files\Lotus\Notes\Notes.ini;)

d. Click Set.

e. Click Apply.

9. Click OK.

10.Close all windows.

Reboot the system.

6.3.8  Step 8: Set up the Notes Client on the Exchange Server

To set up the Notes client for the Exchange Connector, you need to use the ID file 
created to represent the Exchange Connector for Lotus Notes. In our example 
we created the user “Exchange Connector” with an ID file of econnect.id 
(Figure 6-9 on page 181).

We placed the ID file in the c:\Lotus\Notes\Data\ids\People directory on the 
Domino server. The ID file needs to be copied to the Exchange Server’s 
\Notes\data directory, or when requested specify a path to the location of the ID 
file on the Notes server.

1. To set up the client you need to first launch it. Double-click the icon on the 
desktop.

2. At the Notes Workstation Setup dialog box, select the office network as the 
location and click OK.

3. You will be presented with the welcome screen shown in Figure 6-26 on 
page 198. Click Next to proceed.

Important: To ensure this change takes effect, it is necessary to reboot the 
system after the update to the Environment tab; failing to do so will prevent the 
Exchange Connector from working.
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Figure 6-26   Notes client configuration welcome window 

4. You are now requested to enter your username and server address. In our 
example this was Exchange Connector. Due to the lab environment and setup, 
we used the IP address instead of the Domino server name. Using the 
Domino server name should be the preferred method and should work as 
long as the Network and DNS have been set up correctly. See Figure 6-27.

Figure 6-27   Entering user information

5. Check the box “I want to Connect to a Domino server” and click Next

6. Since we selected to not save the ID file in the Domino Directory, we are 
presented with the screen shown in Figure 6-28. Here we are required to 
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provide the location of the Exchange Connector’s ID file. If it was copied to the 
local data directory the location is c:\Lotus\Notes\data\ids\people\econnect.id; 
if not, click Browse, locate the ID file, and click OK.

Figure 6-28   Specifying the location of the ID file

Click Next.

7. The Exchange Connector does not require any of the additional services. 
Click Finish.

8. When you are presented with the Notes dialog box, click OK. 

The setup of the Lotus Notes client code is complete.

6.3.9  Step 9: Install the Exchange Server 2003 Connector for Lotus 
Notes

1. From the Exchange server, insert the Exchange 2003 CD into the CD-ROM 
drive.

2. Open a command prompt and type cd e:\setup\i386\setup.exe where e: is 
the drive letter for the CD-ROM drive.

3. Click Next at the Welcome dialog box.

4. Once you have read the Licensing Agreement, click Yes.

Note: This ID file has no password so we will not be prompted for an 
authenticating password.
 Chapter 6. Using the Microsoft Exchange Connector for coexistence (Exchange 2003) 199



7777ch_exchange_connector_coexistence_2003.fm Draft Document for Review September 11, 
5. On the Component Selection page (Figure 6-29):

a. In the Action drop-down menu next to Microsoft Exchange, select Change.

b. In the Action drop-down menu next to Microsoft Exchange Messaging and 
Collaboration Services, select Change.

c. In the Action drop-down menu next to Microsoft Exchange Connector for 
Lotus Notes, select Install.
.

Figure 6-29   Selecting Exchange Connector for Lotus Notes

6. Click Next.

7. Review your component selection, and click Next.
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Figure 6-30   Component Installation Summary

8. Once the component installation is over, click Next.
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Figure 6-31   Component Installation

9. Click Finish.

6.3.10  Step 10: Configure the Exchange Connector for Lotus Notes

Exchange connector for Lotus Notes is configured using the Exchange System 
Manager. The figure below (Figure 6-32) shows the location of the connector 
when viewing for administrative groups is enabled.

Note: A newer release of Exchange Connector for Lotus Notes is available 
from the Microsoft web site and can be downloaded at the url:

http://www.microsoft.com/downloads/details.aspx?familyid=D9F3A35E-10
46-47B5-B09B-BDA9DE60CD9D&displaylang=en
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Figure 6-32   Exchange System Manager

Use the following steps to configure the Exchange Connector for Lotus Notes:

1. Right-click Connector for Lotus Notes, and click Properties.

2. On the General tab (Figure 6-33 on page 204):

a. In the Notes Server field, type the name of your Domino server.

b. Click Modify, type the path to your notes.ini file (include the file name) and 
click OK. For example: c:\Program Files\lotus\notes\notes.ini

c. In the Connector Mailbox field, enter the name of the mail box previously 
created on Step 3. Type exchangeconnector.box

d. In the Polling interval field, type the interval (in seconds) that Exchange 
connector for Lotus Notes uses to check for new messages delivered to 
Exchange.

e. In the Notes Server language drop-down list, select the language of the 
server running Lotus Domino.

f. In the Convert Notes Doclinks to drop-down list, select one of the following 
formats for Exchange Connector for Lotus Notes to use to convert Lotus 
Notes document links:

Note: Leave the password and confirm password fields empty. Remember we 
did not require a password for the Exchange Connector ID.

Note: For the polling interval field, we suggest using the default of 15 seconds.
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• OLE document link - This is represented by an icon in the Exchange 
message. When the user clicks on the icon, Lotus Notes is started and 
the document link works as it should. (Lotus Notes must be installed on 
the client computer.)

• RTF attachment - (Default) Document is converted to an RTF 
attachment. Because this attachment is a copy of the data from the 
actual notes document, users cannot edit the document.

• URL shortcut - The document link is converted to a URL. When you 
click the URL, the default Web browser tries to access the computer 
running Lotus Notes to which the link points. (The user still requires a 
Lotus Notes name, password, and license to access the document, 
unless anonymous authentication is allowed.)

Figure 6-33   Connector properties box - General tab

3. On the Import Container tab (Figure 6-36):

a. Click Modify to select the Active Directory container to which Lotus 
Domino users are imported.

Note: We recommend that you create a special organizational unit for all your 
Lotus Domino users.
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b. On the Choose a container tab, select the appropriate container where to 
import the Lotus Domino users, and then click OK.

Figure 6-34   Selecting the Import container

c. On the Exchange System Manager dialog box, click OK (Figure 6-35). 

Figure 6-35   Granting the required permissions

d. In the When replicating a mailbox whose primary Windows account does 
not exist in the domain drop-down list, select one of following options for 
Active Directory to use when new users are imported:

• Create a disabled Windows user account

• Create a new Window user account

• Create a Windows contact

Note: We recommend that you select Create a Windows contact as it is likely 
that your Domino users are already registered in Active Directory. 
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Figure 6-36   Import container tab

4. On the Export Containers tab (Figure 6-38 on page 208):

a. Click Add

b. In the Choose a container tab, select the group you want to export, and 
click OK.
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Figure 6-37   Selecting the Export container

c. On the Exchange System Manager dialog box, Click OK.

d. Repeat the previous three steps for each group you want to export.

e. Select Export contacts and Export groups.

Note: Nested organizational units are not selected for export if you select the 
parent organizational unit. You must select each organizational unit 
individually.
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Figure 6-38   Export container tab

5. On the Address Space tab:

a. Click Add (Figure 6-39 on page 209).
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Figure 6-39   Address Space tab

b. On the Add Address Space dialog, select Notes and click OK 
(Figure 6-40).

Figure 6-40   Select Address type

c. On the Lotus Notes Address Space Properties dialog (Figure 6-41 on 
page 210):
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i. In the User name field, type *

ii. In the Domain field, type the name of the Lotus Domino Domain. For 
example: itso3.

iii. Leave cost at 1.

Figure 6-41   Select Domino Domain

i. Click OK
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Figure 6-42   Address Space dialog

6. On the Dirsync Options tab:

a. From the Exchange-Notes directory update schedule drop-down list, 
select a schedule for directory synchronization (Figure 6-43 on page 212).

Note: Do not schedule synchronization during peak traffic hours. If your 
directory information changes infrequently, schedule synchronization for once 
a day. If your directory information changes frequently, schedule 
synchronization for two or more times a day.
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Figure 6-43   Dirsync Options tab

b. Click Address Book Settings Figure 6-44

c. In the Target Name and Address Books section, type exchangenames.nsf, 
in the Default name & address book field.

d. In the Source Name and Address Books section, type names.nsf.

e. Click OK.
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Figure 6-44   Select Target and Source Address Books

7. On the Advanced tab:

a. In the Notes letterhead field, type the Lotus Notes letterhead name you 
want to append to the top of message sent from Exchange users to Lotus 
Domino users.

b. In the Notes router mailbox field, enter mail.box or if running multiple mail 
boxes type mail1.box.

c. From the Delivery order drop-down list, select the order in which 
messages are to be delivered from Exchange to Lotus Domino. The 
options are:

i. Priority - priority messages, such as urgent messages, are delivered 
to the outbound queue first. This is the default setting.

ii. FIFO - Messages are delivered to the outbound queue on a first in, first 
out (FIFO) basis.

iii. Size - Smaller messages are delivered to the outbound queue before 
larger messages.

Note: The letterhead name you specify must match the letterhead name 
defined in the Lotus Notes mail database to which messages are sent. if the 
names do not match, no letterhead is used.
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d. From the Notes database maintenance schedule drop-down list, select a 
schedule for compacting database files.

e. Under Routable domains, click Add.

f. In the Add Routable Domain dialog, type the name of the Lotus Domino 
domain to which Exchange Connector for Lotus Notes does not connect 
directly, and then click OK. Repeat for each additional domain.

g. Message Size limit can be set. (Optional)

h. Click OK

Figure 6-45   Advanced tab

6.3.11  Step 11: Enable the proxy addresses

If you have multiple Exchange servers, you need to synchronize the Site 
Addressing scheme within all the Exchange servers so that Domino addressing 
information is updated across the Exchange site. If this procedure is not done, 
e-mail from and to the Exchange servers, other than the one running the 
Microsoft Exchange Connector for Lotus Notes, will not flow until the next 
scheduled replication.

The default Lotus Notes e-mail address format that is used for Exchange 2003 
users is based on the user’s display name and the name of the Exchange 
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organization. You can modify the rule used to represent Exchange e-mail 
addresses in Lotus Domino. This address rule uses a set of symbols to 
determine how Exchange addresses appear in the Lotus Domino organization.

The default format for Lotus Note’s addresses assigned to Exchange users is:

&d/organization@domain name

Here is what the various portions of this address signify:

• &d = the Lotus Notes display name (typically the full name) of the user.

• Organization = the name of the user's Exchange organization.

• domain name = the Lotus Domino foreign domain name that 
represents the Exchange organization. This is the name you specified 
in the earlier section “Step 6: Create a Foreign Domain document” on 
page 194.

Use the following steps to enable and customize Lotus Notes proxy addresses.

1. From the Exchange System Manager window, select your Exchange server, 
then expand Recipients and go to Recipient Policies. Click on Default Policy in 
the details pane, as shown in Figure 6-46.

Figure 6-46   Recipient Policies

2. In the E-Mail Addresses (Policy) tab, select the NOTES check box to activate 
the address, then click Edit (see Figure 6-47).
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Figure 6-47   Enabling the Notes address

3. In the Address text box, modify the address format to suit your requirements. 
Non-Exchange addresses are always updated, even if you made manual 
changes to specific addresses.
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Figure 6-48   Editing the Lotus notes address format

Table 6-1   Proxy address configuration symbols

To substitute Use this symbol Notes 

The user's alias &M or &m Typically the mailbox 
name. 

The user's initials &I or &i Typically the user's middle 
initial. 

An e-mail address based 
on the user's display name 

&D or &d Blanks and initials between 
the given name and 
surname are ignored. If 
there is a comma in the 
display name, the portion 
of the string to the left of 
the comma is interpreted 
as the surname; the 
portion to the right of the 
comma is interpreted as 
the given name. 

The user's given name &G or &g Typically the user's first 
name. 
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4. Once you configure the address formula, click OK. The edited address will 
appear in the Policy Properties window.

The user's surname &S or &s Typically the user's last 
name. 

An ampersand (&) && To use an ampersand, you 
must precede it with 
another ampersand. 

Note: For additional symbols that can be used, see the following Knowledge 
Base article (the same rules apply to all address formats):

Q285136 How to Customize the SMTP E-mail Address Generators Through 
Recipient Policies

http://support.microsoft.com/?ID=285136

Note: In a multi-domain environment where it is likely to have entries matching 
persons with the same names (ambiguous entries), we recommend that you 
include the domain name in the adress format. As a consequence, persons 
with the same names will be resolved properly.

To substitute Use this symbol Notes 
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Figure 6-49   Edited Lotus Notes address format

5. Click OK to close the Policy Properties window.

6. A message asks you if you want to update all corresponding recipient e-mail 
addresses to match the new addresses. To run Recipient Update Service 
immediately, click Yes. Otherwise click No (addresses will be update the next 
time Recipient Updade Service is run).

7. Select Programs → Microsoft Exchange → Active Directory Users and 
Computers, open the properties for any Exchange user and in the E-Mail 
Addresses tab check that the changes are properly taken into account.
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Figure 6-50   E-Mail addresses tab

6.4  Operating and monitoring the Exchange Connector 
Services

In this section we show you how to:

� Start the Connector

� Operate the Connector

� Run Directory Synchronization

� Monitor the Connector

� Stop the Connector

6.4.1  Start the Connector
For operation of the Exchange Connector for Lotus Notes, you have two related 
services: 
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� Microsoft Exchange Connectivity Controller

� Microsoft Exchange Connector for Lotus Notes

If you start the Exchange Connector for Lotus Notes, it will start the Connectivity 
Controller.

To start the Connector on the Exchange Server manually:

1. Choose Start → Settings → Control Panel.

2. Double-click the Services icon and scroll down to Microsoft Exchange 
Connector for Lotus Notes (Figure 6-51).

Figure 6-51   Starting the Exchange Connector

3. Righ-click and select Start. (Alternately, select Action → Start.) This also starts 
the Microsoft Exchange Connectivy Controller service.

You now have all services and tasks started and can continue to operate the 
Connector. After you have verified the operation of the Connector, you may wish 
to have it started automatically at server start-up. To do this, select Action 
Properties. In the Start up drop-down list, select Automatic, and then click OK.

6.4.2  Operate the Connector

Once you have started the Connector, it is ready for use. In this section we 
describe how to use the Connector to:

� Synchronize the directories
� Verify the directory synchronizations

Directory synchronization
Before you begin the directory synchronization, review the directories for both 
Exchange and Domino servers, noting the user names listed in Active Directory 
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and those in the Domino Directory. You will use these names to verify the 
directory synchronization. Use the following steps to synchronize the directories:

1. Open the Exchange System Manager.

2. Go to the Connectors container and select Connector for Lotus Notes.

3. Select Action → Propoerties. Go to the Dirsync Options tab.

4. Click the Immediate full reload button in the Exchange to Notes directory 
synchronization section.

5. At the dialog box, click OK to acknowledge the full reload request.

Figure 6-52   Synchronizing the directories

6. Click the Immediate full reload button in the Notes to Exchange directory 
synchronization section.

7. At the dialog box, click OK to acknowledge the full reload request.

8. Close the Properties box.

Since you have just requested an immediate full reload, the actual directory 
synchronization may take some time. Be patient!
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Verify the synchronization
To verify the directory synchronization from the Exchange Administrator program:

1. From Exchange Manager System, select the Notes Recipients container.

2. Locate any custom recipients (the ones with a card in front of their names).

Figure 6-53   Notes Recipients container

3. Double-click the custom recipient representing a Notes user. In our example 
we used “Pascal Bourgeois.” 

4. Note the e-mail fields and their address (see Figure 6-54) should show 
something like “Pascal Bourgeois@ITSO2.US.”
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Figure 6-54   Pascal’s Exchange recipient’s entry

5. Click OK to close the custom recipient Properties box.

To verify the directory synchronization from the Domino Administrator: 

1. Open the Exchange Directory database previously created.

2. Select the People view and locate a person document for the Exchange user; 
we used Anaïs Bourgeois.

3. Double-click the Person document.
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Figure 6-55   Domino entry

4. Note that the Mail system field states Other and the Domain field states 
Exchange.

5. Check the Miscellaneous tab. The Calendar Domain field should state 
Exchange.

Figure 6-56   Calendar domain

 

Note: If the Calendar Domain field is empty, you must perform a new 
directory synchronization to update the field. If you later install the 
Calendar Connector and the field is left empty, you will not be able to query 
the free/busy time of an Exchange user.
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6. Close the Person document

6.4.3  Monitor the Connector

This section explains how to monitor the Exchange Connector for Lotus Notes.

1. From the Exchange Manager System, xxxxx

2. xxxx

3. You will see (in a few moments) the queues for the Connector. All the 
processes should be active (Figure 6-57).

Figure 6-57   Browsing Queues

Additional information on the status of the process can be viewed by 
double-clicking a process name.

4. xxxxx.

Note to Reviewer: This section still being completed.. 
226 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm
5. Double-click the Log Browser.?????

Figure 6-58   The log browser

6. Double-click an entry for more details. You can see the level of detail kept for 
each action in Figure 6-59.

Figure 6-59   Log details

7. Click OK and then close the Browse Log panel.

8. Close the Exchange Connectivity Administrator program.

6.4.4  Stop the Connector

From the Exchange Server:

1. Choose Start → Programs → Administrative Tools → Services.
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2. Stop the services (Microsoft Exchange Connectivity Controller, Microsoft 
Exchange Connector for Lotus Notes) by:

� Selecting the service(s) to stop.
� Selecting Action → Stop (or righ-clicking service and selecting Stop).

Congratulations! You have successfully completed the installation and testing of 
the Exchange Connector for Lotus Notes.

6.5  Tips and suggestions

The following section is intended to provide tips and suggesstions to make you 
more aware of nuances and possibly, special outcomes when using the 
Exchange Connector for Exchange 2003. Additionally, we recommend that you 
review Chapter 10, “Co-existence test results - what to expect” on page 309.

� Issue - Pictures or embedded graphics are removed when an Outlook user 
replies to an e-mail message that is from a Lotus Notes user

SYMPTOMS

Consider the following scenario. A Lotus Notes user sends an e-mail message 
that contains a picture or an embedded graphic to a Microsoft Outlook user. The 
Outlook user is in a Microsoft Exchange 2000 Server or a Microsoft Exchange 
Server 2003 organization. The Lotus Notes user receives a reply to the e-mail 
message from the Outlook user. 

In this scenario, the replied to e-mail message that the Lotus Notes user receives 
from the Outlook user experiences one of the following symptoms: 

• The picture or the embedded graphic is missing. 

• There are random ASCII characters in the area where the picture should be. 

CAUSE

This behavior occurs if the following conditions are true:

• The Outlook user is using Microsoft Word as the e-mail editor. 

• The e-mail message is routed over the Microsoft Exchange Connector for Lotus 
Notes from Microsoft Exchange to Lotus Notes. 

RESOLUTION
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To resolve this behavior, modify the text in the Exchconn.ini file on the Microsoft 
Exchange 

Server server that is running the Microsoft Exchange Connector for Lotus Notes. 
Then, you can restart the Microsoft Exchange Connector for Lotus Notes service. 
To do this, follow these steps:

1. Start Notepad. 

2. In Notepad, open the Exchconn.ini file. By default, the Exchconn.ini file is 
stored in the Drive_Letter:\Program Files\Exchsrvr\Bin directory. 

3. In Notepad, locate the following text in the opened Exchconn.ini file:

[LME-NOTES-MEXNTS] 

4. Under the text located in step 3, add the following two text entries: 

RTFStripTag=1

RTFConvertBin=14

5. Save the Exchconn.ini file, and then quit Notepad. 

6. In the Services snap-in, restart the Microsoft Exchange Connector for Lotus 
Notes service.

The original technote can be found at this url:

http://support.microsoft.com/?kbid=907977

To add the MEXOUT_INCAPSULATESMTP registry value: 

1. Start Regedt32.exe.

2. Locate the following registry key:

HKEY_LOCAL_MACHINE\System\CurrentControlSet\Services\LME-NOTES\Pa
rameters\ 

3. On the Edit menu, click Add Value, in the Value Name box type 
MEXOUT_INCAPSULATESMTP, and then in the Data Type box type REG_SZ. 

4. When you are prompted for the string, type FALSE. 

5. Restart the Exchange Notes Connector service.
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The original technote can be found at this url:

http://support.microsoft.com/kb/251955/EN-US/
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Chapter 7. Using Microsoft Exchange 
Calendar Connector

This chapter provides detailed instructions on installing, configuring, and using 
the Microsoft Exchange Calendar Connector.

7

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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7.1  Overview of the Calendar Connector

The Calendar Connector runs as a Windows Service on the Microsoft Exchange 
server. It provides for free/busy time searches between Lotus Domino Server and 
the Microsoft Exchange Server.

on the Microsoft Exchange the free/busy time calendar information for users is 
stored in the free/busy public folder. Lotus Domino stores users’ free/busy time 
calendar information in a Domino database called Busytime.nsf.

When Lotus Notes users are added to Microsoft Exchange Server directory via 
directory synchronization, their fee/busy calendar information is also stored in the 
free/busy public folder on the Microsoft Exchange Server. Thus, when an 
Exchange user queries a Domino user’s busy time, the most-up-to date data is 
retrieved by the Calendar connector.

When a Lotus Notes user queries an Exchange user’s calendar, the Schedule 
manager attempts to supply the data. After checking the domino Directory and 
determining that the target user is not on the local Domino server, it will pass the 
query to the Calendar connector task for the other system. In the case of the 
Exchange Foreign domain, the Calendar connector task that will be used is 
called the Exchange Calendar connector task (EXCALCON).
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Figure 7-1   Conceptual overview of the Exchange Calendar Connector

7.1.1  Prerequisites

To run the Microsoft Calendar Connector, your environment must meet the 
following prerequisites:

� Windows 2000 Server SP1 or later (SP2 recommended)

� Exchange 2000 SP1 or later (SP2 recommended)

� Installed and configured Microsoft Connector for Lotus Notes
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Note: Calendar Connector is also available for 2003. The steps below are 
written using 2000 connector. We point out the one configuration difference 
during the configuration of the general tab for 2003 connector, otherwise the 
install and configuration settings are the same.
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7.2  Installing the Calendar Connector

To Successfully install the Calendar Connector, the following tasks need to be 
accomplished:

On the Exchange Server

Install Calendar Connector

Add a Local Replica for the Schedule & Free Busy public folder

Configure Calendar Connector

Start Calendar Connector

On the Domino Server

Install the Calendar Connector Add-in for Lotus Domino

Update the Foreign Domain Document for Exchange

Start Calendar Connector Add-In

7.2.1  Install Calendar Connector

Calendar Connector is a separate tool provided on the Exchange 2000 SP1 or 
later CD. It is recommended that you install the version provided with SP2 or 
later.

You need to be logged onto the Exchange Server with administrator privileges to 
install the Connector.

Use the following steps to install the Calendar Connector:

1. Insert the Exchange 2000 SP1 or later CD into the CD-ROM drive of the 
server running Exchange 2000 SP1 or later.

2. Open a command prompt and type cd e:\calcon\i386 where e is the drive 
letter for the CD-ROM drive.

3. Type setup.exe, and then press ENTER.

4. At the Welcome dialog box, click Next Figure 7-2 on page 235.
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Figure 7-2   Welcome Wizard

5. On the Select Components dialog box, select Full installation including 
required Schema updates, and then click Next.

Figure 7-3   Select Components
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6. After setup completes, click OK.

Figure 7-4   Install complete

Calendar Connector is now installed on the server running Exchange.

7.2.2  Add a Local replica for the Schedule+ Free Busy public folder

Scheduling information for users in an Exchange 2000 messaging environment is 
stored in a special public folder called SCHEDULE+ FREE BUSY. This folder is 
configured for each administrative group in the Exchange organization. A local 
replica of each administrative group organization needs to be on the Exchange 
Server running the Calendar Connector.

Use the following steps to add a local replica of Schedule+ Free Busy:

1. From the Exchange System Manager, navigate to SCHEDULE+ FREE BUSY 
Figure 7-5 on page 237,
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Figure 7-5   Schedule+ Free Busy

2. Right-click Schedule+ Free Busy, click Properties.

3. On the Replication tab, click Add.

4. On the Select a Public Store page, select the server running Exchange 2000 
with Calendar Connector, and then click OK.

5. On the Public folder replication interval drop-down list, select Always Run.

6. Click OK Figure 7-6 on page 238
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Figure 7-6   Replication Tab

Local replicas are now available on the server with the Calendar Connector.

7.2.3  Configure Calendar Connector

Now that you have installed the Calendar Connector, Use the following steps to 
configure the Calendar Connector:

1. In Exchange System Manager, right-click Calendar Connector, and then click 
Properties.
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Figure 7-7   Exchange System Manager

2. On the General tab Figure 7-11 on page 241:

a. Click Modify button.

b. For 2000 Calendar Connector: On the Select Exchange Notes or 
Groupwise Connector tab, select the Exchange Connector for Lotus Notes 
that is used to connect to the bridgehead server running Lotus Domino, 
and then click OK Figure 7-8.

Figure 7-8   Select Connector for 2000

Note: The next step differs from 2000 to 2003.
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c. For 2003 Calendar Connector: On the Select Exchange Notes or 
Groupwise Connector, type connector, in the Enter the object name to 
select field and click Check Names Figure 7-9. Then Click OK.

Figure 7-9   Select Connector 2003

Here is the result after clicking Check Names Figure 7-10 on page 240

Figure 7-10   Select Connector

d. In the Number of days of free/busy information to request from foreign 
calendars field, enter the number of days that users are able to see free 
and busy information for users on the Domino server. 

Note: The remaining steps are the same for both 2000 and 2003.

Note: Users Calendar will appear to be free if the Free and Busy information is 
beyond the number of days specified.
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e. In the Maximum age in minutes of foreign free/busy data in Exchange that 
can be used without querying the foreign calendar field, enter the number 
of minutes between each query to the Domino Server. Suggest default of 5 
minutes.

f. In the Maximum number of seconds to wait for response from foreign 
calendars field, enter the number of seconds that Calendar Connector will 
wait for a response for an individual user’s free and busy information. 
Suggest default of 15 seconds.

Figure 7-11   General tab

3. On the Calendar Connections tab:

a. Click New.

b. On the Calendar Type tab, select Lotus Notes, and then click OK 
Figure 7-12.

Note: The longer the time interval the least likely chance of up to date 
information.
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Figure 7-12   Calendar Type Lotus Notes

c. On the Notes Calendar Connection tab, in the NT Server Hosting the 
Notes Server field, type the network name of the computer that the 
Domino Server is running on or IP address.

Figure 7-13   NT Server Hosting the Notes Server field

d. Click Modify.

e. On the Notes INI File and Password tab, type the path of the notes.ini file 
or click Browse to browse to the file Figure 7-14. 

Note: We used IP address.
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Figure 7-14   Notes INI path

f. Click OK.

4. On the Schedule tab Figure 7-15

a. Select Always.

b. Click OK.

Figure 7-15   Schedule tab

Note: Password field may be left blank. We did not assign as password on the 
ID.
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7.2.4  Start Calendar Connector

Use the following steps to start the Calendar Connector:

1. Launch Administrative Tools, and then click Services.

2. Right-click Microsoft Exchange Calendar Connector, and then click Start.

Figure 7-16   Start Calendar Connector

After yo have verified the operation of the Connector, you may wish to have them 
stared automatically. Use the following steps for automatic start of the calendar 
connector:

1. Launch Administrative Tools, and then click Services.

2. Right-click Microsoft Exchange Calendar Connector, and then click properties

3. On the General tab, select automatic in the startup type drop-down list.
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Figure 7-17   Automatic Start

7.2.5  Install Calendar Connector Add-In for Lotus Domino

The Calendar Connector provides an EXCALCON add-in task for the Domino 
Server, which allows Notes users to check Exchange free/busy time.

Use the following steps to install Calendar Connector Add-in (EXCALCON.EXE):

1. Locate the EXCALCON.EXE file. It should be in a subdirectory on the 
Exchange Server. Generally the path is: exchsrvr\BIN\calcon\excalcon.exe
Figure 7-18 on page 246

Note: The Lotus Calendar Connector add-in must run on a Windows 
operating system. If you are using Lotus Domino on an UNIX server, you must 
use a different, Intel-based server running Lotus Domino with Windows 2000 
in order to connect to Exchange.
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Figure 7-18   Excalcon.exe

2. Either copy the file to a disk or, more conveniently, set up a mapped disk to 
the Microsoft server and place the Exccalcon.exe in the Domino executable 
directory of the Domino Server.

7.2.6  Update Foreign Domain Document

You must update the Foreign Domain Document with the name of the Domino 
Server running the Calendar Connector add-in and specify the name of the 
gateway file as the Calendar system.

Use the following steps to update Foreign Domain Document:

1. Launch the Domino Administrator Client from your workstation and log on as 
a user who has Lotus Domino Administrator permissions.

2. On the menu bar, click View → Server → Domains.

3. Open your Exchange domain document in edit mode.

4. On the Calendar Information tab:

a. In the Calendar server name field, type the name of the Lotus Domino 
server on which you installed the Calendar Connector add-in. You must 
type the full name, including the certifier information. For example:

migrate2ka/itso/FR

b. In the Calendar system text box, type exchange.box.
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5. Click Save and Close.

Figure 7-19   Calendar Information on Foreign Domain Document

7.2.7  Start Connector Add-In (EXCALCON)

Use the following steps to start the EXCALCON task

1. From the Domino Server Console, type

load excalcon <server name> <system name>

Where <server name> is the name of the Exchange Server and <system 
name> is the Connector’s mailbox name (Exchagne.box).

For example:

load excalcon migrate2kb exchange.box

2. Press ENTER.

To verify that the Calendar Connector add-in loaded correctly, type show tasks at 
the console, and then ensure that there is an entry for Exchange Cal Conn. 
Using the previous example, it should look something like this:

Exchange Cal Conn Not Connected to migrate2kb for exchange.box. Stats=0 0/0 
0
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By default, the Calendar Connector add-in must be started manually each time 
the server running Lotus Domino restarts. You can automate startup of the 
Calendar Connector add-in by updating the notes.ini file on the server running 
Lotus Domino.

Use the following steps to automatically startup the Calendar Connector:

1. Open the notes.ini file in a text editor, such as Notepad.

2. Edit the ServerTasks= line of the ini. At the end of the ServerTasks= line Type:

excalcon <server name> <mail-file name>

For example prior to change the line may look like this:
ServerTasks=Router,Replica,Update,Amgr,AdminP,CalConn,Event,Sched,St
ats,HTTP,DIIOP,IMAP,POP3,NNTP,maps

After you add the parameter for starting the Calendar Connector add-in, the 
line may look like this:

ServerTasks=Router,Replica,Update,Amgr,AdminP,CalConn,Event,Sched,St
ats,HTTP,DIIOP,IMAP,POP3,NNTP,maps,excalcon migrate2kb exchange.box

3. Save and Close.

7.2.8  Lookup Results

This section displays screen shots of free busy lookups from both Notes and 
Outlook clients.

Figure 7-20 on page 249 shows a meeting request by Phil Azer from his Notes 
client. A lookup is performed on invitee Rob Ryan who is an Exchange user.

Note: The Stats information can be understood according to the following 
syntax: Stats=<a> <b/c> <d>, where:

• <a> = the total number of calendar requests made from Lotus Domino to 
Exchange.

• <b/c> = the average number of invitees over the average response time, in 
seconds, per Exchange calendar request made from Lotus Domino.

• <d> = the maximum response time, in seconds, for all calendar requests.
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Figure 7-20   Free Busy lookup from Notes

Figure 7-21 on page 250 shows a meeting request by Rob Ryan from his Outlook 
client. A lookup is performed on invitee Phil Azer who is a Domino User.
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Figure 7-21   Free Busy from Outlook
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Chapter 8. Using the CMT for Exchange 
and Domino Coexistence

This chapter discusses a new addition to the products available for co-existence 
between Domino and Exchange. The product discussed in this chapter is the 
CMT (Common Migration Tool) for Exchange and Domino Coexistence from 
Binary Tree, Inc ( http://www.binarytree.com ). 

The CMT for Exchange and Domino Coexistence (CMT for Coexistence) 
provides an improved solution for coexistence by combining strengths from the 
existing Microsoft Exchange Notes Connector functionality, and utilizing 
advantages of SMTP routing to greatly improve message fidelity and connection 
reliability.

8

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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Note: At the time of this writing, the BinaryTree CMT for Coexistence was still 
in beta testing, specifically testing functionality for support of the Lotus Domino 
7 Server. 

Although this tool was still only in the beta phase, we found that it had 
advantages and certainly warrants mention and review in this Redbook. 

Please note: the product has been deployed in production at 10+ customers of 
various sizes.  As for lack of Lotus Domino 7 Server support, this only applies 
to the Coexistence Hub Server.  All downstream Domino Servers supporting 
users and applications may indeed be at release 7.
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8.1  Overview of the product

By combining the Microsoft Exchange Notes Connector with BinaryTree custom 
software and configuration, the CMT for Coexistence yields a highly functional, 
stable and reliable connection between Microsoft Exchange and Lotus Domino. It 
resembles in many points the coexistence solution using SMTP as described in 
Chapter 9, “Using SMTP routing for coexistence” on page 267, but also uses the 
feature of directory synchronization and free/busy time lookups which is provided 
by the Exchange Connector. Additionally, the CMT for Coexistence provides 
better message fidelity, especially with transformation in html than the Exchange 
Notes Connector does. Once you understand the overview of the product in this 
chapter, you can review the results of our coexistence testing in Chapter 10, 
“Co-existence test results - what to expect” on page 309.

Up to this point, the most popular and functional connectivity solution between 
Microsoft Exchange and Lotus Domino environments has been the Notes 
Connector for Microsoft Exchange. (See Chapter 5, “Using the Microsoft 
Exchange Connector for coexistence (Exchange 2000)” on page 107, or 
Chapter 6, “Using the Microsoft Exchange Connector for coexistence (Exchange 
2003)” on page 169). 

The Notes Connector addresses e-mail, calendar and scheduling and task data 
exchange, automated directory synchronization and free/busy lookup between 
Microsoft Exchange and Lotus Domino environments.  The Notes Connector, 
however, has several shortcomings in the areas of fidelity of certain data 
translation as well as operational stability under heavy loads. To overcome these 
Notes Connector issues, Binary Tree's coexistence solution takes advantage of 
certain Notes Connector functionality, while utilizing other technology to greatly 
enhance fidelity of mail exchange and dramatically improve connection reliability 
by the introducing a number of configuration and programmatic changes into the 
environment.

The basic concept behind CMT for Coexistence is to force transmission of all 
mail and calendar data over an SMTP connection between the two Microsoft 
Exchange and Lotus Domino, which supports high fidelity MIME encoding of rich 
text and html data and iCAL encapsulation of calendar events, while utilizing the 
Notes Connector only for Directory Synchronization and free-busy lookup 
between the two environments. 

8.1.1  Potential benefits

Such approach accomplishes the following goals:
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� Enable high fidelity of mail and calendar data exchange between Microsoft 
Exchange and Lotus Domino environments by utilizing SMTP protocol with 
MIME and iCAL support for data transmission.

� Enable automated directory synchronization between Microsoft Exchange 
and Lotus Domino environments by utilizing Notes Connector's Directory 
Synchronization functionality.

� Enable free/busy schedule lookup between Microsoft Exchange and Lotus 
Domino users by utilizing Notes Connector's Calendar Connector.

� Increase reliability of the connection by substantially reducing the load placed 
on the Notes Connector and shifting it to the SMTP connection.
254 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm
8.2  Technical overview of the product

CMT for Coexistence consists of two modules installed on a Domino Server and 
a series of Visual Basic® scripts set up on the Active Directory Server.

Figure 8-1   Overview over the BinaryTree CMT for Lotus Notes/Exchange Coexistence

Since Binary Tree's coexistence solution relies on iCAL support of SMTP 
protocol, it requires that all Domino Mail Servers be at release level 6.x and that 
the Microsoft Exchange Server, on which the Notes Connector as well as the 
SMTP Connector are implemented be release level 200x. These requirements 
are due to the fact that iCAL support is only available in Domino releases 6 and 
above and Exchange release 2000 and above. Since BinaryTree does not 
support Domino Server version 7.x yet, (as do Microsoft does not support the 
Exchange connector working with the Domino 7 as well) it is necessary to create 
a new Domino Server release 6.x (Notes Connector Hub). A standard Notes 
Connector for Microsoft Exchange with Calendar Connector and an SMTP 
Connector are implemented on a Microsoft Exchange Server release 200x. The 
main purposes of the Notes Connector are:

� To provide automated directory synchronization between Microsoft Exchange 
and Lotus Domino directories.
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� To provide free/busy lookup between Microsoft Exchange and Lotus Domino 
environments.

� To (optionally) perform certain data exchange, such as e-mails originating in 
Lotus Domino with Database/View/Document Links as well as regular mail 
and calendar data exchange between selected Lotus Domino domains and 
Microsoft Exchange.

As cross-population of Exchange and Domino e-mail directories is performed by 
the Directory Synchronization portion of the Notes Connector, Notes and 
Exchange users appear in opposite directories with the following addressing 
information:

� Microsoft Exchange users in Lotus Domino Directory are created as users at 
a Foreign Domain, for example Exchange. Ordinarily a Foreign Domain used 
by the Notes Connector would direct all Mail and Calendar data to a Notes 
database on Notes Hub Server matching the Notes Connector configuration 
(f.e. exchange.box); however, Binary Tree's coexistence solution requires 
that the Foreign Domain is configured to send Mail and Calendar data to a 
different database on Notes Hub Server (f.e. tempexchange.box). 

� Lotus Domino users in Microsoft Exchange directory are created with the 
Name Space of Lotus Domino, indicating that any data sent to the users, 
including Free-Busy scheduling inquiries should be routed via the Notes 
Connector for Microsoft Exchange. However, after the Microsoft Exchange 
Public Folder responsible for routing Free-Busy scheduling inquiries is 
updated with the latest Lotus Domino information, the users are updated with 
the Name Space of SMTP and a specific SMTP address pointing directly to 
the Notes Hub Server, so the mail transfer is being pushed to SMTP.

A Server Task (BTCAL) is installed on the Notes Hub Server to continuously poll 
the tempexchange.box database and transfer mail to Domino Router mailbox 
(mail.box), so that data destined for Exchange is sent with appropriate 
modifications via SMTP. Optionally, depending on the need, BTCAL can move 
data to the Notes Connector database (exchange.box), so that data destined for 
Exchange is sent via the Notes Connector. 

Additionally, a Domino Extension Manager program (BTEX) watches the Domino 
Router mailbox (mail.box) for inbound messages containing iCAL attachments. 
These messages are placed in a "DEAD" routing state and a message is passed 
over to the Domino Server Task program. The Domino Server Task program 
reads the iCAL attachment and creates a $ICAL_UID field with the value of the 
iCAL UID value. The message is then released for delivery.

A Visual Basic script is deployed on the Active Directory server to modify 
addresses of Lotus Domino users newly synchronized by the Directory 
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Synchronization component of the Notes Connector. The script switch the 
primary e-mail address of the Notes users from Notes to SMTP namespace.

8.3  Advantages of the product

Advantages of using CMT for Coexistence include:

� Higher stability - failover and redundancy 

� No dependency on a single threaded Exchange Connector for mail delivery 

� Ability to create redundant alternative messaging paths via SMTP routing 

� Better performance - throughput volume, attachment size, than the Exchange 
Connector, for CMT for Coexistence Connector is multi-threaded.

� Remove limits for temporary storage of attachments on connector servers 

� Native use of SMTP - easier to complete migration or maintain coexistence 
scenario, better fidelity 

� Message content fidelity - HTML - natively supported 

8.4  Setup and Configuration

The detailed installation instruction is ultimately provided with the distribution of 
the product and will not be covered in exact detail here. Our intent here is to 
instead provide a general overview of what components are involved in setting 
up the tool.

Once the Exchange Connector has been installed, the following steps are 
necessary on the Domino side:

1. Copy the binary files into the Domino program directory

– add to the notes.ini the following configuration entries
ServerTasks= btcal "Add BTcal task to serverTasks line".
EXTMGR_ADDINS=btex
BTExchangeDomain=Exchange
BTExchangeServer=exchange1.supervalue.com

Attention: As a prerequisite for installing this tool, you first need to set up the 
Exchange Connector as shown in either Chapter 5, “Using the Microsoft 
Exchange Connector for coexistence (Exchange 2000)” on page 107, or 
Chapter 6, “Using the Microsoft Exchange Connector for coexistence 
(Exchange 2003)” on page 169, depending upon your specific environment.
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BTExchangeDB=tempexchange.box
BTExchangeRouter=exchange.box
btdelay=30
BTORPHANDELAY=120
BTProcessDomain=itso.fr,notes.itso.fr

2. Add an domain alias to the global domain Document (i.e. notes.itso.fr)

3. Create a mail box named tempexchange.box

4. Create a foreign domain named Exchange which will put the mail in the 
tempexchange.box (in the gateway mailfile name field)

5. Create a foreign SMTP domain document

6. Create a new SMTP connection pointing to Exchange server

7. The exchange side must be configured to send messages to Notes over 
SMTP:

a. modify the default recipient policy to include the domain alias (i.e. 
exchange.itso.fr)

b. create a second recipient policy

c. update exchange mapping tables

d. update the smtp namespace for notes connector

8. update the VBscript with the name of your AD LDAP

9. create a scheduled task to run the VB script after DirSync is scheduled to 
update the newly synchronized notes addresses to use of smtp namespace.

8.5  Using the product- step by step

The following screenshots illustrate how to use the product, and the changes it 
makes to the environment once it has been installed. 

Once installed, the product modifies the recipient policies. Figure 8-2 on 
page 259, as well as Figure 8-3 on page 260 illustrate the modified default 
recipient policy in Exchange 2003.
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Figure 8-2   Modified default recipient policy in Exchange 2003

Figure 8-3 again illustrates a second modified recipient policy in Exchange 2003
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Figure 8-3   The second recipient policy

Notice how in Figure 8-4 , the connectors view in Exchange and in particular, 
how the SMTP connection to Domino has been established.
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Figure 8-4   The connectors view in Exchange - notice the SMTP connection to Domino

After the VB script has been run during installation, and all modifications have 
taken place, a notes recipient looks like this: (Figure 8-5 on page 262).
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Figure 8-5   Notes recipient in Exchange - showing both the email and general tabs 

Email Address tab

Exchange General tab
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Figure 8-6   

Notes users in exchange addressbook are configured to use an SMTP 
namespace.

The correct execution of the VB script can be controlled in the event monitor. 
Look for events with the source WSH (Windows scripting host), such as that 
shown in Figure 8-7 on page 264. 
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Figure 8-7   The update script successfully run

Finally, verification of the correct function on the Domino side can be monitored 
in the log.nsf. Below are examples of how message processing should appear in 
the logfile.

Example 8-1   Processing of an invitation from Outlook sent to notes (from log.nsf)

06/29/2006 11:13:52 PM  BTCal: Done checking for temporary messages.
06/29/2006 11:14:20 PM  BTCal: Done checking for temporary messages.
06/29/2006 11:14:48 PM  BTCal: Done checking for temporary messages.
06/29/2006 11:14:49 PM  BTExchange: Message 0011D611 from "Feodor 
Engels" <fengels@itso2.us> with subject: "Invitation to the Breakfast 
meeting" has been stopped for processing.
06/29/2006 11:14:53 PM  BTCal: sending message to processor 
06/29/2006 11:14:54 PM  iCalendar: Logging conversion of request from 
non-Notes source. Product ID: Microsoft CDO for Microsoft Exchange
06/29/2006 11:14:58 PM  BTCal Processor 1: processing complete.
06/29/2006 11:15:21 PM  BTCal: Done checking for temporary messages.

Example of BTCal process an email containing an icalendar attachment 
originated from Exchange. 
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Example 8-2   Processing of an email from Notes destinated to Exchange (from log.nsfI

06/29/2006 11:15:44 PM  Router: Transferred 1 messages to 
MIGRATE2003B/ITSO/FR via Notes
06/29/2006 11:15:49 PM  BTCal: Done checking for orphaned messages.
06/29/2006 11:15:50 PM  BTCal: Transferred message 0011EB8E to the mail 
router database.
06/29/2006 11:15:50 PM  BTCal: Done checking for temporary messages.
06/29/2006 11:15:50 PM  Begin CD to MIME Conversion(Process: Router 
(00000F00:00000007), Database: C:\Program 
Files\Lotus\Domino\data\mail2.box, Note: 000009EE)
06/29/2006 11:15:50 PM  End CD to MIME Conversion(Process: Router 
(00000F00:00000007), Database: C:\Program 
Files\Lotus\Domino\data\mail2.box, Note: 000009EE)
06/29/2006 11:15:50 PM  Router: Transferred 1 messages to [9.33.85.123] 
(host 9.33.85.123) via SMTP
06/29/2006 11:16:18 PM  BTCal: Message 0011EB8E has been removed from 
the router database.
06/29/2006 11:16:18 PM  BTCal: Done checking for temporary messages.

As shown in Example 8-2, BTCal server task stops the message that is intended 
for exchange in the tempexchange.box . It then puts it in the server mail.box for 
being sent to exchange using SMTP transfer. 

Note: The upcoming release of Lotus Notes/Domino 7.0.2 provides many 
improvements in iCalendar proccessing. Since this release was not yet 
available at the time of this writing, it would need further testing to determine 
the exact extent to which using BTCal provides improvements for calendar 
processing, or if alternatively, native Domino processing of iCal now provides 
the same advantages. 
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Chapter 9. Using SMTP routing for 
coexistence

Migrations between messaging systems are often seen as a painful exercise. 
The act of migration itself is not the cause of this, but more importantly, the 
results have a direct relationship with proper strategy and selection of the proper 
coexistence tool and strategy. With the correct planning configuration and testing 
this can be overcome

Traditionally the Exchange connectors have proven problematic with the 
following limitations:

� they don’t scale well under load, 

� have limitations on support, 

9

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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� have prerequisite requirements and finally, 

� create a single point of failure within the messaging infrastructure. 

Ultimately, for a long term solution, these Exchange connectors are not 
recommended for long term coexistence.

Simple Mail Transfer Protocol (SMTP) on the other hand is supported by both 
Microsoft and IBM on all supported release levels, and with the advent of ical 
support, can be used to provide mail and meeting notice coexistence. 
Additionally, by configuring individual or multiple servers to route via SMTP, the 
single point of failure can be removed, thus improving the stability, reliability and 
scalability of the infrastructure. 

For directory lookups you have several choices. You can configure the clients for 
LDAP lookups (refer to Chapter 16, “Directory Coexistence Using LDAP” on 
page 503) or, you can utilize the Exchange connectors Directory Synchronization 
(DIRSYNC) with some simple modifications to the mapping tables and recipient 
policies.If you are using Dirsync, then additional internal smtp addresses will be 
used.

This chapter covers the following topics:

� Overview of SMTP in both the Microsoft Exchange and Lotus Domino 7 
environments

� Requirements for the Exchange SMTP Connector

� Configuring and customizing the Exchange SMTP Connector

� Configuring Lotus Domino 7 for SMTP message transmission

� Using SMTP in the Microsoft Exchange and Lotus Domino environments

� Configuring Exchange connectors fro SMTP Directory Synchronization

Note: For more information regarding addressing and directory lookups in a 
co-existence environment, please refer to Chapter 16, “Directory Coexistence 
Using LDAP” on page 503, and Chapter 17, “Active Directory Integration” on 
page 527
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9.1  SMTP Scenario

The following diagram shows a typical SMTP configuration, We used this 
configurations as a starting point for our solution in our test lab to demonstrate a 
working smtp coexistence. For the benefit of simplicity relays, virus checkers, 
anti-spam servers and edge services have not been included.

Figure 9-1   Typical SMTP configuration

When SMTP is configured in Exchange, The SMTP schema is expanded and 
management of SMTP moved from IIS to the Exchange system manager. (If you 
have not yet installed SMTP ensure that Pop mail is removed from the windows 
IIS installed components.) The components of the Windows and Exchange 
SMTP will be discussed later. In this configuration All SMTP/Internet mail is 
routed via the exchange smtp virtual server and connector utilizing internal DNS 
and External DNS to resolve destination addresses then directly routed to the 
Internet.

Internal DNS

External DNS

Windows
Exchange

InternetFirewall SMTP

Virtual Server

SMTPSMTP Connector
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9.2  SMTP coexistence scenario
The scenario for our examples has two SMTP domains, as illustrated in 
Appendix 9-2, “SMTP coexistence configuration with Domino and Exchange” on 
page 270 We will in this chapter discuss the components and configuration 
requirements to create the scenario.

Figure 9-2   SMTP coexistence configuration with Domino and Exchange 

9.3  Overview of the SMTP environment
In our discussion of the SMTP environment, we describe message transmission 
between Microsoft Exchange 2000/2003 and Lotus Domino 7.

In a later chapter we will discuss the options available for directory coexistence in 
an SMTP environment

During co-existence all inbound SMTP messages from the internet will be 
delivered directly to Exchange, (via inbound relays if used), Utilizing the SMTP 
connector, messages for users in the assigned domino local SMTP domains will 

Internal DNS

IBM Lotus
Domino

External DNS

Windows
Exchange

Internet

Setup
service

Virtual Server

SMTP Connector FirewallSMTP SMTP

SMTP

SMTP

SMTP Connector

Note: For more information regarding addressing and directory lookups in a 
co-existence environment, please refer to Chapter 16, “Directory Coexistence 
Using LDAP” on page 503, and Chapter 17, “Active Directory Integration” on 
page 527
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be redirected to Domino. Messages from Domino for all users not in the domino 
directory will be sent to the exchange server for delivery to the internet or 

9.3.1  Microsoft Exchange SMTP overview

Since the release of Exchange 2000 SMTP as a transport layer has been built 
into the windows operating system. For Exchange mail delivery this has meant 
that the Internet Mail Service (IMS Exchange 5,5) is now provided by the SMTP 
service component of IIS (Internet Information Service). After the installation of 
Exchange all management of SMTP is undertaken in Virtual server component of 
the Microsoft Exchange System Manager. SMTP provides all message transfer 
and translation between All windows servers, Microsoft Exchange Servers and 
Internet messaging systems,. 

Essentially the SMTP service Is made up of the following 2 components

Virtual Server
Each Virtual server represents an instance of the smtp service running on the 
Windows/Exchange server and provides the management and configuration and 
routing for that instance. Within the configuration both inbound and outbound 
parameters are defined, including IP address, listening port (default 25), relaying, 
security, delivery restrictions and options, delivery notifications, etc.

SMTP Connector
SMTP Connectors are used to connect to other mail systems and routing groups, 
it is also used to override options in a virtual server. In particular they enable you 
to configure a designated route for specific messages or domains.In our book we 
will cover the configuration of the SMTP connector to route messages 
specifically bound for the Domino recipients, 

9.3.2  Lotus Domino 7 SMTP environment

SMTP has been the native mail routing protocol since Lotus Domino R5. Domino 
servers act as Internet mail servers by using SMTP/MIME routing as a native 
routing protocol, between Domino servers and multiple SMTP servers or even 
other Domino servers

Domino automatically converts between Notes and MIME format as required, 
which means that clients can send and receive mail with no concern about 
format. For example, if a Notes client sends a Notes-formatted message to an 
client, Domino converts the message to MIME format for the IMAP client.
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9.4  Configuring Microsoft Exchange SMTP

Unlike Exchange 5.5, Exchange 2000 relies heavily on the Windows Operating 
system for it’s routing. Most organizations will already have SMTP set up and 
configured to route mail via the internet to external organizations, customers 
suppliers etc...This section describes how to establish SMTP message 
transmission to Domino from Exchange using the SMTP Virtual server and 
Connector.

Pre-configuration tasks
Before you configure the SMTP Service to communicate with Domino, you 
should review the following list to ensure that the environment is configured 
correctly and that you have the information needed to complete the Internet Mail 
wizard.

� We are assuming that you already have the Exchange SMTP configured to 
route to the Internet via a direct connection or by transferring messages to a 
smarthost.

� Know the SMTP addressing schemes for your organization. 

� Determine the SMTP address for the site. 

� Determine the address space that Domino smtp will use. 

� Obtain the host name and domain name of the Exchange server on which the 
SMTP Virtual server is installed. 

� Determine whether Domain Name System (DNS) is used to provide host and 
domain name-to-Internet Protocol (IP) address resolution.

� Obtain the IP addresses of DNS servers or the SMTP hosts that Domino 
SMTP will be running.

� Ensure that the domino server address is in the DNS.. e.g DOMINO.itso1.eu, 
this will be useful for both secondary smtp addresses and for autoforward

Configuring the SMTP Connector (optional)
1. Open the Exchange Administrator program select Administration groups, First 

Administrative group.
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Figure 9-3   Exchange System Manager Administrate groups

2. Next select routing groups
 Chapter 9. Using SMTP routing for coexistence 273



7777_f_ch_smtp_routing_coexistence.fmDraft Document for Review September 11, 2006 10:43 pm
Figure 9-4   Selecting the Routing group

3. Select Routing Groups First routing Groups as seen inAppendix 9-4, 
“Selecting the Routing group” on page 274 

Note: First Administrative groups and Routing Groups may be renamed 
from the default in your organization
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Figure 9-5   Connector view
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Figure 9-6   Creating a new connector

4. Next select Connector (Appendix 9-5, “Connector view” on page 275), and 
right click when Highlighted select New -> SMTP Connector seen in 
Appendix 9-6, “Creating a new connector” on page 276

5. You will be presented with SMTP Connector configuration box as seen in 
Appendix 9-7, “SMTP Configuration” on page 277. Enter a unique name and 
enter either the DNS name or IP address of the Domino Server.

6.

Note: If entering an IP address ensure that you enclose in square brackets 
[]
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Figure 9-7   SMTP Configuration

7. Once you have entered the IP address of the domino server click the address 
space tab and select Add 
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8.

Figure 9-8   Adding an address space

9. Select SMTP from the dialogue box and click OK this will bring up the entry 
box for the smtp address space as seen in Appendix 9-10, “Customizing the 
address space” on page 280
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Figure 9-9   Address space choices
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Figure 9-10   Customizing the address space

10.Enter the SMTP domain name for the domino server in our lab the domain for 
all our users will be domino.itso.fr
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Figure 9-11   Entering a bridgehead server

11.Although we are not using a separate Bridgehead server the connector 
requires one. If you attempt to close the server without configuring one a 
dialogue box (shown in Appendix 9-13, “Error message” on page 283). To 
create a Bridgehead server link click on general parameters and Click Add 
select the Bridgehead server click OK.
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Figure 9-12   Completed connector

12.The completed Connector screen will now appear. 

13.Click OK 
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Figure 9-13   Error message 

Configuring SMTP Virtual Server
So far we have established a relay for the domino server and enabled the SMTP 
routing from Exchange to Domino for mail destined to the multiple SMTP 
domains that Domino may support. To ensure that we Smarthost correctly (i.e. 
send to when local domain recipients not found in the Directory to a smart host 
server) we need to modify the Virtual server document. By adding the domino 
server address in the ‘Forward all mail with unresolved recipients to host field in 
the messages tab of the virtual server properties. The following instructions can 
be followed

1. Open the exchange system administrator see and select Administrative 
Groups -> First Administration Group -> Servers
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Figure 9-14   Exchange administration group server

2. Select the Exchange server where the virtual smtp server resides and 
select-> Protocols -> SMTP

Figure 9-15   SMTP Protocol

3. Right click on the Default SMTP Virtual Server and select Properties as 
shown in Appendix 9-16, “Selecting Virtual server properties” on page 285
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Figure 9-16   Selecting Virtual server properties

4. Select the messaging tab and in the Forward all mail with unresolved 
recipients to host field enter either the IP address (in square brackets to 
speed up address resolution) or the FQDN of the domino server, as can be 
seen in the following graphic (Appendix 9-17, “Setting the smarthost address 
field” on page 286) we entered the IP address
 Chapter 9. Using SMTP routing for coexistence 285



7777_f_ch_smtp_routing_coexistence.fmDraft Document for Review September 11, 2006 10:43 pm
Figure 9-17   Setting the smarthost address field

5. After restarting the Exchange server you have completed the exchange smtp 
configuration and you are now ready to configure Domino SMTP services

From this pont onwards, all messages sent to user@itso1.eu if not found in the 
exchange server, will be forwarded to the domino server.

9.5  Configuring Lotus Domino 7 for SMTP message 
transmission

In this section we describe how to customize the Lotus Domino server for a direct 
SMTP connection for all Exchange bound mail traffic. If This is not the first 
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domino server in your organization or you already have SMTP configured then 
go direct to 

You will need to make several modifications to the Lotus Domino 7 server to 
establish SMTP support. The necessary steps are as follows:

� Create or Modify the Global Domain documents to allow the domino server to 
send and receive SMTP mail.

� Enable SMTP routing in the Server document 

� Create a Configuration Settings document to do the following:

– Use SMTP to send mail outside the local Internet domain.

– Use SMTP inside your local Internet domain.

9.5.1  Modify/Create the Global Domain document

The Global Domain Document tells domino server how to deal with Inbound and 
Outbound Internet or SMTP mail. It is not within this books scope to discuss your 
network Topology so it is assumed that the connection to the Exchange server is 
across and internal secured LAN or WAN.

To establish SMTP message transfer, begin by customizing the Global Domain 
document, using the following steps:

1. From the Domino Administration client, click the Configuration Tab of your 
Domino Server (Figure 9-18).

Author Comment: Add link to creating a connection doc after it has been 
completed
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.

Figure 9-18   Domino Administration Program (Configuration tab)

2. From the Messaging navigator, select Domains. an example of this can be 
seen in Appendix 9-18, “Domino Administration Program (Configuration tab)” 
on page 288

3. Click the Add Domain button. the domain configuration screen shown in 
Appendix 9-19, “Domain Add window” on page 289 will be presented
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Figure 9-19   Domain Add window

4. Click the pull-down list selector to choose the Domain Type that you are 
creating. 

5. Select a Global Domain document, as shown in Figure 9-20 on page 290. 

6. Click OK.
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Figure 9-20   Domain Type dialogue box

7. Enter a name for the Global Domain Document in our case we where very 
creative and called ours GDD (Global Domain Document)

8. Enter a role for your domain of a role type of R5/R6/R7 Internet Domains or 
R4.x SMTP MTA. you can select this from the Global domain role pull-down 
list Figure 9-21 on page 291.
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Figure 9-21   Global domain role

9. Tick the yes box for > Use as default Global Domain (for use with all Internet 
protocols except HTTP):

10.The completed Basics tab is shown in Figure 9-22 on page 292.
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Figure 9-22   Competed Basics tab

11.Accept the defaults on the Restrictions tab.

12.Next Click the Conversions tab.

Note: In our testing we did not find any reason to change the restrictions Tab, 
However we advise that you revise the options in the top and configure 
appropriately for your site
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:

Figure 9-23   Conversions tab

13.The Conversions tab allows us to configure how Domino will interpret 
Inbound and generate outbound addresses. To ensure that Domino is 
correctly configured for address lookup and address generation we will need 
to make some changes from the defaults as can be seen in the graphic 
Figure 9-23. 

14.You will need to change the following fields:-

• Local primary Internet domain 

Needs to be set to your Domino’s FQDN domain in our example this is 
itso.fr, as we where using multiple Internet addresses we added these 
to the alias fields as well

• Local part Formed From

In the event of a user not having an internet address you need to 
specify how the Local part will be formed. In our example we set this to 
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FullName. when an address is formed this way the address will be 
appended with your Primary Internet domain entered earlier

• Domino Domain(s) included field: 

We recommend that this be set to none Otherwise in conjunction with 
the Domain separator 

• Internet Address Lookup

Set this to enabled to ensure that Domino looks up the internet address 
before trying to create one

15.If appropriate, all other fields and tabs can be kept as default, for our 
connections to exchange this was so.

16.Save and close the Domain document.

This completes the procedure to create and modify the Global domain document.

9.5.2  Enabling Domino Routing and the SMTP Listener Task

Once you have completed creating the Global domain document you need to 
enable the smtp tasks on domino (SMTP routing and SMTP Listener). This is 
enabled via both the Server document and the configuration settings document 

Enable SMTP Listener
. Use the following steps to customize the Server document for the SMTP 
listener task.

1. Whilst still in Domino Administrator navigate to the server configuration tab 
and select the All Server Documents view.as seen in Figure 9-24 on page 295 
and select the appropriate server and click Edit server

Tip: Instead of selecting all server/server you could select current server, 
However experience has shown in a multi server environment this can lead to 
edit the wrong server if multiple administration tasks are being undertaken
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Figure 9-24   Edit server document
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.

Figure 9-25   Server Configuration Document (Basics tab)

2. Enter your hostname as known to the dns in the Fully Qualified Internet Host 
name field In our lab this was migrate2ka.cam.itso.ibm.com as highlighted in 
Appendix 9-25, “Server Configuration Document (Basics tab)” on 
page 296

3. Enable the SMTP listener task field by selecting the drop down selection box 
next to disabled and change field to enabled. see Appendix 9-26, “Enabling 
SMTP Listener” on page 297
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Figure 9-26   Enabling SMTP Listener

4. next select the drop down box next to routing tasks and select SMTP routing 
as shown inAppendix 9-27, “Server Configuration Document enable smtp 
routing” on page 297.

Figure 9-27   Server Configuration Document enable smtp routing

No fields other fields or options on the other tabs for the Server document 
need to be modified

5. Select save and Close
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The SMTP listener task and routing is now enabled.

Establishing SMTP message routing Configuration
The following steps describe how to set up the SMTP routing for both internal 
and external Internet mail.

1. Under the server Navigator, select Configurations view.

.

Figure 9-28   Server Configuration Document

2. Click the Add Configuration button. as shown above you will be presented 
with the Configuration documents basics screen shown in Appendix 9-29, 
“Server Configuration Document (Basics tab)” on page 299
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.

Figure 9-29   Server Configuration Document (Basics tab)

3. Select the ‘Use these settings as the default settings for all servers:’

All other fields can be left as default 

4. .Click the Router/SMTP tab.

Note: There can be only one default configuration document. if this is an 
additional server in your organization then add your server name to the Group 
or server name field
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Figure 9-30   Server Configuration Document (Router SMTP/Basics tab)

5. On the Basics tab, complete the following fields:

� Number of mailboxes: 2

� SMTP used when sending messages outside of the local Internet domain: 
Enabled

� SMTP allowed within the local internet domain: Disabled

� Relay host for messages leaving the local internet domain: (specify either an 
IP address or an FQDN of your relay.) If you do not use a relay leave blank.

Tip: A good rule of thumb would be to specify two or more mailboxes, in 
order to better serve a production messaging volume.
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6. Local Internet domain smart host: (enter the exchange Bridgehead server)

7. For the remaining tabs (Restrictions and Controls, Message Tracking, and 
Advanced), we made no changes and accepted the defaults.

8. Save and close the Configuration document.

All the documents have been configured within the Domino 7 server to enable 
SMTP message transmission, and you are now able to start testing mail flow.

9.6  Sending mail between Exchange and Domino via 
SMTP

In our lab we found it necessary to restart the exchange server before we were 
able to test to ensure that the configuration changes we had made to the smtp 
virtual server and connector would take effect

For testing mailflow in our scenario, we have a Microsoft Exchange user, Cindy 
Ryan send an e-mail message to a Notes user, Susan Pluvial. and then had the 
Notes user reply to the message, which prompts the Exchange user to send a 
meeting request, which is accepted by the recipient

1. User “Cindy” logs on to the Exchange server with her profile.

Note: During the coexistence period you may not want to disrupt the current 
routing architecture thus you may want to continue routing all inbound and 
outbound smtp messages via the exchange server. If this is the case then the 
Exchange Bridgehead server will be the relay, ensure that the bridgehead 
servers is configured to allow inbound and outbound relaying to the FQDN of 
the domino server

Tip: Before you begin, make sure that the SMTP task has been loaded onto 
the Domino server 
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Figure 9-31   Microsoft MAPI profile

2. Cindy is presented with her Outlook inbox.

Figure 9-32   Outlook 2003 (Inbox View)

3. She then creates a new mail message regarding the Big Sale at the local mall 
however Cindy cannot remember Susan’s email address and because her 
account is in domino does not exist in the Exchange directory. Cindy 
therefore needs to do an alternative address book lookup (LDAP)

4. she selects the alternative directory from the address book drop down list and 
is able to enter any of Susan’s attributes (firstname, lastname telephone 
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number etc.). Cindy chose to search in firstname, however LDAP would have 
searched any of the mapped fields and returned all entries that contained the 
word Susan.

Figure 9-33   Selecting LDAP name from the address book

5. Cindy selects Susan’s entry from the directory list and clicks the To button 
and adds her as a recipient for the email, she then clicks OK

6. Cindy continues to edit the email and sends to Susan

Note: Utilizing LDAP for directory lookups and using customized 
connectors for Directory synchronization is covered in another chapter
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Figure 9-34   Cindy’s email to Susan before sending

7. The Notes user, “Susan Povall” receives a new mail notification and opens 
the e-mail message sent via MS Exchange and delivered via SMTP.

Figure 9-35   Lotus Notes client displaying the Exchange SMTP-based message

8. Susan (aka The Lotus Notes user) then replies to Cindy (aka the Microsoft 
Outlook user) sending the message back with her reply over the SMTP 
connection.
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Figure 9-36   Lotus Notes user replying to the MS Exchange user

Figure 9-37   Exchange user creates meeting notice and sends to Notes user

9. Cindy receives the reply in her Outlook inbox. After reading the reply she 
creates a meeting notice and invites Susan to the big shopping spree.
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Figure 9-38   Meeting notice received in Notes via SMTP

10.Susan received the meeting notice intact (thanks to both systems supporting 
ical) and after accepting a calendar entry is created in Susan’s Diary (not that 
she is likely to forget the big sale.), an acceptance is sent to Cindy 

Figure 9-39   Calendar view showing accepted meeting

11.Cindy receives a notification that Susan has accepted here meeting 
request.and upon reviewing the appointment can see that the attendees have 
accepted.
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Figure 9-40   Meeting notice showing accepted by attendees
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Chapter 10. Co-existence test results - 
what to expect

This chapter discusses and illustrates the results users can expect during a 
period of coexistence between Exchange 2000 /20003 and Notes and Domino 7. 

We describe the testing methodology we used with the intent that this can also 
be useful when planning a testing solution for your specific migration and 
co-existence strategy. We then approach the results based on the specific 
coexistence tool used for each scenario:

� “Coexistence with MS Exchange Connector” on page 320

� “CMT for Exchange and Domino Coexistence” on page 325

� “SMTP Routing” on page 329

10

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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� “Coexistence with MS Exchange Connector” on page 320

Attention: The goal of this chapter is to demonstrate an approach and 
methodology to co-existence testing, and to highlight key issues to be aware of 
based on your co-existence solution. Due to time and scope limitations, it is 
not possible to cover every possible variation. 
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10.1  Methodology used for testing

In order to methodically test each of the co-existence solutions discussed in this 
book, we created the matrix shown in Figure 10-1 on page 312. The approach 
was to send a carefully formatted and representative message between both the 
Domino and Exchange systems, while covering an extensive sample of 
messaging and calendaring formatting and functionality. To conduct the test, we 
created a richly formatted document, containing specific elements such as rich 
text, tables, sections, document links and embedded graphics in order to verify 
how these would transfer between the two systems. 
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Figure 10-1   Test Matrix used to methodically test co-existence results between each system

The document used as the primary test message between systems is shown 
below in Figure 10-2 on page 313. We believed this to be a representative, richly 
formatted document, containing specific elements such as rich text, tables, 
sections, document links and embedded graphics.
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Figure 10-2   Richly formatted test message sent between systems

Test Message includes richly formatted text, embedded images, doc-links, tables and sections. 
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10.2  Executive overview of results

This section provides a high level summary of the results and the team’s 
impressions of the available tools for managing co-existence. While the 
subsequent sections of this chapter will provide much greater detail into each of 
the tools, this summarizes our impression. 

Overall, we found the CMT (Common Migration Tool) for Exchange and Domino 
Coexistence from Binary Tree, Inc. ( http://www.binarytree.com ) to provide the 
best message fidelity between Notes and Exchange. In particular, the Common 
Migration tool addresses Notes specific features such as document links and 
sections embedded within a Notes document. 

Next to this solution, we were impressed with fidelity of SMTP routing as a 
co-existence solution. (Keep in mind that SMTP routing does not require 
purchasing a specific 3rd party product, so it is also the most cost effective.) 

Finally, the team was surprised at the lack of fidelity maintained when using the 
the Microsoft Exchange Connectors. Basic formatting such as embedded images 
and tables were modified and we found the overall result to be disappointing.

10.2.1  Summary overview of screenshots

� Figure 10-3 on page 315 illustrates how the CMT (Common Migration Tool) 
for Exchange and Domino Coexistence from Binary Tree, Inc. preserved 
clickable document links, basic section formatting and finally, all other basic 
formatting within the document. 

Attention: When using the Exchange 2003 connectors, we did see significant 
improvements in the retention of table formatting and embedded graphics. 
Figure 10-8 on page 323 illustrates the improved rendering when using the 
2003 Exchange Connector. 
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Figure 10-3   Common Migration Tool for co-existence from Binary Tree

Preservation of clickable document links
and sections
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� As shown in Figure 10-4 on page 317, we also liked the basic message 
fidelity retention when using an SMTP routing solution. All basic formatting 
was retained, including an embedded clickable document link. Section 
formatting was lost, however. 
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Figure 10-4   SMTP rendering of email between Notes and Exchange

SMTP rendering of clickable document links

Section formatting not retained
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� Finally, Figure 10-5 on page 319 illustrates the basic result when using the 
Exchange Connector. We were surprised to see that basic formatting such as 
table formatting or embedded images was not retained. 

Attention: When using the Exchange 2003 connectors, we did see significant 
improvements in the retention of table formatting and embedded graphics. 
Figure 10-8 on page 323 illustrates the improved rendering when using the 
2003 Exchange Connector. 
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Figure 10-5   Email rendering from Notes to Exchange using MS Exchange Connectors

With Exchange Connector - most basic formatting
lost - no preservation of table formatting
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10.3  Coexistence with MS Exchange Connector

The following section describes the results found when testing message transfers 
between the Notes and Exchange Domains using the Microsoft Exchange 
Connector. 

10.3.1  Directory Lookups

As an initial step when sending the message, we wanted to verify that DNS 
Name lookups were working and that we were able to access the Exchange 
Directory when initially sending from the Domino to the Exchange domains. 

From Notes to Exchange
Figure 10-6 illustrate successful DNS Name resolution using the Microsoft 
Exchange Connector, together with the ability to access the Exchange Directory 
for name loopkups. 
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, 

Figure 10-6   DNS Name lookups and accessing the Exchange Directory

From Exchange to Domino - Directory lookups from within
Outlook
Figure 10-7 on page 322 illustrates the directory lookup functionality working 
correctly from within Microsoft Outlook. 

Notice how all names are fully extended. DNS Name resolution

Ability to access the Exchange directory for name lookups
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Figure 10-7   Directory lookup functionality between systems

10.3.2  Messaging - Notes to Exchange

When the message was sent via the Exchange 2003 connector, the basic 
formatting was retained, but Notes specific features such as document links and 
sections were not translated correctly. 

Names translating correctly between systems 

Names available for lookup from within 

the Outlook directory
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Figure 10-8   Example of how a note is sent from Notes to Exchange

Document Links
The following screenshot illustrates how document links are translated when sent 
from Domino to Exchange using the Exchange Connectors. Document links are 
most frequently translated to a Notes specific URL. 

Section formatting not retained

Attention: When using the Exchange 2003 connectors, we did see significant 
improvements in the retention of table formatting and embedded graphics. 
Figure 10-8 illustrates the improved rendering when using the 2003 Exchange 
Connector. 
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Figure 10-9   Document link example

10.3.3  Messaging - Exchange to Notes

Finally, when the original message was sent from Exchange to Notes, the 
formatting was retained. The result appears to be very similar to the SMTP 
routing solution. 

Figure 10-10   Example of how message appeared when sent from Exchange to Notes.
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10.4  CMT for Exchange and Domino Coexistence

This section discusses and illustrates the results from our testing using the CMT 
for Exchange and Domino Co-existence. (See Chapter 8, “Using the CMT for 
Exchange and Domino Coexistence” on page 251 for information on this 
product.) 

10.4.1  Messaging - Notes to Exchange

BinaryTree’s CMT for Exchange and Domino Coexistence (CMT for Coexistence) 
relies on SMTP for message transport, but it processes every message 
originated to exchange prior to releasing it for smtp transfer. It has shown in our 
testing a high level of message fidelity. 

The sender of the mail from notes shows in outlook as an smtp address, so the 
answering mail will be routed over smtp as well. 

Figure 10-11 and Figure 10-12 on page 327 illustrate highlights of this testing. 
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Figure 10-11   Overview of Message transferred using CMT for Exchange and Domino Coexistence Tool

Document
Links
shown
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Figure 10-12   Lower-half of message illustrating how sections are handled 

Section formatting 
twisty indicates section
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Figure 10-13   CMT Coexistence: Notes Section is converted to a mock up section in html

As you see in Figure 10-13, the Notes Section part of the testmail is shown as a 
text line with an triangle showing down, mocking an expanded section. Beyond 
the appearance, visually indicating where a section was placed, there is no 
Notes-centric section functionality. If you click on the twisty image, nothing 
happens. 

However, the big advantage over other approaches is, that the section heading 
and overall layout is retained.

Figure 10-14   CMT Coexistence: Notes Links been showed with an icon in the mail body

The Notes link (document link) has been converted into a notes:/// url, just like in 
the messaging coexistence option based on pure SMTP routing, but instead of 
(Link) in the document, an icon been included which resembles the notes mail 
layout. 

10.4.2  Messaging - Exchange to Notes

The result of message sent from exchange to notes are the same, as in the 
SMTP Routing test, since messages on Exchange side are not being modified by 
the CMT for Coexistence, rather then being pushed to SMTP routing by switching 
the primary email address for the imported Notes contacts in Active Directory. 
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10.5  SMTP Routing

The following section discusses the test results when using the SMTP Routing 
Co-existence Solution between systems, as described in Chapter 9, “Using 
SMTP routing for coexistence” on page 267

10.5.1  Directory Lookups

As an initial step when sending the message, we wanted to verify that DNS 
Name lookups were working and that we were able to access the Exchange 
Directory when initially sending from the Domino to the Exchange domains. 

From Notes to Exchange
Figure 10-6 illustrates the ability to use LDAP to successfully lookup names in 
the address book. 

, 

Figure 10-15   LDAP Directory Lookup used for SMTP Routing

10.5.2  Messaging - Notes to Exchange

To test the functionality of the SMTP coexistence we sent a standard email that 
contained rich text, Attachments, graphics, a table, URL links and some domino 
doc links. In addition, we sent meeting notices. We sent the same messages 
from Notes and Outlook, copying additional recipients in the same and other 
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email systems (Exchange , Domino, Internet) to test recipent and sender address 
resolution. (See 10.1, “Methodology used for testing” on page 311). 

Rich Text fidelity testing
The following screen shots illustrate our results in Outlook. 

Figure 10-16   Received item in Outlook - Table retained formatting

Our first test was for Rich text fidelity. From Notes to Exchange we did not 
experience any corruption to the structure of the email.

• URL links where retained and worked OK

• The Table was in tact and when forwarding, editable

• All embedded Graphics where received as sent

• All rich text, colors, fonts, justification was in tact

• Attachment was received as sent
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Figure 10-17   Sections received in Outlook

Notes specific items - sections and doclinks
Our next test within the message was to embed a Notes section and send to 
multiple recipients.

• Although the data was received in tact, the section was flattened.

• All addressees received the message and all reply addresses worked 
successfully

• The attachment was received successfully by all recipients

• Address resolution worked correctly, i.e. Exchange recipients are 
resolved into flat exchange addresses whilst all other recipient 
addresses are retained as SMTP.
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Figure 10-18   Doclinks received

Our third test was to send Doclinks to Exchange. We found that the doclinks 
where received in tact, However, we where unable to take action with them as we 
did test delivery to a user that had not yet installed Lotus Notes. (This user was 
running Outlook as their client.) Accordingly, if a user had not yet installed Lotus 
Notes, when we clicked the doclink the following error (Figure 10-19) was 
received

Figure 10-19   Doclink error
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Subsequent testing revealed that once Notes was installed, the doclink did 
launch correctly, and, once the user was migrated all doclinks continued to work 
successfully.

Embedded HTML
We then sent an embedded HTML message the following was received

Figure 10-20   Received Embedded HTML

We did not find any anomalies in the received message,.

Calendaring and scheduling testing via SMTP
Finally, satisfied that our mail testing was a success, we moved onto Calendar 
and scheduling. For this we ran a simple scenario. A meeting invite would be 
created in the foreign system (Susan on Notes),the recipient (Cindy) would 
accept the meeting.

The following was the meeting notice received in Outlook.
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Figure 10-21   Meeting notice

• Meeting notices where received intact in Outlook 

• Acceptance, changing, delegation and declination all worked and the 
chair was notified in both directions.

10.6  Summary

The intent of this chapter has been to demonstrate an approach and 
methodology to co-existence testing, and to highlight key issues to be aware of 
based on your co-existence solution. Due to time and scope limitations, it was not 
possible to cover every possible variation. While we were most impressed with 
the results of CMT (Common Migration Tool) for Exchange and Domino 
Coexistence from Binary Tree, Inc. (http://www.binarytree.com ) for providing 
the best message fidelity between Notes and Exchange, we also liked the results 
from SMTP routing. Finally, while not thrilled with the overall results from the 
Exchange 2000 connectors, we were at least pleased to see that the Exchange 

Note: Subsequent testing with different versions of Outlook produced differing 
results. Not all versions of Outlook fully support the iCal standard. We 
recommend ensuring that you have the latest Windows Service pack installed. 
We also noted that Outlook 2000 not only required the latest Service pack, but 
also a hotfix only available from Microsoft support.
334 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7

http://www.binarytree.com


Draft Document for Review September 11, 2006 10:43 pm
2003 Connector provided improvements in formatting and retaining message 
fidelity between Notes and Exchange. 
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Chapter 11. Server level migration Using 
Domino Upgrade Services

This chapter offers an overview of Domino Upgrade Services “DUS” and 
provides step-by-step instructions to use the tool.

This Chapter covers the following topics:

� Overview of Domino Upgrade Services (DUS)

� Preparing for the migration process

� Migrating Exchange users and data to Domino 7

� Converting Exchange addresses to Notes Canonical format

11

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
© Copyright IBM Corp. 2006. All rights reserved. 339

http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html


7777_f_ch_server_migrating_dus.fm Draft Document for Review September 11, 2006 10:43 pm
Note: Domino Upgrade Services (“DUS”) is also commonly referred to in this 
chapter and in other documentation as the Domino Migration Tool.
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11.1  Overview of Domino Upgrade Services (DUS)

Domino Upgrade Services (DUS) in the Domino Administrator client allows you 
to easily migrate information from your existing Microsoft Exchange messaging 
and directory system to Domino 7. With DUS, you can import users from the 
foreign directory, register them as Notes users, and then convert the mail from an 
Exchange mail system to a Domino mail database. The migration tool lets you 
migrate all users from the foreign directory or select specific users to migrate.

11.2  Preparing for the migration process

Sizing the migration workstations is a critical component for the overall success 
of the actual migration. The main factors in determining the size and number of 
migration workstations are: 

� The size of the Exchange Information Stores to be migrated
� The number of users to be migrated
� The amount of time available for the migration

The actual migration process can be accomplished via several workstations at 
once, each handling a different portion of the user community. If you have a large 
number of users to migrate, with lots of data and a short timeframe, we suggest 
using several migration workstations working in tandem. This is illustrated in 
Figure 11-1 on page 342. You should use workstations that have the following 
characteristics:

� The fastest CPU

� The most RAM

� 100mb network card

� Windows 2000 or higher
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Figure 11-1   Migration with multiple workstations

Please refer to [Chapter 3 - planning for the migration] for instructions on 
planning for your migration from Exchange to Domino. 

11.3  Migrating Exchange users and their data to Domino

In this section we cover prerequisites and steps you need to take in the migration 
process. 

11.3.1  Prerequisites for performing the migration

Prior to beginning the migration, verify that your organization meets the following 
prerequisites. 

� Workstation(s) performing the migration has Domino Administrator Client 
installed

� Workstations) performing the migration has Outlook Client installed

� Have access to the Administrator ID (admin.id)

� Have access to the Certifier ID (cert.id).

� Must use the extended mail template (mail7ex.ntf) or the Domino Web Access 
(DWA7.ntf) template for all users migrated to Domino

Once these prerequisites are meet, you will need to complete the following steps:

� Create Administrator profile in Outlook

� Install Exchange as a Foreign Directory Source

Migration
Workstation

Migration
Workstation

Migration
Workstation

LAN 

MS Exchange Domino

Migration
Workstation
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� Migrate users

� Convert Exchange Addresses to Notes Canonical form

11.3.2  Creating the Administrator profile in Outlook

To migrate users from Microsoft Exchange, you must connect to the Exchange 
server storing the mail files you want to migrate. You connect to an Exchange 
server by selecting the Administrator mail profile for the Exchange server from 
which you want to migrate users and their associated mail files. The 
Administrator account, must have Administrator role for the Exchange site and 
server, which gives you full access to all accounts and all mailboxes in the 
Exchange server.

To create the Administrator profile, follow these steps:

1. Select the Outlook client icon on the desktop and right-click the mouse to 
display the menu. Note that for this example we are using the Outlook 2003 
client, but the display might vary slightly, depending on the version of Outlook 
you are using.

2. Select the Properties item, and the Mail General Tab is displayed. 

3. Click Add and the New Profile dialog is displayed Figure 11-2

Note: In our test environment, we used the default Administrator
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Figure 11-2   Mail General tab

4. In the Profile Name box, type the name of the Administrator profile for the 
Exchange server from which you are migrating data. For example type 
Administrator - Exchange Server Figure 11-3.

Figure 11-3   Profile name box

5. Click OK and the E-mail Accounts dialog is displayed (Figure 11-4). Select 
Add a new e-mail account.
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Figure 11-4   Add a new e-mail account

6. Click Next, and a dialog displays that allows you to select the server type for 
the Administrator profile. Select the radio button next to Microsoft Exchange 
Server Figure 11-5 and click Next. The Exchange Server Settings dialog is 
displayed
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Figure 11-5   Server type for administrator profile

7. In the box next to Microsoft Exchange Server, type the name of the Exchange 
server from which you are migrating users.

8. In the box next to User Name, type the name of the Exchange Administrator. 
Click Check Name, and a dialog displays requesting the password for the 
Exchange Administrator. 

9. Type the password for the Administrator, and click OK. The E-mail accounts 
dialog displays with the name of the Administrator underlined.
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Figure 11-6   Exchange Server Settings

10.Click Next. The Congratulation Screen appears Figure 11-7 on page 348
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Figure 11-7   Congratulations window

11..Click Finish and the Administrator profile is created.
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Figure 11-8   Profile created
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11.3.3  Installing Exchange as a Foreign Directory Source
Exchange is available to install as a Foreign Directory Source during the Notes 
client installation. During the setup of the Notes client, expand the Migration 
Tools option and ensure that the Exchange Migration option is enabled 
(Figure 11-9).

Figure 11-9   Installing Exchange as a foreign directory source for migration

11.3.4  Migrating users from the Exchange server to Domino
After you have satisfied the prerequisites in [Change reference] “Prerequisites for 
performing the migration” on page 342, follow these steps to migrate users and 
their associated mail stores from Exchange to Domino.

1. Start the Domino Administrator client and log on using the Domino server 
Administrator’s user ID.

2. Ensure that you are connected to the correct Domino server. From the Server 
pane of the Domino Administrator, select your target Domino server by 
selecting File → Open Server and choosing the Domino server to which you 
want to migrate the Microsoft Exchange server users.
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3. Click OK. Select the People and Groups tab, then select People from the right 
hand menu, and select Register

4. Select the Certifier ID, and Click OK Figure 11-10

Figure 11-10   Choose a Certifier

5. Enter password of your Certifier ID, and click OK Figure 11-11

Figure 11-11   Password Dialog

Note: If you have not set up a recovery ID process, a message pops up that 
warns you that the certifier does not contain recovery information. Click OK to 
continue.
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Figure 11-12   Recovery ID Warning message

6. Register Person dialog appears, Click Migrate People.

Figure 11-13   Register Person dialog

7. When the Migrate People dialog opens, select Microsoft Exchange Users 
from the Foreign Directory Source. in Figure 11-14 on page 353. 
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Figure 11-14   Foreign Directory Source

8. When prompted, select the profile of the administrator for the exchange 
server from which you are migrating, and click OK Figure 11-15

Figure 11-15   Choose Profile

9. In the Filter drop-down list, select All Users and Groups, and Click GO!
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Figure 11-16   Click GO!

10.From the drop-down list of Exchange users, select all users to migrate and 
add to the People and Groups to Migrate list (Figure 11-17).

Figure 11-17   Selecting users to migrate
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11.Select Options to modify the default settings. The options that are most 
relevant to the migration process are:

– Generate random passwords for users with no passwords

This option and the “Overwrite existing passwords with random 
passwords” option are mutually exclusive. If you select one of the options 
and then attempt to select the other, an error message appears.

– Add full name provided to the Notes person document

The User name field of a Person document lists one or more full names 
(as opposed to name components) by which a user is known in Domino. 
For a registered user, the first name listed in this field, the primary Notes 
name, is a hierarchical name based on the certifier ID used to register the 
user. This same name is checked when authenticating a user's right to 
access Domino resources

Figure 11-18   Options to modify the default settings

– Convert mail

If you choose to convert mail, during the registration process, the Domino 
Migration Tool creates a new Domino mail file for the user in question, then 
automatically converts data from the mail file on the Exchange server to 
the new Domino mail file.

– Mail files are created on the Domino server that is specified in your 
registration preferences. If the migration tool cannot create a user's mail 
file for any reason, such as though the specified mail server lacks 
sufficient disk space, the user remains unregistered, and an error is 
logged. Because mail conversion requires mail files to be created 
immediately, you cannot choose the option on the Mail pane of the 
Register Person dialog box to create mail files using a background 
process (adminp). An error message is displayed if you attempt to select 
this option.

– Add Administrator to mail file access control list

When you create a mail file for a user during migration, by default, your 
Domino Administrator ID is placed temporarily in the ACL of the new mail 
file and is assigned Manager access. After the migration completes and 
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the migrated user is successfully registered in Domino, the administrator 
ID is removed from the ACL and replaced with the name of the mail file 
owner. At this point, only the mail file owner can open the mail file.

Figure 11-19   Convert mail only - select when a user has already been registered

– Convert mail ONLY

Select this option if a user has already been registered, and a Notes .ID 
created for the user, on the Domino server. When this option is selected, in 
contrast to the Convert mail option, no mail file is created for the user in 
question. However, data from the mail file on the Exchange server is 
converted to the user’s existing Domino mail file.

12.Select Migrate Figure 11-20

Figure 11-20   Migrate

13.A successfully queued message will appear Figure 11-21, click OK.
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Figure 11-21   Successfully queued

14.Click Done, this will bring you back to the Register Person dialog.

15.In the Register Person dialog, select the Advanced check box, and then click 
the Password Options button.

Figure 11-22   Register Person Advanced

16.On the Password Option Dialog, select Set Internet Password Figure 11-23 
on page 358 and click OK.
 Chapter 11. Server level migration Using Domino Upgrade Services 357



7777_f_ch_server_migrating_dus.fm Draft Document for Review September 11, 2006 10:43 pm
Figure 11-23   Password Options dialog

17.On the Mail tab, in the Mail file template list choose Domino Web Access (7) 
Figure 11-24

Figure 11-24   Mail File Template 
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18.On the Address tab, you can control the creation of the SMTP address format 
Figure 11-25.

Figure 11-25   Address tab

19.On the ID tab, Make sure that the location for storing the user’s ID file is set to 
in Domino Directory. Also verify the Certifier information to make sure that is 
is the one you selected earlier, and click the green check mark Figure 11-26 
on page 360.

Note: We chose Domino Web Access because it gives you flexibility based on 
the client you deploy within your organization. The Domino Web Access 
template give you the ability to roll out a Notes Client, Web Client, or DAMO 
Client without having to change the mail file template. 

Note: (Optional) You may want to store the user’s ID in a file. To do this, select 
the in file option. Then set the path to where you want the ID file to be stored 
by clicking the Set ID file button,
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Figure 11-26   ID tab

20.Click the Register button to fish the registration process and complete the 
migration.

When you click Register the following takes place:

� Person Document is created

� Notes user ID is created

� Domino mail database is created

� Data is migrated from Exchange mailbox to the newly created Domino Mail 
Database on the Domino Server.

11.3.5  Converting Exchange addresses to Notes Canonical format
The Mail Convert tool converts addresses contained within the migrated Domino 
mail file from Exchange format to Notes Canonical format, to ensure that 

Note: If you have multiple users in the registration queue, you can click the 
Register All button.
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calendar entries and messages migrated to the Domino server are fully 
functional in the Notes, Inotes or DAMO client. Examples of fields requiring 
address conversion would be the From or To fields in an e-mail message, or the 
Chair or Required fields in a meeting entry. 

The Mail Convert tool only converts addresses of Microsoft Exchange users who 
exist in the Domino Directory, so all migrated users must have an entry in the 
Domino server Name and Address Book. If migration is carried out for smaller 
groups, the tool should continue to be run each time a group is migrated. Also, in 
order for the address conversion tool to successfully resolve addresses in the 
migrated mail file, the migrated users should be registered using the migration 
tool. If the users are registered individually on the Domino server, then their mail 
file data migrated from Exchange to Domino, the address conversion tool is only 
able to resolve the migrated users’ addresses successfully if the Domino 
Administrator elects to update the existing Domino user during the migration 
process.

The Domino Migration Tool tool resolves the Exchange addresses contained 
within a user’s mail file to Notes Canonical format through two stages. First, 
during the migration process fields containing Exchange addresses are replaced 
with an entry containing the user name combined with the string WTD. This string 
indicates the field needs to be converted to Notes Canonical format. For 
example, if you view a migrated user’s mail file prior to converting the Exchange 
addresses to Notes Canonical format, the address fields will contain a name 
followed by the string WTD, as shown in Figure 11-27 on page 362.

Note: WTD stands for Welcome to Domino.
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Figure 11-27   Address fields will contain a name followed by the string WTD or WTDIO

If you view the Person Document in the Domino address book for a user who has 
been migrated from Exchange to Domino, the Primary Name contains an entry 
appended with the string WTD. As with the address fields contained in the 
migrated mail file, the WTD string indicates that the user has been migrated from 
Exchange to Domino and that the Mail Convert tool needs to be run against the 
user’s migrated mail file. An example of the Person Document for a newly 
migrated user is shown in Figure 11-28 on page 363.
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Figure 11-28   Person Document for a newly migrated user

The Mail Convert tool represents the final stage of the address conversion 
process, in which the address fields in the migrated Domino mail file are replaced 
with a Notes Canonical address. 

When the Mail Convert tool is run against a migrated Domino mail file, the tool 
uses the entries in the Domino address book to resolve the address fields in the 
migrated mail file to Notes Canonical format. For example, Lisa Chase’s migrated 
mail file contains entries in the Chair field for another migrated user, William 
Chase. When the Mail Convert tool is used to convert the address fields in the 
migrated mail file for Lisa Chase, the tool uses the primary name for William 
Chase from the Domino address book to resolve the Chair field containing his 
name in Lisa Chase’s migrated mail file. The WTD string is removed from the 
Chair field and replaced with the appropriate server and domain information, 
forming a Notes Canonical address. 
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Figure 11-29 demonstrates the Chair field containing William Chase’s name 
resolved to Notes Canonical format.

Figure 11-29   Chair field containing William Chase’s name resolved to Notes Canonical format

Note: We tested mail routing without running convert. Mail routing worked. 
The difference is from an end users preceptive. If you do not run convert email 
addresses in prior emails will have an address such as: 

william chase/notesdev/ibm/com/WTD

As compared to when you run convert the address will appear as:

william chase/ibm

The key is that both values are in the person document so name resolution 
and lookup will work.
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Steps to convert addresses to Notes Canonical format
Complete the following steps to convert Microsoft Exchange addresses to valid 
Notes Canonical addresses in the migrated Domino mail file:

1. For the address conversion process to work correctly, the cache for Name and 
Address Book (NAB) entries on the Domino Server which is used for 
Exchange Mail to Domino migration must be current. Perform the following 
tasks on the Domino Server Console to make sure the cache is updated and 
current (note that it is not necessary to do perform a dbcache, because we’re 
starting and stopping the router): 

'tell router q''
'load updall <Domino Address Book>'  (e.g., 'load updall names.nsf')
'load router'

2. To perform the address conversion on all migrated mail files on the Domino 
server (in the mail subdirectory), type the following on the Domino Server 
Console:

load convert -w  mail\*.nsf [-w specifies conversion of Exchange addresses 
only]

Other available commands include those shown in Table 11-1.

Table 11-1   Additional migration commands

Command Example

load convert -w  <specific mail file path> Runs the address conversion on a specified 
migrated mail file:

load convert -w mail\chair.nsf 

load convert -w  -l <text list file path> Generates a text list file with all migrated primary 
mail file paths on the server, excluding any replica 
mail databases. You can then run the Address Fix 
by using the second command below with that text 
file:

load convert -w -l c:\tmp\mailfilelist.txt

load convert -w -f <text list file path> Runs the address conversion on all migrated mail 
files listed in the specified text file:

load convert -w -f c:\tmp\mailfilelist.txt

Note: After all users have been migrated you would run the convert.
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11.3.6  Tip

Once a user has been migrated from Exchange to Domino, this user is most 
likely now listed in three different address books.

� Domino Directory

� Exchange Directory (The directory you created during your coexistence stage 
which Directory synchronization populated.)

� Active Directory

We suggest hiding the entry from users in the Active Directory and Exchange 
Directory. This way, when an end users attempts to address a message to this 
new Domino User, only their new Domino address will appear as a choice.
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Chapter 12. Migrating local Outlook data 
using Notes Upgrade 
Services 

In Chapter 11, “Server level migration Using Domino Upgrade Services” on 
page 339, we described the process for migrating or all user mail file data 
residing on the Exchange server. In this chapter, we examine how to convert data 
stored in a local Outlook .PST (Personal Message Store) file to a local Notes 
.NSF file. The following sections outline the process for migrating a local Outlook 
.PST file using Notes Upgrade Services:

� Overview of the local migration process.

� Automating the local migration process using the Domino Administrator Client

12

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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� Manually invoking Notes Upgrade Services to migrate data.

� Troubleshooting data migration using Notes Upgrade Services
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12.1  Data migration using Notes Upgrade Services

The Microsoft Outlook client stores local mail file data, including email messages, 
contacts, tasks and calendar entries, in PST files. These files may be used in the 
Outlook client to store messages from mail accounts other than Exchange or 
Outlook (such as POP3), or for archiving a user’s Outlook mail file data. PST files 
may also be used to distribute local address books within an organization, by 
copying contacts into a local PST file and distributing among employees. After 
users are migrated from Exchange to Domino, they need to access local Outlook 
data, in addition to mail file data residing on the Domino server. This section 
outlines the use of Notes Upgrade Services to migrate a local PST file, including 
the prerequisites for using Notes Upgrade Services. 

12.1.1  Why local data migration is important

There are a number of common scenarios in which local data migration is 
necessary in the typical corporate infrastructure:

� Outlook users typical archive mail file data to a local PST file on a regular 
basis, which they need to continue accessing after they are migrated from 
Exchange and use a Domino mail client exclusively.

� Exchange data storage is generally limited by the Exchange administrator, so 
Outlook users commonly have a significant amount of mail file data stored in 
a local PST file.

� Because of the Exchange data storage limitation, users may not have the 
option of moving local Outlook data back to the Exchange server prior to 
migration from Exchange to Domino.

� For security reasons, corporations often require users to maintain access to 
historical mail file data. 

12.1.2  An overview of Notes Upgrade Services

The Domino Upgrade Services/Domino Migration Tool accesses the data store 
on the Exchange server and creates a corresponding mail file on the Domino 
server. The Domino Migration Tool is the intended tool of choice for registering 
Exchange users on the Domino server and migrating their Exchange mail file 
data for use in the Notes, Domino Web Access (DWA) or Domino Access for 
Microsoft Outlook (DAMO) clients.

Notes Upgrade Services, also referred to as the Upgrade Wizard, performs much 
of the same functionality as the Domino Migration Tool, with a few key 
differences:
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� Because Notes Upgrade Services works only with a local PST file and 
creates a local .NSF file, no servers are accessed, and no updates are made 
to the server's primary Domino Directory. While Notes Upgrade Services is 
designed to migrate Microsoft Exchange data residing locally in an Outlook 
.PST file, Notes Upgrade Services never accesses the Exchange server.

� Unlike the Domino Migration Tool, which updates the Domino server directory 
and resolves all addresses in the Domino mail file to Notes canonical format, 
Notes Upgrade Services does no address resolution. Addresses in the .NSF 
file resulting from the local migration are not resolved to Notes canonical 
format. 

� Messages, tasks and calendar entries in the .NSF file resulting from the 
Notes Upgrade Services migration are not intended to be fully functional in 
the Domino mail clients. The .NSF file should be used for reference purposes, 
and we do not recommend that users replicate the local .NSF file with their 
Domino server mail file. If users replicate the local .NSF file with their server 
mail file, they will be unable to reschedule meeting invites or respond to email 
messages originating in the locally migrated .NSF file. 

12.2  Preparing the workstation for local migration

Whether you choose to perform migration with Notes Upgrade Services using the 
manual method or by automating the process, each client workstation where 
data will be migrated locally needs to meet the following prerequisites:

� Lotus Notes 6.5.1 or later must be installed with the Exchange Migration 
component

� The Microsoft Outlook client must be installed on the workstation.

� You must use the Extended Mail Template (Mail7ex.ntf) or iNotes Template 
(iNotes7.ntf) for all migrated .NSF files

� You must create a Microsoft Outlook profile associated with the local Outlook 
.PST file

12.2.1  Installing the Exchange Migration Component for Lotus Notes

During the setup of the Notes client, you must install the Exchange Migration 
component of the Migration Tools. This option installs the Notes Upgrade 
Services functionality. In the Install Wizard dialogue during the Lotus Notes 
installation, expand the Migration Tools option and ensure that the Exchange 
Migration option is enabled, as illustrated in Figure 11-1.
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Figure 12-1   Installing Domino Migration Tools

12.2.2  Creating a Microsoft Outlook Profile

Before you can migrate the local Outlook .PST file using Notes Upgrade 
Services, you must create a Microsoft Outlook profile associated with the local 
.PST file. Follow these steps to create a new Microsoft Outlook Profile and attach 
a personal folders file to it:

1. From the Start menu on the desktop, select Settings → Control Panel to 
display the Mail shortcut. Note that for this example we are using the Outlook 
2003 client, but the display may vary slightly depending on the version of 
Outlook you are using.
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Figure 12-2   Creating a new Outlook profile: Control Panel

1. Open the Mail shortcut to display the Mail Setup dialogue, shown in Figure 
11-4.

Figure 12-3   Creating a new Outlook profile: Show Profiles
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2. Click on the Show Profiles button and the Mail dialogue will be displayed with 
a list of all the Outlook profiles that exist for the Outlook client.

Figure 12-4   Add an Outlook profile

3. Click on the Add button and the New Profile dialogue will display Figure 12-4. 
In the Profile Name box type a name for the new profile.(Figure 12-5).

Figure 12-5   Type a name for the new Outlook profile

4. Select the OK button to display the Email Accounts dialogue, illustrated in 
Figure 11-7.
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Figure 12-6   Creating a new Outlook profile

5. In the E-mail Accounts dialog select the View or change existing e-mail 
accounts radio button and click Next > to display the E-mail Account 
dialogue, shown in Figure 11-8.
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Figure 12-7   Select an Outlook Data File

6. Click the New Outlook Data File button and the New Outlook Data File 
dialogue will display, as illustrated in Figure 11-9.

Figure 12-8   Select the type of Outlook .PST file

7. Select the appropriate version for this .PST file and click OK. The Create or 
Open Outlook Data File window shown in Figure 11-10 will display.
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Figure 12-9   Select the Outlook .PST file to migrate

8. Navigate to the .PST file you want to migrate and select OK to display the 
Personal Folders dialogue displayed in Figure 11-11.
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Figure 12-10   Personal Folders dialog

9. Click the OK button and the E-mail Accounts dialogue shown in Figure 11-12 
will display with the New Outlook Data File field populated with the .PST file 
selected in Step 8.
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Figure 12-11   E-mail Accounts dialog displaying the .PST file

10.Click Finish to display the Microsoft Office Outlook dialogue shown in Figure 
11-13.

Figure 12-12   Confirm the Outlook profile creation

11.Click OK and the Outlook profile will be created with the Outlook .PST file 
linked to it. The Mail dialogue illustrated in Figure 11-14 will display with the 
newly created profile in the Profiles list.
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Figure 12-13   Newly created Outlook profile

12.3  Automating Notes Upgrade Services

Notes Upgrade Services is most commonly invoked by an automated process 
configured by the Domino Administrator. Using the Domino Administrator client, 
the Domino Administrator sends an automated email message to all users who 
need to migrate a local Outlook .PST file. This email message contains a button 
which when clicked by the user starts Notes Upgrade Services on the user’s 
workstation. Before initiating Notes Upgrade Services from the automated email 
message, the user must meet all of the prerequisites outlined in [Section 11-2].

12.3.1  Automating a message to initiate Notes Upgrade Services

This section outlines the process by which the Domino Administrator can create 
an automated message delivered to all users who need to migrate a local 
Outlook .PST file using Notes Upgrade Services. Follow these steps to create a 
message that will initiate Notes Upgrade Services on the user’s workstation, 
using the Domino Administrator Client:

1. Start the Domino Administrator client and log on using the Domino server 
Administrator’s user ID
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2. Ensure that you are connected to the correct Domino server. From the Server 
pane of the Domino Administrator, select your target Domino server by 
selecting File → Open Server and choosing the Domino server on which the 
users reside who will receive the automated email message.

3. Click OK. Select the People and Groups tab, then select People from the right 
hand menu, and select Upgrade, as shown in Figure 11-14.

Figure 12-14   Domino Administrator: Upgrade people

4. The Upgrade Notification window will be displayed, as illustrated in Figure 
11-15.
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Figure 12-15   Upgrade Notification: Basics tab

5. Select the Basics tab and click the radio button next to Convert local 
cc:Mail/MSMail/MSExchange data. This will display the Software 
Notification and Mail Conversion tabs, shown in Figure 11-16. If you would 
like to be notified when each user completes their mail conversion, select the 
radio button next to Yes under this section.
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Figure 12-16   Upgrade Notification: Basic, Software Distribution and Mail Conversion tabs

6. To select a user or group to send the upgrade notification, click the Address 
button at the top of the window to display the address book for the Domino 
server you have selected. Select the user or group to whom you would like to 
send an upgrade notification. For this example, we have selected a single 
user, as illustrated in Figure 11-17.
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Figure 12-17   Select the user or group who will be sent an upgrade notification

7. Click the OK button and the To: field in the Basics table will be populated with 
the address or group you selected, as shown in Figure 11-18.
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Figure 12-18   Upgrade Notificaton: Basics tab completed

8. Select the Mail Conversion tab. In the list box under the Mail Conversion 
Options section, you can choose the type of migration to automate by 
selecting the arrow next to the drop-down list. A list of options will display, as 
illustrated in Figure 11-19.
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Figure 12-19   Mail Conversion Options tab: select the migration type

9. Since you are sending users an automated message to initiate the Notes 
Upgrade Services process, select MSExchange from the list box, then click 
the OK button. The ‘Convert user from’ field will be populated with 
MSExchange, as shown in Figure 11-20.
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Figure 12-20   Upgrade Notification: Mail Conversion tab completed

10.Once all options have been configured for the upgrade notification, click the 
Send button, as illustrated in Figure 11-21. This will send an email to the user 
you selected, enabling the user to initiated Notes Upgrade Services to 
perform local conversion of an Outlook .PST file.

Figure 12-21   Sending the Upgrade Notification

12.3.2  Initiating Notes Upgrade Services from an automated message

To initiate Notes Upgrade Services from the upgrade notification message, the 
user should follow these steps:
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1. Open the Lotus Notes client and display the Email Inbox. The Inbox should 
contain a message with the subject “Upgrade from MSExchange to Notes 
mail”, as shown in Figure 11-22.

Figure 12-22   Upgrade notification in the user’s inbox

2. Open the message, as illustrated in Figure 11-23, and notice the button titled 
Convert My Local Data to Notes. 
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Figure 12-23   Upgrade Notification: Convert My Local Data to Notes

3. To initiate Notes Upgrade Services, click the button titled Convert My Local 
Data to Notes. The window shown in Figure 11-24 will display. Follow the 
instructions in 12.4.1, “Starting the Migration” on page 390, beginning with 
Step 4, to migrate your local Outlook .PST file using Notes Upgrade Services.
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Figure 12-24   Starting Lotus Notes Upgrade Services from the Upgrade Notification

12.4  Manual migration using Notes Upgrade Services

While Notes Upgrade Services is most commonly initiated from an automated 
email message sent by the Domino Administrator, there are a number of 
situations in which users may manually perform a local migration using Notes 
Upgrade Services. Following are some of the scenarios in which it is appropriate 
to perform a manual migration from an Outlook .PST file to a Notes .NSF file 
using Notes Upgrade Services:

� After a company acquisition, all users in the newly acquired company are 
migrated from Exchange to Domino, though their mail and calendar data is 
not migrated, and no provisions are made for migrating users’ data from their 
local Outlook .PST files. In order to access historical data from the Notes 
client, individual users must manually migrate their data using Notes Upgrade 
Services.

� Due to the storage limitations of the Exchange server, users may have a 
number of local Outlook .PST files containing archived data. After their 
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Exchange mail file data is migrated to Domino, they still need access to their 
archived data from the Notes client. 

� A user may join a company that operates with a Notes and Domino IT 
infrastructure, but this user has a local Outlook .PST file that he needs to 
access from his Notes client. This is a likely scenario in the case of a newly 
hired executive, who needs to access historical Outlook data, particularly 
contacts. In this case, the Domino Administrator will not institute an 
automated Notes Upgrade Services migration for the executive, but rather the 
executive or an assistance will need to perform the migration manually.

12.4.1  Starting the Migration

Follow these steps to perform a manual migration from an Outlook .PST using 
Notes Upgrade Services: 

1. At a command line prompt, change to the Notes Client program directory, 
where the executable file for Notes Upgrade Services is located. During the 
Notes Client installation, this executable file will be installed to “c:\Program 
Files\Lotus\Notes” by default. The command prompt should appear as 
follows:

c:\Program Files\Lotus\Notes>

2. To initiate Notes Upgrade Services from the command prompt, type 
“Nupgrade 3”, as illustrated in the following example:

c:\Program Files\Lotus\Notes>Nupgrade 3

3. Press Enter and the Notes Upgrade Services will display, as shown in Figure 
11-23.
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Figure 12-25   Notes Upgrade Services

4. Click the Next button and the Notes Upgrade Services dialogue prompting 
you for an Outlook profile will display, shown in Figure 11-24. 

Figure 12-26   Notes Upgrade Services: select an Outlook profile
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5. Select the Outlook profile associated with the Outlook .PST file you wish to 
migrate using Notes Upgrade Services, then click the Next button to display 
the dialogue box illustrated in Figure 11-25.

Figure 12-27   Notes Upgrade Services: select the upgrade

6. Select the upgrade method by selecting the appropriate radio button. The 
Express method will migrate all e-mail, calendar, task and contact elements 
from the Outlook .PST file to a Notes .NSF file. The Custom method, shown in 
Figure 11-26, allows you to migrate either all elements in the Outlook .PST 
file, or Personal Folder, or to migrate only contacts
392 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777_f_ch_client_migrating_dus.fm
Figure 12-28   Upgrade Options: Custom

7. We recommend choosing the Express method to migrate all data in the 
Outlook .PST file, as illustrated in Figure 11-25. Click the Next button to 
display the dialogue shown in Figure 11-27, where you will specify the 
conversion options for Notes Upgrade Services.

Figure 12-29   Notes Upgrade Services: Conversion Options
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8. As outlined in Section 11.2, you must use the Extended Mail Template 
(Mail7ex.ntf) or iNotes Template (iNotes7.ntf) for all migrated .NSF files. In the 
Template name field, select one of these templates by clicking the button next 
to the Template Name field and navigating to the directory where it is located 
on the local workstation, as shown in Figure 11-28.

Figure 12-30   Select the mail7ex.ntf or iNotes7.ntf template

9. Select the location where you would like to save the Notes .NSF file resulting 
from the Notes Upgrade Services migration from the local Outlook .PST file. 
Click the button next to the Folder field and navigate to the directory where 
you would like to save the migrated filed, as shown in Figure 11-29.
394 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777_f_ch_client_migrating_dus.fm
Figure 12-31   Choose a location for the migrated .NSF file

10.The results of the Notes Upgrade Services migration will be written to an 
.NSF file, a_PersonalFolders.nsf, in the location you selected in Figure 11-29. 
Notes that subsequent local migrations using Notes Upgrade Services will 
append this file, unless you change the location where the migrated file is be 
stored. If you are migrating several local Outlook .PST files, it may be useful to 
allow Notes Upgrade Services to append a_PersonalFolders.nsf so that all 
locally migrated Outlook data is located in the same .NSF file.

Figure 11-30 displays the Notes Upgrade Services dialogue populated with 
the template selection and personal folder location.
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Figure 12-32   The template name and folder have been selected

11.Click the Next button and you will be prompted to begin the upgrade process, 
as illustrated in Figure 11-31. If you would like change your folder conversion 
options, click the Previous button to return to the previous dialogue shown in 
Figure 11-29.

Figure 12-33   Notes Upgrade Services: Ready to begin upgrade
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12.Click the Finish button to begin the migration using Notes Upgrade Services. 
The dialogue illustrated in Figure 11-32 will display, indicating the migration 
process is in progress.

Figure 12-34   Notes Upgrade Services: Upgrade in progress

13.You will be prompted, as illustrated in Figure 11-22, to enter the password 
associated with your Notes .id. The Domino Administrator should have 
supplied you with a Notes .id file in preparation for installing the Notes Client. 
If you do not have a Notes .id file, please see your Domino Administrator.

Figure 12-35   Enter the Password for your Notes .id

14.Enter your Notes .id password, then click the OK button and the migration 
process will continue. When the migration is finished, the dialogue illustrated 
in Figure 11-34 will display.
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Figure 12-36   Notes Upgrade Services: Upgrade completed

15.You may now open the results of the Notes Upgrade Service migration, 
located in the file a_PersonalFolders.nsf, from the Notes Client.

12.5  Troubleshooting Notes Upgrade Services

In some cases, the local .PST file being migrated may contain problematic data 
which can’t be properly migrated using Notes Upgrade Services. If this occurs, 
you will be presented with the dialogue displayed in Figure 11-35, informing you 
that the upgrade process completed with warnings or errors.

Figure 12-37   Notes Upgrade Services - Warning

When warnings or errors are returned by Notes Upgrade Services, they are 
written to a log file, log.nsf, located in the data subdirectory of the Notes Client 
install directory. A sample log.nsf file, shown in Figure 11-38, displays the 
messages returned by Notes Upgrade Services.
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Figure 12-38   Notes Upgrade Services - Log Entry in the log.nsf file

The entries in the Notes Upgrade Services log file provide information about 
what processes executed during the migration processing, and any failures 
during the processing. These entries can help you determine whether the 
Outlook .PST file contains faulty data that can’t be accessed during migration 
processing, and can be particularly useful for the IBM support teams if you report 
a problem with Notes Upgrade Services. 

In general, if Notes Upgrade Services returns a warning but the migrated data 
contained in the local .NSF file appears correct, there is no need to take action. 
However, if Notes Upgrade Services returns an error, we recommend the 
following actions:

� Attempt to repair the Outlook .PST file by using a data repair tool to fix the 
problems that may exist with the Outlook data. 

� If the Outlook data repair is successful, delete any existing .NSF file 
(a_PersonalFolders.nsf) created during the failed Notes Upgrade Services 
processing. If the Outlook data repair is not successful, contact your system 
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administrator for assistance with troubleshooting the erroneous Outlook data 
file.

� Repeat the steps outlined in Appendix 12.4.1, “Starting the Migration” on 
page 390
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Chapter 13. Server Level Migration 
process using CMT from 
Binary Tree

This chapter provides detailed instructions for setting up the Binary Tree 
Common Migration Tool (CMT) and using it to migrate users from Microsoft 
Exchange to Lotus Domino, from server to server. We explain in detail the setup, 
usage, and on-the-fly configuration, followed by some examples of the expected 
results obtained when using the tool. The procedure to perform the client 
migration using the same tool is detailed in Chapter 14, “Local Data Migration 
using the Binary Tree tools” on page 439.

13

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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Depending on your migration scenario, you may have to combine both 
procedures and set up the server and client migration parameters 
simultaneously.
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13.1  What is Common Migration Tool
The Binary Tree Common Migration Tool (CMT) migrates data from one e-mail 
system to another. While the tool can be used to migrate from numerous e-mail 
systems to Lotus Notes, the focus of this chapter is to describe its capabilities in 
migrating from Exchange 2000/2003 (and Outlook) to Lotus Notes and Domino 
7.

Like Domino Upgrade Services, the CMT has the ability to migrate both 
server-based data and end user-based data. The results of both server and end 
user migration are presented in Chapter 15, “Migration Results” on page 467.

During our testing we found that the CMT provides:

� Easy setup

� Good control and selection of data to migrate

� Usable logging of status at each stage of the migration process

� Good failover when encountering errors, including: 

– Usable references to reason of failure

– Ability to continue with further migration requests

� Ability to trigger and restrict end user migration, that is, where, how. and when

� Ability to migrate public folders (separate migration tool)

13.2  Installation
The CMT tool is physically a Domino database. All administration and 
configuration tasks are conducted within this database. It is good practice to 
install the CMT databases into a subdirectory, preferably called CMT, of the 
Notes data directory of the Domino Server.

Prerequisites
The following prerequisites should be in place to ensure that the migration 
process is as smooth as possible: 

� A Lotus Domino server 7 or higher

� A workstation with Lotus Notes 7 or higher

Important: For end user migration the CMT database needs to be installed on 
the Domino server rather than on the client. However, you can replicate it to a 
local workstation and work from there.
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� A Notes Client with an ID file that is a member of the administrators group and 
that has appropriate access to the Domino server.

– If the ID to be used is not the administrator, grant the ID Editor access to 
the certification log database.

– Also ensure the ID has been granted Editor access, along with the group 
and the roles of GroupCreator, GroupModifier, UserCreator, and 
UserModifier to the Domino Directory for the organization.

– Add the ID to the Access Server field in the Domino Directory for all 
servers to which CMT will be migrating data.

– The ID should also sign all design elements of the CMT database through 
the Domino Administrator Client.

For server-to-server migration:

� In the case of already created mail databases, the ID used for migration 
should have full Manager access to all target Lotus Notes mail databases.

� Ensure a version of Outlook is installed, on the workstation running CMT, with 
a profile that has Administration privileges to the Exchange servers that data 
will be migrated from.

13.2.1  Set up the licenses

Before you can start to use the migration tool to migrate users, you need to install 
the license key. The licensing is per user and is not dependent on either the 
source or target mail system.

1. Open CMT by selecting from the databases folder or use: 

File → Database → Open (or Ctrl+O) and entering the file location (that is, 
data\CMT\cmt.nsf).

2. Select License information. This opens the License Information document.

3. Click Enter License Key and click Yes to accept the CMT agreement terms.
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Figure 13-1   License information document of CMT database

4. Enter the license key provided by Binary Tree and click OK (see Figure 13-2).

Figure 13-2   Enter license information

5. Close the CMT License Information document.

13.2.2  The five steps to migration with CMT

Binary Tree recommends the following five high-level steps to use the migration 
tool for setup and migration of users.

1. Configure CMT settings

2. Add users from foreign directory source

3. Select users for migration

4. Migrate server data
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5. Migrate local user data (if and when appropriate depending on your 
messaging client)

In the following sections we describe these steps in detail, except for Step 5 
which is covered in Chapter 14, “Local Data Migration using the Binary Tree 
tools” on page 439. Although manual configuration and migration is possible, for 
this discussion we have used the CMT wizards in each case. The CMT wizards 
are useful aids in setting up a migration, particularly for the first time user of the 
tool, since they help you determine which information is needed based on the 
type of migration that you intend to do. When you open the database, the 
following wizard buttons are located at the top of the screen: 

� Configure EU Settings
� Add Users
� Server Migration
� End User Migration

Figure 13-3   Binary Tree CMT main window

You can move forward and backward through most of the screens by clicking the 
Next and Back buttons located at the bottom right-hand corner of the screens. 
There is also a Cancel button in that corner.
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13.3  Set up CMT and migrate users

13.3.1  Configure CMT settings
The first stage of the migration is to configure the CMT tool by providing 
information on both the target and source mail systems. 

1. Open the Database and click Configure EU Settings (Figure 13-3 on 
page 406). You will be presented with the main source mail system selection 
screen shown in Figure 13-4. By default, all supported mail systems are 
selected; you will need to deselect the mail systems not required, leaving you 
with the mail systems you wish to migrate from.

Figure 13-4   Source and target mail system selection 

2. When you have only the correct source mail systems selected click Next. 
Lotus Domino is selected as the target mail system by default.

3. Now you are required to enter information on the Domino mail system, such 
as the default directory server (using either the canonical format or the 
abbreviated hierarchical name), and the Domino directory filename (see 
Figure 13-5 on page 408). In addition, specify if the mail database is to be 
migrated in the current mailbox on the server, or locally into a separate mail 
database with the filename of your choice. Select the appropriate Mail 
Template Version to be used when creating the new mail boxes. Click Next to 
proceed.

Note: Although no messaging client is selected in our example, you may 
decide to select the appropriate messaging clients to migrate from.
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Figure 13-5   Domino Directory settings

4. The Outlook and Exchange settings dialog is where you provide information 
on the Outlook and Exchange systems, such as default migration contents. 
The settings dialog provides the following options:

Note: If you choose to migrate to a new local copy, the local mail database 
should be created before you start migrating. See Chapter 14, “Local Data 
Migration using the Binary Tree tools” on page 439.
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Figure 13-6   Outlook and Exchange settings

– Message types to migrate

The CMT tool lets you select which message types are migrated. For 
example, you could choose to migrate mail messages but leave calendar 
entries untouched. As can be seen in Figure 13-6, we opted to migrate all 
data. However, you may decide that not all data is relevant for migration, 
so you can refine the selection.

– Message stores to migrate

• Migrate Exchange server data

The user's mailbox and data are on the Exchange server. When you 
migrate Exchange server data, the user's mail and folder structure 
saved on the server will be migrated. When you choose to migrate 
Exchange server data, you also have the option to migrate shared 
Exchange mailboxes. A shared Exchange mailbox is used by more 
than one user. To migrate shared Exchange mailboxes, select the 
Migrate Shared Exchange Mail Boxes check box (see below for further 
information and advices.)

• Migrate personal folder data

The data are local to the users's machine or stored on a network drive. 
They are in the form of a. PST file. This data is not stored on the server. 
If there is more than one. PST file, CMT will migrate all of them.

• Migrate personal address book data

The data are local to the user's machine or stored on a network drive. 
They are in the form of a. PAB file.
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You may also decide that the only data you want to migrate is calendar, 
messages, and contacts. Later, during the selection of users for 
migration step, you have the ability to further refine the data selection 
by changing from the defaults and adding date ranges, so as not to 
migrate older data.

– MAPI profile to use

Unless you have created a single/default MAPI profile with administration 
access, you should select Let users choose profile to ensure that a profile 
with sufficient privileges for logging into Exchange can be chosen.

– Migrate shared Exchange mail boxes

The option to migrate shared mail boxes should be used with caution since 
this data is used by more than one user, and is only available if you have 
chosen to migrate Exchange server data. When this option is selected, the 
shared data will appear in each user’s mailbox. It may be more appropriate 
to create a mail-in database into which to migrate the shared data, and 
giving the users that require it access.

– Migrate to Notes systems folder

Data from Exchange, by default, will be migrated by the CMT tool into the 
top-level folder in Notes. The Exchange/Outlook folder structure will be 
retained. All of the users' Exchange folders will be placed under this 
top-level folder, and the relevant data/mail messages will be stored within 
them. Thus within the Notes user’s mail database they will have separate 
folders for their Notes data and old Exchange data.

By selecting Migrate to Notes system folders, data within the Exchange 
system folders (Inbox, Sent Items, Drafts, and Deleted Items) will be 
migrated directly into the equivalent Notes system folders (Inbox, Sent, 
Drafts, and Trash). All other non-system Exchange folders will be migrated 
to Notes. In other words, the folders will appear under the Notes root-level 
folder structure and not under an Exchange top-level folder. See 
illustrations in Table 13-1 on page 411 for a comparison of the option 
selection.
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Table 13-1   Comparing the folder migration options

When you have completed your selections, click Next and you will be 
presented with the next settings screen (Figure 13-7 on page 412).

Folders migrated to Exchange Mail folders 
(default selection from Figure 13-11 on 
page 415)

Migrate to Notes system folders option 
selected (from Figure 13-11 on page 415)

Note: The figures above illustrate where the migrated folders and the 
corresponding content can be found depending whether the Migrate to 
Notes system folders option is selected. (By default, the top-level folder 
name is Exchange Mail, but can be changed to suit your requirements as 
shown in Figure 13-11 on page 415.)
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5. The final settings dialog allows you to provide information on top-level folders 
in the Exchange mail clients. If you did not select Migrate to Notes system 
folders (Figure 13-5 on page 408), all data migrated from Exchange will be 
migrated under the top-level folder named. 

You also have the option to select which message classes to migrate. A 
message class is how a note is stored in Exchange. To specify which 
message classes to migrate, type in the message classes separated with a 
semicolon (;). A semicolon must also follow the last message class entered. 
To have all message classes and rich text migrated, use an asterisk (*); this 
will reset message classes to default. The defaults are:

IPM.Note.RFC822.MIME;IPM.Note.RFC822; 

Click Next and you will be presented with the settings completion screen.

Figure 13-7   Top-level folder settings

6. Click Finish and you will be returned to the CMT Database main view.

13.3.2  Add users from foreign directory source

When you have completed the configuration, you need to add users from the 
foreign directory into the CMT database before you can register them.

When users are not registered to the Domino directory, you must import them 
from a non-Domino directory, i.e. a foreign directory. You can import users from a 
foreign directory for either an end-user or server-to-server migration. The names 
of the users can be imported from a text file or an Exchange server.

Note: It is possible to select pre-registered users from a Domino database.
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1. To add users into the CMT migration database, click the Add Users button 
and launch the corresponding wizard.

Figure 13-8   Select Add Users button

We opted to select our users for migration from Active Directory since our 
Exchange users are not registered to the Domino directory. Therefore we 
selected Import from Foreign Directory Wizard (Figure 13-9);

Figure 13-9   Select directory source

2. Click Run Wizard. You will be presented with a screen where you select the 
source systems to import the users from (Figure 13-10).
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Figure 13-10   Select directory import source

We selected Exchange as the source system for directory information. The 
target Domino server and directory have been acquired automatically from 
the configuration information provided earlier. If the intended destination 
server is different, it is possible to change it now. Select the mail template 
version 7.0.

3. Click Next. The Exchange input parameters screen will be displayed 
(Figure 13-11).
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Figure 13-11   Exchange input parameters

Here you have the option to specify the settings for the migration of users 
from the identified directory source, and override the default parameters set 
earlier.

– Select the type of data to migrate from the following choices:

• Mail items: All e-mail messages a user has received.

• Calendar items: A user's calendar items. When reoccurring 
appointments in Outlook do not have a reoccurring end date, a 
reoccurring end date will be created for them that is five years past the 
current year. For example, an appointment is on August 1, 2002, and 
reoccurs yearly, but does not have a reoccurring end date. It will 
migrate to Notes as the same appointment, but with a reoccurring end 
date of August 1, 2011 (with a migration performed on August 1, 2006).

• Journal: Journal entries made by a user.

• Task items: All tasks a user has entered.

• Contact items: Contacts in the user's address book.

• Note items: All notes a user has made.

– CMT can migrate the folder structure from the source, as well as the data 
contained within. If you enter a top-level folder name here, all migrated 
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data will be located in that folder structure, separate from the standard 
Notes folders. In our example we used Exchange mail. We would therefore 
expect that the folder structure and its contents from Outlook will be placed 
here in the migrated user’s mail file, unless we select Migrate to Notes 
system folders (see “Migrate to Notes systems folder” on page 410 and 
Table 13-1 on page 411).

– Select to use either the alias or name value when logging into Exchange:

• If you select Alias, CMT will use the unique ID for each user to access 
each user’s mail store. Using the alias is recommended because it is 
unique to each user.

• If you choose Name, CMT will use the user’s last name, first name, and 
middle initial to access the mail store. This is not recommended 
because the incorrect mail store could be accessed when users have 
similar names.

– If you want rich text format (RTF) data to be migrated, click the check box 
next to Migrate Rich Text Format (RTF) when available.

– If you select Create Exchange distribution lists in Domino Directory at 
registration time, you are telling CMT that you want it to create the 
distribution lists in which the individuals being registered by CMT belong. 
(An additional dialog box appears during this preliminary phase. See 
Figure 13-28 on page 426.)

– If you select Attempt to resolve names, CMT will attempt to resolve 
names in the contacts list and e-mails to the counterparts in the Domino 
directory.

– As per recommendation, we used the alias profile for logging into 
Exchange. 

4. Click Next. The screen returned gives you the option of further limiting the 
amount of data that will be migrated by specifying date ranges for several 
types of data (Figure 13-12 and Figure 13-13 on page 417). 
Also, you may define rules for a finer tuning (Figure 13-14 to Figure 13-20 on 
page 421).

Note: The groups will be migrated only when the individuals are registered 
to the Domino directory with CMT. If individuals are not registered with 
CMT, the groups to which they belong will not be created. 
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Figure 13-12   Exchange input parameters filter

Figure 13-13   Exchange input filter with date range selected
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Specify start and end dates. Only the data within the specified range will be 
migrated to Domino.

5. Make your data selections and click Next.

How to define migration rules
If you select Use rules (Advanced), you are asked to specify a number of 
additional parameters, as described thereafter (Figure 13-14 onwards).

� Click Edit Rules.

Figure 13-14   Defining migration rules

� Select the appropriate options as required to match your server-to-server 
migration requirements.

As an example, you can decide to migrate mails received from January 1, 
2000 to December 31, 2005 into an archive, with all mails received from 
January 1, 2006 moved into the active mail file. Mails received before January 
1, 2000 are not migrated. Additionally, all appointments within the same date 
ranges will be migrated to the same databases accordingly.
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Figure 13-15   Defining a server-to-server migration rule

� Click Insert Rule to validate your rule settings.

Figure 13-16   Defined server-to-server migration rule

� Select your next set of mail parameters and click Insert Rule.
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Figure 13-17   Adding an additional server-to-server rule

� Select the appointment migration parameters.

Figure 13-18   Defining Appointment migration rule
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Figure 13-19   Set of migration rules before validation

� Once you are done with your set of rules, click OK.

Figure 13-20   Defined set of migration rules

� Click Next to proceed with the Add Users configuration settings.
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6. You are presented with the Exchange User Filter screen (Figure 13-21). The 
options are: 

a. Select all users in GAL

b. Select GAL users from list

c. Select only users from one Exchange Home Server

If you select a particular server you are required to specify the name, and 
only users from this server will be available for selection.

Figure 13-21   User selection options

The other two options are to import the entire GAL or to select from currently 
imported users. If this is the first time you are doing the migrations, you should 
opt for Select all users in GAL. 

Rather than import all the users, and to show additional options, we opted to 
select users from the GAL. 

7. Click Next to proceed.

Note: The purpose of Import of users is to create CMT person documents 
in the cmt database that will be used for registration and migration. This 
does not add users to the Domino Directory.
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Figure 13-22   Exchange User Selection

Depending on the option taken, you are presented with either the Exchange 
User Selection screen (Figure 13-22) or the Import Users screen 
(Figure 13-29 on page 426). If you selected to import all users, go to step 14 
on page 426. 

8. Select the Build Exchange user list. You are requested to select a MAPI 
profile (Figure 13-23). Ensure you have set one up as mentioned in the 
“Prerequisites” on page 403. If not, you will have to cancel, build the profile, 
and start the Add Users wizard again.

Ensure the selected profile has administrator privileges. Otherwise, you will 
not be able to access either the Global address list or, during migration, the 
user data to migrate.

Figure 13-23   Select MAPI profile
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9. Click OK to select the profile. You are prompted for a password. If you are not 
logged into the NT Domain you are presented with a window asking for the 
logon credentials for the Domain. Enter the required information and click OK. 
Importing users batch starts.

A status screen is displayed while the import is running. An example of this 
screen is in Figure 13-24.

Figure 13-24   User import status window

When the import has completed you are presented with a screen informing 
you of the number of successfully imported users. 

Figure 13-25   User import confirmation

10.Click OK.

11.You will return to the select users screen, similar to the one shown in 
Figure 13-22 on page 423. This time, click Select users from Exchange user 
list. You are be presented with a list of users, as illustrated in Figure 13-26.
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Figure 13-26   Selecting users to import

Figure 13-27   Selecting users and distribution lists to import

Note: If you selected to import distribution lists (see Figure 13-21 on 
page 422), the selection dialog box appears as shown on Figure 13-27.

Distribution list
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12.Select the users to import and click OK. The users will be added to the import 
list.

13.If you selected to import distribution lists (see Figure 13-21 on page 422), the 
screen shown in Figure 13-28 on page 426 will be displayed. Specify settings 
related to the importing of the distribution lists and click Next. (In our example 
we are using the same database where the Exchange users are listed and the 
group names identified with the EXC prefix.????)

Figure 13-28   Distribution list migration

14.The final step is to import users into the CMT database. Click the Import 
Users from Exchange button (Figure 13-29). 

Figure 13-29   Import users
426 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm
15.When the import is complete you are presented with a message box 
informing you of how many users have been successfully imported 
(Figure 13-30).

Figure 13-30   Imported users message

16.Click OK.

17.The Import users screen remains on your screen. Click Next.

18.A message appears informing you that you have finished importing users. 
Click Finish and you are returned to the database main view.

Figure 13-31   Finished Importing users screen

You can verify that the users you have just imported are ready for registration into 
the Domino directory from the Registration view or the Server Migration view.
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Figure 13-32   Imported users ready for registration

13.3.3  Select users for migration

The next task is to select and register users.

1. Click Add Users (as in Figure 13-8 on page 413); you are once again 
presented with the user migration setup screen.

2. This time, select Register to Domino Directory Wizard in the Add Users 
dialog. Click Run Wizard to start. (Figure 13-33).

Figure 13-33   Select registration wizard

3. The registration settings screen is presented (Figure 13-34).

Note: This task is not necessary for any of your users who are already 
registered in the Domino server.
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Figure 13-34   Registration settings: Screen 1

4. Complete all the fields, following these guidelines: 

a. It is advisable to enter the server’s IP address. 

b. In a single server environment the mail server, template server, and 
registration server will be the same. This may or may not be the case in a 
multi-server scenario. Ensure you enter the correct server names in the 
fields.

c. The standard mail template file for Domino 7 is Mail7.ntf.

d. We recommend that you select the unlimited filename format.

e. If it is required (mostly during the pilot project), add the mail administrators 
group in the administrators field. This will add the mail administrators 
group to the ACL of the mail databases. Remember to remove this once 
you start your full deployment!

Tip: The filename format setting controls the format of the shortname. 
Specifying Unlimited will use the shortname (which is unique) as the name 
of the user's mail file. 8.3 will set a mail file name that is eight characters 
long; If 10.3 is chosen, then it will be 10 characters long. 
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f. In the Local Admins field enter the names of the administrators or groups 
who should have administrator access to users' person documents in the 
Name and Address Book (NAB) after they are registered. The format 
should be: administrator's name/mail server. Separate each administrator 
with a comma (,). The default is the localadmins group.

g. You also have the option to generate a random password or use a default 
one. If you select default, be sure to enter a password in the default 
password box.

h. Set the complexity of the password that users must use when changing 
the password. Values range from 0 (weak) to 16 (complex).

i. If you want to create an internet password for the user, select the Set 
internet password box.

5. Click Next to proceed to the second registration settings screen.

6. Enter the location of the certification ID, the certification log, select the 
relevant security type, and complete all other fields. You also have the option 
of adjusting the format of the Internet address to be created and the location 
to store the created ID file.

Figure 13-35   Registration settings: Screen 2

7. Click Next, you will be prompted for the certifier ID password.

8. Enter the password and click OK. The Select People screen appears.

Attention: Passwords are saved in the CMT person document.
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9. Click the Select Users button. You are presented with a list of users flagged 
ready for registration from the CMT database. Select the users you wish to 
register.

Figure 13-36   Select users for registration

10.When you have selected all the required users, click OK to close the dialog, 
then click the Register Users button (Figure 13-37). The selected users will 
now be registered.

Figure 13-37   Run registration

11.You will be prompted to supply the certifier ID password.
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Figure 13-38   Certifier password prompt

A status bar is displayed during registration (Figure 13-39), followed by the 
completion message (Figure 13-40). Take note of and follow up on any errors. 
For further assistance in case of errors, refer to “Troubleshooting the 
migration” on page 436.

Figure 13-39   Registration status
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Figure 13-40   Registration complete

13.3.4  Migrate server data

Once you have registered users and selected them for migration, you are in a 
position to start the migration of the user data from Exchange to Domino. Users 
are eligible for migration when:

� They have a status of “Registered” and a green (???) or purple icon in the 
column under the server that will be migrated (in the Registration view). 

� They have a status of “Registered” or “Ready for Registration,” the server 
being migrated is Exchange, and they have a green (???) or purple icon 
under that server column (in the Server Migration view).

For a full description of the status categories, see the CMT help accessible via 
the CMT database.

Figure 13-41   People by ready for registration status view

Note: Users with a status of “Ready for Migration” and no yellow light will not 
be imported during the server-to-server migration. They either will be or have 
been migrated with an end-user migration.
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In our example (Figure 13-41) we show four users. Three of them registered and 
one failed migration, assuming all four users will be available for migration.

Once again CMT provides an easy to use wizard for migration. As with a manual 
migration, the migration wizard will only allow you to select users from the CMT 
database that are in the correct status.

1. Click the Server Migration button and launch the corresponding wizard from 
the main database view (Figure 13-42).

Figure 13-42   Selecting server migration

2. You are presented with the list of users ready for migration. You have the 
option to migrate all users or select the users for migration. If you select all 
users, the wizard will attempt to migrate all users that are in the relevant 
status noted previously, meaning it will not attempt to migrate all the 
Exchange users in the GAL.

Figure 13-43   List of users ready for migration

3. Select all users listed or some of them only, and click OK.
434 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm
Figure 13-44   User selection

4. You are requested to select a MAPI profile. Be sure you have set one up as 
mentioned in the “Prerequisites” on page 403. If not, you will have to cancel, 
build the profile, and start the Add users wizard again.

The selected profile must have administrator privileges; otherwise, you will 
not be able to access either the Global Address List or, during migration, the 
user data to migrate.

.

Figure 13-45   Select MAPI profile

5. Click OK. The migration begins and a status screen displays its progress 
(Figure 13-46). Depending on the amount of data and speed/bandwidth of the 
network, the migration might take a fair amount of time.
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.

Figure 13-46   Migration status window

During the migration process, you have the option to suspend, and resume, 
the migration. This is a useful option that in our testing did not result in either 
a failed migration or migration with errors. The option is useful if you need to 
suspend the process due to resource constraints. The option to cancel is also 
available.

A completion notice is displayed when the migration is finished 
(Figure 13-47). Take note of and follow up on any errors. For further 
assistance in case of errors, refer to “Troubleshooting the migration” on 
page 436.

Figure 13-47   Migration completion screen

13.4  Troubleshooting the migration

In the event that a registration fails, you are presented with the status screen. It 
lets you know the number of successful and the number of failed registrations. In 
the event of a failure, further investigation will be required. Most causes of failure 
are simple and easily rectified. To find out the cause of the failure, open the CMT 
database and click Registration. A list of users and their status is displayed 
(Figure 13-48).
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Select and open the failed user’s document, which will be in the Failed 
registration category.

A migration information section is at the bottom of the document. The cause of 
the error is displayed in this section (Figure 13-49).

Figure 13-48   Troubleshooting: CMT registration view

Figure 13-49   Troubleshooting status of migration
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Chapter 14. Local Data Migration using 
the Binary Tree tools

This chapter provides the details for a client side migration using the Binary tree 
Common Migration Tool. The following instructions should be used in conjunction 
with the latest release memos from Binary Tree.

14

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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14.1  End user migration overview

Once you have migrated a users account from Exchange to Domino the end user 
may have some data (mail, contacts, calendar entries etc.) stored locally in one 
or more Personal folders files (.pst) If they are using Lotus notes they may want 
to migrate this data into the Lotus Domino system whether this be for archiving or 
personal reference. (migrating data into Domino if using Outlook is covered in 
another Chapter) 

Once the data is in Domino there are a number of options for the storage and 
access of the data. for example server side archiving

14.2  Configuring the Binary tree tool for Outlook 
migration

Instructions for configuration of the Common Migration tool have been covered in 
Chapter 13, “Server Level Migration process using CMT from Binary Tree” on 
page 401.

However a quick overview follows as it may be the case that all data to be 
migrated is end users data and the migration requirements area that only end 
user data is migrated (i.e. all data is local). In all cases end users migration will 
only take place once the users has a registered account and mailbox in domino

14.2.1  Installing the CMT

14.2.2  Configuring CMT and import users for migration

With the Binary Tree CMT The system administrator can configure the choice of 
users that will be migrated, and in addition how users will initiate said migration, 
The configuration is undertaken through the Wizards to set up CMT for end user 
migration the administrator needs to configure end user settings

1. Open the CMT 

You will be presented with the following screen 

Note: If you have already installed, configured and run the CMT for server 
side migration and started or completed the migration of users from exchange 
go to Chapter 14.3, “Migrate local user data” on page 446
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Figure 14-1   CMT Configure settings

2. Click > Configure End User settings (EU settings)

Figure 14-2   Selecting migration source

3. Select Outlook

You have the option to select multiple mail sources, In most migrations 
during configuration you most likely would have selected the server based 
migration as well. 
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Figure 14-3   Configure Domino server 

4. Enter the information for the destination mail system.

a. Domino directory mail server.

This is the name of your primary domino server

b. Domino Directory Filename

In all cases this will be names.nsf

c. Personal address Book

In most cases a personal address book will also be called names.nsf. this 
database is the local contacts directory

d. Target mail database

You have the option to import your data into either the current mail 
database in which case the imported data will be replicated back to the 
domino server. Or a separate local database., If you select local database 
you will be prompted for the name of the database, ensure that you have 
already created the database. 
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e. mail template version

For migration to domino 7 always use the 7.0 template

Figure 14-4   Selecting data to migrate

5. Select the data to migrate

The common Migration tool gives you the option to be granular on the 
information that will be migrated from the local PST file into your domino 
mail file. In our example we migrated all the data.

– Message types to migrate

The CMT tool lets you select which message types are migrated. For 
example, you could choose to migrate mail messages but leave calendar 
entries untouched. As can be seen in Figure 14-4, we opted to migrate all 

TIP: to create a mail database for migration

file -> database -> new

server > local

title > my exchange mail (nb this can be anything)

filename > myexchangemail.nsf (again any unique name)

select the extended mail template mail7ex.ntf

-> OK
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data. However, you may decide that not all data is relevant for migration, 
so you can refine the selection.

– Message stores to migrate

• Migrate Exchange server data

The user's mailbox and data are on the Exchange server. When you 
migrate Exchange server data, the user's mail and folder structure 
saved on the server will be migrated. When you choose to migrate 
Exchange server data, you also have the option to migrate shared 
Exchange mailboxes. A shared Exchange mailbox is used by more 
than one user. To migrate shared Exchange mailboxes, select the 
Migrate Shared Exchange Mail Boxes check box.

• Migrate personal folder data

The data are local to the users's machine or stored on a network drive. 
They are in the form of a .PST file. This data is not stored on the server. 
If there is more than one .PST file, CMT will migrate all of them.

• Migrate personal address book data

The data are local to the user's machine or stored on a network drive. 
They are in the form of a .PAB file.

You may also decide that the only data you want to migrate is calendar, 
messages, and contacts. Later, during the selection of users for 
migration step, you have the ability to further refine the data selection 
by changing from the defaults and adding date ranges, so as not to 
migrate older data.

– MAPI profile to use

Unless you have created a single/default MAPI profile with administration 
access, you should select Let users choose profile to ensure that a profile 
with sufficient privileges for logging into Exchange can be chosen.

– Migrate shared Exchange mail boxes

The option to migrate shared mail boxes should be used with caution since 
this data is used by more than one user, and is only available if you have 
chosen to migrate Exchange server data. When this option is selected, the 
shared data will appear in each user’s mailbox. It may be more appropriate 
to create a mail in database into which to migrate the shared data, and 
giving the users that require it access.

– Migrate to Notes systems folder

Data from Exchange, by default, will be migrated by the CMT into the 
top-level folder in Notes. The Exchange/Outlook folder structure will be 
retained. All of the users' Exchange folders will be placed under this 
top-level folder, and the relevant data/mail messages will be stored within 
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them. Thus within the Notes user’s mail database they will have separate 
folders for their Notes data and old Exchange data. 

By selecting Migrate to Notes system folders, data within the Exchange 
system folders (Inbox, Sent Items, Drafts, and Deleted Items) will be 
migrated directly into the equivalent Notes system folders (Inbox, Sent, 
Drafts, and Trash). All other non-system Exchange folders will be migrated 
to Notes. In other words, the folders will appear under the Notes root-level 
folder structure and not under an Exchange top-level folder.

When you have completed your selections, click Next and you will be 
presented with the fourth settings screen

Figure 14-5   Configure data location

6. Enter Details on messages to migrate and location in Domino mail File

In the previous configuration step you had the option to select wether or 
not migrated messages will be stored in the notes system folders. If you 
did not select this then These settings allow you to provide information on 
top-level folder name that all data migrated from Exchange will be 
migrated under to. 

You also have the option to select which message classes to migrate. A 
message class is how a note is stored in Exchange default is * , all 
messages,

To specify which message classes to migrate, type in the message 
classes separated with a semicolon (;). A semicolon must also follow the 
last message class entered. 

Tip: we recommend that the message class setting remains as default
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Figure 14-6   Finished configuration

You have now finished the configuration of the end user migration.

14.3  Migrate local user data

Once you have the users registered in the CMT you need to run the end user 
migration wizard to configure how the end user migration will be initiated. There 
are a number of options within this wizard that we will review in this section

– Configure Trigger wizard: 

There are various options for how an end users migration is started 
(triggered), either automated on open mailbox or by a migration start 
button. This wizard allows the administrator to define in which way this 
will happen
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Configuring the trigger

Figure 14-7   Selecting Configure Trigger wizard

7. You are presented with the trigger type selection screen. Select your trigger 
method, either via an e-mail message or automatically on mail database open 
(Figure 14-8).

Figure 14-8   Trigger type selection

– The 2 options will give you additional configuration options.

• If you select Automatically trigger migration on database open this will 
launch a wizard that will generate Lotuscript code that need sot be 
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added to migrated users mailbox. The script will check for local data 
and automatically add the data to the users mail database

• If you select to email the migration button, you can use the standard 
email or select to create a customized email. In both cases the users 
are sent a button that will launch the local migration wizard.

14.3.1  Using the Automated Migration

Figure 14-9   Select automatic trigger

– Selecting automatic trigger will present you with ECL to allow the binary 
tree program to execute some programs. select start trusting BT
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Figure 14-10   ECL warning window

– You will be presented with a wizard 

– Click next

Figure 14-11   Mail customization Wizard start page

– The Wizard will launch.

– Select Next
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– You will be presented with a prompt screen to store the Created 
instructions and DLL file

Figure 14-12   

• To change the location, enter or browse for the location and filename 
for the generated script by clicking on Browse.

– Click Next

– A screen with the instructions and the code to enter into the Mail database 
template will be presented as shown in Table 14-13 on page 450

Figure 14-13   Mail database window

– This piece of generated LotusScript you must insert this script into the mail 
template. By default, the code will be generated in the Windows temp 
directory. 
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– The custom code will be written to file and displayed in the wizard screen.

– Click Next.

– Click Finish

Figure 14-14   CMT complete
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Figure 14-15   The created file

After the custom script has been generated, you need to start Lotus Notes 
Designer and Open the mail file template.

Next open the output file created by the CMT and follow the instructions to 
complete the mail template customization. (The instructions are included in a 
comment section of the generated LotusScript code, with the user specific 
%INCLUDE . )

Run the load design task to refresh the design of all user mail databases so 
that they contain this script.

When a user now opens 
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14.3.2  Using the send email Button

Figure 14-16   Selecting an email trigger with customized mail message

Figure 14-17   Customized mail message

– If you select customize mail message you have the opportunity to create 
an interactive message, by the sue of the tags you can enter information 
from the CMT person form, as a detailed description of each of the tags is 
given in Table a on page 455
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Figure 14-18   Field tags option selection box

– A selection box can be bought up by clicking view tag list as shown in 
Table 14-18 on page 454 

– You can now create your email message that users will receive when you 
schedule them for end user migration.

Tag Description Remarks

<!-Subject-> Subject of the message

<!-SendTo-> Who to send the migration message 
to

The full name stored in the user's 
person document

<!-MigrateTo-> Migration Platform to migrate to Target mail system, located on the 
General Settings tab of the Settings 
document

<!-DeliveredDate-> Date the migration message was 
sent to the user

The date the mail message was sent

<!-StartDate-> Start Date for the user to begin their 
migration (also the date range the 
'Start Migration' button to trigger 
migration is valid)

Defined on the CMT person document 
under the End User Migration info 
section

<!-EndDate-> End Date for the user to finish their 
migration by (also the date range the 
'Start Migration' button to trigger 
migration is valid)

Defined on the CMT person document 
under the End User Migration info 
section

<!-AllowedProducts-> The products the users is allowed to 
migrate

AllowedProducts corresponds to the 
Allowed Products on the User's person 
document
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– When you have completed your message Click Next

– Click Finish

14.4  Adding Users

Once you have configured the CMT for end user migration you need to add users 
to the Tools database for migration selection.

If you have already migrated from exchange the users that have domino 
mailboxes will be ready for selection

The following steps assumes you are doing end user migration only. 

� If not already done so open the CMT 

� select from the top bar ADD USERS as shown in Appendix 14-19, “Select 
add users” on page 456

<!-HelpContact-> Person to contact if the migration 
encounters a problem

Corresponds to the custom help text 
used in the standard migration 
documenta

a. Table of email tags

Tag Description Remarks

Note: You can only migrate end users data to users that have Lotus Notes and 
a domino mailbox
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Figure 14-19   Select add users

� You will be presented with a screen for the users source directory. as shown 
in Appendix 14-20, “Select add users source” on page 456

Figure 14-20   Select add users source

� As we want to migrate users local data from Outlook PST to Domino NSF 
then the users should already be in Domino, wether this be by migration or 
default registration. Therefore the directory source will be Domino Directory

� select domino directory and Click Run Wizard the following screen will be 
displayed
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Figure 14-21   Select users

� Select All people in Address Book 

� Click next

Figure 14-22   Import users button

� Click Import User from Domino NAB.

� Click Next and the results screen is displayed

Note: The size of your domino directory will determine the length of 
time this will take. In our lab exercises we maintained a small directory, 
and the process finished very quickly. Unfortunately you do not get a 
finished indicator and have to wait for the cursor to be released
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Figure 14-23   Import users results

You are now ready to schedule end user migrations with the send button email

14.5  Sending the migration e-mail

This step is only necessary if you opted to trigger end user migration by sending 
a button to the user. If you opted to customize the mail template then the 
migration will be done automatically when a user opens there mailbox for the first 
time.

1. To send the migration e-mail, open the CMT database. 

2. Select the End user Migration in the left hand bar as shown in 
Appendix 14-24, “Selecting end user migration” on page 459
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Figure 14-24   Selecting end user migration

3. When you click End User migration you will be presented with a list of users 
that are registered in domino and have domino mailboxes.
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Figure 14-25   Select users for migration

4. Multiple users can be selected by clicking next to the names. selected users 
are represented by a tick. 
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Figure 14-26   Send migration message

5. Click Actions

6. Scroll down and Select -> Send selected people migration doc

email messages will be sent to the users containing the migration button.
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Figure 14-27   reviewing the document

7. By opening the person document (as shown above in Figure 14-27) in CMT 
you can review when the end users was sent the message this can also be 
used as an Alternative method to send the migration message or even 
resend.

8. The user will receive a message like the one shown in Figure 14-28 on 
page 462 in their Notes inbox.

Figure 14-28   Migration mail message in the inbox

9. The user needs to click the Start Migration button. The migration will begin 
and the user will be given status messages as the migration progresses. An 
example is shown in Figure 14-29 on page 463.
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Figure 14-29   Migration message and Button

10.When the migration is complete, the user is presented with the migration 
complete message shown in Figure 14-30.
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Figure 14-30   Migration completed

11.Click OK.

End user migration is now complete.

Migration document
The user’s migration document is updated in the CMT directory, and the 
administrator can check the status. A sample is shown in Figure 14-31.

Figure 14-31   Extract if status in CMT person document

Various details about the end user migration have been recorded and can be 
very useful for both troubleshooting and planning of further deployments.
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Tip: We noticed during our testing, that if selected in the EU setting of the 
configuration, the end user migration will migrate both local and server data if 
the server migration has not already completed. This function of the CMT tool 
can be useful in distributing the responsibility of the data migration to the end 
user and restricting the window of opportunity for the period available to the 
user for migration, thus helping to plan the migration load.
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Chapter 15. Migration Results

This chapter provides a review of the migration results of a user’s data. The goal 
is to provide an understanding of how a representative set of data will 

The format for the comparison is that the ‘pre-migrated” image comes first, the 
DUS migrated image second, and the CMT image is displayed third. The 
migration tools have been configured and run with the suggested defaults to give 
the reader and understanding of the “out of the box” capabilities of these tools.

This chapter deals with the migration results obtained with the Domino Upgrade 
Services (DUS) and CMT tools from Binary Tree for the following items:

� Inbox folder migration

� Mail message conversions

� Calendar entries
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� Contacts

� Tasks/To Do
468 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777_f_ch_migration_results.fm
15.1  Mail Migration Results

This section show the results of migration various mail items using both the DUS 
and CMT tools.

15.1.1  Inbox

Figure 15-1 illustrates a message in the Outlook client, pre-migration from 
Exchange. The user is able to scroll messages and preview a message in the 
preview pane in the Outlook client.

Figure 15-1   Outlook Inbox view

As shown in Figure 15-2 on page 470, and Figure 15-3 on page 471, both DUS 
and CMT convert the inbox and its contents. The user has access to functionality 
similar to that available in the Notes client.

Note: The format for the comparison is that the ‘pre-migrated” image comes 
first, the DUS migrated image second, and the CMT image is displayed third.
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Figure 15-2 on page 470 illustrates the Inbox view using the DUS migration tool. 
Similar to the Outlook feature, the user can preview the body and contents of the 
message. 

Figure 15-2   Notes 7 Inbox view: DUS migration

Figure 15-3 on page 471 illustrates the Inbox view using the using the CMT 
migration tool.
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Figure 15-3   Notes 7 Inbox view: CMT migration

15.1.2  Mail message migration results
In this section, we show migration results of individual mail messages with 
various elements in them.

HTML messages
The first object is an HTML message. It is quite likely that Outlook users have 
sent URLs, to guide other users to Web pages. Alternatively, the messages sent 
may exist as HTML content, or typically, newsletters for your company go out to 
your users as HTML pages.

Figure 15-4 on page 472 illustrates a message in HTML format, beginning with 
how it appears in Outlook, pre-migration. 
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Figure 15-4   Outlook HTML message

Both tools (namely DUS and CMT) convert the HTML message fairly well and 
very similarly. The message retains its functionality; however, some of the 
formatting is lost during the migration.

Figure 15-5 on page 473 illustrates the migrated message containing HTML 
content, using the DUS migration tool. 
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Figure 15-5   Notes 7 HTML message conversion: DUS

Figure 15-6 on page 474 illustrates the same message, after it has been 
migrated using the CMT migration tool. 

Note: You may also wish to refer to the test results discussed in Chapter 10, 
“Co-existence test results - what to expect” on page 309 to see the results of 
embedded HTML messages sent between the two environments. 
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Figure 15-6   Notes 7 HTML message conversion: CMT

Messages with Embedded Objects
Mail messages in Outlook may contain embedded objects. Most often these are 
objects created with one of the MS Office applications, such as Excel® or Word.
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Document with an embedded Excel graph

Figure 15-7   Outlook embedded Excel graph

DUS does not convert the embedded object at all, as shown in Figure 15-8 on 
page 476. 
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Figure 15-8   Notes 7 embedded Excel graph: DUS

CMT tools convert embedded objects into images in attachments and includes 
them as attachments to the message. After the migration, the Excel graph is not 
editable in Notes; however, you are able to view it in Notes. The results can be 
seen in Figure 15-9 on page 477. 
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Figure 15-9   Notes 7 embedded Excel graph: CMT

If your users have created embedded objects and you need to bring them / 
maintain them in a fully functional state from Outlook to Notes, you may need to 
look into other solutions. (See Appendix A, “Other migration tools” on page 727) 
for possible other solutions. ) 

Alternatively, one technical solution would be to convert the objects into 
attachments before migration. This could be automated programmatically, for 
example, by writing a VBScript to iterate through mail messages, creating 
attachments. There might also be third party applications that will do this.

Message with embedded Excel worksheet
Figure 15-10 on page 478 illustrates the next message, this time with an 
embedded spreadsheet shown in the Outlook client. 
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Figure 15-10   Outlook embedded Excel worksheet

Again, similar to the results with the embedded graph discussed in the previous 
section, DUS does not convert the embedded object at all. The results can be 
seen in Figure 15-11 on page 479. 
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Figure 15-11   Notes 7 embedded Excel worksheet: DUS

CMT tools convert embedded objects into images in attachments and includes 
them as attachments to the message. (Figure 15-12 on page 480) After the 
migration, the Excel worksheet is not editable in Notes; however, you are able to 
view it in Notes.
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Figure 15-12   Notes 7 embedded Excel worksheet: CMT

Message with embedded table
Figure 15-13 shows a message where we created a table with some cells and 
sample text using the Outlook editor.
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Figure 15-13   Outlook embedded table

Both DUS and CMT converts the table correctly, maintaining the text inside the 
table, as well as the formatting of the table.

Figure 15-14 on page 482 illustrates how the table was translates using the DUS 
Migration tool. 
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Figure 15-14   Notes 7 embedded table: DUS

Figure 15-15 on page 483 illustrates how the table was translated using the CMT 
Migration tool. 
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Figure 15-15   Notes 7 embedded table: CMT
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Message with a URL, attachment and signature in the message body
Figure 15-16 on page 484 illustrates the next text message (shown first in 
Outlook), containing a URL, an attachment, and a signature in the body 
message. 

Figure 15-16   Outlook URL, attachment, and signature in message body

Both DUS and CMT tools converted the URL properly and placed the attachment 
at the bottom of the message. 

DUS loses the graphic from the signature. The results can be seen in 
Figure 15-17 on page 485
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Figure 15-17   Notes 7 URL, attachment, and signature support: DUS

CMT places the graphic from the signature as an attachment at the bottom of the 
message. The results can be seen in Figure 15-18 on page 486. 
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Figure 15-18   Notes 7 URL, attachment, and signature support: CMT

15.2  Calendar migration results
Calendar migrations were performed against an Outlook client connected to our 
Exchange server. We performed migrations with the Lotus DUS tool and Binary 
Tree’s CMT tool. This section shows the results of our calendar migration 
activities.

Overall calendar view in Outlook client
This first section illustrates the Calendar Overview, using each of the clients and 
the respective migration tools. 
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Figure 15-19 illustrates the Outlook calendar view from within the Outlook client. 
In this example, there is one meeting scheduled. 

Figure 15-19   Outlook calendar view

Figure 15-20 on page 488 illustrates that the meeting was migrated successfully 
using the DUS tool. 
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Figure 15-20   Notes 7 calendar view: DUS

Figure 15-21 on page 489 illustrates that the established meeting was also 
migrated successfully using the CMT migration tool. 
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Figure 15-21   Notes 7 calendar view: CMT

Calendar Entry
This section illustrates, in slightly greater detail, how a specfic Calendar entry 
appears once migrated. 

Figure 15-22 on page 490 illustrates the Outlook calendar entry, pre-migration. 
 Chapter 15. Migration Results 489



7777_f_ch_migration_results.fm Draft Document for Review September 11, 2006 10:43 pm
Figure 15-22   Outlook calendar entry

Figure 15-23 on page 491 illustrates that the Calendar Entry was migrated 
successfully using the DUS tool. All data was maintained. 
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Figure 15-23   Notes 7 calendar entry: DUSt

Finally, Figure 15-24 on page 492 illustrates how the Calendar Entry appears in 
Notes when migrated using the CMT tool from Binary Tree. As with the DUS tool, 
all data was maintained. 
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Figure 15-24   Notes 7 calendar entry: CMT

15.3  Contacts
This section shows the results of the migration of contact information from 
Outlook to Notes using both DUS and CMT tools. Although the contacts and the 
contacts view look a bit different in Notes than in Outlook, the data has been 
converted correctly and similar functionality is available for users in Notes.

Figure 15-25 on page 493 illustrates the view of Contacts from within the Outlook 
client. 
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Figure 15-25   Outlook contact view

For the DUS migration option, DUS migrates contacts as part of the user’s mail 
file into the ($users) view. To add the contacts to the local names.nsf, the end 
user would select Actions → Synchronize Address Book from the menu bar.

The results of the Contacts view using DUS (($Users) View: DUS) is shown in 
Figure 15-26 on page 494. This is the first step. 
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Figure 15-26   ($Users) View: DUS

Once the user then performs the action to add the contacts to the local 
names.nsf, (namely the end user would select Actions → Synchronize 
Address Book from the menu bar), the results will appear similar to those shown 
in Figure 15-27 on page 495. 
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Figure 15-27   Contacts Personal Address Book: DUS

CMT migrates contacts as a separate .ns4 file. The end user who has been 
migrated will receive an email with the subject Contacts from Exchange. This 
email contains the .ns4 file and a button titled Insert Contacts. To add contacts 
to local names.nsf end user would click the button.

Figure 15-28 on page 496 illustrates an email containing the .ns4 file and the 
Insert Contacts button. 
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Figure 15-28   Email with contacts: CMT

Once the user clicks the button, the local name and address book in Notes will be 
populated, similar to the results shown in Figure 15-29 on page 497. 
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Figure 15-29   Contacts Personal Address Book: Using CMT

15.4  Tasks/To Do entries
This section shows how the tasks in Outlook are migrated to Notes. Tasks are 
called To Dos in Notes. Again, the tasks list looks different in Outlook than the To 
Do list in Notes, but the data has been correctly migrated and similar 
functionality is available for users in Notes.

Figure 15-30 on page 498 illustrates the tasks view in the Outlook client, 
pre-migration. 
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Figure 15-30   Outlook tasks view

Figure 15-31 shows the same set of tasks, now referred to as “To-Dos” in Notes, 
once they have been migrated using the DUS tool. 

Figure 15-31   DUS To Do view

Finally, Figure 15-32 on page 499 illustrates the results of the migration of tasks, 
this time using the CMT tools from Binary Tree. The tasks were brought over 
successfully into Notes and can now be viewed / manipulated through the 
“To-Do” list. 
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Figure 15-32   CMT To Do view

15.4.1  Summary
In this chapter we have shown the results of Exchange-to-Domino migration. 
Migration of mail messages, calendar entries, contact information, and tasks 
were detailed. The migration was done using both the Lotus Domino Upgrade 
Services tools and BinaryTree’s Common Migration Tool.

Although the data is successfully migrated, some items are converted differently, 
as the creators of the migration tools had a different design point. Compare the 
migration results to the way your users use these items to determine what tool to 
use for the migration, as well as to set the expectations of the end users, whose 
data is being converted. 
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Chapter 16. Directory Coexistence Using 
LDAP

Organizations with multiple messaging systems have a requirement for directory 
lookups and application authentication. The synchronization of the directories is 
a viable option and is discussed in other chapters, however it may not be 
practical or desirable to deploy and manage multiple directories, multiple times. 
In addition Authentication for non-migrated users may be required. LDAP can be 
used to authenticate against Active Directory for user access to both migrated or 
newly deployed applications.

LDAP is a viable solution and relatively simple to setup, thus in this chapter we 
discuss how LDAP (Lightweight Directory Access Protocol) enablement and 
Directory Assistance can meet both the need for directory lookups and user 
authentication.
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16.1  LDAP Directory Configuration

This section discusses the implications of configuring an LDAP-enabled Domino 
directory and the requirements for using a common, application-independent 
directory during coexistence.

16.1.1  Common directory requirements for coexistence

Exchange and Domino utilize unique and incompatible directory architectures. 
Each directory is application-specific, storing only the information needed by the 
applications accessing the Exchange or Domino server, but not accessible to 
other applications. In a coexistence scenario this presents a particular obstacle, 
because users still residing on the Exchange server and users who have been 
registered on or migrated to the Domino server need to communicate with one 
another. For example, a user who is still using the Outlook client over an 
Exchange server needs to send mail to co-workers who have already been 
migrated to the Domino server. Ideally, the Outlook client user should be able to 
use the same address book, or directory, when addressing mail, regardless of 
whether the recipients reside on the Domino or Exchange server. Likewise, a 
user who has been migrated to the Domino server from Exchange needs to send 
mail messages to co-workers who are still residing on the Exchange server. 
LDAP provides a common, application-independent directory solution for users 
during the period of coexistence. 

Scenarios requiring a common directory solution
There are several possible scenarios requiring a central directory solution, all of 
which can be effectively managed using LDAP 

These scenarios are examined in greater detail in Chapter 17, “Active Directory 
Integration” on page 527 where we will discuss the use of ADSync to manage the 
domino users and groups from Active directory® administration tools

1. User and data migration coexistence

All users and their mail file data are progressively migrated from Exchange to 
Domino over a period of weeks or months. There is a period of coexistence, 
during which some users remain on the Exchange server using the Outlook 
client, while others have been migrated to the Domino server

2. User migration coexistence

Users are migrated from Exchange to Domino, but their mail file data remains 
on the Exchange server. There may be a period of coexistence during which 
some users are using a Domino mail client on the Domino server, while other 
users remain on the Exchange server using the Outlook client. 
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3. Non-migration coexistence

Exchange users are registered on the Domino server, but neither the users or 
their data are migrated from Exchange to Domino. 

In order for users in these three scenarios to ‘find’ each other from their 
respective Domino or Exchange environments, the following components must 
be completed:

� The Exchange server directory must be LDAP enabled.

� The LDAP service must be enabled and configured on the Domino server 
directory. This section deals only with this second component, and the 
considerations for implementing an LDAP-enabled Domino directory.

� An LDAP account needs to be created in the users address book

� An additional address book needs to be added to the outlook profile

16.1.2  LDAP architecture overview

Lightweight Directory Access Protocol (LDAP) is a fast growing technology for 
accessing common directory information. As an open, vendor-neutral standard, 
LDAP provides an extendable architecture for centralized storage and 
management of information. 

LDAP defines the content of messages exchanged between an LDAP client and 
an LDAP server. The messages specify the operations requested by the client 
(that is, search, modify, and delete), the responses from the server, and the 
format of data carried in the messages. LDAP messages are carried over TCP/IP, 
a connection-oriented protocol, so there are also operations to establish and 
disconnect a session between the client and server. 

The LDAP directory stores and organizes data structures known as entries. A 
directory entry usually describes an object such as a person, device, a location, 
and so on. Each entry has a name called a distinguished name (DN) that 
uniquely identifies it. The DN consists of a sequence of parts called relative 
distinguished names (RDNs), much like a file name consists of a path of 
directory names in many operating systems such as UNIX and Windows. The 
entries can be arranged into a hierarchical tree-like structure based on their 
distinguished names. This tree of directory entries is called the Directory 
Information Tree (DIT). 

Each entry contains one or more attributes that describe the entry. Each attribute 
has a type and a value. For example, the directory entry for a person might have 
an attribute called officePhoneNumber. The syntax of the telephoneNumber 
attribute would specify that a telephone number must be a string of numbers that 
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can contain spaces and hyphens. The value of the attribute would be the 
person's telephone number, such as 512-555-1212. 

A directory entry describes some object. An object class is a general description, 
sometimes called a template, of an object, as opposed to the description of a 
particular object. For instance, the object class person has a surname attribute, 
whereas the object describing John Smith has a surname attribute with the value 
Smith. The object classes that a directory server can store and the attributes they 
contain are described by schema. Schema define what object classes are 
allowed where in the directory, what attributes they must contain, what attributes 
are optional, and the syntax of each attribute. For example, a schema could 
define a person object class. The person schema might require that a person 
have a surname attribute that is a character string, specify that a person entry 
can optionally have a officePhoneNumber attribute that is a string of numbers 
with spaces and hyphens, and so on. 

16.1.3  Interaction between the LDAP enabled server and client

An LDAP client is any client accessing the LDAP directory, while the 
LDAP-enabled server would be either the Exchange or Domino server.The 
general interaction between an LDAP client and an LDAP-enabled server takes 
the following form: 

1. The client establishes a session with an LDAP server. This is known as 
binding to the server. The client specifies the host name or IP address and 
TCP/IP port number where the LDAP server is listening. 

2. The client can provide a user name and a password to properly authenticate 
with the server, or the client can establish an anonymous session with default 
access rights. The client and server can also establish a session that uses 
stronger security methods such as encryption of data. 

3. The client then performs operations on directory data. LDAP offers both read 
and update capabilities. This allows directory information to be managed as 
well as queried. LDAP also supports searching the directory for data meeting 
arbitrary user-specified criteria. Searching is a very common operation in 
LDAP. A user can specify what part of the directory to search and what 
information to return. A search filter that uses Boolean conditions specifies 
what directory data matches the search. 

4. When the client is finished making requests, it closes the session with the 
server. This is also known as unbinding. 

LDAP defines operations for accessing and modifying directory entries such as: 

� Binding and unbinding

� Searching for entries meeting user-specified criteria
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� Adding an entry

� Deleting an entry

� Modifying an entry

� Modifying the distinguished name or relative distinguished name of an entry 
(move)

� Comparing an entry

16.2  LDAP implementation in Domino and Exchange

Microsoft Exchange 2000 and 2003 install with default LDAP enablement, and 
the Exchange administrator does not have the option to enable or disable the 
LDAP configuration.

The Domino server installation offers the server administrator the option to install 
the Domino server with LDAP enablement, allowing the Domino administrator the 
flexibility of optimizing performance when LDAP enablement is not needed. While 
installing the Domino server with LDAP enablement does not increase the size of 
the Domino installation, server performance may be impacted when LDAP is 
enabled. This depends on various factors, including the number of directory 
lookups or authentication requests initiated on the server, but server 
performance will be optimal when LDAP is not enabled. Domino allows the 
administrator to enable or disable the LDAP service depending on the needs of 
the IT infrastructure.

16.2.1  Enabling LDAP during Domino server installation

Follow these steps to enable the LDAP service during the Domino server 
installation:

1. Initiate the Domino server installation by running the server setup.exe and 
follow the instructions in Appendix F, “Installing Domino” on page 823 to 
complete the Domino server installation.

2. After you have completed the installation of all Domino server files, you need 
to complete the server setup. Start the Domino server by using the icon 
located on your desktop, or from the Start menu. The Lotus Domino Server 
dialogue show in Figure 16-1 will appear, allowing you to choose whether to 
start Domino as a Windows application or a regular application.
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Figure 16-1   

If you choose to start Domino as a Windows service, the LDAP service will be 
enabled by default. If you choose to start Domino as a regular application, you 
will need to explicitly enable LDAP during the Domino setup process.

3. Proceed with the Domino setup, configuring your server settings as outlined 
in [Chapter...setting up the Domino server], until you are presented with the 
Server setup dialogue prompting you to select the internet services for your 
Domino server. As mentioned in the previous step, if you elected to start 
Domino as a Windows service, LDAP will be enabled by default; if not, select 
the checkbox to enable LDAP. 
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Figure 16-2   Enable LDAP on the Domino server

4. Finish the server installation, and the Domino server will be configured for 
LDAP directory enablement. 

Enabling LDAP from the server console
If you choose not to enable the LDAP service during the Domino server 
installation, you can later enable LDAP manually from the server console. You 
will need to enable LDAP each time you start the Domino server. To start the 
LDAP service, execute this command at the server console:

> Load LDAP

Enabling LDAP by editing the server NOTES.INI file
You may also enable the LDAP service by editing the ServerTasks setting in the 
NOTES.INI file, located in the Domino installation directory. There are three ways 
to edit the NOTES.INI file, so you may follow one of these sequences to edit the 
NOTES.INI in the Domino server directory:

� Open the NOTES.INI file and edit it. The procedure for doing this depends on 
your client's or server's operating system and the text editor you use. Edit the 
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ServerTasks line in the NOTES.INI file by adding the LDAP parameter 
(notated here in bold letters), then save the file:

ServerTasks=Update,Replica,Router,AMgr,AdminP,CalConn,Sched,LDAP,
RnRMgr

� Edit the Configuration Settings document on the server, the method we 
recommend for editing the server NOTES.INI file. Follow these steps to edit 
the server NOTES.INI file using the Configuration Settings document:

a. From the Domino Administrator, open the Domino Directory and click the 
Configuration tab.

b. To edit an existing Configuration Settings document, highlight it and then 
click Edit Configuration.

c. To modify NOTES.INI settings on the server, click the NOTES.INI Settings 
tab. This tab lists a number of current settings in the server's NOTES.INI 
file.

d. To add or change a setting, click Set/Modify Parameters to display all 
settings that you can set in the Configuration Settings document. Select 
the setting(s) you want to add/modify.

e. Save and close the document.

f. Use the Set Configuration server command.

Disabling LDAP from the server console
In the same manner that you can enable the LDAP service manually from the 
server console, you can disable LDAP from the serve console as well. If you 
disable LDAP, it will reload on server startup if you have configured the LDAP 
service during server setup, or by enabling LDAP through the NOTES.INI file. To 
disable or stop the LDAP service, execute this command at the server console:

> Tell LDAP Quit

You can also stop and restart he LDAP service in the same manner, by executing 
the following command at the server console:

> Restart Task LDAP

16.3  Enabling Directory Assistance for LDAP 
authentication

By enabling Directory Assistance, Domino Authentication to migrated public 
folders and applications can be passed for non-migrated users via LDAP to the 
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active directory. The following instructions will enable you to set up Directory 
Assistance

1. From the domino administrator connect to the primary Directory server.

– File -> Database -> New

This will open the new Database dialogue Box

• Enter the server name ..... in our case this was migrate2ka/itso

• Enter a name for the database ..... we used Directory Assistance

• Enter a file name .... we used DA.nsf.

• in the template enter DA50.ntf ... you can click on show advanced 
templates and select directory assistance template also)

– Click OK

– If you have multiple domino servers ensure this file is replicated to all 
domino servers in the domain.

2. Next we need to set up Domino to use the Directory assistance. To do this the 
server configuration document needs to be updated as follows.

a. From the domino administrator connect to the primary Directory server

– Click Configuration Tab

– Click Server and select the primary domino server (migrate 2ka)

b. From the Domino Administrator, click the Configuration tab.

i. Next to "Use Directory on," select the administration server for the 
Domino Directory.

ii. In the left pane, expand Server - All Server Documents.

iii. Select the Server documents for all servers that use the same file 
name for the directory assistance database. A check mark appears 
next to each document. 

iv. Choose Actions - Set Directory Assistance Information.

v. Enter the file name that you gave to the directory assistance database 
on these servers -- for example, DA.NSF. If the directory assistance 
database is in a subdirectory under the data directory, include the path 
relative to the data directory -- for example, DIRECTORIES\DA.NSF.

vi. Click OK.

vii. When you see the dialog box stating "Request has been submitted," 
click OK again.

viii.Use the command tell adminp process interval to force processing 
of the Set Directory Assistance Field request, or wait until the 
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Administration Process processes the request when it next processes 
interval requests. 

ix. Replicate the modified Domino Directory to the servers that will use the 
directory assistance database.

x. Restart the servers so they detect the directory assistance database 
file names in their Server documents. 

16.3.1  Entering the directory assistance database file name to a 
Server document manually

Follow these steps to enter the directory assistance database file name to a 
Server document manually:

1. Make sure that you:

a. Created and replicated the directory assistance database. 

b. Have either Author access and the ServerModifier role, or Editor access in 
the ACL of the Domino Directory to which you will add the file names.

2. From the Domino Administrator, click the Configuration tab.

3. Next to "Use Directory on," select the server whose Domino Directory you 
want to modify.

4. In the left pane, choose Server - All Server Document.

5. Select a specific Server document, and then click Edit Server.

6. In the "Directory Assistance database name" field in the "Directory Info" 
section on the Basics tab, enter the file name that you gave to the replica of 
the directory assistance database on this server -- for example, DA.NSF. If the 
directory assistance database is in a subdirectory under the data directory, 
include the path relative to the data directory -- for example, 
DIRECTORIES\DA.NSF.

7. Click Save & Close.

8. If the Domino Directory you changed is not the replica of the server whose 
directory assistance database file name you specified, (8)replicate the 
updated Domino Directory to the server. 

9. Restart the server so it detects the directory assistance database file name 
now in its Server document.
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16.4  Enabling Client LDAP lookups

The following section describes how to setup the Outlook and Notes clients to 
lookup LDAP entries. It is possible to automate the process using Policies in both 
systems, however this is beyond the scope of this Redbook. Furthermore, 
instructions on deploying desktop and profile changes can be found from both 
Microsoft and IBM websites

16.4.1  Creating LDAP address book in Outlook

To enable Outlook to lookup addresses in Domino, an LDAP address book needs 
to be added to the profile.Tthe following steps discuss how this is done.

1. First, Open an outlook and select a profile

Figure 16-3   Selecting account settings

2. Click Tools -> Account settings as shown above in Figure 16-3,
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Figure 16-4   Add a new account

3. Select address books

4. Select New
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Figure 16-5   New address book options

5. Select the default Internet Directory Service (LDAP)

6. click Next
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Figure 16-6   LDAP server information window

7. Enter the server name this can either the hostname or FQDN of the domino 
server.

8. Click More Settings
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Figure 16-7   Advances settings tab one

9. Enter a display name for the address book, e.g.. Notes users. We left ours as 
the server name

10.Click the search tab

Figure 16-8   Search settings tab

Note: By default, the port should be 389 unless you have changed this in 
domino do not change
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As displayed in Figure 16-8 on page 517, you have the option to specify a search 
string. Domino has a default base so there is no requirement for you to enter the 
Organization as a search base.

11.Click OK

12.The ldap address book has now been added to the Outlook profile and the 
Domino database is now searchable from Outlook. An example follows in 
Figure 16-8.

.

Figure 16-9   Select address book

16.4.2  Finding an address in the Domino Directory from Outlook

To find an address in the Domino directory from Outlook, you can do this in two 
different ways: 

Approach 1 - 
1. First, inside a new memo, click the To: button. This will bring up an address 

dialog similar to the one shown in Figure 16-10 on page 519 .
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Figure 16-10   Selecting names from an address book in either 

Approach 2
1. Similar to the approach shown in Figure 16-9 on page 518, 

2. Select Tools

3. Select Address Book
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Figure 16-11   Select an address book

4. Click the twisty in the address book tab

5. Select the newly created address book
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Figure 16-12   Search for account in directory

You will be presented with a screen similar to Figure 16-12. You can enter any of 
the attributes for the person to be found. In our case, we used the firstname and 
returned one value. In the event of multiple attributes, all accounts with the value 
you typed in any field will be displayed.

16.4.3  Creating and LDAP account in Notes

To enable Lotus Notes to lookup addresses in Active Directory you need to 
create and account in the Local Address Book for the LDAP server. The following 
instructions should assist you in doing this
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Figure 16-13   Select the address book icon

1. Open the address book by selecting the address book icon as shown in 
Figure 16-13 above, or -> File -> Database -> Open. Select local for server 
and in database field enter names.nsf. 
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Figure 16-14   Create a new account

2. Select New

3. Select Account from the drop down list

Figure 16-15   Basics tab

a. On the basics tab

i. Enter a descriptive name for the account, e.g. exchange or the server 
name
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ii. Enter the FQDN of the Active Directory Global domain controller in our 
lab this was the same as the exchange server

iii. If needed enter a userid and password for the bind, by default this 
should not be required

iv. All other fields should be left as default

Figure 16-16   LDAP Protocol Configuration

b. Enter the search base, In our example the Active Directory Organization 
Forest for the exchange users was ITSO1 all the attributes of 

– we entered DC=itso1

– All other fields can remain as is.

c. Click Advanced tab

Figure 16-17   LDAP port configuration
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On the advances tab you can specify the port. In most organization the LDAP 
port (non SSL) is set at 389

d. Click Save and Close

Figure 16-18   Selecting directories

4. To test the configuration as with Outlook, we can open another directory from 
the address book.

a. Click Directories on the top selection bar

Figure 16-19   Selecting search criteria

b. Select the recently created directory

c. Enter a search term, as before, we entered a first name
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Figure 16-20   LDAP search results from Active Directory

The results will be returned as in Figure 16-20 Additional details about the 
returned entry can be obtained by clicking Details. Finally, Address book lookups 
are also possible when sending email by clicking the To: button in the new memo.
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Chapter 17. Active Directory Integration

Since Active Directory is a requirement for deploying Microsoft Exchange 2000 
and 2003, IT organizations which maintain an Exchange environment rely 
exclusively on Active Directory deployment within their infrastructure. Domino, 
however, maintains its directory configuration and group and user authentication 
entirely within the Domino environment. While Exchange and Domino utilize 
unique and incompatible directory architectures, administration of both servers in 
a coexistence scenario requires a central, application-independent directory for 
managing both Exchange and Domino users. Without central management of all 
users, the server administrator would be required to register, delete and rename 
users separately on their respective servers.

Recognizing that an organization’s server or messaging implementation should 
not dictate directory usage, Domino supports Active Directory for both 
authentication and for group and user management. The Active Directory 

17

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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Synchronization tool, or ADSync, allows Active Directory administrators to 
manage users and groups in both Active Directory and the Domino Directory as 
a unified operation from the Active Directory Users and Computers Console.

This chapter discusses how Active Directory synchronization meets both user 
authentication and management needs. The following sections outline the 
considerations for implementing Active Directory synchronization for a 
coexistence scenario:

� The role of Active Directory

� Using Active Directory synchhronization to manage users in Active Directory 
and the Domino directory

� Lotus ADSync during coexistence and beyond

Attention: To learn more about how Domino supports Active directory for 
authenitcation using LDAP, see Chapter 16, “Directory Coexistence Using 
LDAP” on page 503.
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17.1  Understanding the role of Active Directory

This section illustrates the role of Active Directory in a corporate infrastructure, 
as well as the role of Active Directory during a coexistence scenario. Active 
Directory used in concert with ADSync offers you the convenience of using 
Active Directory for your corporate directory, while managing both your 
LDAP-enabled Domino server directory and Active Directory from one location. 

17.1.1  Active directory remains the corporate directory

In an environment where Active Directory has been used as the corporate 
directory in conjunction with Exchange and other Microsoft business 
applications, after deploying Domino and removing Exchange from the IT 
infrastructure, it is preferable to continue using Active Directory as the corporate 
directory. Active Directory is the underlying infrastructure used to deploy 
Microsoft business software and is necessary to manage authentication of those 
applications. The following are a few examples:

� Active Directory is used to manage the existing corporate directory, with 
implications beyond Outlook messaging users. 

� Active Directory is used for authentication of Windows domain file and print 
services

� Active Directory is used for authentication of applications outside of the E-mail 
messaging space, such as Sharepoint.

During the coexistence of Domino and Exchange, with Active Directory as part of 
the IT infrastructure, without ADSync the IT Administrator would be required to 
maintain two separate directories. Figure 17-1 on page 530 offers an illustration 
of the early coexistence scenario before the implementation of ADSync. Without 
ADSync to manage users in both the Domino directory and Active Directory, 
users on the respective directories must be managed separately.
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Figure 17-1   Initial Domino deployment with two independent directories

With the introduction of ADSync into the infrastructure, users and groups in the 
Domino directory and Active Directory are administrated centrally in Active 
Directory. Figure 17-2 on page 531 illustrates the role ADSync plays in allowing 
central management of users in the Domino directory and Active Directory. In this 
illustration, the blue shaded area represents directory management where users 
exist in both Active Directory and the Domino directory, with all changes being 
made in Active Directory and replicated automatically to Domino.
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Figure 17-2   ADSync is used to manage users and groups in Active Directory and the 
Domino directory

The following sections outline likely coexistence scenarios and illustrate how 
ADSync in conjunction with LDAP enablement can be used to manage users in 
both the Domino directory and Active Directory

17.1.2  User and data migration coexistence

All users and their mail file data are progressively migrated from Exchange to 
Domino over a period of weeks or months. During the period of coexistence, 
some users are still residing on the Exchange server using the Outlook client, 
while others have been migrated to the Domino server. Because the users’ mail 
file data is migrated to Domino, a seamless directory solution is crucial. For 
example, the creator of a meeting who still resides on the Exchange server must 
be able to add invitees to the meeting who have been migrated to Domino, or 
send updates to users who were migrated to the Domino server after the meeting 
was created. ADSync allows the IT administrator to manage users who still 
reside in Exchange as well as users who have migrated to Domino, from one 
central location.

Note: ADSync is included in the Domino installation, and the Microsoft 
Windows operation system is not a prerequisite for the domino server
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Figure 17-3   Domino and Exchange coexistence, using LDAP for directory lookup

17.1.3  User migration coexistence

Users are migrated from Exchange to Domino, but their mail file data remains on 
the Exchange server. In this scenario, users do not have a need to preserve their 
historical data, and will begin working with a new mail file in Domino to create 
mail messages and calendar entries. Because no mail file data is migrated, 
calendar entries and updates are not a consideration. However, there may a 
period of coexistence during which some users reside on the Domino server 
using a Domino mail client, while others remain on the Exchange server using 
the Outlook client. In this case, ADSync allows the IT administrator to manage 
from one central location those users still residing in Exchange as well as those 
users who have migrated to Domino.

Since mail file data is not migrated from Exchange to Domino, it is important that 
you plan for the end of Outlook usage, after which users will be required to use a 
Domino client exclusively. This is particularly relevant in the case of meetings and 
other calendar entries (such as tasks, appointments, etc.), where all attendees to 
a meeting will be migrated to Domino, but their mail files containing the meeting 
information will not. We suggest that you establish a date after which Outlook 
users will stop sending meeting invites and scheduling calendar entries, prior to 
the date when they will reside on Domino and use a Domino mail client 
exclusively.
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17.1.4  Non-migration coexistence

In this coexistence scenario, Exchange users are registered on the Domino 
server, but neither the users or their data are migrated from Exchange to Domino. 
Users begin using the Notes, DWA or DAMO client over the Domino server, but 
maintain their historical data on the Exchange server for reference. As with the 
user migration coexistence scenario, we suggest that you establish a date after 
which Outlook users will stop sending meeting invites and scheduling calendar 
entries, prior to the date when they will reside on Domino and use a Domino mail 
client exclusively. After the users are registered on the Domino server and using 
a Domino mail client, they should only be accessing their data on the Exchange 
server for reference, and should be instructed not to use Outlook and the 
Exchange server for sending mail messages or meeting invitations.

Figure 17-4   Application authentication through LDAP lookups - for users in Active 
Directory, but not in Domino Directory 

17.1.5  Using Lotus ADSync for long term user management

After Exchange has been removed from the IT infrastructure and all users reside 
on Domino, Active Directory will still likely be used for managing the existing 
corporate directory and authenticating Microsoft applications. In this 
environment, Lotus ADSync continues to play a crucial role in managing users 
and groups in both the Domino directory and Active Directory. Figure 17-5 on 
page 534 illustrates how Lotus ADSync fits into the IT infrastructure containing 
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the Domino server, Domino directory and Active Directory, with LDAP used for 
Domino application authentication.

Figure 17-5   Active Directory remains after Exchange is removed

17.2  Installing Lotus ADSync

In order to use the ADSync tool, you must enable Domino Directory W2000 Sync 
Services during the installation of the Domino Administration client. This option is 
available under the Domino Administrator list of options. Enable Domino 
Directory W2000 Sync as shown in Figure 17-6 on page 535.
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Figure 17-6   Enable Domino Directory W2000 Sync Services

After installing the Domino Administration client, start a DOS command prompt 
window, and navigate to the directory where you installed the client. Type the 
following command and press Enter:

$c:\Program Files\Lotus\Notes> regsvr32 nadsync.dll

The command adds a container entry for Lotus Domino Options to the Active 
Directory Users and Computers management screen and returns the 
confirmation shown in Figure 17-7. You are now enabled to administer groups 
and users in Active Directory.

Figure 17-7   Lotus ADSync successfully installed

17.2.1  Synchronizing with the Domino Directory

Before you can start registering and managing users and groups from Active 
Directory, you must enable the Lotus Domino Options using the following steps.
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1. From the Active Directory Container shown in Figure 17-8, double-click the 
Lotus Domino Options entry.

Figure 17-8   Active Directory Users and Computers: Lotus Domino Options

2. Double-click the entry for Domino Directory synchronization in the results 
pane to initialize the Lotus ADSync tool and synchronize Active Directory with 
the Domino Directory. You will be prompted to enter the Domino Administrator 
.id and the Domino administrator .id password for the Domino server to 
synchronize with Active Directory, as illustrated in Figure 17-9.

Figure 17-9   Enter the Administrator ID and password

3. You will next be prompted to select a Domino server for all Active 
Directory/Notes user synchronizations, as shown in Figure 17-10 on 
page 537. Select the appropriate Domino server from the drop-down 
selection box.
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Figure 17-10   

4. Click the OK button. If the synchronization is successful, the success 
dialogue shown in Figure 17-11 will display.

Figure 17-11   

5. Double-click the Domino Directory synchronization entry to display the Lotus 
ADSync Options window, shown in Figure 17-12 on page 538.
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Figure 17-12   Lotus ADSync Options window

From the Lotus ADSync options tab you can make the following selections:

– Enable or disable all synchronization operations

– Customize synchronization options with "Select synchronization 
operations to enable."

– Configure prompting options from the drop-down selection box

– Choose to use the CA process for user registration

6. Select the Notes Settings tab to display the Notes Settings for Lotus ADSync, 
as shown in Figure 17-13 on page 539.
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Figure 17-13   Lotus ADSync: Notes Settings

On the Notes Settings tab you can specify:

– Registration server (which Domino server will be used for registration)

– Administration ID (which user ID will have administrative privileges)

– User deletion options. From the drop-down selection box, you may choose 
which actions should take place when a user is deleted.

– Default certifier and policy

– Group type mappings

7. Select the Field Mappings tab (shown in Figure 17-14 on page 540) to specify 
which Active Directory fields to map to Domino Directory fields. During 
ADSync tool initialization, the schemas from Active Directory and Domino are 
mapped based on default settings. If additional field mappings are needed, 
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left-click in the right column under "In Domino Directory" and a drop-down 
selection box with Domino directory fields will display.

Figure 17-14   Lotus ADSync: Field Mappings

8. Select the Container Mappings tab, shown in Figure 17-15 on page 541, to 
map Active Directory containers to Notes Certifiers and Policies. Active 
Directory containers are a special class containing both a namespace and 
attributes. The container does not represent anything real or concrete, but 
rather holds one or more objects. Objects, on the other hand, are the 
underlying principle of everything in the Active Directory. Servers, 
workstations, printers, users, documents, and devices all represent objects. 
Each object has its own access control list (ACL) and attributes. By design, 
the synchronization tool allows you to preserve the hierarchies in Active 
Directory and Domino using mapping. You can select a specific container to 
map to a certifier and/or a policy. You may restrict access to a directory 
structure (container, object, etc.) with group policies in Active Directory just as 
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you can use the extended access control list in Domino to issue restrictions. 
An extended ACL is an optional directory access control feature available for 
the Domino Directory, an Extended Directory Catalog, and the Administration 
Requests database.

Figure 17-15   Lotus ADSync: Container Mappings

While the Domino Directory and Active Directory are synchronized, a user can 
have certain rights in one directory and not the other. ADSync does not ensure 
that Active Directory group policies and Domino extended access control lists are 
synchronized. Therefore, the administrator is responsible for ensuring no security 
settings are bypassed in either directory. In this example, we selected the 
container root, the domain controllers, and the Users container. Beside the 
container you wish to associate with a certifier, double-click in the Notes Certifier 
column to see your selection choices. Select the appropriate certifier and click 
OK to continue.
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17.2.2  Registering existing users in Domino from Active Directory

Now that the Domino certifiers have been associated with the Active Directory 
containers, you can register existing Active Directory users and groups in 
Domino. Follow these steps to register an existing Active Directory user in 
Domino:

1. From the Active Directory Users and Computers window, select the 
appropriate container in the left-hand pane, then choose which user or group 
to register in the right-hand pane. In this example, we chose Users as the 
container. Right-click the selected entry and a pop-up window will display with 
Register in Domino as one of the options, as illustrated in Figure 17-16.

Figure 17-16   Register an existing Active Directory user in Domino

2. Select the option Register in Domino and the Choose Registration Options 
dialogue shown in Figure 17-17 on page 543 will display.
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Figure 17-17   Choose Registration Options

3. Select the appropriate registration options for this user, then click the 
Register Now button. The dialogue illustrated in Figure 17-18 will display, 
prompting you to select the Notes certifier and the Notes policy for this user. 
You must select a Notes policy from the drop-down list.

Figure 17-18   Select a certifier and registration policy

4. Once you have specified a certifier and registration policy for the Active 
Directory user you are registering in Domino, click the OK button to register 
the Active Directory user in the Domino Directory. The success window 
shown in Figure 17-19 on page 544 will display, indicating the registration 
process has completed.
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Figure 17-19   Registration in Domino is complete

17.2.3  Managing users with Active Directory

With the implementation of ADSync, you can manage (add, delete, modify) both 
Domino Directory and Active Directory users from Active Directory. If delete or 
modify a user in Active Directory who exists in the Domino directory, because 
Active Directory and Domino Directory are ‘synced’, the changes you made in 
Active Directory will be reflected in the Domino Directory as well. Likewise, you 
can simultaneously add a user to Active Directory and Domino Directory. In this 
section we outline the method for adding, deleting and modifying users in Active 
Directory and propagating these changes to the Domino directory.

Adding users in Active Directory
Follow these steps to add a user in Active Directory:

1. From the Active Directory Users and Computers window, select the 
appropriate container in the left-hand pane. From the menu bar at the top of 
the window, select Actions to display the Actions menu, then select New -> 
User, as illustrated in Figure 17-20 on page 545.

Note: During coexistence, when adding a new user to Active Directory you will 
be given the option to create an exchange mailbox and a domino mailbox. 
Once the migration has completed and Exchange has been decommissioned, 
only the option to create a Domino mailbox will be offered.
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Figure 17-20   Active Directory Users and Computers: Actions: Add new user

2. The New Object - User dialogue will display, shown in Figure 17-21 on 
page 546. Complete the user name fields, including the user logon name.
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Figure 17-21   New Object - User: complete user fields

3. Click the Next button and the dialogue box shown in Figure 17-22 on 
page 547 will display. In this dialogue, type the password for this new user, 
ensuring it meets the security standards for your IT infrastructure. Also select 
the password settings for this user.
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Figure 17-22   Create a password for the new user

4. Click the Next button to display the dialogue illustrated in Figure 17-23 on 
page 548. Since we’re migrating to Domino, the checkbox next to Create an 
Exchange mailbox should not be selected.
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Figure 17-23   No need to create an Exchange mailbox for this user

5. Click the Next button and the dialogue shown in Figure 17-24 on page 549 
will display, allowing you to register the new user in the Domino directory. We 
recommend selecting this checkbox, so the new user will exist and be 
accessible in both Active Directory and the Domino Directory. We also 
recommend selecting the checkbox next to Use common password, as 
setting one password for Windows and Notes is most convenient for the user. 
Fill in the password fields and set an explicit policy for this user (a requirement 
for this dialogue).
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Figure 17-24   Register the new user in Domino

6. Select the Next button and you will be prompted to enter the certifier .id and 
password for the Domino server on which this user will be registered, 
illustrated in Figure 17-25 on page 550.
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Figure 17-25   Enter certifier ID and password for the Domino server

7. Select the OK button and a confirmation window, illustrated in Figure 17-26 
on page 551, will display. Notice that the new user will be added to the 
Domino directory as well as Active Directory.
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Figure 17-26   New user confirmation window - user will be registered in Domino

8. Click the Finish button to create the new user in Active Directory and the 
Domino Directory. A Lotus ADSync dialogue will display confirming that the 
new user has been registered in Notes (the Domino Directory). 

Figure 17-27   Success - new user registered in Domino

Deleting a user in Active Directory
Follow these steps to delete a user in Active Directory:

1. From the Active Directory Users and Computers window, select the 
appropriate container in the left-hand pane. In the right-hand pane, select the 
user to be deleted. Right-click to display the available list of actions, then 
select Delete, as shown in Figure 17-28 on page 552.
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Figure 17-28   Select the user to delete, then select Delete from actions list

2. A confirmation dialogue, illustrated in Figure 17-29 on page 553, will display, 
prompting you to delete the user’s mailboxes on Exchange and/or Domino. 
We recommend deleting the user’s mailboxes on either server where they are 
present to conserve disk space.
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Figure 17-29   Delete the user’s mailboxes

3. Click the OK button and the dialogue shown in Figure 17-30 will display, 
confirming that the user has been deleted from the Domino directory, as well 
as from Active Directory.

Figure 17-30   User has been deleted from Domino Directory

Modifying a user in Active Directory
Follow these steps to modify a user in Active Directory:

1. From the Active Directory Users and Computers window, select the 
appropriate container in the left-hand pane. In the right-hand pane, select the 
user to be modified and open the user’s record. The General tab will be 
displayed, as illustrated in Figure 17-31 on page 554.
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Figure 17-31   Active Directory user properties - General tab

2. Add the required information to the user’s record. In this example, shown in 
Figure 17-32 on page 555, we’ve added a phone number for this user.
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Figure 17-32   Add a phone number to the user’s record

3. Click the OK button and the Lotus ADSync dialogue shown in Figure 17-33 
will display. Because the Domino Directory and Active Directory are 
synchronized, you have the option of updating the Domino Directory with the 
changes made to this user. Click the Yes button to update the user’s record in 
the Domino Directory.

Figure 17-33   Synchronize this change with the Domino Directory

4. If you open the Domino Directory containing this user, you will find that the 
user’s record has been updated with the changes you made in Active 
Directory. Figure 17-34 on page 556 illustrates the Domino Directory entry for 
Piglet Chase, updated with a phone number.
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Figure 17-34   Domino Directory record, updated with the Active Directory changes

17.2.4  Registering new Domino users in Active Directory

In addition to registering users and groups from the Active Directory Users and 
Groups window for both the Windows 2000 and the Domino environments, you 
can register new users from the Domino Administrator client. Because the 
Domino Directory and Active Directory have been synchronized using ADSync, 
the new users registered in Domino will also be accessible from Active Directory. 
Follow these steps to register new Domino users in both Domino Directory and 
Active Directory:

1. Start the Domino Administrator client and open the server where you will 
register a new user. Select the People and Groups tab, as illustrated in 
Figure 17-35 on page 557.
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Figure 17-35   Server Configuration tab: People and Groups tab

2. On the right side of the screen, select Register -> Person. You will be 
prompted to enter the Notes Certifier ID file, as illustrated in Figure 17-36 on 
page 558. Select the appropriate certifier file to be used, supply the certifier 
password and click OK.
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Figure 17-36   Choose the certifier ID and password

3. When the Register Person dialogue displays, complete the information for the 
new user, including any policy setting and password options. Figure 17-37 on 
page 559 illustrates the Register Person dialogue with all fields completed. 
Ensure that the password options for this user comply with your IT 
infrastructure’s security policy.
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Figure 17-37   Register Person dialog: Basic tab

4. Select the Advanced checkbox to display the Advanced registration options, 
as shown in Figure 17-38 on page 560. Complete the information appropriate 
for your organization in the Mail, Address, ID Info, Groups, and Roaming 
sections. The Mail settings options are shown in Figure 17-38 on page 560.
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Figure 17-38   Register Person: Advanced options - Mail settings

5. Click the tab to display the Other section, then select the Windows User 
Options button to add this person to Windows 2000. The Add Person to 
Windows 2000 dialogue will display, as illustrated in Figure 17-39 on 
page 561.
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Figure 17-39   Add Person to Windows 2000

6. In this window, select the Active Directory container and Windows 2000 
groups to add this person to, then click OK when finished. In this example, 
illustrated in Figure 17-40 on page 562, we’ve placed the user in the Users 
container, though we could have placed the new user in any container 
appropriate for that user's security rights.
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Figure 17-40   Add Person to Windows 2000

7. Select the OK button to return to the Register Person dialogue, shown in 
Figure 17-41 on page 563. Select the check mark box circled in Figure 17-41 
on page 563 to confirm all information has been completed for the new 
person. The entry will be added to the Registration Queue window at the 
bottom of the screen, as illustrated in Figure 17-41 on page 563. 
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Figure 17-41   New person in the registration queue

Click the Register button to initiate the registration process. Once the registration 
process completes, this person will exist in both the Domino Directory and Active 
Directory.

17.2.5  Managing users with Active Directory

With the implementation of ADSync, you can manage (add, delete, modify) both 
Domino Directory and Active Directory users from Active Directory. If delete or 
modify a user in Active Directory who exists in the Domino directory, because 
Active Directory and Domino Directory are ‘synced’, the changes you made in 
Active Directory will be reflected in the Domino Directory as well. Likewise, you 
can simultaneously add a user to Active Directory and Domino Directory. In this 
section we outline the method for adding, deleting and modifying users in Active 
Directory and propagating these changes to the Domino directory.

Adding users in Active Directory
Follow these steps to add a user in Active Directory:

1. From the Active Directory Users and Computers window, select the 
appropriate container in the left-hand pane. From the menu bar at the top of 
 Chapter 17. Active Directory Integration 563



7777_f_ch_revised_Integrating_w_Active_Directory.fmDraft Document for Review September 11, 
the window, select Actions to display the Actions menu, then select New -> 
User, as illustrated in Figure 17-42 on page 564.

Figure 17-42   Active Directory Users and Computers: Actions: Add new user

2. The New Object - User dialogue will display, shown in Figure 17-43 on 
page 565. Complete the user name fields, including the user logon name.
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Figure 17-43   New Object - User: complete user fields

3. Click the Next button and the dialogue box shown in Figure 17-44 on 
page 566 will display. In this dialogue, type the password for this new user, 
ensuring it meets the security standards for your IT infrastructure. Also select 
the password settings for this user.
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Figure 17-44   Create a password for the new user

4. Click the Next button to display the dialogue illustrated in Figure 17-45 on 
page 567. Since we’re migrating to Domino, the checkbox next to Create an 
Exchange mailbox should not be selected.
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Figure 17-45   No need to create an Exchange mailbox for this user

5. Click the Next button and the dialogue shown in Figure 17-46 on page 568 
will display, allowing you to register the new user in the Domino directory. We 
recommend selecting this checkbox, so the new user will exist and be 
accessible in both Active Directory and the Domino Directory. We also 
recommend selecting the checkbox next to Use common password, as 
setting one password for Windows and Notes is most convenient for the user. 
Fill in the password fields and set an explicit policy for this user (a requirement 
for this dialogue).
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Figure 17-46   Register the new user in Domino

6. Select the Next button and you will be prompted to enter the certifier .id and 
password for the Domino server on which this user will be registered, 
illustrated in Figure 17-47 on page 569.
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Figure 17-47   Enter certifier ID and password for the Domino server

7. Select the OK button and a confirmation window, illustrated in Figure 17-48 
on page 570, will display. Notice that the new user will be added to the 
Domino directory as well as Active Directory.
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Figure 17-48   New user confirmation window - user will be registered in Domino

8. Click the Finish button to create the new user in Active Directory and the 
Domino Directory. A Lotus ADSync dialogue will display confirming that the 
new user has been registered in Notes (the Domino Directory). 

Figure 17-49   Success - new user registered in Domino

Deleting a user in Active Directory
Follow these steps to delete a user in Active Directory:

1. From the Active Directory Users and Computers window, select the 
appropriate container in the left-hand pane. In the right-hand pane, select the 
user to be deleted. Right-click to display the available list of actions, then 
select Delete, as shown in Figure 17-50 on page 571.
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Figure 17-50   Select the user to delete, then select Delete from actions list

2. A confirmation dialogue, illustrated in Figure 17-51 on page 572, will display, 
prompting you to delete the user’s mailboxes on Exchange and/or Domino. 
We recommend deleting the user’s mailboxes on either server where they are 
present to conserve disk space.
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Figure 17-51   Delete the user’s mailboxes

3. Click the OK button and the dialogue shown in Figure 17-52 will display, 
confirming that the user has been deleted from the Domino directory, as well 
as from Active Directory.

Figure 17-52   User has been deleted from Domino Directory

Modifying a user in Active Directory
Follow these steps to modify a user in Active Directory:

1. From the Active Directory Users and Computers window, select the 
appropriate container in the left-hand pane. In the right-hand pane, select the 
user to be modified and open the user’s record. The General tab will be 
displayed, as illustrated in Figure 17-53 on page 573.
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Figure 17-53   Active Directory user properties - General tab

2. Add the required information to the user’s record. In this example, shown in 
Figure 17-54 on page 574, we’ve added a phone number for this user.
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Figure 17-54   Add a phone number to the user’s record

3. Click the OK button and the Lotus ADSync dialogue shown in Figure 17-55 
will display. Because the Domino Directory and Active Directory are 
synchronized, you have the option of updating the Domino Directory with the 
changes made to this user. Click the Yes button to update the user’s record in 
the Domino Directory.

Figure 17-55   Synchronize this change with the Domino Directory

4. If you open the Domino Directory containing this user, you will find that the 
user’s record has been updated with the changes you made in Active 
Directory. Figure 17-56 on page 575 illustrates the Domino Directory entry for 
Piglet Chase, updated with a phone number.
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Figure 17-56   Domino Directory record, updated with the Active Directory changes
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Chapter 18. Public folders for Domino 
administrators

We appreciate that some readers of the redbook may not be Microsoft engineers 
who have worked with Exchange. The purpose of this chapter is to describe what 
Public Folders are in Exchange, and what they can be used for.

The contents of this chapter should help you understand the environment you are 
migrating better, and we have, within this chapter included additional details on 
how to create and administrate Public Folders.The subsequent chapters will 
explain the methods and available tools for coexisting and moving Public folders 
from Exchange to Domino
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18.1  Public Folder Overview
Public Folders are a Collection of shared information”

A user’s data takes many forms, Calendar entries, project details, activities, 
Contacts, tasks email, etc. Some of this data may be private and relevant only to 
a single user, however some data can be useful to group of users or the entire 
organizations accessible by a single user. The full potential of this data is only 
realized when it is shared. Traditional and still often used methods for sharing 
data is utilization of a shared disk or networked file system, More recent methods 
would be via Document management systems, Public folders Built into current 
releases of exchange (2000/2003) provide an additional and simple repository for 
this information that is accessible through Outlook. In most instances they are 
used to store shared calendars (e.g. room booking), files, contacts, and global 
emails. Some are open to the entire organizations or limited to a group of 
individuals

The data and format of public folders offers a degree of flexibility that allows you 
to customize the forms, and fields contained in the documents and thus the end 
user has the ability to define how the documents are viewed. When migrating the 
folders this needs to be taken into consideration as the form constructs and fields 
may not exist in the target domino database

In addition the Folders can be taken off-line and viewed whilst in a disconnected 
mode. The timing of the migration needs to take this into consideration also

18.1.1  Public Folder structure
By default a Public folder exists in a single Exchange server. For users to have 
access to the data The Public Folder Hierarchy (i.e. the infrastructure not 
contents) needs to be replicated throughout the organization. Once done the 
Data (i.e. documents) can be selectively replicated. This is important to note as 
not all data may be available at the time of migration as the hierarchy and the 
data may replicate at different intervals. (i.e. ensure that a full replication has 
completed and Public folders are no longer updated before you begin the 
migration.

18.1.2  Public Folder Security
Public Folder Access is Granted via the Security Tab of the Public Folders 
Properties, the hierarchy of the access can be granted at both the root and object 
level and can permission to grant access can also be devolved to users.
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In many cases Migration tools will not be able to migrate the access and the 
Administrator will be required to add access via ACL’s to the migrated database

.Additional information on permissions is given in the following section. 

18.1.3  Required permissions
If you are creating a Public Folder, the permissions needed depend on where you 
are creating the folder. If you wish to create a subfolder, you need to create the 
rights in the permissions page of the parent folder (Figure 18-2). If you wish to 
create a folder at the root of the Public Folder hierarchy, you need rights to the 
Information Store at the site level.

Figure 18-1   The properties tab of the Test public folder

18.2  Creating Public Folders and administering them
To ensure smooth migration testing, the public folder migration should be 
undertaken, Using copies or newly created folders should be used, in addition to 
having a basic understanding of how to create and administrate Public Folders 
can help the specialist resolve any issues they might encounter during the 
migration and coexistence.
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18.2.1  Tools used to create public folders
In addition to Importing Public Folders can be created via the Exchange system 
manager or from within Outlook (assuming permissions on the public folder 
hierarchy have been granted. For further administration the Exchange system 
manager program should be used to administrate and build the public folder 
Hierarchy and apply permissions to any created folders.

18.2.2  Required permissions
before you can create a public folder the root hierarchy needs to be created and 
default permissions granted If you are creating a subfolder, you need to assign 
the correct permissions on the parent folder as well as the subfolder otherwise 
users will have too much or too little access to create or modify public folders.

Access to the security of the root Public folder open the Exchange system 
manager.

� Right Click the folder

� Select Properties (as shown in Figure 18-2 on page 583)
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Figure 18-2   The properties tab of the root public folder

� Select the security tab
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Figure 18-3   Security of the root folder

� Here you have the ability to assign or revoke public folder tree access. In our 
default installation the ability to create Public folders in the root was restricted 
to the system administrators.

Public Folder permissions
� We devolved the access to allow the ability to create a subtree from one of 

our folders. Once created Right Click on the folder

� Select Properties 

� Select Permissions
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Figure 18-4   Public Folder properties

� Select Client permissions
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Figure 18-5   Public folder permissions ability to create subfolders

� Click Add 

� add the members of the public folders

� Click the tick box “Ability to create Sub Folders”

� Click OK

� Click OK

18.2.3  Creating a Public Folder
As mentioned earlier there are a number of ways to create a public folder.

Via Outlook or via the Exchange System Manager the following procedures can 
be followed to create a public folder

Creating a Folder in the Public folder tree hierarchy
� Open Exchange system manager

� Select administrative Groups

� Select First Administrative group
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� select and right click Folders

� select new folder

� Give the folder a name 

� Click the security tab and assign permissions as described above

Creating a public folder with the exchange system manager
� Open the exchange system manager

� Select administrative groups

� Select First administrative group

� Select Folders

� Right Click Public Folders

� Select new -> Public Folder (see the following Figure 18-6 on page 587)

Figure 18-6   System manager > creating a public folder
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� You will be presented with the properties box of the Public folder

� give your public folder a name and description

� Additional control information can be added on the replication limits and detail 
tabs for our testing default settings are adequate

Figure 18-7   Public Folder general tab

� Click OK

By default the root permissions will be default on this folder to allow different 
access i.e. restrict or allow the posting and reading of documents 

� Select the newly created Public Folder

� Right Click

� Select Properties

� Select permission tab
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Figure 18-8   Setting permissions

� define access as per requirements.

� Click OK

Using Outlook to create a public folder
To create a public folder in Outlook you need the permissions granted at the 
folder level as described above (“Creating a public folder with the exchange 
system manager” on page 587)

Assuming you have access the following procedures can be used to create a 
public folder

� Open Outlook with the desired profile

� Create the new Public Folder in one of 2 ways,

– navigate to the location in which you want to create the folder (I am 
creating mine in the test folder created earlier) 

– Right click the location and select ‘New Folder’ (Figure 18-9 on page 590).
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Figure 18-9   Creating new public folder 1

� or via -> File -> New Folder

Figure 18-10   Creating a public folder 2

In both cases you will be presented with the create public folder properties 
box.

� Enter a name for the folder and select the content type to store.

�
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Figure 18-11   Initial Public folder properties

� Click OK

Public folders in exchange 2000/2003 can have moderators to check the 
content before it is published. the following additional instructions define how 
to assign moderators and change the permissions of the folder

� Right click the Public folder

� Select properties
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Figure 18-12   Public Folder Properties

� You have the option to add a description or by clicking the home page tab 
assign a web page to make the public folder available via the web browser.

� Select the Administration tab 

� Click on the Moderated Folder button 
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Figure 18-13   Administration tab and moderated folder button

� You will be presented with the following screen (Figure 18-14 on page 594)
 Chapter 18. Public folders for Domino administrators 593



7777ch_Public_folders_for Domino_Administrators.fmDraft Document for Review September 11, 
Figure 18-14   Adding moderators

� Add required Moderators

� If desired also add an autoforward for all content

� Click the Permissions Tab 
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Figure 18-15   

By default Author access is granted 

� change the access as required to ensures that users have the required 
access

� Click OK
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18.3  Considerations for Public Folder Migration
There are various tools for migrating Public folders. The subsequent chapters will 
be discussing the following:-

� Binary Tree CMT for Public Folders

� EcKnowledge Cashal for Public folder migration and coexistence

� Manual Migration

– Using Dus

– Using export

– Using Spreadsheet

We will also review the differences between public folders and shared data and 
the implications and differences of the migration of shared data to Domino

However before migrating Public folders consider the following:

– Is the data required in your new system

– What access will need to be granted in the domino db post migration

– Is this a private folder or Public

– Review if Folders are being correctly used a new team room in domino 
may be more appropriate

– Get users to clean up defunct entries in the folder before migration

– Check for complex folders and custom forms.
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Chapter 19. Public Folder migration & 
coexistence using 
ecKnowledge

In a large migration it is likely that large parts of you user community will not 
immediately be using the Notes clients. If your organization is using Public 
Folders, there might be a need to not only migrate the Public Folders, but to 
maintain some level of coexistence with bidirectional updates.

In this chapter, we shown how to set up and use CASAHL Technology Inc.’s 
ecKnowledge product. We tested the tool in our lab using a sample Public Folder 
and Domino database, setting up coexistence between them and then migrating 
the information. We have included all of the steps required to set up the product 
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publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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and connector. We strongly advise testing this product and the other products in 
the marketplace to determine which one is best for your organization. 

For more information about ecKnowledge, visit the CASAHL Web site at: 
http://www.casahl.com/ecKnowledge/default.asp
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19.1  Product setup and considerations
The installation of the ecKnowledge product is simple enough, but there will be 
some decisions to make prior to beginning the process.

19.1.1  Exchange considerations
On the server that will act as a gateway, you need an Outlook client (not Outlook 
Express) along with a profile with sufficient rights to read and write to any public 
folder you wish to migrate and coexist with. For the sake of simplicity we used the 
Administrator’s account, which has the rights to control any object in the 
Exchange hierarchy. 

You also need an account to associate with the service account created by the 
ecKnowledge program. The Windows login account specified for ecKnowledge 
service during install is really important for two reasons:

� Exchange/Outlook Mail profiles are user specific. Therefore, before installing 
ecKnowledge, you must make sure that the profiles are set up for the login 
account specified for ecKnowledge service during install.

� Since Exchange/Outlook security relies on Integrated Windows 
Authentication, the specific Windows login account selected during 
ecKnowledge install will determine the access rights for ecKnowledge server.

We used the Administrator’s account here as well, again for simplicity’s sake. In a 
real world implementation, you should consider creating a specialized account 
with a complex password for this application and giving it any necessary 
permissions to any Public Folders you intend to use.

If you will be working with Exchange Public Folders, then Outlook must be 
configured to connect to the Exchange server. You also need to understand 
which forms were associated with which Public Folder applications. 
ecKnowledge gets data from the Organizational Forms library on the Exchange 
server or from within the Public Folder itself. With that information, it reads fields 
in the Public Folder form and creates them in a Domino database, if necessary, 
or allows you to do mappings. We advise taking a look at the properties pages of 
the Public Folders you wish to work with to see what forms are being used. You 
may also wish to look at the design of the forms for any underlying logic that you 
might want to change before you begin.

19.1.2  Domino considerations
During our testing we installed the ecKnowledge product on our Domino server. 
The ecKnowledge product uses the Domino dll files to access the Lotus Notes 
 Chapter 19. Public Folder migration & coexistence using ecKnowledge 599



7777_f_ch_Public_Folder_Migration_EcKnolwedge.fm Draft Document for Review September 11, 
databases. We do not recommend nor do you need the Notes client on the 
Domino server for ecKnowledge to work. ecKnowledge can also be placed on a 
computer with just the Notes client if you prefer.

� You will need to know the password, if any, that is associated with the ID on 
the server. 

� Make sure that the ID has sufficient rights in the access control list to read 
and write to any Lotus Notes database.

� The Lotus Notes/Domino executable directory must appear in the Windows 
System PATH environment variable.

� At a minimum, you also need to create blank Lotus Notes databases for each 
Public Folder you wish to migrate and coexist with, assign the appropriate 
rights, and replicate as required for you environment. 

� Create (or have someone create for you) additional forms and views for each 
of the migrated Public Folders/Domino databases to better mimic the look and 
feel of the Public Folder. 

� Monitor the performance of the Domino server that is acting as a gateway. 
You might want to dedicate a server for this function.

19.1.3  Other considerations
Make sure the profile you use can connect to the Exchange server. It is also wise 
to create replicas of the Public Folders you are coexisting with, if they are not 
there already, on the server with which the profile is associated. That should help 
avoid any unnecessary network traffic. You should also set expectations as to the 
latency of any transaction. Remember that what starts out on an Exchange 
server somewhere needs to replicate to the server with the profile, through the 
gateway, and then to whatever Domino server has a replica. The latency that you 
had with Exchange may no longer be true in this coexisted state.

ecKnowledge can be installed not only on a Windows server, but also on a 
Windows workstation provided the workstation offers connectivity to your Domino 
server through a Notes client and to the Exchange Server with a configured 
Outlook client (a local MAPI profile).

If ongoing coexistence with replication is needed, you should consider setting up 
a dedicated machine for this purpose. Several factors should then be taken into 
consideration, such as how often the Public Folders and the Notes databases are 
updated. Additionally, the network performance may also determine where 
ecKnowledge server is installed. For example, if there is a lot of data being 
transferred, it may make sense to install ecKnowledge on the same server 
computer as Exchange server or Domino server to reduce networks packets 
going back and forth, and to increase overall throughput of the system.
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19.1.4  Application design
Before we begin, it is useful to do a before and after comparison of the Exchange 
Public Folder and the Domino database.

Domino Developers will want to create multiple views and build forms with 
sections and tabs in the target database to mimic the appearance of the 
Exchange Public Folder. Outlook can use auto fill-in features to do what Domino 
developers might “mask” in a field like a telephone number. So the Public Folder 
design should be examined carefully before the migration of data begins. While 
ecKnowledge can create a form and propagate it with fields from an Exchange 
Public Folder, it will be basic at best, and the views will have no value for the end 
user. One final note: certain types of embedded objects, such as Visio, do not 
seem to render properly. Test the migration thoroughly and set your end users’ 
expectations appropriately before you begin.

Figure 19-1 on page 601 shows the Employees public folder in Outlook before 
migration. Basically, it contains detailed information about the company 
employees. 

Figure 19-2 on page 602 shows the Domino database before the data is 
migrated into Notes. We have created basic items, such as views, forms, actions 
and navigators using Domino Designer.

Figure 19-1   Data in an Outlook view
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Figure 19-2   The Domino database before migration

19.2  Setting up ecKnowledge
First, you should be logged in with the account and e-mail profile you will use to 
run the program. If you are installing the program on a Domino server, be aware 
of the fact that you have to reboot the system after installation. Once you get 
started, setting up ecKnowledge is simple enough if you’ve covered all the issues 
mentioned earlier. 

1. The initial screens are the typical Windows/InstallShield setup routines and 
licensing agreements (Figure 19-3, Figure 19-4, Figure 19-5). 
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Figure 19-3   First window you see after starting the executable

Figure 19-4   Welcome window
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Figure 19-5   ecKnowledge license agreement

2. When you get to the registration screen, accept the defaults and use the Key 
Manager later to get the proper keys from CASAHL.

Figure 19-6   Product registration window

3. The program location can be modified from the standard destination folder if 
you wish (Figure 19-7).
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Figure 19-7   Selecting a program location

4. You can select either a custom or typical setup (Figure 19-8). ecKnowledge 
has a wide variety of connectors for other products, such as Oracle, 
Microsoft’s SQL, SharePoint and Groove, as well as SAP. Licensing is done 
per connector, so you may decide to use this product for things other than just 
Exchange and Domino migration and coexistence. We chose the Typical 
installation.
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Figure 19-8   Selecting a typical install

5. We decided to create a separate program group for the icons.

Figure 19-9   Program Group creation

6. After the program groups are created you are asked for an account 
(Figure 19-10) to associate a service with. We used the Administrator’s 
account, but that is not what you would normally do in a production setting. 
606 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm
You should create an account, which you will use with your Outlook profile as 
well, that has rights sufficient that it can act as a service. The service 
associated with this account initially will be set to manual, which means it will 
not start automatically if the server requires a restart. After testing of the 
connector is completed, you should consider setting the service to automatic.

Figure 19-10   Selecting an account and setting a password

7. Figure 19-11 shows you a dialog box to either configure ecKnowledge to start 
with some same applications, or a blank system catalog for you to create your 
own applications.(Should you opt for a blank catalog, an MDB - Microsoft 
Access - database is created for this purpose.)
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Figure 19-11   Creating a system catalog

When you install ecKnowledge with the samples, you will find some additional 
services added to the mail profile associated with the account used to install 
the program. 

Figure 19-12   Sample CASAHL applications installed into the profile
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19.2.1  Entering the product keys
1. Start the Key Editor program located in the ecKnowledge directory 

(Figure 19-13). 

Figure 19-13   Starting the Key Editor

2. The first time you start the program you might see the dialog box shown in 
Figure 19-14. Click OK.

Figure 19-14   Dialog box after starting Key Editor for the first time

3. Enter the Site and the Features key you obtained from CASAHL 
(Figure 19-15 on page 610).

Note: The Key Editor automatically generates a Site Code based on the 
machine. If you move the program to another machine, you may need to 
contact CASAHL for a new Site Key and Features key.
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Figure 19-15   Entering the product keys in the Key Editor

19.2.2  Post-installation tasks
1. After entering the product keys, go to Windows services and set the 

ecKnowledge service to start automatically. Otherwise, when you reboot the 
server you will need to restart the service manually. Quit Domino if it is 
running and reboot the computer.

2. After rebooting the computer, verify that the ecKnowledge service is running. 
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Figure 19-16   ecKnowledge service

19.2.3  Creating the connection between Domino and Exchange
Connections are created with the Composer program, which is also located in 
the ecKnowledge program group (Figure 19-17).

Figure 19-17   ecKnowledge program group

Important: If you want to do coexistence for a period of time, to minimize 
disruptions, we would recommend creating “Replication” objects to perform 
ongoing synchronization. This chapter walks through creation of 
“Import/Export” objects, which we typically recommend if you want to do one 
shot migration. Replication objects will provide functionality for two-way 
synchronization with conflict detection, etc.
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We found two approaches to the next step. You can either create the connections 
to Lotus Notes databases and Exchange folders first, or as part of the 
Import/Export wizard. We selected to use the Wizard.

1. Select Create → Import/Export to start the wizard.

Figure 19-18   Creating connections with Import/Export wizard

2. Click Create New Connection to create the connection (Figure 19-19 on 
page 613).
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Figure 19-19   Creating a new connection

3. You need to be very specific when filling in the dialog box shown in 
Figure 19-20. Be careful if the machine you are using has multiple profiles. 
Make sure you spell correctly the profile with the proper credentials to the 
Public Folders you wish to migrate/coexist with. 

4. Click the button next to the Folder field to choose the source Public Folder.
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Figure 19-20   New connection dialog

5. Choose the folder for migration/coexistence and click OK (Figure 19-21) to 
confirm the folder selection and click OK to confirm the Connection dialog. 
You are returned to the Source dialog (Figure 19-22).
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Figure 19-21   Selecting the source folder for migration

6. Here things get a bit tricky. ecKnowledge reads information from the 
Organizational Forms Library and the Public Folder. You need to know what 
form and fields you want to use for the migration before you get started. 
IPM.Contact.HR form has the fields we want and is associated with the public 
folder Employees. Choose the form and click Next to proceed to the 
Destination dialog.
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Figure 19-22   Choose the form carefully!

7. The next step is setting up the Domino side. Click Create New Connection to 
create one.

8. When you create the Domino connection you need to specify the Domino 
data path and the nsf file you want to use (Figure 19-23). The path may vary 
from machine to machine. Our Domino database has a form, although if it did 
not, ecKnowledge would create one.
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Figure 19-23   Configuration for the Domino Connector

9. Once you click OK to confirm the Connection properties, you are returned to 
the Target dialog (Figure 19-24). Select the correct form and click Next to 
proceed. 
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Figure 19-24   Finishing up the connector 

10.The next step is to map fields (Figure 19-25 on page 619). You can elect to let 
ecKnowledge do it for you automatically (Figure 19-26) but you will still need 
to verify the mapping (Figure 19-27 on page 620). Click Next to proceed.
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Figure 19-25   Column mapping step

11.The next option asks if you want to match columns based on names, which 
we accepted.

Figure 19-26   Automatic column mapping

Note: In some cases, you may need to massage data when converting from 
MS Exchange to Lotus Domino (e.g. when Domino designers created the 
application a little differently). To take care of such issues, ecKnowledge 
includes data transformation feature which allows conversion of data using 
simple table values, VBScript, Javascript or Notes formula. The data 
transformations can be associated during column mapping.
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Figure 19-27   Automatic field mapping choice of mapping column by name

12.Figure 19-28 shows the field matches ecKnowledge can find and shows fields 
it could not. One necessary step is the selection of a key field or fields. If this 
selection is not made, you will see a warning message.
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Figure 19-28   Field mappings

13.Select your key field. We chose the company name field as the key field 
(Figure 19-29). Click OK.

Figure 19-29   Key selection

14.You have the option of setting up filtering for the Import/Export Connector. 
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Figure 19-30   Parameter choices

Filtering can be set up by field (Figure 19-31) or keyword (Figure 19-32). 
VBScript or Domino’s formula language can be used to set parameters. 

Figure 19-31   Field filter choices
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Figure 19-32   Field sort by keyword

15.You can also decide what you want to do with the source data and how to 
handle errors. We selected Update existing records in Target with same keys.

Figure 19-33   Parameter control

16.The step shown in Figure 19-34 provides execution, error control, and job 
handling.
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Figure 19-34   Execution control dialog box

17.The following four figures show the different scheduling options. You will need 
to take into account the expectations of your end users and your long term 
goals as you make these choices.
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Figure 19-35   Coexistence can be run manually

Figure 19-36   Running coexistence as a daily event
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Figure 19-37   Running the job weekly

Figure 19-38   Running it once a month
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18.If you want an e-mail notification to occur based on a condition, you can 
select a user to send it to (Figure 19-39 on page 627).

Figure 19-39   Notifications

19.Click Next.
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Figure 19-40   Final configuration window

20.Click Finish.

19.2.4  Running the coexistence
For our testing purposes, we elected to run the job manually from the Composer 
program. 

1. Select the job in Composer, right-click it, and select Start to start the job 
(Figure 19-41).

Note: In many cases, we found that the Exchange hierarchy contains 
multiple similar folders. To take care of such cases, ecKnowledge provides 
an XML API. This API will allow to define the replication or import/export 
mappings one in Composer, and then just run in the context of different 
folders. 
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Figure 19-41   Starting the job in Composer

2. Figure 19-42 shows the data populated as a result of the job we created. If we 
select an entry, we can see how the data appears in Notes (Figure 19-44) and 
compare it to the same record in Outlook. (Figure 19-44 on page 631).
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Figure 19-42   Migrated data in Domino database

Figure 19-43   A single record shown in Notes 7
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Figure 19-44   The same record in Outlook 2003

3. Finally, if you need to modify any job, you can go into Composer and examine 
it’s properties. Figure 19-45 shows the options that will be presented.
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Figure 19-45   Import/Export properties

19.3  Working with a blank database
In the previous example we prepared a customized Domino database, set up the 
connectors, and migrated the data. The next example shows what an Exchange 
Public Folder looks like if you start out with a blank database and migrate data to 
it using ecKnowledge.

19.3.1  The Exchange Public Folder
The Exchange Public Folder has service requests in it (Figure 19-46). The form 
used is a simple one with a simple page holding all the fields (Figure 19-47). 
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Figure 19-46   The request view of the Service Request Public Folder
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Figure 19-47   The Exchange Service Request form

The steps involved with migrating the data is almost the same as in our previous 
example. The only difference occurs when you are setting up the Domino side of 
the connector. Remember you are starting with a blank database with only the 
default view. In Figure 19-24 on page 618 you selected from the available 
Domino forms. Because you have no forms, type in the name of the form you 
would like ecKnowledge to create. 

19.3.2  Migration results using a blank database
ecKnowledge does successfully migrate the data, as seen in the document 
pictured in Figure 19-48. While somewhat plain looking, it does have the 
information from the Service Request Public Folder in it and it is somewhat 
usable.
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Figure 19-48   Migrated data with the form created by ecKnowledge

The view, however, only shows document numbers, and to someone unaware of 
Domino view capabilities it would look broken (Figure 19-49).

Figure 19-49   The view of data migrated into a blank database

To give end users what they had in Outlook, we need to modify the Notes view to 
show the contents of the Request Date, Request Number, Requested By and 
Service Description fields. We will do that with the Domino Designer program.
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19.3.3  Using Domino Designer to modify the view
This section is not a complete guide to building views; that would be beyond the 
scope of this book. All we are interested in doing right now is making the views 
look the same as they do in Outlook. You will need a copy of Domino Designer, 
which must be purchased separately. This section assumes you have never used 
Domino Designer before. If you are a Domino developer, you can skip this part 
since it is only targeted for Exchange Administrators and other who need a very 
basic high-level overview of how changing a view is done.

1. Open the Service Request Database in Domino Designer. 

2. Select the Untitled view in the left side of Designer (Figure 19-50). By default, 
only one column is defined, and that uses a document number by default 
defining what is presented to the end user. 

Figure 19-50   The default view of the Domino Service Request Database
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3. Each column in a Domino view will have its own set of properties that will 
control things like appearance, sort order, and data format. You can reach the 
column properties by right-clicking the column in designer. You can also 
access them by the menu selections Design → Column Properties).

You change the contents of a column at the bottom of designer. There you 
can place the content of a field, or multiple fields if you wish. You can add 
logic and simple functions as well.

4. Let’s change the value of the first column. With the first column selected, at 
the bottom of the screen select the field radio button (Figure 19-51) and then 
select the reqdate (requested date) field.

Figure 19-51   Select the Field radio button then reqdate

5. You can then go to the properties box for the column and change things like 
the title and format of data. Clicking the check box saves your changes.
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Figure 19-52   Column properties

6. You might as well change the name of the view and save it. In the Domino 
Designer select Design → Properties.

Figure 19-53   View properties

7. You can insert or append to add additional columns. Inserting adds a column 
to the left of the selected column and appending adds a column to the right of 
the last existing column. If you make a mistake you can drag and drop a 
column to the right place later. Figure 19-54 shows that we are inserting a 
new column.
638 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm
Figure 19-54   Adding a column

8. You can add any field you want to be shown in a view except for a field of type 
Rich Text. 
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Figure 19-55   Appending a column to a view

9. Add the fields you want to each column, and make whatever changes to the 
column properties you may need, based on the types of data. 

10.When you are done, your end users will see something that is similar to what 
they had in Outlook. This is illustrated in Figure 19-56 on page 641. 

If you need more information on how to further customize views for your end 
users, see the Domino Designer 7 Help database, IBM Redbook Domino 
Designer 6: A Developer’s Handbook, SG24-6854-00, contact a Business 
Partner, attend a Domino Developer’s training class, or search the Lotus 
Developer Domain at http://www.lotus.com/ldd for additional resources.
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Figure 19-56   The Notes view after the modifications

19.4  Conclusion
If you have data in your Public Folder that you need to not only migrate but also 
coexist with, as demonstrated here, you do have options. Success will depend on 
you setting expectations as to performance and latency and making the transition 
of entering data in Outlook to Notes as seamless as possible. It may require 
some planning and effort but that should help overcome any resistant to 
migrating from Exchange to Domino that is based on data stored in Public 
Folders.
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Chapter 20. Public Folder migration 
using CMT migration tool

This section deals with a one way migration of Public Folder data from Microsoft 
Exchange 2003 to Lotus Domino 7. The tool we describe for accomplishing this 
is the CMT for Exchange Public Folders migration tool (referred to as “CMT” or 
“CMT tool” later) from Binary Tree. The Domino Upgrade Service does not 
currently support the migration of Public Folder data. As with all the products 
mentioned in this book, you should thoroughly evaluate the CMT tool to see if it is 
appropriate for your environment.
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Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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20.1  Binary Tree’s CMT for Exchange Public Folders
The data in a Microsoft Exchange Public Folder often has significant value that 
has been protected with permissions based on the identities stored in Active 
Directory. To help firms recover the intellectual capital often found in these Public 
Folders, Binary Tree has created CMT for Exchange Public Folders. CMT not 
only takes data from the Public Folders, but can also mimic the permissions that 
existed on the Exchange servers in brand new Domino databases. CMT migrates 
the standard Exchange document types, including mail messages, calendar 
events, journal items, tasks, and notes. If your Public Folders contains forms that 
have been modified to include additional fields and data types, the CMT tool can 
be customized to migrate this data as well. Visit the Binary Tree Web site for 
additional information about the CMT for Exchange Public Folders migration tool 
at: http://www.binarytree.com

Migrating Public Folders from MS Exchange Server to Lotus Domino Server is a 
four-step process: 

� First, you set up the migration settings from within CMT,

� Secondly, you import the public folder names into CMT, 

� Then, you resolve the names from within CMT,

� Finally, you migrate the public folder contents into Notes databases.

20.2  Setting up the CMT tool
The CMT migration tool is a Domino database that needs to be configured prior 
to its use. Before you begin that, one issue that came up in our testing: verify 
permissions on the Public Folders being migrated. A MAPI profile is needed to 
read the Public Folder Hierarchy and the data in the Public Folders. It is 
recommended that the MAPI account used have owner rights to any public folder 
being migrated. That allows the profile to read all of the information in a Public 
Folder, including attachments, and recreate the Public Folder contents in the 
migrated databases. Verify, as well, that the Notes user migrating the Public 
Folders has the necessary rights to create Domino databases on a server.

20.2.1  Configuring the import of Public Folders tool
1. On your Notes client, open the CMT tool database and open the Migration 

Settings document (Figure 20-1).
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Figure 20-1   Default view of the Migration Database

2. On the General Settings tab (Figure 20-2 on page 646), you will need to:

– fill in the name of the Domino server where the Domino address book 
(Domino Directory) is located, 

– enter the name of the Domino address book file name. 
The address book on the Domino server is used to compare and try to 
resolve the names found in the Exchange permissions to get a Notes 
canonical name that coincides with the Exchange distinguished name. 
This process is covered in the Security section on page 651.

– select the level of logging for the migration tool.
Only use verbose logging for debugging purposes. Verbose logging will 
generate very large logs that get attached to the Public Folder document.

– select the Public Folder template.
The CMT for Exchange Public Folder Migration Tool comes with a 
modified mail template that is used for creating the Notes databases. The 
main modification is the ability to store contact lists in the folder list in 
Notes. CMT also keeps shared calendars and shared contact lists 
separate in the folder list. The template design is open for further 
modifications.

The Custom code flags and Rules options are advanced options. 

Important: Modify the default Access Control List (ACL) entries of the 
template to suit your access requirements.
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Figure 20-2   Domino Configuration page

On the Exchange Public Folder page (Figure 20-3 on page 647 and Figure 20-4 
on page 648) you will need to select different parameters. 

You may need to set the Exchange Public Folder Root to have nothing in it, 
depending on what you would like to import. The root is top-level Public 
Folder you would like to migrate. This becomes a Notes database and all of 
the sub-folders under this root become internal folders in this database. If you 
migrate multiple top-level folders, you will have multiple Notes databases. We 
left the Exchange Public Folder Root blank, so we could take all of the 
Exchange Public Folder.

Note: You can create rules to further refine your migration process. The 
procedure and features provided are similar to those described in chapter 
Chapter 13, “Server Level Migration process using CMT from Binary Tree” on 
page 401, and more specifically in “How to define migration rules” on 
page 418.
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You will specify the names of the Domino server and the directory where the 
new Notes databases are created. The default directory name is All Public 
Folders.

Make sure you have all of the message types selected that you would like to 
migrate. If you leave the wildcard symbol “*”, CMT will migrate all of the 
message classes as well as rich text.

You might also want to specify a profile to use for the migration of Public 
Folders. That will prevent being asked each time a database is created. The 
MAPI profile used for the migration has to have Owner access in the 
Exchange permissions.

Figure 20-3   The Exchange Public Folder configuration page (top half)

The security options are found under the Exchange Public Folders Migration 
Settings (Figure 20-4 on page 648). CMT can bring over Database security, 
Folder security and Document security. These settings determine what rights 
should be migrated along with the data. Make the appropriate selections 
according to your security requirements and policies.

– Database security: The database security settings will remain intact and 
apply to the public folders migrated to Notes.
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– Folder security: The security surrounding each folder (who can access 
which folders) will apply to the migrated folders in Notes.

– Document security: The security surrounding each document (who can 
access which documents) will apply to the migrated documents in Notes.

– Ignore ALC entries whose permissions exactly match the Default 
entry: The Access Control List (ACL) has the names of users who can 
access a specific database and documents in Notes. Each database has 
an ACL. In Exchange, security is at the folder level. In order to users’ 
security to stay the same after the migration, CMT has to manipulate the 
document and database security. Each ACL has a default entry. You can 
have users who either match or do not match the ACL entry added to the 
ACL. Click on the check box to have users whose security does match the 
default NOT added to the ACL. Uncheck the check box to have users 
whose security does match the default ADDED to the ACL.

Figure 20-4   The Exchange Public Folder configuration page (bottom half)

The Import All Public Folders Actions section relates to the Import All Public 
Folders button found in the Public Folders views. 

– Merge database at top level: The same database name is used for the 
top-level folder and all of the sub-folders found in the Exchange folder 
structure. 

– Use Aggregate Names: The Exchange display name is used for the 
Notes database name.
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The Custom fields section is used for migrating custom MAPI properties that 
are found in the Exchange Public Folders. You have three options: 

– Ignore custom fields

– Use mapping file.

– Bring across all custom fields. If you select this option, you will need to go 
into the design of the Notes database and make all of the new fields 
viewable in Notes (see “Dealing with customized Public Folder forms” on 
page 662).

3. Once your selections are completed, click on Save & Close. You are ready to 
import and migrate the Exchange Public Folders. 

20.3  Importing Public Folder names

1. Open the Public Folders view and select By Display Name.

2. Click Import All Public Folders as shown in Figure 20-5 on page 649. This 
does not perform the migration; it just brings in the folder names so you can 
select the ones you wish to migrate into Notes database(s).

Figure 20-5   Bringing the Public Folder list into the CMT database

3. As the process begins you are asked for the Public Folder root (Figure 20-6). 
We went with the default of All Public Folders. 
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Figure 20-6   Public Folder root selection

4. The next question concerns which MAPI profile you want to use. If multiple 
profiles exist on the workstation, choose the one with owner rights to the 
Public Folders you wish to import (Figure 20-7).

Figure 20-7   MAPI profile selection

Figure 20-8   List of imported Public Folders
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20.4  Name resolution, Security and Migrated 
permissions

During the Public Folder import phase, CMT is collecting the user entries found 
in the Exchange permissions and creating a person or group document located 
in the Security view of the CMT for Exchange Public Folder Migration Tool (see 
Figure 20-9 on page 651).

When you open any of the Security views, a list of all of the Exchange Display 
Names appears. The next step is to try and resolve all of the Exchange Display 
Names to a Notes Name. Select all documents and click on the Resolve 
Selected button. When the resolve is done, it will prompt you to see the log that 
was generated during the process. If the resolve worked, you should see a Notes 
Name that corresponds with the Exchange Display Name. For the names that did 
not resolve, you will have to edit the documents and select the correct Notes 
Names or mark the user as Ignore.

Figure 20-9   Successful mapping of users from Exchange to the Domino Directory

Additional information is found in the ACL Settings section in the Public Folder 
document (see Figure 20-14 on page 655).

With the ability to do ACL matching, CMT for Public Folders will translate 
Exchange permissions into Domino permissions. The equivalent permissions are 
shown in Table 20-1.
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Table 20-1   Permission levels in Exchange and Domino

Figure 20-10 is an example of a security document showing Anais Bourgeois has 
been resolved and marked as a person. The Exchange Permissions are mapped 
to Notes security during the migration. When CMT finds the Exchange 
Distinguished Name, it replaces the Distinguished name withe the Notes 
Canonical Name in Notes security. To ensure that security is brought over, you 
need to make sure all users have an Exchange Distinguished name with a 
matching Notes Canonical name.

Exchange permission Domino permission

None No Access

Contributor Depositor

Reviewer Reader

Author Author

Editor Editor

Owner Manager
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Figure 20-10   Name Resolution document for Anais Bourgeois

Once you have resolved the names found in the list, you are ready to proceed 
with migrating the Public Folders.

20.5  Migrating Public Folders

The next step requires a bit of analysis before you go forward. The CMT tool is 
designed to import data from the “standard” kind of Exchange Public Folders, 
such as Contacts. The CMT tool will use a template with forms that map to fields 
in those kinds of forms. If you ask CMT to evaluate and import “customized” 
folders, you might not get the expected results. More on that later.

For our Migration test we started with some basic Public Folders which are based 
on the “standard” kind of forms, as well as a mix of folders that had the basic 
Outlook forms customized. 
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In your testing of the product, be sure to evaluate a wide cross section of 
documents that are in a Public Folder. In some migrations, success is a seamless 
transfer of data across systems. Since Public Folders may hold timely and 
relevant business information, mitigating any issues before hand will help meet 
any expectations that may be set as part of the deployment.

Before you migrate any public folder, you can review and edit the info data 
collected during the Import phase.

1. Open the public folder document to be reviewed. The informational data is 
classified into four categories (Figure 20-11).

The Exchange Folder Info section lists the data collected from the Exchange 
Public Folder, including the message classes if any.

Figure 20-11   Overview of a imported public folder document
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The Migration Settings section shows the folder name, the Domino server, the 
Notes database path, and the Notes URL for the public folder. You can edit 
any value as required.

Figure 20-12   Overview of migration settings for a public folder

The Workflow section provides useful information on the status of the 
migration, whereas the ACL Settings section gives insight on the roles and 
permissions granted. 

Figure 20-13   Overview of workflow settings for a public folder

Figure 20-14   Overview of ACL settings for a public folder

If you are satisfied with your settings, close the document. 

2. Select the folders you want to import from the list and click the Migrate 
Selected button to start the job (Figure 20-15).
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Figure 20-15   Selecting the Public Folders to be migrated

3. You may be prompted to accept or reject the overwriting of Domino databases 
and may need to confirm the MAPI profile used during the migration. (You 
have the ability to predefine these options in the Exchange Public Folders 
configuration page, see Figure 20-4 on page 648.)

Figure 20-16   Overwriting existing databases message

4. You will see different progress bars while migrating.

Figure 20-17   Typical progress bar seen during a migration
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Figure 20-18   Progress bar indicating the status for a given Public Folder

5. When the migration is done, a green check mark appears next to the name of 
the folder, indicating successful migration.

Figure 20-19   Status report showing a batch of successfully migrated Public Folders
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6. Figure 20-20 shows the Domino database after the Public folder information 
has been migrated to it.

Figure 20-20   The selected migrated Public Folders

CMT tool was successful in bringing in standard type of Public Folder data. The 
following is a series of documents in both Outlook and Notes showing different 
types of Public Folder data.

The first example is one of more difficult items, a contact form. First shown in 
Outlook and then in Notes. The users experience will be somewhat similar with 
data fidelity maintained.

Attention: We did see mixed results when looking at the various documents, 
and noticed that not all data is migrated without problems. CMT for Exchange 
Public Folders tool uses the same engine for converting documents as CMT 
for Notes does, and we have documented the migration results of the 
individual message types, in Chapter 15, “Migration Results” on page 467. We 
advise that you carefully examine the data types that may exist in your Public 
Folders and consider the consequences that the possible loss of any data 
fidelity might present.
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Figure 20-21   A contact in Outlook
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Figure 20-22   A contact in Notes

The view of “Contacts”, Figure 20-23 on page 661, also has a similar look and 
feel to it’s Outlook counterpart (Figure 20-24 on page 662). The same contact 
shows up multiple times because of her multiple categorization. 
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Figure 20-23   The “Address Card” view of Outlook in Notes 
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Figure 20-24   The same Address card view in Outlook

Dealing with customized Public Folder forms
Public folders might contain non standard forms, meaning something other than 
the standard mail and post, Journal, Contact, Note, Task, and Calendar kinds of 
forms. Those custom properties (or fields) will be imported as part of the 
message in Notes. You need to take some extra steps to create the User 
Interface to show those fields to your end users.

1. Open the Migration settings document as shown in Figure 20-2 on page 646.

2. Go to the Exchange Public Folder configuration page.

3. The very last field in the document is where you set up how Custom fields are 
treated in the migration. Select Bring across all custom fields.

Figure 20-25   Custom fields setting in Migration settings

4. Do the Public Folder migration again. 

5. Figure 20-26 shows a non standard form in Outlook.
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Figure 20-26   A service request form in Outlook

The default Domino database where we migrated the public folder to is shown in 
Figure 20-27.

Figure 20-27   Domino database after migrating non standard forms into it

6. To see that the fields actually are part of the document, open the properties 
for a document (Edit → Properties) and go to the second tab (the Fields tab). 
Scroll down the list of fields to see the custom fields. RequestNumber field in 
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Figure 20-28 is an example of a custom field. On the right-hand side of the 
dialog box you can see that it has the value 1001.

Figure 20-28   Document properties: List of fields

7. If you open the document, you notice that none of those fields are actually 
shown as part of the document. 

8. The document contains a file attachment. When opened, it looks similar to 
Figure 20-29 on page 665. Each row lists a custom field name and the value 
of the field in the document. You can use this as a guide when designing the 
form to show the document. 
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Figure 20-29   Custom fields of the migrated document

9. Use Domino Designer to create a form to show those fields to the end user. 
Going through all the necessary steps to create a form and views to show all 
these fields is beyond the scope of this Redbook. For detailed information 
about designing Domino applications, see the Domino Designer 7 Help 
database, IBM Redbook Domino Designer 6: A Developer’s Handbook, 
SG24-6854-00, contact a Business Partner, attend a Domino Developer’s 
training class, or search the Lotus Developer Domain at 
http://www.lotus.com/ldd for additional resources.

10.Figure 20-30 shows the design of a form in Domino Designer that we created 
to show the desired end result of the migration. The form is an example of 
what a application might create to mimic the look and feel of a customized 
form in a Public Folder.
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Figure 20-30   Service Request form in Domino Designer

11.Figure 20-31 shows the document in the Public Folder and migrated into the 
Notes client. The document is viewed with the form we created.
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Figure 20-31   The migrated document in Notes shown with a custom form

20.6  Summary
Migrating data in a one way manner between Exchange and Domino can be 
done using the CMT tool. What is required is making sure that the profile has the 
correct permissions on the Exchange side, that the application has not been 
customized, and that sufficient permissions are available on the Domino server 
to which the data is being migrated. It is reasonable to expect that some post 
migration work may need to be done, especially when customized forms have 
been used in Exchange. Additional development work is need to mimic the 
functionality of custom applications that have forms with additional fields. 
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Chapter 21. Manual migration of Shared / 
Public data

This chapter covers the manual migration of Public Folder to Domino.

Although many tools exist for migrating data form Exchange/Outlook to 
Domino/Notes some of which are covered in earlier chapters, there may be times 
when manual intervention may be required or better suited. The objective of this 
chapter is not to substitute these tools but to demonstrate the Manual method of 
moving data from Microsoft exchange to Domino. To this end this chapter will 
cover the following

– Basic Public Folders
– Public folders Shared Contacts
– Public Folders Shared Calendars

21

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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We feel that these are the areas that may need additional attention or may be 
simple enough to do without the need of 3rd party tools.

Please Note that once data has been migrated into Domino, you may need to 
modify how this data is displayed thus you will need to be able to create Domino 
databases and views, as well as manipulate data in Domino documents. If you 
intend to store the new databases on a server (needed for shared information) 
then you will need the access rights to the domino server to create databases on 
the server
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21.1  Pre-requisites
Manually moving data does not mean retyping it in or simple cut and pasting, It 
means using the installed applications import and export functions to move the 
data therefore certain pre-requisites are required to enable you to move the data 
from exchange Public/Shared Folders.

You will need at least need the following:

� Active Directory / Exchange privileges To create mailboxes, NB access to AD 
and Exchange admin tools will be required

� An Outlook Client

� A Notes 7.x Client and Designer

� Spreadsheet Program with the ability to read and write .XLS * .123 files

Given these programs you should be able to move data from most Exchange 
stores into a domino database

We have found additional support on the web for more complex migrations the 
following websites can be very useful in providing information on data extraction 
from exchange and Outlook.

http://www.outlookcode.com/dev/customimport.htm

The Web site contains not only a set of tools to import and export data from 
Microsoft Outlook, but access to VB Scripts, forums and information on Outlook 
in general.

21.2  Using DUS to Migrate Public Folders
The Domino Upgrade services where discussed in detail in Chapter 11, “Server 
level migration Using Domino Upgrade Services” on page 339

As noted the Domino Upgrade Services or DUS as it is more commonly known 
takes data from an Exchange mailbox and copies it to a Domino database 
(mailbox) given this If we can get data from the Public folder into a migration 
mailbox folder we will be able to migrate using the DUS. Our objective then 
becomes getting Public Folder data into a mailbox. 

Noticing manual methods for moving copying data may have 
unpredictable results depending on the source and destination of said 
data. It maybe that additional manipulation of the data is required pre 
and post migration
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The migration itself follows some simple steps

� Create an exchange mailbox, ensure that the account used for the migration 
will need full access rights to the mailbox.

� connect the mailbox to your Outlook Profile.

� Copy the Public Folder information into the new empty mailbox.

� Check the quality of the data.

� Migrate the mailbox using DUS.

� Review and manage the migrated data in the new database

The actual steps are discussed in detail in the following section 21.4, “Migrating 
Contacts Public Folder” on page 679

21.3  Using a spreadsheet as an Intermediary
It is possible to import Lotus 123 spreadsheet data into a domino database, by 
exporting your public folder data to excel and then saving as a 123 file this import 
function can be used to migrate non standard public folders into Domino

The following procedures describe the simple steps required to Migrate the data 
from the public folder into a domino database.

I

The following step is optional, you may be able to import into an already created 
database

� Open domino designer and create a new database

� review the public folder and create the forms and views as per your 
requirements

� Open Outlook using the migration mailbox profile

� Create a new folder

� Navigate to the public folder to migrate

� Copy the items from the public folder to the new folder

� Open the new folder and export the data to excel

Note: some basic domino design skills will be required to do this for non 
standard forms and fields
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– select File

– Select Import and Export

Figure 21-1   import/export

– select export as file

Figure 21-2   Select export as to file

– Select export to Microsoft Excel
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Figure 21-3   Export as Microsoft Excel

– Select the new folder as the export source

Figure 21-4   Select folder to export

– Click Next 

– Enter a filename and location
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Figure 21-5   Enter a filename

– Click Next

– The next box defines the field mapping Click Define field mapping

Figure 21-6   Option to map fields

– The current field maps should be a one to one, However there may be 
fields that you do not want to map or wish to map to similar fields defined 
in your domino database forms
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Figure 21-7   Field mapping attributes

– Click OK

– Click next

– Click Finish

– The folder has now been successfully migrated to a domino database

� Review the spreadsheet and remove any unwanted fields rows columns etc. 
and if required add additional information

� Insert a top row in the spreadsheet and ensure that each row matches the 
corresponding field in your Lotus Notes database. ensure the cells in this row 
are left justified and are formatted as Text

� save the file as a Lotus 123 (.wk1)(you may want to save as excel first in case 
of errors later)

� Exit Excel

� Open Lotus Notes 

� Open the database created earlier

� Select File Import
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Figure 21-8   Import option

� Selected file type as Lotus 123

� Select the 123 workbook created earlier
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Figure 21-9   Import file 

� Click Import

� When prompted Import as main document and select a form created earlier

� In column format select as defined by wks file

Figure 21-10   Import options
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� Click OK

� The data will now be migrated

Figure 21-11   Simple 2 field import

� we created a simple public folder with 2 fields body and billinginformtion the 
above Figure 21-11 on page 679 shows the results. (note - this db took 2 
minutes to create a single form with 2 fields and a single view

Remember that Domino can use Lotus 123 data, Lotus 123 does not need to be 
installed on the system (we also noted the beta2 version of excel 2007 does not 
have the ability to save files in the lotus format. 

21.4  Migrating Contacts Public Folder
Outlook contact information is another common Exchange Public Folder is 
shared contacts. We discuss in the shared data chapter how the migration tools 
can be used to migrate shared contacts from a shared folder, the same process 
can be used on the public folder.

Another method that can be used is to send the contacts as vCards across the 
coexistence solution or to save to a shared network and drive and import to Lotus 
Notes. The following procedures explain how to do this.

� Open Outlook

Note: There is a hard limit of 8.192 rows for this type of import (wk1 limit), 
alternative methods of migration will need to be sought or manual creation of 
multiple wk1 file will be required for larger files
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� Select the Contacts public folder 

� CTRL A (Select all) as shown in Figure 21-12

Figure 21-12   Select all contacts 

� Select Actions

� Click Forward as vCard → 
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Figure 21-13   Forward Contacts as vCards

� The message will be received in the domino mailbox

� Open the received mail item

Figure 21-14   The recived vcards

� Select All (-> edit -> select all or CTRL-A)
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� select Save

place the files in a holding directory

� Create a new Personal address book

– File -> Database ->new

– select to save the file on the server

– enter a meaningful title

– enter a unique file name

– select the personal address book template (pernames.ntf)

Figure 21-15   Create a new address book

– Next Right Click inside the open database

– Select manage ACL

– Add all users who need access to the Database with defined permissions

– next Select File Import

– Select the files saved
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Figure 21-16   Selecting Import vCards

� Click Import

� for each vcard each vcard a prompt box to save will pop up

Figure 21-17   vcard import save prompt

� Click save for each vcard

� The following is a view of the imported files
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Figure 21-18   Imported vCards

21.5  Migrating shared Calendars Public Folder
Outlook calendar information is a common exchange Public folder application 
similar to contacts, Both Domino and Exchange support iCal calendar standard, 
Similar migration procedures can be used as described in the previous chapter 
(Chapter 21.4, “Migrating Contacts Public Folder” on page 679). however instead 
of forwarding as vCards the entries will be as icalender files (.ics)

We found that we had to do each calendar entry individually, This we thought 
could be extremely time confusing. However many tools exist, the following open 
source being one of many that will export the entire calendar as an ics file

http://outlook2ical.sourceforge.net/

The file can be either mailed or accessed via domino import. in either case a 
prompt will be given for each calendar entry to be saved.

Note: In our testing we found some issues with the ical support in Outlook 
2000 and XP, both required patches and Hotfixes to fully support ical as stated 
in the products release Notes. Later versions we had at most recent sp levels 
and did not have the same issues
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21.6  Archiving or sending Public Folder data elsewhere
If you do not feel comfortable creating applications using extracted Public Folder 
data, you can send the Public Folder elsewhere for someone else to work on it. 
It’s unlikely that you will want to send the entire data store because that would 
require an Exchange 5.5 server and recreating permissions. A PST (personal 
storage file) is a much more convenient way of doing it.

Creating a PST from a Public Folder is simple. 

1. Select the Public Folder and go to the File → Import/Export option.

2. This invokes a wizard that walks you through the steps that get the job done. 
When the wizard begins, select the Export to a File action (Figure 21-19).

Figure 21-19   Select export to a file

3. Select Personal Folder File (.pst)

Tip: A PST could also be used in a migration to store old mail messages of a 
critical nature. In the future, an Outlook client is all that would be required to 
recover a single document, which could be printed or e-mailed to the new 
system later.

Attention: The larger you make the PST, the more likely it is to get corrupted. 
There is a 2 gigabyte limit on PST files. You would be better served by created 
several smaller PSTs instead of one big one.
 Chapter 21. Manual migration of Shared / Public data 685



7777_f_ch_Manually_migrating_Public_folders_shared_data.fm Draft Document for Review 
Figure 21-20   Select a file type to export to

4. You can select one or a set of nested folders if you want.

Figure 21-21   Pick the folder you want to export

5. Give the file a name and specify a location.
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Figure 21-22   File name and the location

6. It is usually a good idea to give the Public Folder a different title than the 
default of Personal Folder, just in case the developer has multiple personal 
folders to work with (Figure 21-23).

Figure 21-23   Specify a name for the personal folder

7. You can put a password on the PST. Be aware that if you lose the password 
you will need to recreate the file.
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After the PST is created you can send it to anyone you choose, by any means, 
including electronic. Just remember that if you burn the file onto a CD you will 
need to copy it back to disk and remove the read only attributes before you use it.

21.7  Summary
Data can be moved from Exchange Public Folders manually and be reused later. 
In this chapter, we have described several ways to do this. You might consider 
using one of these techniques if the data in your public folders is simple in 
structure and coexistence is not required. IF your data is extensive or complex 
then we recommend that you use one of the 3rd party tools available.
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Chapter 22. Migration of Shared Data

This chapter covers the topic of migrating shared data from Exchange/Oulook to 
Domino.

Although Shared data is like any other mailbox data we get asked many times 
during migration discussions on what to do about shared data.

Before we answer we like to understand what is meant by shared data, as it can 
take many forms. In outlook users have the ability to share aspects of their 
mailbox this ability to share data should not be confused with delegation.

users can share the following

� Contacts

� Folders

22

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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� Calendars

� Tasks

� Notes

� Journal

The level of sharing that can be granted can be restricted from no access to full 
access. There are many reasons why people share data and although this is not 
the ideal method it is used by some people. However the most common form of 
sharing data takes the form of sharing an account (shared mailbox), this tends to 
be to have one address for mail in request that a number of users may need 
access to (for example support). the rest of this chapter will clarify how you 
should treat the migration of shared data many tools exist for migrating data form 
Exchange/Outlook to Domino/Notes some of which are covered in the red book 

In earlier chapters we reviewed the use of Domino’s migration tools and Binary 
Tree’s CMT. Both these tools can be used for the migration of the data.
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22.1  Migrating shared mailboxes.

Shared mail boxes for migration purposes can be treated the same as any other 
user account however additional steps will be required during the migration 
regardless of the tool to migrate.

� Review the current access to the shared mailbox.

– Open active directory users and computers

– Select the shared mailbox user account

– right click and select properties

– click the security tab

– take note of the users granted access and level off access

� Post Migration 

– Right click the database

– select manage ACL

– add users noted above with relevant access

– If database is to be mail enabled add to domino’s mail in database list

22.2  How to share data in a mailbox

You may need the ability to create and test the migration of shared data therefore 
this section will explain the procedures for setting up a shared mailbox and also 
how to configure your outlook account to share aspects of the data.

22.2.1  Creating and configuring a shared Mailbox

To share any other folder other than the Inbox, Contacts, Calendar, Notes, or 
Journal, you must share permissions on the folder you want to share and each 
folder that is higher in the folder hierarchy. For example, to give another person 
access to a folder that is under Inbox in your mailbox, you must grant 
permissions to the Mailbox, Inbox, and the subfolder. Even though it might 
appear you're granting the other person access to more folders than you want, 
only the items in the Inbox subfolder will be available.

Sharing folders should not be confused with Delegate Access, another feature 
available to Outlook users who connect to a Microsoft Exchange Server. 
Delegate Access provides the additional functionality of allowing another person 
to send and reply to messages in your mailbox on your behalf. You would use 
Delegate Access with your administrative assistant so that they can send and 
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reply to e-mail messages on your behalf, including scheduling and accepting 
meeting requests. you may share a folder for multiple access for a limited group 
of suers when you don’t have rights to share the same data in a public folder

Share a folder

To share an e-mail folder permission needs to be granted at the top level 
folder for example if you create a Folder called Projects and then under 
projects create a subfolder called 2006 to grant access to 2006 you will first 
need to grant at least read access to Projects, the following procedures can 
be used to share a folder in Outlook/Exchange

– Open Outlook with your desired folder

– Click a folder (The items in the folder will be shown in the viewing pane)

– Right click the folder to share and select sharing as shown in Figure 22-1 
on page 692 below

Figure 22-1   Folder Properties sharing

– You will be presented with the sharing properties box as shown >
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Figure 22-2   Sharing properties 

– Click permissions

– Click Add 

– Select a user from the GAL and click OK

– Assign permissions which can be granted from just being able to see the 
folder to being a able to create subfolders and edit/delete items.

– we assigned Christopher the rights to read and edit items and create 
subfolders see 
 Chapter 22. Migration of Shared Data 693



7777_f_ch_shared_data.fm Draft Document for Review September 11, 2006 10:43 pm
Figure 22-3   Assign user sharing permissions

– Click OK

22.2.2  connecting to another users shared folder

Open Outlook and log in with the profile that has permissions to a shared folder 
mailbox

1. Select File > Open > Other User Folder as seen in Figure 22-4 on page 695
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Figure 22-4   Open additional folder

2. Enter the details of the users account and folder that you want to connect to, 
you can use the name button that will bring up the GAl for you to select the 
name. A selection box will show available folders.

Figure 22-5   Selecting user and folder

3. Click OK

4. The folder will now open in a new pane in outlook.

22.3  Migrating shared Data
The following section will describe how to migrate shared mailboxes. Shared data 
will be migrated by default However all the sharing permissions will not. If a user 
still has a requirement to share the data Once the mailbox has been migrated the 
administrator will need to add the users to the ACL of the database and provide a 
database link to the mailbox for each user
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22.4  Using CMT to Migrate Shared Data
By default Binary tree Common Migration tools do not migrate shared data 
however within the migration settings there is an option to do so

Figure 22-6   CMT migration settings shared mailbox

22.5  Using DUS to Migrate Shared data

The Domino Upgrade services where discussed in detail in Chapter 11, “Server 
level migration Using Domino Upgrade Services” on page 339.

As noted the Domino Upgrade Services or DUS as it is more commonly known 
takes data from an Exchange mailbox and copies it to a Domino database 
(mailbox). By default when you a users data is migrated non of the shared folders 

Note: When this option is clicked when an end users migration is initiated all 
shared folders will be migrated along with the users other local data. this 
means that multiple copies of the same data will exist in multiple peoples 
migrated mailboxes

Note: Information on shared data will be required prior to migration. This may 
be very difficult as it is initiated on a user level. i.e. users have granted the 
permissions to share folders etc with other users. therefor the migration of 
shared data should be undertaken on a one to one basis
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are migrated and all permissions on shared folders is lost. If it is deemed 
necessary to Migrate this data to a shared source then the following procedures 
can be followed to do so.

Overview
If we copy all shared data into a intermediary mailbox folder we will be able to 
migrate using the DUS. or any other migration tool for that matter thus Our 
objective then becomes getting the data into a mailbox to migrate and gather 
information on the shared folder permissions 

The migration itself follows some simple steps

� gather information on shared folders, permissions accounts etc.

� Create an exchange mailbox, ensure that the account used for the migration 
will need full access rights to the mailbox.

� connect the mailbox to your Outlook Profile.

� Copy the shared data information into the new empty mailbox.

� Check the quality of the data.

� Migrate the mailbox using DUS.

� Review and manage the migrated data in the new database.

22.5.1  Create a migration mailbox
Using the Exchange System Manager (NB You need to be a member of the 
exchange Administrative group) to create a mailbox. When you create the 
mailbox, give the mail account the AD permissions that will belong to the person 
who will modify their Outlook profile to include this mailbox later. although we 
create a user account this will be used only for a migration holder for shared 
Folder information and accessing the shared data in other users mailboxes

The following steps walk through the configuration of an already created account 
mail box

Note: This will be a manual intensive process and have to be done on a user 
by user basis and planning for this should be included in the planning phase. 
For large scale migration, either get users to move shared folders into public 
folders or use the CMT and look at utilizing Team rooms for provide managed 
share repositories.
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Figure 22-7   Opening a mailbox properties

� From the Active Directory Users and Groups management console select the 
required user account, -> Right Click -> Properties

� Select the Exchange Advanced tab as shown in Figure 22-8 on page 699

Tip: to see exchange advanced properties select View > advanced 
features
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Figure 22-8   Selecting the exchange advanced tab
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Figure 22-9   Exchange Advanced tab

Select the mailbox Rights button
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Figure 22-10   Add user access

� Select Add

Figure 22-11   Adding user

� Type the migration mailbox user name and click check name
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Figure 22-12   Select rights

� Select the rights the mailbox user should have the user should have full 
mailbox access

22.5.2  Copy Contents from shared folder to migration Folder

5. Copy the contents of the Shared Folder.

a. Log into the Migration mailbox account

a. connect and open the shared folder from the folders view (use procedures 
described in Part 22.2.2, “connecting to another users shared folder” on 
page 694

b. from within the folder Click Edit Select All (CTL A)
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Figure 22-13   Copying the contents of a Shared Folder

6. Copy the selected contents to the clipboard either CTL C or -> edit -> copy
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Figure 22-14   Copy content to the clipboard

7. Next create a new folder in the migration mailbox 

a. File -> New _> Folder

b. Give it a meaningful name i.e. Graemes contacts

c. Select the location under the mailbox tree

d. Click OK

8. copy the contents of the clipboard into the newly created folder shown as 
Figure 22-5 on page 695.
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Figure 22-15   Copying contents into a new folder

We can now use the Domino Upgrade Service to bring the data into Domino.

Once the migration is complete domino the Administrator will need to change the 
access to the ACL to give access to all the users 

� Open domino administrator

� select the registration domino server

� Create a new mailbox

� select people and groups

� from the right hand tool bar select -> people -> register

Tip: contacts will be created as a subfolder in contacts and when migrated will 
be migrated as contacts and will thus not be visible as a folder in the new 
mailbox. an additional step has been added to describe what to do with 
contacts
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� Click the options Button ans select the following options 

– Allow registration of previously registered people

– click don’t prompt for duplicate person

• select the update the existing address book entry option

– Click the don’t prompt for duplicate mail file

• select replace the existing mail file option

Figure 22-16   Registration options

– Click OK

� Click the migrate people button

� Select exchange as the foreign directory source

Tip: you may want to reuse the same account for multiple shared 
migrations (this may also be the case for shared mailboxes) the following 
option should be used if this is the case
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Use a profile that has full access to the exchange migration mailbox 
created earlier

� Click GO

� Select the migration mailbox and click add

� Click Options

� Deselect all options and select Convert mail only

Figure 22-17   Migration options convert mail only

� Click OK

� Click Migrate

you will get an error about user migrated with errors this can be ignored

� Click Done

� Enter a Password that meets your password requirements, and select an 
explicit policy

� Click the tick box
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Figure 22-18   Completing registration settings

� Click Register

The account data will now be migrated

� Click OK

� If there are any errors review and rectify the error messages are normally 
descriptive enough

� Click Done

Configuring the data for sharing
Once the data is in domino you will need to configure the ACL for sharing, given 
that all users that need access have been migrated they can be added to the 
ACL.from the domino administrator

� Select the file tab

� Select the mail subdirectory

� Select the migration mailbox 

as we intend to re-use this db for multiple migration then do the following
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– select -> file -> database -> new copy

Figure 22-19   Making a copy of the database

– enter the details for the new copy, keep in the server but give the file a 
descriptive title and unique file name
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Figure 22-20   Details if the new mailbox

– Leave all other details as default 

– Click OK

� Select the new mailbox

� Right Click on the mailbox and select Access Control

� Click manage
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Figure 22-21   Access the ACL

� Add the users as required for sharing, user can be selected from the address 
book by selecting the person icon
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Figure 22-22   Adding users to the ACL

� You now have the data shared in domino and shared amongst the users

For data using custom forms additional work on the domino views and forms may 
be required. Other redbooks accessible from http://www.ibm.com/redbooks 
cover design and development of domino databases.

Special considerations for shared contacts.
Shared contacts will be migrated as contacts into the migration mailbox, although 
they are visible via the web access they will need to be synchronized to a 
personal address book.

� Log into the migration account on domino

� open the mailfile

� select actions -> synchronize address book
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Figure 22-23   Synchronize the address book

The contact data in he address book will be synchronized with the personal 
address book on the local machine (names.nsf)

Figure 22-24   Synchronization complete

The personal address book can be copied to the domino server and relevant 
permissions assigned as discussed earlier.

Note: if you intend to re-use the same databases be sure to delete and 
recreate before each migration. Otherwise, you will mix your data.
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Chapter 23. Migration Project wrap up - 
Removing the Microsoft 
Exchange environment

This chapter deals with removing Microsoft Exchange from your organization. 
The process can be simple or fairly complex depending on the size of the 
installation and the speed of your migration. 

23

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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23.1  Removing Exchange servers
As you begin removing Exchange servers from your company, be sure to consult 
the appropriate Microsoft documentation, some of which is listed here. Not 
following the proper procedures might lead to a disruption in the messaging flow, 
Public Folder access, directory services, and other Exchange server 
functionality.

23.1.1  Reasons to remove Exchange carefully
If you are removing a single server from a single site the process is a very 
straightforward one. After you migrate your users and are confident that all is well 
with your Domino migration, you simply power off or reconfigure the server.

If you run a multi-server, multi-site environment, you will most likely need to go 
through a period of coexistence before you can reuse the equipment, if that’s 
your plan.

During that period of coexistence there might be Public Folders that need to be 
replicated and re-homed. Connectors may need to be replaced or removed, 
routing may need to be recalculated, and directory connectors may need to be 
removed. You need to consider where you are in your migration before you start.

23.1.2  Reasons for leaving things alone
You may, of course, elect to leave your Exchange structure intact, shutting it off 
only after you’ve migrated completely. This certainly will give you a fallback 
position should something in you Domino migration go wrong. The servers which 
hold Exchange could be getting old as well, so reusing those servers will 
probably not be a high priority. Leaving the Exchange servers up could also 
facilitate the recovery of any messages that might have, for whatever reason, not 
migrated over successfully. Finally, there is the possibility of problems with some 
regulatory issues concerning the deletion, however unintentional, of mail. 

23.1.3  Additional resources
The Microsoft Knowledge Base has some very important articles on the topic of 
removing Exchange 2000/2003. Failure to take a look at these documents first 
can result in some serious issues later. You can get to any of the following 
technotes by going to http://support.microsoft.com

� Knowledge Base article 189286 covers deleting a server from a site.

� Knowledge Base article 152959 covers deleting the first server in a site. This 
may or may not be the same as the previous item.
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� If you accidently erased the Organizational Forms Library, Knowledge Base 
article 239760 may help you recover the lost forms.

� And finally, if you need to recover a single mailbox from a deleted server 
without causing problems with your remaining Exchange organization, see 
Knowledge Base article 163713.

23.1.4  Before you begin removing Exchange
First, you should be completely confident that the Domino migration is going 
according to your plan. Your connectors should be working, and both messages 
and directory changes, if you’ve elected to put both in, are working predictably. 
Any profiles that users had to the old Exchange servers should be gone by now 
and, if they are not, you should be removing them. Having a user start Outlook 
and have nothing happen will make no one happy.

You should have good backups that have been thoroughly tested. Few things 
could be worse than finding out management wasn’t quite ready yet, and you’ve 
just finished removing Exchange and the tapes don’t work.

What is your Exchange contraction strategy? If you can’t answer that question 
you better start working on one. Do you know what Public Folders are on what 
servers? How about the one connector you had in an Exchange site that acted 
as a gateway? Removing Exchange is easier than installing it, but that doesn’t 
mean you can get away with no planning.

In the locations that have Exchange, how many Exchange servers are there in a 
given site? If there is more than one, do you know which was the first one? If this 
is a phased contraction, it might make a difference.

As you are removing Exchange from your network, remember the old carpenter’s 
motto: “Measure twice, cut once.”

We next go through some scenarios of Exchange removal. The two we focus on 
are a single server in a single site, and multiple servers in a single site.

23.2  Single server, single site
This scenario might apply to a branch office. Consider that you have migrated 
your users and their mail to Domino and you still have Exchange in your 
organization. If you just shut down this Exchange server, the other Exchange 
servers, at the least, would still attempt to send it directory changes and mail. In 
a worst case situation, this server would have your only internet connection and 
the removal of the server could impact other users in other sites. 
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23.2.1  Considerations
Being extremely cautious, let’s imagine some of the things that could be on that 
server:

� A mailbox you chose not to migrate, like an archival mailbox that held 
information from the mailboxes of other users.

� Public Folders that do not have replicas elsewhere.

� Connectors, or it could be a key management server.

� The server could be a bridgehead or a replication hub.

� Public Folders might be homed on it.

� Maybe you started to deploy Active Directory and the server has the Active 
Directory connector on it.

� The server is used to expand a distribution list.

These items, in and of themselves, are not a reason to necessarily keep a server 
up indefinitely. However, they may represent issues that need to be mitigated 
prior to decommissioning any Exchange Server. What follows are some 
suggestions on how to deal with such conditions.

� Mailboxes not migrated

If a mailbox contains messages but was not migrated, there are two 
alternatives. Either place the mail in a PST—the details on how to do this are 
the same as for a Public Folder—or confirm you have a good backup, and 
recover messages as required on an Exchange server that is not really part of 
the network. For details on this, see Microsoft Knowledge Base article 
163713. If you put the mail in a PST and store it optically, you will need to 
return it to disk and change the permissions from read only. If you are relying 
on tape, be aware that recovering an Exchange server can take several hours 
from start to finish.

� The server has connectors

The impact of removing a server that has a connector could be profound to 
the other remaining users of Exchange. Be sure to create alternate 
connectors with a lower cost than the connector being removed. Also, allow 
for any changes you make to your topology to propagate through the rest of 
your Exchange environment. If the connector on the one server in the one site 
is the Internet connector, make sure that you have a way to send mail to the 
Internet, as well as the appropriate MX records to point to the connector. 
Allow sufficient time for the MX records to replicate on DNS servers 
throughout the world. If someone else is hosting DMS services for you, make 
sure the provider makes the changes correctly. 
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� It is a key management server

This server manages keys used to sign and encrypt mail. If this server was 
unavailable and a user’s certificate expired, they might not be able to open 
some messages. See the Microsoft documentation on how to move this 
functionality elsewhere.

� Bridgehead server

While not very likely, a server might act as a hub for one or more functions. If 
the single server is acting as a bridgehead, make sure you adjust your 
topology accordingly.

� Public Folder home server

If you have a Public Folder that was created on the Exchange Public server 
you wish to decommission, then the Public Folder will need to be re-homed in 
order to ensure that proper permissions are maintained. To re-home a folder, 
first create a replica on another server, and then go to the advanced 
properties of the folder resetting the home server (Figure 23-1).

Figure 23-1   Changing the Home server of a Public Folder

Public Folder permissions can be reset when a consistency check is done on 
the information store. Orphaned Public Folders get new permissions when the 
original server can no longer be found in the directory. The consistency 
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checker is manually run when you delete a number of objects and want to 
clean things up. The Consistency Adjuster is on the Advanced tab of the 
Property page of the server (Figure 23-2).

Figure 23-2   Consistency adjuster on an Exchange server

� An Active Directory connector is on the server

The Active Directory Connector is used to synchronize data between the 
Exchange 2000/2003 world and Active Directory. Loss of the connector 
means there would no longer be updates between Exchange 2000/2003 and 
perhaps Exchange 2000 servers that might have been part of a cancelled 
deployment. Your alternatives are to break the connector and let no further 
changes replicate or place the connector elsewhere.

� Server is specified to expand distribution lists

A distribution list can be parsed locally or on a specified server. Verify that 
distribution list expansion is not on a targeted server.

23.2.2  Removing the server
If you are satisfied that you are ready to decommission this single server, take 
the following steps.
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Remove all existing connectors to the site
You need the appropriate levels of permissions to remove connectors. 

1. From the Exchange Administrator program, first delete the directory 
connectors (Figure 23-3).

Figure 23-3   First step in removing the directory connector

2. Confirm the deletion by clicking Yes.

Figure 23-4   Confirm the directory connector deletion
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3. If you have the rights, you next have the option of removing the connector at 
the remote site (Figure 23-5). If you do not have permissions, the deletion will 
fail. Click Yes to confirm the deletion.

Figure 23-5   Removing remote directory connector

4. The dialog shown in Figure 23-6 warns of the consequences of using the 
Consistency Adjuster before you have verified that the Public Folders have 
been re-homed properly. You should have done this as part of your 
pre-contraction checklist.

Figure 23-6   Consistency Adjuster warning dialog

5. Remove your site connector to the Branch Office (Figure 23-7).
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Figure 23-7   Removing the site connector

6. You will be asked to confirm this action. Click Yes.

Check Event viewer
Make sure you check the Event viewer program for errors. Verify that messaging 
and directory services between the remaining sites still function.

Force replication
In the site or sites that remain, force replication from servers that connected to 
the site about to be removed to other sites.

Get rid of orphaned objects
Run the consistency adjuster on all servers (Figure 23-2 on page 720).

Important: Besides Site Connectors, you may find either X.400 or SMTP 
connectors that would need to be removed as well.
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Recalculate routing
Run the routing calculation on the routing calculation page of the site addressing 
tab (Figure 23-8).

Figure 23-8   Recalculating routing

Your server’s global address routing table will no longer show a way to get to the 
Branch Office (Figure 23-9 on page 725).
724 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777ch_Migration_project_wrap_up.fm
Figure 23-9   The revised Site Addressing or GWART

Check the Event viewer for any errors.

Uninstall Exchange 2000/2003 
Uninstall Exchange 2000/2003 software from the server being removed by 
running the setup program.

23.3  Removing a server from a multi-server site
In this scenario you have multiple Exchange servers in a site. You might have 
some users on one Exchange server but not on the other. The things you need to 
be careful of are the same as the single server, single site scenario, but with one 
big exception: the first Exchange server in a site does things that other Exchange 
servers do not. Among the things a first server does, by default, include it being:

� A routing calculation server

� Site folder server

� Default site folder replica server

� Offline Address Book generation server

So, if you have a choice, you would delete the first server last under most 
circumstances. Knowledge Base Article 152960 deals with moving first server 
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functionality. Best Exchange practices will have you move those functions before 
decommissioning the first server.

Otherwise, removing other Exchange servers from a site follows the same 
pattern as a single server, single site. The steps are as follows:

1. Verify everything on the single server, single site list.

2. Make sure the server is not the first server.

3. Run the Exchange setup from the server you are decommissioning and make 
sure to remove all connectors. Not doing this may result in your being unable 
to remove the server.

4. Using the Exchange Administrator on a remaining server, remove the object 
that represents the deleted server.

5. Force replication to other sites.

If you need to keep users on Exchange in a site but need the server, either 
migrate the users or use the Exchange Administrator to move them to another 
Exchange server in the same site.

23.4  Summary
It may take several months to migrate all users from Exchange to Domino in a 
large organization. In a low bandwidth environment, you do not want 
unnecessary network traffic from redundant messaging systems, so 
decommissioning servers is important not only from a networking perspective, 
but from a cost of ownership perspective as well. It is very important to consult 
the Microsoft documentation to ensure that contracting your Exchange 
environment is done properly.
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Appendix A. Other migration tools

In this book we have covered in detail some of the most valuable and most 
recognized tools used in a migration project. There are, however, additional tools 
on the market, addressing some specific issues and tasks that may be very 
relevant for companies migrating from Exchange to Domino. Some of these 
specific tools are covered in this appendix.

The main goal in this appendix is to give an overview of additional tools, and to 
point out the specific value each tool provides and for which situations it is most 
suitable. Some of the additional tools discussed here do not deal directly with the 
migration aspect of data, but add value in additional ways to a migration project.

The tools covered include

� “Coexlinks”

A

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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� “ICODEX Client Genie”

� “Transend Migrator”

� “GMI Infopath_2_Notes”

� “Nash!Com Domino on Unix/Linux Start Script”

� “Nash!Com Trace & Lowercase Conversion Extension”

Note: IBM does not necessarily endorse the tools listed in this Appendix over 
other available tools to be used in a migration. While there may be many 
additional tools in the market, the scope required for discussing each of them 
exceeds what is possible in this book. Instead, we focused on those tools with 
which members of the Redbook team had experience with. 
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A.1  Coexlinks
Coexlinks is a coexistence solution which maintains the fidelity of embedded 
Notes document links (Document Links). It complements the Microsoft Exchange 
connector or the pure SMTP routing solution by adding message fidelity while 
sending mail messages from Notes to Outlook which contain embedded notes 
document links. 

(Please refer to Chapter 5, “Using the Microsoft Exchange Connector for 
coexistence (Exchange 2000)” on page 107, or Chapter 6, “Using the Microsoft 
Exchange Connector for coexistence (Exchange 2003)” on page 169, or finally, 
Chapter 9, “Using SMTP routing for coexistence” on page 267 for the details on 
each of these solutions.) 

As we highlight in Chapter 10, “Co-existence test results - what to expect” on 
page 309, (specifically in the section , “Document Links” on page 323.) the 
fidelity of document links is normally lost when sending messages between a 
Domino and Exchange Domain. Rather than the document link remaining in the 
Notes document, it appears within the message received on the Exchange side 
as a long URL. Coexlinks addresses this issue. 

A.1.1  Overview
Coexlinks is a Tool manufactured by Genii Software, http://www.geniisoft.com

It watches the outgoing Notes mail messages for notes document links (doclinks) 
and converts these to a format that can be handled by non-notes clients, 
including Microsoft Outlook. It offers:

� Seamless conversion of doclinks, view links and anchor links, as well as link 
hotspots

� Customized disclaimer on modified messages

� Converts links to choice of NDL attachments, Notes URL links or Web HTTP 
links

� Selective conversion to HTTP links by database allows non Notes users to 
use notes databases over the web

� Optional formatting URLs allows calls to agents or servlets to process links

� Plug in architecture requires no scripting, coding or design changes

A.1.2  Value add
Organizations that have Domino for a period of time typically deploy a large 
number of business applications utilizing some mail workflow. The workflow 
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process often involves mail processing, by sending mail notifications to a user 
asking them to perform certain actions on Notes documents. For example, give a 
manager’s approval to a vacation leave request. Such mail notifications usually 
contain direct links to the Notes documents in questions These links are typically 
notes links, i.e. they work specifically as intended only inside Notes Client. 

Noteslinks can be generated not only through a workflow application, but also 
directly by a user, since this is a quite common way to send information to other 
notes users. In many cases, the users sending messages might be unaware of 
the mailsystem which the target recipient is using. If an Outlook user receives an 
email that contains such notes links and does not have Notes Client installed on 
the same machine, he would not be able to open such a link. 

Coexlinks converts such noteslinks into a format that allow a user to open such 
links by using the web interface of the database. 

A.1.3  How can this tool can be used in Migration/Coexistence 
project?

This tool can be used in any migration project with an extended coexistence 
phase. Typically, following coexistence scenarios would benefit most from this 
tool:

� You expect a long coexistence phase after an enterprise merger with a 
significant number of users using Notes and Outlook over significant period of 
time.

� You have Notes based applications that utilize mail based workflow and you 
want to enable your Outlook users to work with it, without modifying the 
application.

� You want to add a specific disclaimer to mails that has been routed from your 
Notes environment into Exchange without leaving your organization (namely, 
the messages do not pass through an SMTP Gateway which could also 
function to provide a disclaimer).

A.1.4  Technical Background
Coexlinks is an Extension Manager plug in. It scans the server outgoing mail.box 
for messages containing notes links and converts them into a desired format. For 
the Coexistence scenario preceding an actual Migration from Outlook to Notes, 
where Outlook Users would not have Notes installed on their machines, the most 
suitable conversion way is to convert all noteslinks to appropriate web links, that 
would be opened in a browser. 
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For routing purposes CoexLinks can be installed on the gateway hub server 
transferring mail. Or in a large organization with a large mail workload, Coexlinks 
can be installed on every Domino Server.

Figure A-1 illustrates a sample message, how it is sent from an Notes based 
workflow application. You can see the doc link embedded. 

Figure A-1   A sample message, how it is sent from a Notes-based workflow application

Figure A-2 on page 732 illustrates he same message has been converted by 
coexlinks. Notes links has been replaced to .ndl files in this example, but could be 
replaced to http:// links as well where appropriate.
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Figure A-2   The same message has been converted by coexlinks. Notes links has been replaced to .ndl files 
in this example, but could be replaced to http:// links as well where appropriate.

A.1.5  Installation
The detailed installation instructions for this tool is provided with the distribution 
of the product and will not be covered specifics here. The intent is to provide a an 
overview of what components are involved in setting up the tool.

To install the product, the following steps are taken, 

1. Copy the CoexLinks software, named nCOEX.dll for Windows systems, 
libCOEX.so for Solaris and libCOEX.a for AIX, and the license file liccoex.lic 
into the same directory as the Domino server software.

2. In the Notes.ini file on the Domino Server, add COEX to the extmgr_addins 
line.

So, if your extmgr_addins entry in the notes.ini looks like this:
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extmgr_addins=toool1, tool2

it should be changed after the installation to:

extmgr_addins=toool1, tool2, COEX

3. After you have done these steps, you need to restart the Domino Server.

A.1.6  Configuration Settings
There are a number of additional configuration settings which can be set in the 
servers notes.ini file. We will not cover all of them here, but instead, focus on the 
ones that are important to get an understanding of this product. 

COEXDocLinkType
Determines the form the converted doclinks will take. If set to 0, doclinks will not 
be converted at all, and all other CoexLinks processing will be suspended. 
Effectively, this is a way to temporarily disable CoexLinks. The most common 
choices are 2, for NDL attachments, which works well with all versions of 
Outlook, and 8, for URL hotspots.

Table 23-1   Overview of the COEXDocLinkType notes.ini setting

COEXLimitToDB[n]
Limits processing of messages to specific databases, which are usually specific 
mailboxes. For example, you can limit processing of messages to those which 
flow through the exchange.box if you want to use CoexLinks in conjunction with 
the Microsoft Exchange Connector. This ensures that only messages destined 
for the Exchange Connector will be converted, and other e-mails which may be 
routed to Notes client users will not.

Notes.ini value Meaning

COEXDocLinkType=0 disable CoexLinks - no processing will 
take place

COEXDocLinkType=2 convert to NDL file attachments - 
leave text in place

COEXDocLinkType=4 convert to text URL's

COEXDocLinkType=8 convert to URL hotspots - default 
Notes://

COEXDocLinkType=16 convert to NDL file attachments - no 
text left in place

COEXDocLinkType=32 convert to URL hotspots - default 
http://
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Table 23-2   Overview of the COEXLimitToDB notes.ini setting

COEXPrependDocLink
Enables a disclaimer to be prefaced every message that has been changed by 
the conversion process.

Example: A-1   sample notes.ini entries to enable a disclaimer been added to every mail 
that has been converted by coexlinks.

COEXPrependDocLink=1
COEXPrependDocLinkText1=**********************************************
COEXPrependDocLinkText2=Lotus Notes doclinks have been converted to
COEXPrependDocLinkText3=URL links.  Launch the hotspots to
COEXPrependDocLinkText4=access the linked document in web browser.
COEXPrependDocLinkText5=**********************************************

A.2  ICODEX Client Genie
Client Genie is a tool that allows full remote control of all Notes Client settings, 
including the Notes desktop (workspace), bookmark data, toolbars and notes.ini. 

While ICODEX Client Genie is not a tool which is directly involved with migrating 
data, it is a very useful tool to consider once your organization is working with 
and administering a Notes and Domino Environment. 

A.2.1  Overview
Client Genie (http://www.clientgenie.com)is manufactured by ICODEX, and 
was originally been marketed under the name INTEGRATE!People. It is a highly 
configurable solution for controlling, managing and monitoring Notes Clients from 
a centrally administered Notes database. 

The key features Client Genie provides include:

� Enhanced Lotus Notes Login Screen with easy Location- and 
User-ID-Selection

� Central Administration of the Lotus Notes Workspace 

Notes.ini value Meaning

COEXLimitToDB1=exchange.box process only messages sent via the 
Microsoft Exchange Connector and not 
affect any messages set directly over 
SMTP (via mail.box)
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� Central Administration of Replicator pages 

� Central Administration of Personal Names 

� Central Administration of notes.ini

� Central Administration of Welcome page (Homepage bookmark) 

� Central Administration of the Bookmarkstore 

� Central Administration of Toolbars

� Stores desktop, bookmark and various other data as XML for enhanced 
roaming and rollback 

� Viewing e.g. Notes desktops with a web browser just like in Notes, without 
needing physical or network access to the respective users computer 

� Automatic building of "maintenance-free" portals that mix centrally controlled 
notes-, web- and filelinks with user individual noteslinks all from a single point 
of administration into a single point of information access portal for every user 
to just about any information.

A.2.2  Value add
Almost all Lotus Notes settings can be administered centrally with the Lotus 
Notes / Lotus Domino Components within ICODEX Client Genie and can be 
distributed and / or synchronized when a user registers to a Lotus Notes / Lotus 
Domino server. These settings range from security settings and usability settings 
(e.g. close window with right mouse double click), user- and group related 
location and connection settings, to specific database settings related to the 
user's position and role(s) within the company as well as their current 
geographical location and connectivity state.

ICODEX Client Genie secures full consistency of Lotus Notes Client 
configurations and can help to significantly maximize cost saving potential (e.g. 
minimize help desk enqueries and costs due to different and formerly 
uncontrollable client configurations). 

Finally, ICODEX Client Genie enables the transformation of a wide range of 
Lotus Notes and Lotus Domino contents and functions in the Web browser, e.g. 
the Notes desktop or Workspace itself. 

A.2.3  How can this tool can be used in a Migration/Coexistence 
project?

Although Client Genie is not a dedicated data migration tool, but rather a Notes 
Client deployment and management tool, ICODEX Client Genie can still be very 
valuable in an Exchange to Domino migration project. It helps in deploying a 
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unified and customized Lotus Notes Client desktop and helps to reduce helpdesk 
load by giving administrators the tools to remotely control any of the Notes 
Clients settings from a serverside database. Additionally, it allows to modify these 
settings at any given time, even if the Notes Client will only connect to a server at 
a later time. All changes are applied without any emails or end user interaction. 

Here some example scenarios depicting how Client Genie could be used in a 
Microsoft Exchange to Lotus Domino migration project:

� By using the ability to run agents in a Lotus Client, you could install a 
migration tool on the end users’ machine(s) and run the agent with a help of 
Lotus Script, or through Windows Scripting Host (WSH). For example, you 
could run the Domino Migration Services local data migration process (i.e 
nupgrade.exe) (see Chapter 12, “Migrating local Outlook data using Notes 
Upgrade Services” on page 367) and auto fill the dialog boxes the user would 
have to complete by himself. Additionally, as a preventative measure, you 
could also ensure that the local data migration process could not be run a 
second time (accidentally allowing a user to migrate all the data a second 
time with the result of creating duplicate data). Alternatively, you could use 
Client Genie to deploy TransSend Mail Migrator (see Appendix A.3, “Transend 
Migrator” on page 741) and run it in batch mode (visible or invisible).

� By defining a corporate standard for Lotus Notes Client desktop, you could 
give a newly migrated user give a ready to use, fully "furnished" desktop 
surface with all desktop icons, bookmarks, local replicas, replicator page 
settings and toolbars in place. This allows users to use the new platform in the 
most productive way, reducing the time required for training and learning the 
new environment (Note: to some degree, the ability to deploy and create a 
standardized desktop can also be accomplished by using the build in setup 
policies in the Domino directory - this however is mostly limited to initial setup 
only and does not cover the entire lifecycle of a notes client. For additional 
information on this topic, see the Domino Administrator Help 
http://www-12.lotus.com/ldd/doc/domino_notes/7.0/help7_admin.nsf/f4b82fb
b75e942a6852566ac0037f284/74996b4926fa94378525706f0065b175?Open
Document )

� By creating a custom skin for the login dialog and the Notes workspace, you 
could implement your company’s Corporate Design, to drive end user 
acceptance of your project.

� When you have a migration project as a result of an enterprise merger or 
acquisition, and you are integrating new users into an existing Domino 
infrastructure you could use Client Genie to support the consolidation of your 
Domino Servers by redirecting the bookmark links and workspace tiles on the 
users desktop to reflect database moves across servers. Furthermore, Client 
Genie can help in the renaming of servers or whole domains, without any 
interaction required from end users. This contributes toward minimizing the 
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load at your helpdesk that usually accompanies large scale changes in your 
organization.

� By using the log database of Client Genie you could analyze how Notes 
Clients are set up "out there", and how your end users utilize Lotus Notes. 
Namely, this can help to identify what databases users have links to on their 
desktop and in their bookmarks, which screen resolution are they running and 
even latency times as to identify network bottlenecks from a clientside 
perspective.

A.2.4  Technical Background
ICODEX Client Genie runs as a client / server application. On the Lotus Notes 
Client, there is a .dll file that runs as an extension manager addin that 
communicates with the two Client Genie databases that reside on the Domino 
Server - to download new instructions and upload comprehensive monitoring 
information as well as XML file exports of the current client configuration across 
desktops, bookmarks, replicator pages, replicas and toolbars. 

A.2.4.1   High level overview of how it works
When a user logs into Notes, Client Genie looks in the Client Genie Central 
database for updated settings for that user, converts the local desktop , 
bookmarks etc. into XML format, synchronizes - if necessary - with the new 
settings, and finally uploads all data to a monitoring database in zipped format. 

On the Server, the Domino administrator can create new settings for workspace 
tabs, databases, bookmark folders, bookmarks, toolbars, agent runners and 
many more, and assign them to groups or specific users as well as to clients with 
certain attributes, such as laptops, desktops or citrix users only. In the Monitoring 
database, every Notes Desktop can be viewed offline and every setting of the 
client can be controlled. 

Figure A-3 on page 738 illustrates how Client Genie looks like for the user: Users 
log into Lotus Notes - the ICODEX Client Genie Login Screen displays (naturally 
not with Single Sign On). The login screen can be freely customized; all ID & 
security handling is still done by Notes - the ICODEX Client Genie Login dialog 
only ensures that new changes can be downloaded from the server and 
immediately applied to the local client configuration before Notes locks it (like 
deskop*.ndk, bookmark.nsf, ...).
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Figure A-3   Client Genie replaces the Notes login dialog with a customized, skinned 
version

After successful password entry, users see a short progress bar, indicating THAT 
something is happening, but not allowing the end user to choose WHETHER it 
happens or not (and without being dependent on the end user as with email- / 
buttonbased administration)

Figure A-4   After the login dialog the user sees progress bars

After synchronization is finished, Lotus Notes starts as usual. Except for the 
managed content such as e.g. the position of a database tile, bookmark or 
replicator page entry, and the server to which they point to, all of which is fully 
controlled through the administration documents in the Central database. 

Finally, Figure A-5 on page 739 illustrates how Client Genie can provide a 
customized skin to the Notes Desktop to provide a compliance with corporate 
design and identity. 
738 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777_f_ax_other_tools.fm
Figure A-5   Client Genie can provide a customized skin to the Notes Desktop to provide a 
compliance with corporate design and identity

A.2.5  Installation
The detailed installation instruction is provided with the distribution of the product 
and will not be covered in extensive detail here. We will give only a general 
direction of what components are involved in setting up the tool.

Installation of Client Genie is divided into two parts:

A.2.5.1   Serverside Installation of Client Genie
This involves creating a Database File (*.NSF) for 

� CG Central Database

� CG Monitor

� CG Help

No other files or configuration on server is needed.
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A.2.5.2   Clientside Installation of Client Genie
Clientside installation involves:

� Deploying the Lotus Notes C API DLL

� Deploying Client DLL (corpdesk.dll) and License File (ICODEX.lic) to either 
the notes data or program directory - ICODEX Client Genie does not require 
any admin rights or registry settings.

� Configuring Client Notes.ini (Adding one entry)

This installation process can be done by building a customized Lotus Notes 
Client install package, or if the Notes Clients are already rolled out, via an email 
based setup that is build into Client Genie.

A.2.6  Configuration
All the configuration of all the user settings is done in the Client Genie Central 
database, which is illustrated in Figure A-6 on page 741. 
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Figure A-6   Client Genie Central Database

All the settings are made by creating appropriate Notes documents that are 
arranged hierarchically as parent documents (i.e. multiple Database Icon 
documents can be attached to a Workspace Page document). All documents 
have fine tunable access control entries of readers and authors fields.

A.3  Transend Migrator
Transend Migrator is an easy to install and use Windows utility for converting 
email data between virtually all legacy and leading edge email systems and 
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clients, including Outlook/Exchange, Notes, GroupWise, IMAP, Netscape, 
Eudora, Pegasus, AOL, Outlook Express and more. It provides both an intuitive 
wizard driven interface for end users and technicians and a powerful command 
line batch mode processor for automating the conversion of thousands of users 
from a central location.

A.3.1  Overview
Transend Migrator is manufactured by Transend Corporation. 
(http://www.transend.com/) 

It is a client-based utility for converting data to and from a number of email 
programs including a migration from Exchange/Outlook to Lotus Notes and vice 
versa. It covers:

� Messages/Folders

� Local Archives

� Address Books

� Calendars

� Tasks

Notes versions 4 to 7 are supported. All versions of Outlook/Exchange are 
supported. Both the Notes and Outlook clients need to be installed on the PC 
running Transend Migrator, which can be installed on a network drive or the end 
user's PC.

Transend Migrator typically is run from the end user's PC, but can also be run for 
multiple users from a central location (see below: Running Transend Migrator 
from a Central Location). Transend Migrator includes both a graphical Windows 
interface with easy to follow wizard-like instructions as well as a powerful 
command line batch mode processor.

The users Exchange mailbox and Outlook personal folders (.pst file) can be 
converted to the Notes server or local .nsf file. Transend Migrator provides a 
report of the completed migration and generates a detailed log file.

A.3.2  Value Add
Transend Migrator is a full scaled migration tool that allows the conversion of all 
personal data from Outlook to Lotus Notes. It offers alot of configuration 
possibilities and can be tweaked to your very specific migration goal. 

Here are some highlights:

� Runs on the client machine either in a GUI or directly using a command line.
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� Attachments are converted and maintained with the converted messages or 
can be detached from the message and copied to a specified directory. 

� Addresses can be converted to a format that can be replied to through Notes 
based on a specified name conversion rule.

� Outlook Contacts or Personal Address Book are converted to the users local 
names.nsf, including personal addresses and distribution lists.

� You may optionally specify an email address conversion rule, so that the 
converted addresses would work in the new environment. (i.e. convert 
Exchange addresses to SMTP or to Notes hierarchical name)

� All data from the Outlook address book is converted, including: name, email 
address, comments, location, department, manager, company name, title, 
suffix, job title, spouse, children, assistant, pager, office phone, office fax, 
home phone number, home fax, cell phone, birthday, office address, home 
address. (Domino Upgrade Services does not migrate some fields, like 
birthday)

� The user's Outlook calendar is converted to the Notes calendar. Transend 
Migrator gets all Outlook appointment types: anniversary, all day, meeting, 
and reminder. It also converts the Tasks list. Reoccurring entries are 
supported, but expanded to multiple entries in Notes. Data fields retrieved are 
Subject, Location, Room, StartDateTime, EndDateTime, Importance, 
DueDate, AppointmentType, SentTo, RequiredAttendees, 
OptionalAttendees, comments, and attachments.

� Can be installed on a network drive

There are some limitations:

� It runs on a client machine and need both a MAPI (i.e. Outlook) and Notes 
installed side by side.

� You have to create the Lotus Notes user accounts in advance

� There is no management interface were you would track the status of the 
migration of multiple users

� When running in the GUI mode a user required to do a lot of interaction with 
the dialog boxes, being asked for quite obscure technical information and 
settings.

� It does not migrate all Outlook data in one step. The user need to start it 
multiple times to migrate mails, than calendar and then address books.
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A.3.3  How can this tool can be used in Migration/Coexistence 
project?

While Transend Migrator is a client level tool, it can be run from a centralized 
location, without any user intervention. For centralized operation, access is 
required to both the users' Outlook/Exchange mailbox stored on the server (if 
Exchange is involved) and any local personal folders (.pst files). On the Notes 
side, there must be access to the users’ Notes email database (typically stored 
on a server but it could also be a local .nsf file) and their local names.nsf file for 
address books (local .nsf files are stored in each user's notes data directory).

If Outlook data is converted to local Notes .nsf files (one for each user), then 
access to the Notes server is not required. The local Notes .nsf files can then be 
distributed to the Notes users.

Transend Migrator can be run in an interactive or batch mode. A single batch 
mode .dat file can be created for multiple users, which would enable the 
conversion of groups of users in a single process.

This is done by running the program TMB.EXE. TMB by default looks to the file 
UAB.DAT for its script.

A script consists of various keywords that supply the same information that is 
collected by the user interface. When all the required information is present, you 
trigger a conversion by using the keyword "Start". TMB performs the requested 
conversion, and then returns to processing the script. If additional data is found, 
the process begins again. The UAB.DAT file that is supplied with Transend 
Migrator can be used as a starting point for your own script.

A.3.4  Technical Background
When Transend Migrator starts, it displays the Conversion Type screen. This 
allows you to indicate which type of conversion you will be performing. You may 
select Message Folders, Address Books, Calendars or Tasks/To Do.
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Figure A-7   Transend Migrator - manual migration - Step 1

From the same Dialog box you have the access to the program options dialogs. 
Below are the screenshots for the Outlook and Notes settings screens.
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Figure A-8   Transend Migrator - Outlook options
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Figure A-9   Transend Migrator - Notes options

Next you will be asked for what systems you want to migrate to and from.

Figure A-10   Transend Migrator - manual migration - Step 2
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In order to access Exchange or Outlook to extract the data, you must have 
already installed the Exchange or Outlook client on your machine. In most cases 
Outlook will be accessed via a "profile". If you are using a profile, enter the name 
of the profile here. As an alternative to using predefined profiles, you can tell 
Transend Migrator to extract data from a .pst file that you specify. If you are 
converting address book data, this screen will include the field "Contact Folder", 
where you may enter an alternate name of the folder containing your Outlook 
contacts if you are not using the standard default.

Figure A-11   Transend Migrator - manual migration - Step 3

The logon screen for Lotus Notes asks you to enter values for the Notes user 
name, mail database, and password. Default values for both the user name and 
mail database should appear in these fields. This screen also contains a 
checkbox for "Shared Folders", which should be checked if you intend to convert 
to a shared Notes database.
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Figure A-12   Transend Migrator - manual migration - Step 4

The folder selection screen presents a list of all existing Outlook/Exchange 
folders (what you are converting from). Folders in a multi-level hierarchy (folders 
within folders) will be separated from higher levels by a slash. Single or multiple 
folders can be selected for conversion.

Figure A-13   Transend Migrator - manual migration - Step 5

Prior to running the conversion, the following options can be set from the 
Miscellaneous Options screen:
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Figure A-14   Transend Migrator - manual migration - Step 6

� Convert only those...: To convert only those messages that contain the given 
string. Leave this field blank to convert all messages.

� Max Attachment Size: This field allows you to limit the size of attachments 
that are converted. If you want all attachments to pass, enter all 9's in this 
field. There is a command line switch that allows you to specify that deleted 
attachments will be copied to a directory. See Command Line Options.

� Max Distribution List: Use this field to cut off a distribution list (to's and cc's) at 
a given number.

� Oldest Message Date: This option allows you to convert only those messages 
that were created more recently than the given date. To convert all 
messages, enter a very old date (such as Jan 1, 1980, the default).

� Message Store: This field appears only if you are converting to a system that 
supports multiple message stores, such as Exchange or Outlook. In that 
case, you may select the message store from the drop down list.

� Name Conversion: For many conversions, the original email address of 
people on the distribution list will not make any sense in the new system. This 
field allows you to create an Internet style address based on a display name.

In the example in the Figure A-14 on page 750 the address conversion rule 
would convert the sender Gregory Engels to GEngels@itso.de
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A.3.5  Installation
The detailed installation instruction is provided with the distribution of the product 
and is not covered in extensive detail here.. The intent is to provide only an 
overview of what components are involved in setting up the tool.

To install Transend Migrator, run the install file. You may select the install 
directory, and optionally create a program group for the main executable 
TM.EXE.

All documentation is provided via a Windows Help file. You can invoke the help 
system by running TM.EXE and pressing the HELP button, or by running 
WINHELP.EXE and opening the file UA.HLP.

The setup program will copy files required by all conversion types. For a smaller 
installation, you may remove DLL files that are not required by the type of 
conversion you are doing. 

It is also possible to install the tool on a network drive, so that there would be no 
need to run the installer on the single client machines.

A.3.6  Configuration
Transend Migration does not need to be configured in order to be able to run, but 
you have to enter the client license key in the GUI dialog field

The included command line tool tbm.exe does take a lot of command line 
parameters. 

A.4  GMI Infopath_2_Notes
GMI InfoPath_2_Notes is a notes tool that allows an automated migration of 
Microsoft InfoPath® forms and views into Lotus Notes

A.4.1  Overview
GMI Infopath_2_Notes is manufactured by Smartix Gmbh 
http://www.smartix.de

GMI InfoPath_2_Notes provides a set of rule-based transformations to migrate 
any MS InfoPath form in a Notes database and therefore provides the solution 
for option (c) above.

This transformation includes 4 different steps.
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1. Saving the MS InfoPath form as resource-files

2. Selecting a target location on your Domino server or local Notes client

3. Migrating the UI of the selected Form according to the specified translation 
filter

4. Migrating the code of the form based on configurable translation filter and 
highlight the migrated elements in the new created Notes application

A.4.2  Value Add
GMI InfoPath_2_Notes enables the automated migration of any known MS 
InfoPath form to a new Notes database.

Within the migration process, approximately 85% of the complete code will be 
migrated within seconds and all unknown elements will be highlighted for manual 
correction afterwards.

Using GMI InfoPath_2_Notes allows the migration-team to do a much better and 
much completer job with little additional costs within its project.

Additional advantages of an automated migration are:

� consistent data model due to identical fieldnames

� identical UI of the notes-application lead to a reduction of a need to train the 
endusers

� fast and error-free status quo on the new platform due to exclusion of human 
error-sources

� consistent solution across all existing MS InfoPath forms (and views)

A.4.3  How can this tool can be used in Migration/Coexistence 
project?

To migrate a MS InfoPath application proceed with the following steps as 
described:

1. Open your MS InfoPath in design-mode
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Figure A-15   Microsoft InfoPath open in edit mode

2. Select the form on your computer (Open a form in design mode - on my 
computer)

Figure A-16   The dialog box to select a form template (.xsn file)
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Figure A-17   This is a fragment of the InfoPath form in edit mode

3. Save the resource-files for this form

the menu command is File → Extract Form Files
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Figure A-18   Save the forms resource files

4. Go to your InfoPath_2_Notes - database and run the action 

Figure A-19   Run the action transform InfoPath to Lotus Notes
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5. Select a location for the new Notes database

Figure A-20   Select the filename for the new database

6. And if necessary - customize the result of your migration
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Figure A-21   The new Notes form opened in Domino Designer 

A.4.4  Technical Background
As with many other enterprise scale (and often "complex") IT systems (similar to 
WebSphere Portal and WebSphere Application Server) MS InfoPath applications 
are build of a bundle of resource-files in XML-format. When deploying MS 
InfoPath form, these resource-files will be combined in a "run-time" file with the 
extension ".xsn"

Table A-1   Files contained in the InfoPath .xsn file

Resource file is used for

manifest.xsf stores information about combined 
files and field-formats

schema.xsd stores field-information

template.xml stores additional field information

sample.xml handles default-values and some 
example data
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GMI InfoPath_2_Notes reads the XML-stream of all these files and combines 
them into a valid DXL-stream.

This DXL-stream will then be imported to an empty Notes-database and creates 
forms and included Code within this empty database.

For the transformation of the UI-information like tables, fields and action-buttons 
GMI InfoPath_2_Notes uses the GMI framework to translate the MS InfoPath 
structure in the GMI-XML-pattern in the first step:

Figure A-22   Setting for InfoPath to GMI framework conversion

During the second step the GMI-representation of the MS InfoPath form will be 
transformed in a Notes-application using the "GMI → Lotus Notes" set of filter

script.js or script.vb stores the enhanced code

view_1.xsl keeps all the UI-information

Resource file is used for
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Figure A-23   Settings for translation of GMI-XML to Lotus Notes

For the transformation of code-elements like JS, VB or some "special elements" 
like @Formulas a set of code-translation-filter will be used:

Figure A-24   Settings for translating code elements into @Formulas

So in this case the expression "normalize-space(.)" will be replaced by 
"@Trim(FIELDNAME)".

The result of these transformations will be pasted in the corresponding location in 
the DXL-tree - so a Default-value will remain a default-value and a 
Input-validation will become a input-validation
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A.4.5  Installation
The detailed installation instruction is provided with the distribution of the product 
and is not covered in extensive detail here. The intent is to provide only an 
overview of what components are involved in setting up the tool.

GMI InfoPath_2_Notes is a single Notes database (.nsf).

To Install GMI InfoPath_2_Notes just copy the database somewhere in your 
notes-data directory and sign the database.

A.4.6  Configuration
Open the database and go to "Configuration" - "all config documents" area and 
open the "Config"-document.

Figure A-25   GMI Infopath_2_Notes settings menu

Here you have to enter the licence-key provided on your invoice.

Figure A-26   The license key is the one setting that is mandatory

Now the installation has been completed successfully!
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A.5  Tools which may be helpful for a UNIX migration
The following tools described are especially helpful if your migration from 
Exchange will result in a migration from Microsoft Exchange to Domino running 
on a UNIX or Linux environment. Specifically, if you will be migrating into a UNIX 
environment, these tools may be very useful:

� A.6, “Nash!Com Domino on Unix/Linux Start Script”

� A.7, “Nash!Com Trace & Lowercase Conversion Extension” on page 765

A.6  Nash!Com Domino on Unix/Linux Start Script
For companies wishing to migrate not only to Notes and Domino, but who wish to 
also take advantages of the stability and scaleability provided by running Domino 
on the UNIX platform, this tool may be very helpful. 

When Lotus Domino is deployed on a Unix operating systems, including Linux , 
Domino does not come with a standard start and stop script, contrary to the 
expectation of some Unix administrators. Nash!Com Domino Start Script is a 
specific tool which addresses this issue.

A.6.1  Overview
The Domino on Unix/Linux Start Script is written by Daniel Nashed from 
Nash!Com and is available free of charge upon request from Nash!Com, 
homepage: http://www.nashcom.de/nshweb/pages/startscript.htm

Daniel Nashed can also be reached directly at mailto:move2lotus@nashcom.de

The Domino cross platform start/stop and diagnostic script has been written to 
unify and simplify running Domino on Linux and Unix. The start script is designed 
to be one stop shopping for all kind of operations done at the Unix prompt. The 
script can start and stop the server, provides an interactive console and run NSD 
in different flavors.The script ensures that the environment is always setup 
correctly and supports multiple partitions.

A.6.2  Value Add
Nash!Com Domino on Unix/Linux Start Script provides a comfortable and reliable 
way of running your Domino Server on Unix or Linux operating Platform.
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A.6.3  How can this tool can be used in Migration/Coexistence 
project?

If you are considering to deploy the Linux operating System for your Domino 
Servers, (perhaps because you no longer wish to incur the cost of Windows 
licensing fees) this start and stop script will help your administrators to install and 
running Domino on Linux or AIX or Solaris.

A.6.4  Technical Background

Components of the Script
The script consists of the following:

rc_domino
This shell script has two main purposes

� Have a basic entry point per instance to include it in RC run-level scripts for 
automatic startup of the Domino partition You should have one script per 
Domino partition or a symbolic link with a unique name per Domino partition.

� Switch to the right user and call the rc_domino_script.

Notes:

� If the user does not change or you invoke it as root you will not be prompted 
for a password. Else the shell prompts for the Notes Unix user password.

� The script contains the location of the rc_domino_script. You have to specify 
the location in DOMINO_START_SCRIPT (default is 
/opt/lotus/rc_domino_script).

rc_domino_script
This shell script contains

� The configuration per Domino server specified by notes Unix user. You have 
to add more configurations depending on your Domino partition setup.

� Implementation of the shell logic and helper functions.

� General configuration of the script.

Script Commands
The script can be invoked with a number of command line commands. 

start
Starts the Domino server and archives the last OS-level Domino output-file. The 
output-file is renamed with a time-stamp and compressed using the configured 
compression tool. Compressing the log file is invoked in background to avoid 
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slowing down the server start when compressing large log-files. The start 
operation does clear the console input file and logs information about the Unix 
user environment and the security limits of the Unix user.

stop
Stops the Domino server via server -q and waits a given grace period 
(configurable via DOMINO_SHUTDOWN_TIMEOUT -- default 10 minutes). After 
this time the Domino server is killed via NSD if it cannot be shutdown and 
processes are still ruining after this time (see "kill" command below) The Java 
controller remains active if configured.

stopjc
In case you configured to use the Java controller (USE_JAVA_CONTROLLER) 
this command shuts down the controller component. When starting the server 
and the controller is running it will be shutdown before starting the server. There 
is currently no way to restart Domino with a running Java Controller from the 
Domino console. The work-around is to stop and restart the controller.

restart
Stops the Domino server and restarts it using "stop" and "start" command with all 
implications and specially the time-out values for "stop".

status
Checks if the Domino server is running and prints a message. Return code of the 
script:

� 0 = server is not running

� 3 = server is running

monitor
Attaches to the output and the input files of a running Domino server and allows 
a kind of live console from a telnet/ssh session using the input and output files. 
ctrl+c terminates the live console.

archivelog
Archives the current server text log-file. The file is copied, compressed and the 
current log file is set to an empty file without losing the current file-handles of the 
server process. There might be a very short log file interruption between copying 
the file and setting it to an empty file. The new log file contains a log-line showing 
the archived log file name.

info
Generates a sysinfo style NSD (nsd -info).
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nsd
Generates a NSD without memcheck (nsd -nomemcheck).

fullnsd
Generates a full NSD including call-stacks and memcheck

kill
Terminates the Domino server (nsd -kill)

setenv
Sets the Domino server environment. You need to invoke the script in a way that 
the environment variables are inherited into the current shell.

A.6.5  Installation
1. Copy the scripts into your Domino binary directory and ensure the variable 

DOMINO_START_SCRIPT (default is /opt/lotus/rc_domino_script) matches 
the location of your main start script.

2. Ensure that your Unix user name matches the one in the configuration part of 
the Domino server.

3. Ensure to setup the following script variables per Domino partition:

Table A-2   Main variables that should be configured in the script

4. For Aix and Solaris change first line of the scripts from "#!/bin/sh" to 
"#!/bin/ksh". Domino on Linux used sh instead of ksh. The implementation of 
the shells differs in some ways on different platforms. 

A.6.6  Configuration
This script is not intended to set all the OS-level tuning. Tuning your OS-level 
environment should be always done on OS-level directly.Tuning your OS-level 
environment in the start script would imply having root permissions to start the 
Domino server. This script is designed to run with the standard notes user for 
each partition.

All configuration can be moved into one or multiple external files, either one per 
partition or a general config file, separated from the script logic

Script Variable Explanation default value

LOTUS Domino binary directory /opt/ibm/lotus

DOMINO_DATA_PATH Domino data directory /local/notesdata
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A.7  Nash!Com Trace & Lowercase Conversion 
Extension

Nash!Com Trace & Lowercase Conversion Extension is a Lotus Domino Server 
plug-in that helps migrating from Windows operating system to UNIX based ones 
like Linux and AIX. You can learn more about this at 
http://www.nashcom.de/nshweb/pages/nshextlo.htm

A.7.1  Overview
Domino uses functionality provided by the operating system it resides on to 
perform tasks such as a listing of a directory or finding a database by its 
filename. So, if the operating platform is case sensitive for filenames, Domino 
also behaves that way. Windows is a case insensitive platform, so a file named 
MigrationTeamroom.nsf and migrationteamroom.nsf as well as 
MIGRATIONteamroom.NSF is considered the same file. This is not so on UNIX 
based operating systems such as Solaris or Linux.

When moving Domino Servers from Windows to UNIX one might run into huge 
problems with databases who’s filenames consist of mixed case spelling (for 
example MigrationTeamroom.nsf). Most problems occur in the following areas

� agents try to open databases

� server replication

� mail delivery (when the person document contains wrong casing)

� opening mail-files (when the location document contains wrong casing)

� opening databases from the workspace (when the icon has been added with 
different casing when the database was already in the cache)

� when opened via HTTP,...

The main problem is that this behavior is not controllable/supportable in day to 
day operation. You cannot be 100% sure that you find all places to correct the 
casing and specially migrating from another platform where casing is ignored. 
And in some cases you also run external/3rd-party applications which you cannot 
control at all.

For some customers this might not be an issue, especially if you don’t have a 
large number of databases, but for some can became a major problem when 
facing migration of a Domino Server to other platforms.

In addition the behavior of two databases with different casing would be still 
inconsistent because once one of the databases has been opened, further 
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requests (also for the database with other casing) would hit the open database in 
cache and ignore casing. So you could never open both databases.

A.7.2  Value add
This solution addresses this problem by translating all calls to create and open 
databases to lower-case. After converting all files and directories to lower-case 
on the file-systems the routine will prevent this problem by translating all 
incoming open or create requests to lower-case.

In case of an error opening a database most servertasks and also server core 
services do not report their process name and which database they tried to open. 
Mostly you see only the message like "File not found" on the server-console 
which is not really helpful to narrow the problem. This option helps to find 
problems and also to trace open of all databases.

The solution for Linux is available free of charge. Implementations on 
commercial level for Solaris and AIX are available from info@nashcom.de

A.7.3  How can this tool can be used in Migration/Coexistence 
project?

This tool is not directly relevant for the data migration aspect of a Microsoft 
Exchange to Lotus Domino project, but becomes extremely valuable if that 
migration from Exchange also results in a switch to the UNIX platform. Again 
your decision to switch to UNIX or Linux may be influenced by the decision to 
reduce costs and no longer pay for Microsoft Windows Licensing. This tool is 
appreciated most by administrators who have familiarity administering a 
Microsoft server, but are new to the case sensitive nature of the UNIX platform. 

A.7.4  Technical Background
The tool is implemented via Notes C-API Extension Manager technology and 
monitors the following Extension Manager Events

� EM_NSFDBOPENEXTENDED
EM_NSFDBCREATE
EM_NSFDBCREATEANDCOPY

All three calls are monitored with the EM_BEFORE for translation. The open 
event also is monitored in the EM_AFTER step to trace error messages of 
database open requests. This routine uses the internal LMBCS routine and 
therefore also supports international characters.
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A.7.5  Installation:
Perform the following functions to install this tool:

� Copy into binary directory and modify notes.ini

� in the Notes.ini file on the Domino Server add nshextlo to the extmgr_addins 
line.

So, if your extmgr_addins entry in the notes.ini looks like this:

extmgr_addins=toool1, tool2

it should be changed after the installation to:

extmgr_addins=toool1, tool2, nshextlo

A.7.6  Configuration
Configuration is based on the following parameters. 

A.7.6.1   notes.ini
� Bit flag which can be used to enable/disable different functions:

nshextloOptions=1

Log all database requests returning an error with

� calling process/task

� filepath

� status / error

� open options

Example:

Example: A-2   NSH Lovercase Translation Log Example

NshExtLo: DBOpen: (adminp) : '/local/notesdata/names.nsf' OPT:0x0 ST:0 
USER: 'Gregory Engels/ITSO/DE

nshextloOptions=2

Same as Option 1 but log all databases not just databases with error codes.

nshextloOptions=4

Translate Upper case to Lower case filenames. The translation will be logged on 
the console/ in log.nsf.
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nshextloOptions=8

enables verbose logging. In most cases verbose logging is not needed and could 
cause a high number of additional log messages.

Example: A-3   Log File with nshextloOptions=8

NshExtLo: translating to lowercase '/local/notesdata/DB.nsf
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Appendix B. Migration Procedures - 
abbreviated overview

The following Appendix reviews the steps taken in migrating users at the server 
level. In particular, it discusses the steps of migration, including setting an 
autoforward and hiding the GAL once a user migration is complete.

Finally, this appendix is intended to build upon specific data provided in earlier 
chapters - particularly those discussed in Part 4, “Migration Process - tools and 
procedures” on page 337. Please also refer to Chapter 4, “Overview of the 
Migration Procedures” on page 93. 

B

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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Detailed overview of procedure for migrating Users
The following Procedures can be used for migrating users from Exchange to 
Domino. The physical migration of a user mailbox may be only a click of a button 
However, additional procedures should be undertaken to complete the process. 

1. Utilizing the Migration plan select the users for migration

a. Inform user of migration

Do this many times, request the user clean up his mailbox. If you were in 
the process of moving to a new home - you wouldn’t take the trash with 
you, right? In the case of a migration, why take your non-business and 
unwanted emails to your new system?

2. Register the User in Domino either using Domino administration -> People 
and Groups -> Tools > register -> Migrate.

3. After selecting the system to be exchange and choosing the relevant profile

4. Select the users to migrate. 

At this moment in time, do not migrate the mailbox (i.e. select option do 
not convert mail)

Note: Specific technical details for a migration procedure is documented in 
Part 4, “Migration Process - tools and procedures” on page 337. This section 
is merely intended to serve as an overview of the steps and key 
considerations.

Tip: While it sounds obvious - make sure users who are about to be migrated 
have cleaned out their mail files and emptied the trash from their mail file. This 
will have a significant impact to reduce the number of messages requiring 
migration. 
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Figure B-1   Migration options on User registration

Alternatively, if you are using the CMT, select ADD users > Registration > 
register

5. Register users in Domino,

If using Domino migration tools deselect the option to convert mail and 
select add admin to ACL (this is necessary to be able to add migrated mail 
documents later

6. Install mail client for user being migrated - (Outlook Connector or Full Notes 
clients) As an option, you can also enable Sametime for Instant Messaging. 

7. Set an Autoforward on the exchange account - the following steps describe 
how....

Setting an Autoforward on the Exchange Account 

a. If a directory synchronization solution has been installed then a 
synchronization needs to be run to put the domino account into Exchange 
and the following step to add a contact to exchange is not required

b. Add a Contact to Exchange

Note: This is an important step for a successful migration If non 
migrated users still in exchange reply to mail or select a recipient 
from local contacts the replyto address will be the old exchange 
address, setting an autoforward will ensure that all mail is received 
in his new mailbox on Domino
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i. Open the Active Directory Users and Computers right click the 
Organization. 

ii. Select New

iii. Select Organizational Unit 

Figure B-2   Adding a new organizational unit

iv. Enter a name, for example, we used mytest as can be seen in the 
following Figure B-3

Figure B-3   Creating a new folder for custom contacts
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v. Select the newly created Organizational Unit folder

vi. Right Click

vii. Select New -> Contact

Figure B-4   Creating a new contact

viii.Enter details of the person you are migrating and give a meaningful 
display name
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Figure B-5   Creating a new contact properties

ix. Click Next

x. Ensure that ‘create an exchange e-mail address’ is ticked 

xi. Click Modify

Figure B-6   Create new contact email address options

• Click SMTP address
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Figure B-7   Address input

• Enter the secondary domino smtp address (i.e. localpart+@+domino 
server FQDN ) in our example this will be cryan1@migrate2ka.itso1.eu 
as shown in Figure B-7

• There is no need to modify anything on the advanced tab

• Click OK

• Click Next

• Click Finish

Add the Autoforward
In Active directory users and computers 

1. Select View

2. Select Exchange Advances features
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Figure B-8   enable viewing of exchange advance features

3. Select the user account

4. Right Click -> Properties

5. Select the Exchange General tab
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Figure B-9   Exchange advance tab

6. select Delivery options
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Figure B-10   Delivery Options

7. Click the Forward radio button 

8. Click Modify (as shown in Figure B-10)

a. You will be presented with the address box to add an address
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Figure B-11   Selecting a forwarding address

b. Select the forwarding account (should be at name domain/OU. In our 
example it is cindy ryan itso1.ey/mytest as seen in Figure B-11
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Figure B-12   Selecting the forwarding address from Active Directory

c. Select OK

d. Select OK

From now on all email for the user will be forwarded to the Domino account. The 
user can be migrated any time from this point onwards

Considerations - Migrating the mail account using CMT 

The following instructions are a brief summary of the migration of the users’ data 
to Domino and assumes that users have already been registered (either using 
CMT or DUS)

a. Open CMT

b. Add users 

Note: Full instructions on using the CMT to migrate users can be found in 
Chapter 13, “Server Level Migration process using CMT from Binary Tree” on 
page 387
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c. Select import from foreign directory and click run wizard 

d. Enter the target domino server if different from default 

e. Select the tick boxes, migrate to notes folders, migrate rich text, 
distribution lists, resolve names. 

f. Click ok on the next screen, and ensure select users from exchange is 
selected and click ok 

g. Select the user(s) you are migrating and add users 

h. Click left hand pane [REGISTRATION] to see user list, 

i. Select user(s) you want to migrate and check that the information is 
correct in the doc (server name and mail file) 

i. if migrating to a different server than to the registered home server, 
then you will need to change the entry in CMT

j. select the top PANE [SERVER MIGRATION] 

k. select the user(s) to migrate and click ok. 

l. Users will now be migrated.

m. Check migration and mailflow changes are successful

Considerations - Migrating the mail account using DUS

The following instructions are a summary of the steps to undertake to migrate a 
user:

a. Open administrator and click the people and Groups tab

b. Select Register

c. Select Migrate person

d. Select Exchange as the source

e. Select the user accounts to migrate

f. Click Migrate

g. Click Register All

h. The accounts will now be migrated

i. Check migration and mailflow changes are successful 

Note: Again specific instructions on using the DUS to migrate users can be 
found in Chapter 11, “Server level migration Using Domino Upgrade Services” 
on page 339. 
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Hide the account from the GAL
Hide the account from GAL. 

1. From active directory users and computers with Exchange advance features 
enabled

a. Select the user account

b. Right Click -> Properties

c. Select exchange advanced Features

Figure B-13   Exchange Advanced features

d. Select Hide account from Exchange
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Figure B-14   select hide account

e. Click OK

The account is now hidden from all address lookups

� If using Exchange connectors for directory synchronization Run a 
synchronize now and replicate directory between exchange servers

� Provide users with desktop support (via sametime) 

� In some migrations a removal of the account would be required once a 
successful migration has been acknowledged.

Pleas also refer back to Chapter 4, “Overview of the Migration Procedures” on 
page 93. 
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Appendix C. Integrating Domino with 
Sharepoint Portal

Many customers are now exploring the use of portal technologies as a way to 
manage the deployment of Domino Web Access. 

The objective of this chapter is to provide some instructions on deploying Domino 
Web access via Sharepoint Portal. 

In additon to this appendix, we recommend specific Redbooks, and tehcnical 
articles on IBM/Lotus Developerworks (http://www.lotus.com/ldd) and best 

C

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html

Note: This appendix is intended as a helpful guide to one possible approach. 
It is not necessarily a supported approach or configuration, and is intended to 
provide a helpful guidance for possible integration.
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practics on deploying Domino web applications. Finally, many IBM Business 
Partners provide specific web components that allow you to deploy different 
aspects of Domino Web Mail in a similar way to Domino Websphere Portlets.
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C.1  Domino Web access in sharepoint portal
As mentioned in the introduction, many IBM Business Partners provide custom 
web components to integrate Domino Notes mail into either a standalone web 
application, or a more integrated coporate portal, Alternatively, given the required 
in-house development skills, it is possible to develop your own web components. 
A simpler and more straight-forward aproach is to deploy Domino Web Access 
and utilize the supplied WAS plug-ins to provide Single Sign On (SSO) and the 
Domino Web redirector database to provide secure, reliable web access to a 
user’s mail file. 

The following steps discuss how to configure Single Sign On (SSO) and provide 
access to a Domino Mail file via a Sharepoint portal.

Step 1 - Install the WAS plug-ins
1. The Websphere Application Server (WAS) Plugins can be found in the 

following domino Directory :-

*\Program Files\Lotus\Domino\data\domino\plugins\was6\w32

Figure C-1   WAS plugins

2. Create the following directories on the Windows sharepoint server

· C:\WebSphere\AppServer\bin

· C:\WebSphere\AppServer\config

Note: It is assumed that in all instances, the Sharepoint Site is secured and 
default access has been disabled. If this is not the case, for SSO to work, 
Anonymous Access must be disabled for the Sharepoint web site in IIS
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· C:\WebSphere\AppServer\etc

· C:\WebSphere\AppServer\logs

� copy the file iisWASplugin_http.dll to C:\Websphere\AppServer\bin

� copy the file plugin_common.dll to C:\Websphere\AppServer\bin

� copy the file \Lotus\Domino\Data\domino\plugins\plugin-cfg.xml to 
c:\WebSphere\AppServer\config

Figure C-2   WAS plugins
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Figure C-3   WAS config plugin

3. Configure the Plugin-cfg.xml

• Wordpad c:\WebSphere\Appserver\config\plugin-cfg.xml

• Change Hostname to the hostname of the domino server

• Add the following after <UniGroup Name=default_host_URIs”>

<Uri Name="/*.nsf*"/>

<Uri Name="*.NSF*"/>

<Uri Name="*/icons/*"/>

<Uri Name="*/domjava/*"/>
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Figure C-4   Configuring Plugin-cfg.xml

4. Next, update the registry

– Regedit

Add the following entries to the registry under

_HKEY_LOCAL_MACHINE

> SOFTWARE

>IBM (If IBM does not exists create right click on SOFTWARE New Key)

• Right Click IBM

• Click New

• Click Key
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Figure C-5   Creating the WebSphere Key

• Enter Websphere Application Server

• Right Click Websphere Application Server

• Click New

• Click Key

Figure C-6   Creating the WebSphere version key

• Enter 5.0

The version number may change depending on the version of 
Websphere installed. e.g. 5.1.0.1

The following string values need to be added.

• BinPath with a value of C:\websphere\AppServer\bin

• InstallLocation with a value of C:\websphere\AppServer

• LibPath witha a value ofC:\websphere\AppServer\lib

• MajorVersion with value of 5 (again dependant on the release)

• Plug-in Config with a value of 
C:\websphere\AppServer\config\plugin-cfg.xml

To add a string the following instructions can be followed
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• Right Click the version number created before

• Select new

• Select String Value

Figure C-7   Adding a string

• Enter the string name e.g BinPath

• Right Click the string (binpath)

• Select Modify

Figure C-8   Modifying the string 

• enter the string value e.g C:\websphere\AppServer\bin

Figure C-9   Adding the String value

• Do the same for each of the strings mentioned above

• Finally, the registry should look like the following
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Figure C-10   The completed registry

5. Configure IIS

• Open the IIS manager

Figure C-11   Start IIS manager

• Navigate to the Default Website

• Right Click the default Web Site

• Select New

• Select Virtual Directory
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Figure C-12   Default Web site add new virtual directory

• You will be presented with the Virtual directory creation wizard as 
shown in Figure C-13 on page 794

• Click Next

Figure C-13   Virtual Directory creation wizard
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• Enter SePlugins as the Alias

• Click Next

Figure C-14   Entering a virtual directory Alias

• Enter the path for Website contents path this should be Default web 
C:\Websphere\AppServer\Bin

• Click Next
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Figure C-15   Enter the content path

• Select Run Scripts and permissions in the the permissions box as 
shown in Figure C-16

• Click Next

Figure C-16   SePlugins Permissions
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• Click Finish

6. Next Right Click in Default Web Site 

Figure C-17   Options in Right click

• Select Properties

• Click ISAPI Filters tab
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Figure C-18   ISAPI Filters

• Click Add

• Enter iisWASPlugins for the filter name

• Enter C:\websphere\AppServer\bin\iisWASPlugin_http.dll for the 
executable. NB you can use browse to search for the file if you wish
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Figure C-19   WAS Plugin Filter

• Click OK

• Click OK

7. Next add a WebExtension

• from IIS manager select Web Service Extensions

• Right Click

• Select Add new web service extension
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Figure C-20   Create a new Web extension

• Call the extension iisWASPlugins

• Add the following Dll’s to the required files

C:\websphere\AppServer\bin\iisWasPlugin_http.dll

C:\websphere\AppServer\bin\plugin_common.dll

• Click > Set extension services to Allow
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Figure C-21   Configuring the Web extension

• Click OK

• Right Click Web Sites

• Select the Services Tab

• Select > Run WWW services in IIS 5.0 isolation mode

Note: do not do the following step if you are configuring IIS on the 
same physical machine as sharepoint server otherwise Sharepoint 
will fail to load
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Figure C-22   IIS 6.0 run in iis 5.0 isolation mode

• Click OK

• Restart IIS

8. Add the path extensions for the Domino Web Access

• Start the Sharepoint central Administration tool

Start > Programs > Administration Tools > Sharepoint Central 
Administration
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Figure C-23   Start Sharepoint Administration

• Select Configure Virtual Server Settings under Virtual server 
configuration
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Figure C-24   Configure Virtual server settings

• Select the Virtual server to configure. In our website this was 
<sharepoint web site>
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Figure C-25   Select virtual Web site

• Under <Virtual Server Management> Select <define managed path
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Figure C-26   Select managed path

• under Add a new path

• Enter http://<server name:port>/mail

• e.g http://sps1-lab-1:89/mail

• Click exclude Path

• Click OK
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Figure C-27   Defining an exclude path

• Repeat for the following 

/inotes

/domjava

The command line to do this is as follows:-

stsadm -o addpath -url http://localhost/mail -type exclusion

stsadm -o addpath -url http://localhost/inotes -type exclusion

stsadm -o addpath -url http://localhost/domjava -type exclusion

9. Add users credentials to the person document.

You need to add the Domain login credentials to the user accounts. If you use 
the ADSYNCH to add users from Active Directory they are automatically 
added. 
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– open the person document

– In the username field add the domain/userid e.g GLP/SPOVALL

Figure C-28   Add Windows credentails to Domino account

10.Set up Web redirection.

As we pass the credentials to Domino, Domino can now match to a user 
record. Domino therefore knows the mailfile for the user. It would be a tedious 
task to configure a unique mail web part for each user containing the location 
of the mailfile. Fortunatly, Domino comes with a web redirector that we can 
use to automaticlly open a person’s mailfile based on passed credentials.

The current one shipped with domino has limited capability, Unlike an earlier 
release, it does not allow the administrator to define the mail component that 
should be open (e.g. inbox, calendar, address book etc). However the version 
641 available at: 
http://www-10.lotus.com/ldd/sandbox.nsf/140e61e7f55c607685256ead0064
d6c4?OpenForm&ParentUNID=F4B19C0C3327DF5385256A8F0063BDF4.

Unzip and copy the WebMailRedirect641.ntf to the Domino server data 
directory.

– Create the Inbox redirector database 

• from the domino administration client File > Database > New

• Select the server for the database (eg. migrate2003b/itso/fr)

• Give the database a name (e.g mail redirector)

• Give the database a file name (eg redirmail.nsf)

• Select the server where you copied the template to

• Select WebMailRedirect641.ntf as the template.
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Figure C-29   Create redirector database

• Click OK

Next configure the database

• Click Setup

• Click Server Settings and select dynamic if you have multiple servers 
and Fixed if you have a single server .

• If fixed enter the domino server name
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Figure C-30   Redirector server settings

• next Click UI setup

• Set the timeout to 0

• Disable personal profiles

• Click the twisty next to Disable for Global profiles

• Select iNotes inbox portal
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Figure C-31   Select the default view

• The configuration should look like as shown in Figure C-32 on 
page 811

Figure C-32   Completed ui setup

• Click Application setup

• select Click to Auto Set ACL settings

• Click Save and Exit

• Create new redirector database for Calendar

• Optionaly create additional redirct databases for ToDo’s and Notes
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•

� Add web part to Sharepoint

Add additional web parts to your sharepoint site for Mail and Calendar.

– launch your browser

– enter the URL of your site (in our example we created a new site thus our 
url was http://sps-lab-1:89/sites/mail/newsite

– Click Modify Shared page

Figure C-33   Modify page

– Under modify shared page click Search

– Enter “Page Viewer” in the search box

– select page viewer web part and click add as shown in Figure C-34 on 
page 813

Tip: For a full inotes view leave the uisetup as defaults
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Figure C-34   Add Web page viewer

– Click OK

– Exit the modify page (click the little x)

– Select open the tool pane form the new web part

Figure C-35   Configure the Web Part

– Enter the full FQDN of the domino server followed by /<redircordb.nsf> in 
our example this would be http://migrate2003b.cam.itso.ibm.com/redir.nsf
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Figure C-36   Configure the Web Part

– adjust the size to your site preferences

– Click OK

– the web part should resolve to the new url 

– clear all cache from the the web browser and when prompted Log in as a 
valid domino user in our example this was spovall

Figure C-37   User login prompt to sharepoint portal
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– the redirector message will be displayed in the web part window whilst the 
mial file is accessed and the view built

Figure C-38   Redirector message

– after a short while the mail file will be open in the web part

Figure C-39   Domino inbox accesed in sharepoint
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In Summary we have reviewed how to setup single signon between sharepoint 
and Domino. further utilsing the webredirctor we are able to create individual web 
parts for differnet aspects of the domino mail. Web based applications can also 
be accesed in this way by entering the full url to access the required view or form 
or by creating web srevices. Other rebooks cover this topics in detail.
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Appendix D. Tips for performing a 
successful migration

This appendix helps you identify and resolves some potential issues during the 
process of migrating from Exchange to Domino. 

D

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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List of issues and solutions
Table D-1 lists a few situations that you can encounter during the migration 
process that require some simple troubleshooting.

Table D-1   Troubleshooting tips

issues Solution

If you need to migrate a user more than once… The Domino Migration Tool is designed as a "run 
once" utility, which registers users and creates 
associated mail files on the Domino server. You can 
migrate a user more than once, but remember that 
if you migrate to the same Domino mail file, the 
existing data is not replaced, just appended. 

If you need to "re-migrate" a user, delete the 
existing Domino mail file from the Domino server, 
then perform the migration for that user again. You 
are informed that the user is already registered on 
the Domino server and prompted to update the 
existing user. Do this, complete the migration, and 
a new mail file is created for the migrated user on 
the Domino server.

If the address conversion for a user's mail file fails… While running the address conversion utility, you 
might see the message, Address conversion 
failed for this user.

It's crucial that the server name and address book 
be up to date before running the address 
conversion. Update the name and address book 
following the instructions previously outlined, then 
perform the address conversion again.

If after migration, a user's mail file displays 
addresses (such as in the Chair item or From item) 
in Microsoft Exchange format…

If addresses are displaying in Exchange format, you 
might have forgotten to perform the address 
conversion on this mail file. 

To be on the safe side, perform the address 
conversion on all the migrated mail files on the 
Domino server. Also, it is possible that you have not 
yet migrated the user whose address is displaying 
in Exchange format. After that user has been 
registered on the Domino server and the 
associated mail file migrated, run the address 
conversion utility again.
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If the Domino Migration Tool fails while users are in 
the process of being migrated…

If the migration process fails, which can happen if 
the server connection is lost, it is best to start the 
process again, beginning with the user in transit 
during migration.

If the migration process fails while migrating a user, 
that user and any others in the Registration Queue, 
are saved in preparation for registration and 
migration. Because the user was in transit when the 
failure occurred and might be partially migrated, it is 
best to delete that user's mail file from the server 
when the server connection is restored. Then, 
resume the migration process by selecting Register 
All in the Register Person dialog.

issues Solution
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Appendix E. Exchange Connector 
installation checklist

In this appendix we provide a checklist to be used to retain information that is 
required during the installation of the Exchange Connector.

E

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html
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General setup information
To install and configure the Exchange connector for Lotus Notes you will need 
at a minimum the following information:

– Domino Version __________________

– Notes Client Version ______________

– The Domino server name ____________________. 

Note: In a multi-server environment, your registration server and mail 
server might not be the same.

– The name of the Domino Administrator ID file is ________________.

– The password for the Domino Administrators id _________________

– Mail File Template name ______________________

– Domino Certifier location ______________________

– Domino Certifier Password ____________________

– The Exchange Administration account name ____________

– The Exchange Administration Password ________________

– The Exchange server name is ________________________ 

– The Exchange Organization name is ___________________

– The Exchange Site name is ____________________

– The WinNT domain name is ___________________.
822 Migrating from Microsoft Exchange2000/2003 to Lotus Notes and Domino 7



Draft Document for Review September 11, 2006 10:43 pm 7777ax_installing_domino.fm
Appendix F. Installing Domino

This appendix serves as a quick reference for optionally installing Domino.In the 
case that you are migrating from Exchange and are not familiar with installing 
Domino Servers, this can be used as a quick reference guide. 

F

Note: This Redbook is still in “draft” mode and is still undergoing final technical and 
grammatical review. While in draft mode, the paper may contain minor editing 
comments, minor omissions, technical inaccuracies or spelling errors. The intention in 
publishing this draft is to provide the information as quickly as possible, and to provide 
the greatest value to the technical community. Expected final publish date = late - 
October 2006. For latest draft, check: 
http://www.redbooks.ibm.com/redpieces/abstracts/sg247777.html

Important: This appendix is simply a quick reference for optionally installing 
Domino. Refer to the product documentation available at the IBM Web site for 
comprehensive instructions:

http://www.lotus.com/ldd/notesua.nsf/0b345eb9d127270b8525665d006bc355/831
3e8d10f025dee8525698100541f6d?OpenDocument
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Installing Domino
Complete the following steps:

1. To install Domino Enterprise Server Version 7.x launch the setup file. 

2. Click Next, as shown in Figure F-1.

Figure F-1   Domino Setup Welcome window

3. Click Yes to accept license terms, as shown in Figure F-2.
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Figure F-2   License agreement

4. Fill in your Name and Company and then click Next, as shown in Figure F-3.

Figure F-3   Enter your name and company

5. Select the installation directory and click Next, as shown in Figure F-4.
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Figure F-4   Installation folder

6. Select Domino Enterprise Server, as shown in Figure F-5. If needed, you 
can customize services by clicking the Customize button. Click Next.

Figure F-5   Server Setup window
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7. The installation is complete, as shown in Figure F-6. Click Finish and then 
start Domino server to begin the setup.

Figure F-6   Successful installation window
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8. The window will change to show “Welcome to Domino Server Setup,” as 
shown in Figure F-7. Click Next.

Figure F-7   Domino setup window
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9. In the First or additional server window, select Set up the first server or a 
stand-alone server, as shown in Figure F-8. Click Next.

Figure F-8   Set up single server
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10.In the Provide a server name and title window, enter your values (you can 
leave the title blank because it is not a required field), as shown in Figure F-9. 
Click Next.

Figure F-9   Domino Server name and title
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11.In the Choose your organization name window, enter your values (in this 
example, ibm) and provide a suitable password for the Organization Certifier, 
as shown in Figure F-10. Keep this password somewhere safe, because you 
will need it later. Click Next.

Figure F-10   Organization and Certifier password
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12.Enter the Domino domain name and click Next, as shown in Figure F-11.

Figure F-11   Enter the Domino domain name
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13.In the Specify an Administrator name and password window, enter the name 
Domino Admin with a suitable password, as shown in Figure F-12. As before, 
keep this password somewhere safe.

Figure F-12   Domino Administrator name and password
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14.When choosing which Internet services Domino should run, select all three 
options, as shown in Figure F-13, and click Next.

Figure F-13   Domino services setup
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15.The Domino network settings window shows that all available ports have 
been enabled and that setup has determined what the fully qualified domain 
name of the server should be, as shown in Figure F-14.

Figure F-14   Domino network setup
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16.In the Secure your Domino Server window, select Prohibit Anonymous 
access to all databases and templates and Add LocalDomainAdmins 
group to all databases and templates, as shown in Figure F-15. Click Next.

Figure F-15   Domino Server security setup
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17.The final window asks you to review and confirm the setup options. Click 
Setup.

Figure F-16   Domino final setup window

When setup finishes, start the Domino server. For Windows environments, we 
recommend that you start the Domino server as a Windows service the first time 
you are prompted.

Install Domino Administrator and Lotus Notes Client
The Notes Client is required to administer and configure the Domino server. In 
this example, we install the Notes Client to the same machine as the Domino 
server. When installed to separate directories, the client and server can coexist; 
however, this is not advised in a production environment.

Complete the following steps:

1. From the Notes Client install CD, select Notes Administration client and run 
setup.exe. Click Next in the Welcome window, as shown in Figure F-17 on 
page 838.
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Figure F-17   Client Configuration Welcome window

2. Accept the license agreement and click Next. 

3. Select a directory and click Next, as shown in Figure F-18.

Figure F-18   Notes installation directory
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4. Now, select the client to install and click Next, as shown in Figure F-19.

Figure F-19   Select client type

5. When prompted for a user name, enter the name of the Domino Administrator 
you created (in this example, Domino Admin) and the host name for the 
Domino server, as shown in Figure F-20. Click Next.

Figure F-20   User Information window
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6. Clear the Setup instant messaging option and click Next, as shown in 
Figure F-21.

Figure F-21   Clear the Setup instant messaging option

7. On the Additional Services window, clear all options and click Finish, as 
shown in Figure F-22.

Figure F-22   Notes Client setup final window
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8. The Notes Client will now connect to the server and perform some local setup 
activities. Note that this will take a couple of minutes to complete before 
displaying the window shown in Figure F-23.

Figure F-23   Directory Profile setup

9. Set the field values, as shown in Figure F-23, and click Save & Close.
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Related publications

The publications listed in this section are considered particularly suitable for a 
more detailed discussion of the topics covered in this redbook.

IBM Redbooks
For information on ordering these publications, see “How to get IBM Redbooks” 
on page 844. Note that some of the documents referenced here may be available 
in softcopy only. 

� ????full title???????, xxxx-xxxx

� ????full title???????, SG24-xxxx

� ????full title???????, REDP-xxxx

� ????full title???????, TIPS-xxxx

Other publications
These publications are also relevant as further information sources:

� ????full title???????, xxxx-xxxx

� ????full title???????, xxxx-xxxx

� ????full title???????, xxxx-xxxx

Online resources
These Web sites and URLs are also relevant as further information sources:

� Description1

http://????????.???.???/

� Description2

http://????????.???.???/

� Description3

http://????????.???.???/
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How to get IBM Redbooks
You can search for, view, or download Redbooks, Redpapers, Hints and Tips, 
draft publications and Additional materials, as well as order hardcopy Redbooks 
or CD-ROMs, at this Web site: 

ibm.com/redbooks

Help from IBM
IBM Support and downloads

ibm.com/support

IBM Global Services

ibm.com/services
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